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About This Guide

How to use these guides

These guides function as both a tutorial and as a guide for performing your own
experiments.

Note: First-time users of the ViiA™ 7 System, please read this booklet, Getting Started
with ViiA™ 7 System Experiments thoroughly. The booklet provides information and
general instructions that are applicable to all the experiments described in this binder.

How to use these booklets as tutorials

Each booklet in this guide provides a tutorial for running an example experiment
using ViiA™ 7 Software and the example data provided on the installation CD. The
following booklets are provided:

Getting Started with ViiA™ 7 System Experiments — introductory information and
experiment workflow common to all experiments.

Running Standard Curve Experiments — designing, running, and analyzing a
Standard Curve experiment.

Running Relative Standard Curve and Comparative C Experiments — designing,
running, and analyzing Relative Standard Curve and Comparative Cy
experiments.

Note: This booklet also provides information on setting up, running, and
analyzing a gene expression study of two Comparative Cy experiments.

Running Genotyping Experiments — designing, running, and analyzing a
Genotyping experiment.

Running Presence/ Absence Experiments — designing, running, and analyzing a
Presence/Absence experiment.

Running Melt Curve Experiments — designing, running, and analyzing a Melt Curve
experiment.

ViiA™ 7 System Experiments - Appendixes — common information such as ordering
information, additional documentation, and glossary.

Note: In all booklets, the term “experiment” refers to the entire process of
performing an experiment, including setup, run, and analysis.

How to use the guides with your own experiments

Each booklet contains instructions specific to an example experiment provided on the
installation CD. However, you can use the booklets as guides for your own
experiments; tips for running your own experiments are provided at various points in
each booklet.

Getting Started with ViiA™ 7 System Experiments 5



How to use these guides

Assumptions
This guide assumes that you have access to the example experiments provided with
the software.

How to access an example experiment

Start the ViiA™ 7 Double-click (ViiA™ 7 Software shortcut) to access the Home screen, shown
Software below.

- SEEE

Tl New Bxpenmant - GF Cpen.. bl Save - I 5 roort. - B i

ViiA™ 7 Software ABERed o

i, Experiieat = i G  Anshee
‘; Setup (J Quickgrart Experimaent

R B == . v Qene.
- e | Consoke LXpress e

Sty |
@ Readwipp .]
3
d_u.
Open an example From the Home screen, click Open, to navigate to the experiments folder (default):
experiment <drive>:\ Applied Biosystems\ ViiA7 Software v1.1\ experiments\examples, and open

the example experiment file.

Data files in the Examples folder

¢ ViiA7 96-Well Comparative Ct Example.eds

* ViiA7 96-Well Multiplex Example.eds

* ViiA7 96-Well Presence-Absence Example.eds

* ViiA7 96-Well SNP Genotyping Example.eds

* ViiA7 96-Well Standard Curve Example.eds

* ViiA7 96-Well SYBR Green PCR w Melt Example.eds
* ViiA796-Well Relative Standard Curve Example 2.eds
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A note on system security

ViiA796-Well Relative Standard Curve Example.eds
ViiA7_384-Well_Comparative_Ct_Example.eds
ViiA7_384-Well_Comparative_Ct_Example_1.eds
ViiA7_384-Well_Comparative_Ct_Example_2.eds
ViiA7_384-Well_Comparative_Ct_Study_Example.edm
ViiA7_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example.edm
ViiA7_384-Well_Melt_ Example.eds
ViiA7_384-Well_Multiplex_Example.eds
ViiA7_384-Well_Presence-Absence_Example.eds
ViiA7_384-Well_Relative_Standard_Curve_Example.eds
ViiA7_384-Well_Relative_Standard_Curve_Example_2.eds
ViiA7_384-Well_SNP_Genotyping_Example.eds
ViiA7_384-Well_Standard_Curve_Example.eds
ViiA7_384-Well_SYBR_Green_Melt_Example.eds
ViiA7_384-Well_SYBR_Green_PCR_with_Melt_Example.eds
ViiA7_TaqMan_Array_Comparative_Ct_Example.eds
ViiA7_TagMan_Array_RNaseP_Example.eds
ViiA7_TagqMan_Array_Standard_Curve_Example.eds

In addition to the above, the experiments folder also contains the following user
sample files:

BarCode_Template 384Wb.txt
ViiA 7 Custom Sample Properties_example.xls

A note on system security

The Security, Auditing, and e-Signature (SAE) feature in ViiA™ 7 Software enables
role-based access control to enforce data integrity and authentication of users logging
into the system, to strengthen system security. The feature tracks actions performed by
users on experiments, templates, and studies, and it tracks changes to the SAE settings.
You can enable and later disable this feature to accommodate your security needs.

To enable or disable the feature, from the toolbar select Tools » Security P Settings.

For more information on the SAE feature, please refer to Applied Biosystems ViiA™ 7
Real-Time PCR System User Guide (PN 4442661).

Note: If you have not purchased the SAE module, the security feature is disabled for
experiments, templates, and studies.
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Safety information

Safety information

Note: For general safety information, see this Preface and Appendix B, Safety. When a
hazard symbol and hazard type appear by a chemical name or instrument hazard, see
the “Safety” Appendix for the complete alert on the chemical or instrument.

Safety alert words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert word —
IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of
observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most
extreme situations.

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety symbols” in Appendix B, Safety).

Safety Data Sheets (SDSs)

The SDSs for any chemicals supplied by Applied Biosystems or Ambion are available
to you free 24 hours a day. For instructions on obtaining SDSs, see “SDSs” in
Appendix B, Safety.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems,
Ambion or Invitrogen contact the chemical manufacturer.

8 Getting Started with ViiA™ 7 System Experiments



Safety information

Safety labels on instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in

the preceding section.

Hazard
symbol

English

Francais

/N

CAUTION! Hazardous chemicals. Read the Safety
Data Sheets (SDSs) before handling.

ATTENTION! Produits chimiques dangereux. Lire les
fiches techniques de sireté de matériels avant toute
manipulation de produits.

CAUTION! Hazardous waste. Refer to SSDS(s) and
local regulations for handling and disposal.

ATTENTION! Déchets dangereux. Lire les fiches
techniques de sdreté de matériels et la régulation
locale associées a la manipulation et Uélimination
des déchets.

AN

WARNING! Hot lamp.

AVERTISSEMENT! Lampe brilante.

WARNING! Hot. Do not remove lamp until 15 min
after disconnecting supply.

AVERTISSEMENT! Lampe brilante, apres avoir

déconnecté le cable d’alimentation de l'appareil,
attendre environ 15 minutes avant d’effectuer un
remplacement de la lampe.

WARNING! Hot. Replace lamp with an Applied
Biosystems lamp.

AVERTISSEMENT! Composants brdlants.
Remplacer la lampe par une lampe Applied
Biosystems.

CAUTION! Hot surface.

ATTENTION! Surface brilante.

DANGER! High voltage.

DANGER! Haute tension.

WARNING! To reduce the chance of electrical
shock, do not remove covers that require tool access.
No user-serviceable parts are inside. Refer servicing
to Applied Biosystems qualified service personnel.

AVERTISSEMENT! Pour éviter les risques
d’électrocution, ne pas retirer les capots dont
Uouverture nécessite lutilisation d’outils.
Linstrument ne contient aucune piéce réparable par
Lutilisateur. Toute intervention doit étre effectuée par
le personnel de service qualifié venant de chez
Applied Biosystems.

CAUTION! Moving parts. Crush/pinch hazard.

ATTENTION! Pieces en mouvement, risque de
pincement et/ou d'écrasement.
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Chapter 1

General Information and
Instructions

Experiment Shortcuts

CHAPTER 1

General Information and
Instructions

This chapter covers:

B Order materials for the experiment............ ... ... ... ..., 12

Setupanexperiment.......... ... ... i 13
B Preparereactions ...............o i 24
B Starttheexperiment.......... ... ... .. i 38
B Review experimentresults .............. ... .. Lo i 52
B Exportanexperiment. ...............iiiiiii 57

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking &) in
the toolbar, or selecting Help » ViiA™ 7 Software Help.
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1 Chapter 1 General Information and Instructions
Order materials for the experiment

Order materials for the experiment

There are two ways to order materials required for the experiment:

¢ Order directly from the Applied Biosystems store.
* Access the Applied Biosystems store from the ViiA™ 7 Software.

About ordering from the Applied Biosystems store

Note: Product availability and pricing may vary according to your region or country.
Online ordering through the Applied Biosystems Store is not available in all countries.
Contact your local Applied Biosystems representative for help.

Note: See Applied Biosystems ViiA™ 7 Real-Time System User Guide (PN 4442661) for a
complete list of instrument parts and accessories, consumables, and reagents or
Booklet 7, ViiA"™ 7 System Experiments - Appendixes of this binder for a complete list of
compatible consumables and reagents.

Applied Biosystems recommends the following browsers and Adobe® Acrobat®
Reader® versions to use the Applied Biosystems web site:

Note: Confirm that your computer has an Internet connection.

Mozilla® Microsoft®
Operating System ) ® Internet Adobe® Reader®
Firefox ®
Explorer
Windows® XP/ Firefox® v2.0 or Internet Explorer® | Adobe® Reader®
Windows® 7 later v6.0 or later v4.0 or later

Note: Make sure that cookies and JavaScript are turned on for the web site to function
correctly.

Access the store from ViiA™ 7 Software

1. To find your assay on the Applied Biosystems Store, complete the Find Assay
pane in the ViiA™ 7 Software:

a. Enter a gene name in the Enter Gene Name field, then click Find Assay.

b. In the Find Assay Results dialog box, select your assay.

c. Click Apply Assay Selection. The selected assay gets added to your
shopping list.

2. Check that the Experiment Shopping List contains the desired materials, other
than the assay selected in the previous step, and that the quantities are correct,
then click Order Materials in List.
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Chapter 1 1
Set up an experiment

3. Inthe Order Materials - Login dialog box, enter your user name and password for
the Applied Biosystems Online Store, then click Log In and Submit.

Order Materials - Log In x|

Log into the Applied Biosystermns Store to place the selected iterns in your shopping basket, If you do
not have a user name and password, click "Register Mow" to create a new account,

' OR .
Store Log In Reqister

To log irto the Applied Biosysterns Store, enter your user name Ifyau do not

and password then click"Log In and Subrmit', have an Applied
Binsystems

Lser Marne: ngcﬂh8?54 account, click
the link below to
create a new

Password: I**************

account.

Reqister MNow

™ Remember my user name and password for future orders

Note: If you do not have an account with the Applied Biosystems Online Store,
click Register Now to create an account.

4. When you are connected to the Applied Biosystems Store, follow the prompts to
complete your order.

Set up an experiment

Define experiment properties

All experiments require the same general setup tasks; individual booklets supply
specific parameters. The following procedures outline general steps to take to set up an
experiment.

Access ViiA™ 7 Software and click the Experiment Setup icon. Click Experiment
Properties to access the Experiment Properties screen.

Define experiment name and type

1. Enter a unique experiment name in the Experiment Name field. The default is a
date and time stamp, which you can change. For example, 2010-04-12 173730.

* Enter a name that is descriptive and easy to remember. You can enter up to
100 characters.

* You can only use the alpha-numeric, period (.), hyphen (-), underscore ( _)
and spaces () characters.

Getting Started with ViiA™ 7 System Experiments 13



1 Chapter 1 General Information and Instructions
Set up an experiment

Select the reagent

14

Note: Make sure each experiment name is unique. If you have named two
different experiments with the same name, you cannot run them on the same
instrument. You will receive the following error message:

Failed to Start Run x|

@ Unable ta start the run,
The experiment already exists, Delete the experiment before starting the run,

If you do not want to delete the existing experiment, rename the duplicate
experiment and then proceed to the run.

(Optional) Enter or scan the barcode on the reaction plate. You can enter up to 100
characters in the Barcode field.

(Optional) Enter a user name to identify the owner of the experiment. You can
enter up to 100 characters in the User Name field.

(Optional) Enter comments to describe the experiment.

Select the block type you are using to run the experiment
¢ 384-Well Block
¢ Array Card Block
* 96-Well Block (0.2mL)
¢ Fast 96-Well Block (0.1mL)

Select the experiment type:
e Standard Curve
e Relative Standard Curve
¢ Comparative Cp (AACr)
e Melt Curve
¢ Genotyping
e Presence/Absence

Select the reagent you are using to detect the target sequence:

TagMan® Reagents
SYBR® Green Reagents
Other

Note: If you select SYBR® Green as the reagent, then you have the option of
including a melt curve for that experiment.
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Set up an experiment

Define the instrument run properties

1. Select the ramp speed for the experiment:
e Standard
¢ TFast

2. For Genotyping and Presence/Absence experiments, select the options for the
data collection to include in the experiment run:

* Pre-PCR Read - to include data before amplification occurs. Use the data
collected during pre-PCR read to normalize florescence data collected
during post-PCR read.

e Amplification - to include real-time data.

* Post-PCR Read - to include data after amplification has taken place.

3. (Optional) For real-time data collection, you can change the default analysis
settings in the Preferences for the following:

* Automatic analysis
¢ Automatic save
* Baseline settings

Go to Tools » Preferences. Click the Experiment tab. Select the Auto Analysis
and Auto Save check boxes for the ViiA™ 7 Software to automatically analyze
and save experiment results. You can also edit the following default baseline

settings:
Field Entry
Start Cycle Number 3 (default)
End Cycle Number 15 (default)

Note: By default, the Auto Analysis and Auto Save check boxes are selected.
4. For the Melt Curve experiment, select the Include PCR check box, to include PCR.
5. Save the experiment. The default file name ( .eds extension) is the experiment
name that you entered when you set up the experiment and saved it for the first

time. Changes to the experiment name after the first save do not update the file
name. To change the file name, select File » Save As.

Getting Started with ViiA™ 7 System Experiments 15
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Set up an experiment

The Experiment Properties screen for a Standard Curve experiment looks like this:

How do you want to identify this experiment?

T Bxperiment Mame: |viAT 334-well Standard Curve Example Comments |standard Curve examplk e

Barcode;

User Mame: 'Ex.-nu:ia User L .

Which block are you using to run the experiment ?

Py 384-Well Block | | Arvay Card Bhock | 96-Wedl Block (0.2mL} | Fast 96-Well Block (0.1mL)

< Standard Curva | | Rolative Standard Curve ] | Comparative Cf (ANCT) | | Melt Clirve |

Genntyping Presence/ Ahsence

Which reagents do you want to use to detect the target sequence?

o TagMan® Resgents | | SYBRIE Green Reagents | | (it J

What properties do you want for the insbrument run?

standard J s Fast |

Define targets, samples, and biological replicate groups

Use the Define screen to define targets, samples and biological replicates for your
experiment. For Genotyping experiments, use this screen to specify the number of SNP
assays to include in the experiment.

Note: You can start a run without these definitions, but there will be no real-time data
in the amplification plots (the amplification plots can be seen only after you have set
up the plate).

1. Click Define to access the Define screen.

2. Define targets.
a. Click New to add targets and define them.

b. In the target table, click a cell in the Target Name column for the target, then
enter your target name. The default name is Target 1.

C. Select the Reporter and Quencher from the respective drop-down menu.

Note: The default reporter and quencher dyes used depend on the reagent
selected during experiment setup. For example, if TagMan@® is the selected
reagent, the default reporter FAM and default quencher is NFQ-MGB.

d. Select the target Color from the drop-down menu.

e. (Optional) Click Save to Library to save the newly added or existing edited
targets to the target library.

Note: Use the targets from the Target Library to avoid re-entering the
information. See “(Optional) Use libraries when designing your own
experiments” on page 23 for information on target libraries.

f. Click Import from Library to add targets from the target library.
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3. Define samples.
a. Click New to add samples and name them.

b. In the samples table, click a cell in the Sample Name column for the sample
to define and enter your sample name. The default sample name is Sample 1.

c. Select the sample Color from the drop-down menu.

d. (Optional) Click Save to Library to save the newly added or existing edited
samples to the sample library.

Note: Use the samples from the Sample Library to avoid re-entering the
information. See “(Optional) Use libraries when designing your own
experiments” on page 23 for information on sample libraries.

e. Click Import from Library to add samples from the sample library.

4. Define biological replicates.

a. In the Define Biological Replicates Groups table, click New to add biological
replicate group and name them. You can enter up to 100 characters in this
field.

b. Select the Color from the drop-down menu.
c. Click in the Comments column to add comments for that biological replicate

group.

5. Select the Passive Reference from the drop-down menu.

The Define screen for a Standard Curve experiment looks like this:

Target Name Reporter Quencher Color Sample Name Color

RNAse P FAM + |NFQ-MGB v‘ v‘ 5K -

10K -

Biological Replicate Groups

Hew

Biological Group Name Color Comments

Passive Reference

ROX v

Getting Started with ViiA™ 7 System Experiments 17
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Set up an experiment

Assign targets, samples, and biological replicate groups

Use the Assign screen to assign targets, samples, and biological replicate groups to
wells in the reaction plate. For Genotyping experiments, use this screen to assign SNP

assays.

Note: You can start a run without these assignments, but there will be no real-time
data in the amplification plots (the amplification plots can be seen only after you have

set up the plate).

1. Click Assign to access the Assign screen.

2. Assign targets.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select a target and assign its task, in the plate, from the drop-down menu.
Depending on the experiment type, options are:

Experiment type Legend Tasks
Standard Curve U Unknown
S Standard
N Negative Control
Relative Standard Curve U Unknown
Standard
N Negative Control
Comparative CT Unknown
Negative Control
Genotyping U Unknown
1/ Positive Control Allele 1/ Allele 1
2/2 Positive Control Allele 2/ Allele 2
1/2 Positive Control Allele 1/ Allele 2
N Negative Control
Presence/ Absence U Unknown
| Internal Positive Control
N Negative Control

Melt Curve

Unknown

Negative Control

18
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Targets

Plate Layout

Chapter 1 1
Set up an experiment

3. Assign Samples.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select the check box next to the sample to assign to the selected wells.

Note: You can assign only one sample to a well. If the selected wells contain
mixed assignments (indicated by a [ ), remove existing sample assignments
before you make the new sample assignment.

4. Assign Biological Replicate Groups.

a. Select wells using the plate layout or the well table on the Assign screen.

b. Select the check box next to the biological replicate group to assign to the

selected wells.

The Assign screen for a Standard Curve experiment looks like this:

Well Table

Name
| |russep o= |
Samples ——0on A
| sk |
| o |
Biological Groups ————— &)

N EA R N R A E R e A
a (IR0 (% (S SO N X 0P NP Y P 0
i bs s Bl B's s Eo o o Bl Bl So Bo Bio Bfu Bl Bl Bl o o Sfo Blu Elu B £
< |0 [ o o 0 CE R 0 0 CE
o 0 [ e 0 CE R 0
< |0 [ o 00 P 0
- |0 o o 0 CE P CE0 R 0 0 0
o o0 [ e 0 CE D R 0 N
1 | [ 0 0 0 CE R Y 0 O
|0 [ o 0 CE D R R 0 O
> |0 [ o o 0 CE R 0 0 CE
o0 [ o e 0 CE R 0
|0 [ o 0 R
o |0 0 0 0 CE N C0 R 0 R 0
o0 [ e 0 CE N R N
o | [ 0 0 CE 0 R 0
- o0 [ o e 0 CE D R N 0
T'\fe\ls:mmﬁ Eso 16 0 Empty
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Set up an experiment

Alternate procedure for assigning targets, samples, and biological replicate groups

As shown below, you can also paste assignment information from an *.xls file into the
plate layout of the ViiA™ 7 Software for wells with single targets.

Note: You must select the header, and the Well Number and Well Position columns
while copying information from the *.xls file.

Note: Any of the columns not copied are treated as NULL values for those columns.

A1 - A Well Number
A | B | C | D | E | F | G | H | |

| 1 |Well Numhber Well Paositi Sampl Biological Group Target Task Dyes Quantity  Comments
| 2 | 1 Al gk RMageP UNKNOWN  FAM-NFO-MGE
| 3 | 2 A gk RMageP UNKNOWN  FAM-NFO-MGE
| 4 | 3 A gk RMageP UNKNOWN  FAM-NFO-MGE
| 5 | 4 Ad gk RMageP UNKNOWN  FAM-NFO-MGE
| B | 5 A gk RMageP UNKNOWN  FAM-NFO-MGE
| 7 | G A gk RMageP UNKNOWN  FAM-NFO-MGE
| & | 7 AT gk RMageP UNKNOWN  FAM-NFO-MGE
ER g Ag gk RMageP UNKNOWN  FAM-NFO-MGE
| 10| a Al gk RMageP UNKNOWN  FAM-NFO-MGE
| 11| 10 Al0 gk RMageP UNKNOWN  FAM-NFO-MGE

12 11 All Sk RhagelP UNKNOWH  FAM-NFO-MGE
1 13 | 12 AlZ gk RMageP UNKMNOWN | FAM-NFO-MGE
| 14 | 13 Al3 gk RMageP UNKMNOWN | FAM-NFO-MGE
| 15 | 14 Ald gk RMageP UNKMNOWN | FAM-NFO-MGE
| 16 | 15 Al5 gk RMageP UNKMNOWN | FARM-NFO-MGE

Copy and paste the selected information

o e
Well Table

| ™, Define and Set Up Standards | <

Plate Layout

Targets

[ JRNaserP
I~ B Target 1 I - I| ‘

- Select Itern -« |M- Select Ttern -

in Table Group By

# |Wel\| Sample | Biological ... | Target | Task | Ciyes | Quantity |Cumments
0 Al Sk RMaseR UMNEROWN - FAM-MFO-...
1 A2 Sk RMaseP UMKHOWN - FAM-MFO-..
2 A3 Sk RMaseR UMENOWH - FAM-NFO-...
3 A4 Sk RMNaseF UNENOWN - FAM-NFO-...
4 A5 SK RMNaseP UNMENOWN - FAM-NEO-..,
5 AB K RMaseP UNENOWMN - FAM-MFO-,..
5 A7 Sk RMaseP UMNEROWN  FAM-MNFO-...
7 A8 Sk RMaseP UMEROWN - FAM-MFO-...
g A9 Sk RMaseR UMNEROWN - FAM-MNFO-...
Samples ——————————— (a7 9 a0 Sk RMaseP UMKNOWN  FAMAMFO-..
.. 10 411 Sk RMasel UMKMOWH FAMAFO-...
11 A12
5.5'( ‘ 12 a13
I Sample 1 ‘ 17 al4
: 14 A1S
15 Alg
15 A17
17 A18
18 A19
19 AZ0
20 AZl
21 A22
22 A23
Biological Groups —— ] 23 A24
. Biological Group 2l Gl
25 B2
26 B3
27 B4
28 BS
29 Bo
30 BF
31 E&
32 B9
33 BlO
34 Bll
35 El12
28 D12
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Define the run method

Chapter 1 1
Set up an experiment

Use the Run Method screen to set up the run method for your own experiments in the
ViiA™ 7 Software.

1. Click Run Method to access the Run Method screen.

Note: You can save multiple run methods to the Run Method Library for later
use. See “(Optional) Use libraries when designing your own experiments” on
page 23 for information on run method libraries.

2. Enter a number from 1 to 20 for the reaction volume per well. The ViiA™ 7
Instrument supports the following maximum reaction volumes for the
consumables listed below:

MicroAmp® Optical 384-Well Reaction Plate - 30uL

Applied Biosystems Array Card - 1uL

MicroAmp® Optical 96-Well Reaction Plate (0.2mL)- 200uL
MicroAmp® Optical 96-Well Reaction Plate (0.1mL)- 100pL
MicroAmp® Optical 8-Tube Strip with cap (0.2uL)- 200uL
MicroAmp® Fast 8-Tube Strip with cap(0.1pL)- 100uL
MicroAmp® Optical Reaction Tube without cap (0.2uL)- 200uL
MicroAmp® Fast Reaction Tube without cap (0.1uL)- 100uL

3. In the Graphical View tab, review and, if necessary, edit the run method.

Make sure that the thermal profile is appropriate for your reagents.

Edit the default run method or replace it with one from the run method
library included in the ViiA™ 7 Software.

Enable data collection by clicking 7 -

Note: Enabling data collection is especially useful when you later need to
analyze data collected in real-time during the various stages.

Edit the ramp rate. You can increase or decrease the ramp rate for a stage.

Note: Ramp rates are decimal numbers from 0.015—3.4.
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¢ Edit the PCR Stage.
¢ Change the Number of Cycles for the PCR stage.

¢ Select the Enable AutoDelta check box, to increase or decrease the
temperature and/or hold time for each subsequent cycle or to change the
Starting Cycle for AutoDelta. Enabling AutoDelta displays the £ icon.
Click the AutoDelta Off & icon to change the AutoDelta settings for the
cycling stage in the AutoDelta Settings dialog box. Then, click Save Setting
to display the AutoDelta On 4 icon.

x

AutoDelta Settings For Cycling Stage

AutoDelta Temperature: |+ 'l II 0.01 3:

Walid AutoDelta Temperature Range: -2.27 to 0,12

AutaDelta Time: I + vl FEH

Starting Cycle: 1

Save Setting W

Note: If you selected SYBR® Green as the reagent, the Melt Curve stage
automatically appears in the Run Method screen. If you delete the Melt
Curve Stage section from the protocol, then the melt curve is active in the
Add Stage drop-down menu.

4. Complete the tasks on the Optical Filters tab:

By default, the Optical Filters tab is not visible. To show the Optical Filters tab, go
to Tools » Preferences, and select the Show optical filters for run method check
box under the Default tab.

x|
Defaults Startup Experiment Print Export Display Format SMTP Settings

Select your default folders, the default block type, and whether to show optical filters in the run method.

Data Folder: CoApplied BiosystemsWiiA Texperiments Browse
Import Folder: CoApplied BiosystemsWiiA Texperiments [m
Instrument Type: Wiis™ 7 -

Block Type: 354-Well Block v

MNurnber of Significant Figures: |3

¥ Show optical filters for run method

Import System Preferences Export System Preferences m W

e To add a new filter set to the filter set library, click Save.

¢ Toload a saved filter set, click Load.
¢ To go back to the original filter set combinations, click Revert to Defaults.
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Note: Select the filter set that matches the profile of the dye you have added to the
plate. Refer to the Applied Biosystems ViiA™ 7 Real-Time PCR System User Guide
(PN 4442661) for information on the emission spectrum for each dye, and the filter
at which each dye is read.

(Optional) Use libraries when designing your own experiments

Target, Sample, and
SNP Assay libraries

Run Method library

The ViiA™ 7 Software allows you to save information to libraries, so you can easily use
the information again when setting up an experiment. The libraries include:

* Targets library

* Samples library

* SNP Assay library (only available for Genotyping experiments)
* Run Method library

You can access the Targets, Samples, and SNP Assay libraries from the Tools menu to
add, edit, delete, and import or export items. You can also access a library by clicking
Import from Library in the Define screen when you are setting up an experiment.

You can use the Run Method library from the Run Method screen to:

e Save a new run method for later use.

¢ To select an existing run method for an experiment.

To add a run method to the Run Method Library:

1. Click Save Run Method in the toolbar of the Graphical View tab on the Run
Method screen.

2. Enter a name and description (optional) for the run method, then click Save.

To select a run method from the Run Method Library

Click Open Run Method on the Run Method screen, and select one from the saved run
methods.
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Prepare reactions

Supported consumables

The ViiA™ 7 Instrument is optimized for Applied Biosystems consumables. These can
be ordered from the Applied Biosystems website. Use the consumables appropriate for

the sample block of your instrument.

Maximum

Samble reaction Recommended
blocl'.)k Consumable volume reaction
(pL) volume (pL)

supported
384-Well e MicroAmp® Optical 30 5-20
Plate Notched corner 384-Well Reaction Plate

e MicroAmp® Optical
Adhesive Film

Array Applied Biosystems Array | 1 1
Card Card
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Maximum
reaction Recommended
Sample .
block Consumable volume reaction
(pL) volume (pL)
supported
96-Well e MicroAmp® Optical 96- 200 10-100
Plate Well Reaction Plate
(0.2mL) e MicroAmp® Optical
Adhesive Film
e MicroAmp® 94-Well
Support Base (only
used during sample
preparation)
e ViiA™ 7 System 96-Well
Plate Adaptor
Fast 96- e MicroAmp® Fast Optical 100 10-30
Well 96-Well Reaction Plate
Plate e MicroAmp® Optical
(0.1mL) Adhesive Film
e MicroAmp® 94-Well
Support Base (only
used during sample
preparation)
e ViiA™ 7 System Fast 96-
Well Plate Adaptor
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Maximum
reaction Recommended
Sample .
block Consumable volume reaction
(uL) volume (pL)
supported
96-Well e MicroAmp® Optical 8- e 100 for e 10-30 for
Plate Cap Strip Fast 96- Fast 96-well
(0.2uL) e MicroAmp® Optical 8- well plate
and Fast Tube Strip (0.2uL)/ plate * 10-100 for
76-Well MicroAmp® Fast 8- e 200 for 96-well plate
plate Tube Strip (0.1pL) 96-well
(0.7uL] * MicroAmp® 96-Well plate
Tray/ Retainer Set
(Blue) (0.2uL)/
MicroAmp® 96-Well
Tray (Black) (0.1pL)
e MicroAmp® 96-Well
Support Base (only
used during sample
preparation)
o ViiA™ 7 System 96-Well
Tube Adaptor/ ViA™ 7
System Fast 96-Well
Tube Adaptor
96-Well e MicroAmp® Optical e 100 for e 10-30 for
Plate Tube without cap Fast 96- Fast 96-well
(0.2uL) (0.2uL)/ MicroAmp® well plate
and Fast Fast Reaction Tube plate e 10-100 for
96-Well without Cap (0.1uL) e 200 for 96-well plate
plate e MicroAmp® Optical 8- 96-well
(0.1uL) Cap Strip plate
e MicroAmp® 94-Well
Support Base (only
used during sample
preparation)
e MicroAmp® 96-Well
Tray/ Retainer Set
(Blue) (0.2uL)/
MicroAmp® 96-Well
Tray (Black) (0.1pL)
o ViiA™ 7 System 96-Well
Tube Adaptor/ ViA™ 7
System Fast 96-Well
Tube Adaptor

WARNING! Make sure that you use the flat caps for 0.2pL tubes and 0.1pL tubes. Use of rounded caps damages
the heated cover.
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Supported reagents

Applied Biosystems supports the reagents listed below for experiments performed on

the ViiA™ 7 System.
Experiment Reagent

Standard Curve  Applied Biosystems TagMan® Reagents
 Applied Biosystems SYBR® Green reagents
e Other reagents

Relative Standard Curve * Applied Biosystems TagMan® Reagents
* Applied Biosystems SYBR® Green reagents
e Other reagents

Comparative Ct (AACy) * Applied Biosystems TagMan® Reagents
 Applied Biosystems SYBR® Green reagents
e Other reagents

Melt Curve * Applied Biosystems SYBR® Green reagents
e Other reagents

Genotyping * Applied Biosystems TagMan® Reagents
e Other reagents

Presence/Absence  Applied Biosystems TagMan® Reagents
e Other reagents

Note: Fast Universal Master Mix is not recommended to be used with the 96-well (0.2
HL) reaction plates or reaction tubes and tube strips sealed with caps.

Reagent detection process

Applied Biosystems  Description

®
TagMan™ Reagents TagMan® reagents use a fluorogenic probe to enable detection of a specific PCR

product as it accumulates during PCR cycles.

Advantages

* Increased signal specificity with the addition of a fluorogenic probe.

* Multiplex capability.

* Optional preformulated assays, optimized to run under universal thermal cycling
conditions, are available.

* Can be used for either 1- or 2-step RT-PCR.

Limitations

Require synthesis of a unique fluorogenic probe.
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TagMan® Reagents detection process

PCR and detection of cDNA

a. Assay components

N
——
TTorurns

Forward primer

3

Probe ) Reverse primer
I[N T
ETTERETES
N

5

% cDNA template 4

&HHIIHHHHHHHHHHHHHHHHHIIIHHHH [T IHHHHIHHHH% - cona

3

5

b. Denatured template and annealing of assay components L,

~ g

3 5 X
Reverse primer LEGEND
AR I o o e e e e T
neS
Probe )v b FAM™ dye
Forward primer / Quencher
%HHHHHHHHHHHHHHHHHHHHHHHH\ NI N aunnn HHHHHHHHH%
Minor groove
3 s \MGB binder
c. Signal generation AmpliTag Gold®
DNA Polymerase

3 5'

kﬂ\\\\\\\\\\\\\l TrrmrTrrrrTTTTTin UUH HHHJULH HHH ‘ I I IH% C PI'Obe

JR RO A by
N 4 P Reverse primer x
<~E -~ K Primer
Forward primer V's * — MGB
5 e 7 UM 8 === Template
,,,,,,,,, [ i aiiTad S

3 5 “===  Extended primer

Applied Biosystems
SYBR® Green
reagents
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Description

SYBR Green reagents use SYBR® Green I dye, a double-stranded DNA binding dye, to
detect PCR products as they accumulate during PCR cycles.

Advantages

* Economical (no probe needed).
¢ Allow for melt curve analysis to measure the Tm of all PCR products.
* Can be used for either 1- or 2-step RT-PCR.

Limitations

Bind nonspecifically to all double-stranded DNA sequences. To avoid erroneous
information signals, check for nonspecific product formation using melt curve or gel
analysis.
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SYBR® Green detection process

I ——— Step 1: Reaction setup

The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

) Step 2: Denaturation

When the DNA is denatured into

FORWARD
PRIMER

single-stranded DNA, the
SYBR® Green | dye is released and
the fluorescence is drastically reduced.

Step 3: Polymerization

During extension, primers
anneal and PCR product

® @ is generated.

REVERSE
PRIMER

Step 4: Polymerization completed
SYBR® Green | dye binds to the
double-stranded product,

resulting in a net increase in
fluorescence detected by the
instrument.

Precautions while preparing reactions

Make sure that you do not prepare the reactions on a wet table. Wet surfaces lead
to contamination of your reactions.

Wear appropriate protective eyewear, clothing, and powder-free gloves.

Make sure that you use the appropriate consumables. The quality of pipettors and
tips and the care used in measuring and mixing dilutions affect data accuracy.

Make sure that you perform dilutions exactly as instructed. Mistakes or
inaccuracies in making the dilutions directly affect the quality of results.

Use a permanent marker or pen to mark a tube and the side of a plate or array
card. Do not use fluorescent markers.

Make sure that the arrangement of the PCR reactions matches the plate layout
displayed in the ViiA™ 7 Software.

Materials required while preparing the dilutions

DI water or DEPC water
Microcentrifuge tubes
Pipettors
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Pipette tips

Vortex mixer

Centrifuge

Sample stock

Standard stock

Reaction mix components

Plate or array card

Guidelines for preparing the dilutions, reaction mix, and plate

30

Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers.

Use TE buffer or water to dilute the standards and samples.
Prepare the reagents according to the manufacturer’s instructions.
Keep the dilutions and assay mix protected from light, in the freezer, until you are
ready to use it. Excessive exposure to light may affect the fluorescent probes or
dyes.
Prior to use:

— Mix the master mix thoroughly by swirling the bottle.

— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend
the samples by vortexing, then centrifuge the tubes briefly

Do not allow the bottom of the reaction plate to become dirty. Fluids and other

contaminants that adhere to the bottom of the reaction plate can contaminate the
sample block(s) and cause an abnormally high background signal.

Correct Incorrect

Liquid is at the bottom of Not centrifuged with enough force
the well. or

Not centrifuged for enough time

For Genotyping experiments, prepare the reactions for each SNP separately.

Place the reaction plate or array card at 4 °C and in the dark until you are ready to
load it into the instrument
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Seal the reaction plate

If you use optical adhesive film to seal your reaction plates, seal each reaction plate as
follows:

Note: The sealing instructions are applicable to 384-well and 96-well reaction plates.

1.

Load the reaction plate using the plate layout described in “Assign targets,
samples, and biological replicate groups” on page 18.

Note: For 96-well reaction plates, place the reaction plate onto the center of the
96-well base, then perform this step. Be sure that the reaction plate is flush with
the top surface of the 96-well base.

Note: You can also use the MicroAmp® Optical 8-Cap Strip to seal the 96-well
reaction plates.

Remove a single optical adhesive film (film) from the box. Bend both end-tabs
upward. Hold the film backing side up.

In one swift movement, peel back the white
protective backing from the center sealing surface.
Do not touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may result in
haziness, but it will not affect results. Haziness disappears when the film comes
into contact with the heated cover in the instrument.

Holding the film by the end-tabs, lower the film onto the reaction plate (adhesive
side facing the reaction plate). Make sure that the film completely covers all wells
of the reaction plate.

Applying firm pressure, move the applicator
slowly across the film, horizontally and
vertically, to ensure good contact between the
film and the entire surface of the reaction
plate.
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6. Using the applicator to hold the edge of the film in place, grasp one end of the
end-tab and pull up and away sharply. Repeat for the other end-tab.

Note: Ensure clean removal of both end-tabs
from the dotted line. Improper peeling of the
end-tab can cause sticking of plate on the
heated cover assembly.

7. To ensure a tight, evaporation-free seal, repeat
step 5. Applying firm pressure, run the edge
of the applicator along all four sides of the
outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight, evaporation-free seal.

8. Inspect the reaction plate to be sure that all wells are sealed. You should see an
imprint of all wells on the surface of the film. Check for the perforated tab to be
completely torn off to avoid plates from sticking to the instrument after a run.

IMPORTANT! Remove all excess adhesive from the perimeter of the optical adhesive
cover. When the film is applied, the glue from the optical adhesive cover can adhere to
the edges of the plate. If the excess glue is not removed, the plate may adhere to the
gripper of the Twister® IT Robot or to the sample block of the ViiA™ 7 Instrument.
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Fill and seal the array card

Fill and spin the IMPORTANT! Wear powder-free gloves while preparing the Arrays.

array card

1.

2.

d. Dispense the fluid so that it sweeps in and

Remove an array card from its box and place it on a clean, dry surface.
Using a permanent marker, mark the side of the empty array cards.

Transfer the experiment-related chemistries and solutions into the port of the
array card.

For each transfer:
a. Place the array card on a lab bench, with the foil side down.
b. Load 100 pL of fluid into a pipette.
c. Hold the pipette in an angled position (~45 degrees) and place the tip into the

fill port. There is a fill port on the left arm of each fill reservoir — it is the
larger of the two holes.

Do not allow the tip to contact and possibly damage the coated foil beneath
the fill port.

Fill Vent
port | port

around the fill reservoir toward the vent port.
Pipette fluid into the fill reservoir, but do not go

past the first stop of pipettor plunger when 2%‘(%\;@&
pipetting the reagents into the array card, or you %\%@ﬁ@
may blow the solution out of the port. &Qﬁ\i@)ﬁ

IMPORTANT! Do not allow the tip to contact and possibly damage the coated
foil beneath the fill port.
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. Place the filled array card(s) into a centrifuge array

. Place the filled carrier clips into the centrifuge buckets.
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card carrier clip and place empty array card(s) in the
remaining slots. Make sure that the labels on the
buckets and clips face the same way.

IMPORTANT! Make sure to balance the loads in opposite buckets in the centrifuge.

Make sure that the array-card fill reservoirs and
bucket and clip labels face outward when loaded into
the centrifuge. Balance the loads in opposite buckets.

IMPORTANT! You must run the centrifuge with all four buckets in place and each
of the two carriers filled with the array card. Place empty array cards (4-pack PN
4334812 and 1-pack PN 4351471) into unfilled slots.

. Close the centrifuge cover, then spin the array card(s) for 1 minute at 1200 rpm.

. When the run is finished, stop the centrifuge, then spin the array card(s) again for

1 minute at 1200 rpm.

IMPORTANT! Do not try to save time by doing one spin for 2 minutes. The two
sets of ramps are important for a good fill into the array card.

. When the second run is finished, open the centrifuge and check that the fluid

levels in the reservoirs of each array card have decreased by the same amount.
Also, check for the formation of bubbles in all wells and note possible problems.

Correct Incorrect

i 2 3 4 & 8 7§ i 2 3 4 ® 8 7 B i 2 3 & & ® 7 8§
E\D
@ @ 1 e @ |

. If necessary, centrifuge the array card(s) for an additional minute to fill any

unfilled wells. Do not exceed three 1-minute runs or centrifuge the array card for
longer than 1 minute at a time.

Note: Visit http://www2.appliedbiosystems.com/lib/multimedia/taqman_tlda/
tlda_1.cfm to view an online video of loading an array card.
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card(s)

. Press down on all four corners of the array

. Use the two alignment pins in the fixture to
position the array card correctly.
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. With the carriage (roller assembly) of the TagMan® Array Micro Fluidic Card

Sealer in the Start position, place a filled array card into the fixture with the foil
side up so that the fill reservoirs are the farthest away from the carriage.

card to ensure that it is fully seated within the
fixture.

Alignment pins

4. Seal the array card by running the carriage slowly over it, in one direction only.

Do not apply downward force on the carriage as you move it forward over the
card.

5. Remove the sealed array card from the fixture and trim the fill reservoirs from the

array card assembly using scissors. Trim the foil array card so that the edge is
even with the plastic carrier.
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IMPORTANT! Completely remove the fill reservoirs from the array card so that the
edge is free of residual plastic. The plastic from the fill reservoirs that extends beyond
the edge of the card can prevent the card from seating properly on the sample block
and affect amplification.

Correct Incorrect

@ @ | 7@ @

IMPORTANT! As you seal the remaining filled array cards, store them in a dark place
until you are ready to use them. The fluorescent dyes in the array card are
photosensitive. Prolonged exposure to light can diminish the fluorescence of the dye.

Capping and uncapping the 96-well reaction tubes and tube strips

Note: Make sure that you secure the caps on the tubes and tube-strips tightly to avoid
sample evaporation.

If you use the 96-well MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes
without Cap, use the MicroAmp® Cap Installing Tool (PN 4330015) and follow the

instructions below for:
* Applying the MicroAmp® Optical 8-Cap Strip or MicroAmp® Optical Tubes
without Cap to the tubes
¢ Removing a cap string from a plate
Required materials:

e MicroAmp® Cap Installing Tool
* MicroAmp® Optical 8-Tube Strips or MicroAmp® Optical Tubes without cap

¢ MicroAmp® Optical 8-Cap Strip

el lalalalalal)

Grooved side for flat

cap strips
Recessed cups | I

for rounded
cap strips

™ c—

MicroAmp® Cap Installing Tool
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MicroAmp® Optical
8-Cap Strip (flat)

Remove a cap string
from a plate
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1. Grasp the Cap Installing Tool so that the grooved side is exposed.
2. Hold the strip of caps over the tube strip or the row of tubes.

3. Use the grooved side (shown) of the Cap
Installing Tool to push and seat each cap firmly
in place. Use a rocking motion to properly seat
each cap.

The MicroAmp® Cap Installing Tool is also used for removing the MicroAmp® Optical
8-Cap Strip from the 96-well optical plates and tray/retainer assemblies. To remove the
cap or cap strip:

1. Insert the small protrusions on the side of the
Cap Installing Tool under the webbing
between the caps on a cap strip.

2. Slowly pry the strip from the plate or Tray/
Retainer assembly.
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Start the experiment

To start an experiment:
1. Access the Instrument Console.
2. Load the reaction plate or array card into the instrument, as shown on page 41.

3. Run the experiment as shown on page 43.

Instrument Console

The Instrument Console displays all the ViiA™ 7 Instruments discovered on a
network.

‘ fosmirajs1iol

Instrument Status: READY
Rury Stabiis:
Growap: My Instnarents

7 LCaliberation Status — 0o T
i RaOL 01-28-201... JGUEST Current:
¥ Backgr,, [03-29-201.,. |AOAMINIST.., Current
Fosmirajs 1101 Liifarm....[01-28-201... [ADMINET. .. Curent
READY

i‘r Ir i F 1_; ir ’i_r 1 | 2 Lamnp Life 10 hor
Z7BEE0001 e sl ) el L EPE00Y Delifrance EHGLI_¥nk Erag2 Total Cyrles for Block i
HLINE ONLINE COHLIKE CQHLINE CMLINE OHLINE CRLINE Toilal Decress for Bodk ]
Instrument Properiies —— ]
lﬂ i i w i ﬂ Instrument Label Li
FEDTEST’SD 5Gj5NGC.I'-|IJ'2‘2 SGS'I.ECH:& W ; E; \h‘\.lFtlll'ﬂ‘I H‘u Sl F LI
182 tenna_Calpe angg
CHLINE OHLMNE CMLINE HLINE CRLINE AHLHE Instrumant Frmwans Wer,,, 0,171
1P Address 1732845
Blok Tyos SE4-uell Plate (16x24)

Controllar Rrmmers Varson 08,1
Cytics Frrowere Wersion |S535
Thermal Black Frmwans .. 255
Heated Cover Fimmvars . [255
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Left panel The features on the left panel of the Instrument Console allow:

¢ Instrument access: Open and close the ViiA™ 7 Instrument door from the ViiA™
7 Software user interface.

¢ Group management:
— Create, rename, and delete groups and assign instruments to the groups.

— Add and remove instruments to and from My Instruments.

Note: To add instruments, select the icon of the ViiA™ 7 Instrument that you
want to add to the My Instruments list. Then click Add to My Instruments.
Similarly, click Remove from My Instruments to remove an instrument from
the My Instruments list. You can also drag and drop the instrument icon into
My Instruments or into the group created by you.

— Display instrument groups from the Display Group drop-down menu.
according to their activity. Select the status from the Filtered By drop-down
menu. For more information on the status of an instrument, see “Monitor the
experiment” on page 44.

¢ Instrument management:

— Monitor experiments (check the run status or monitor a temperature plot or
amplification plot during a run). For more information on monitoring
experiments, see “Monitor the experiment” on page 44.

— Maintain instruments (check the calibration status of instruments and
perform different calibrations). For more information on Instrument
maintenance, refer to Applied Biosystems ViiA™ 7 Real-Time PCR System User
Guide (PN 4442661).

— Manage files (upload setup files; download completed experiments; and
create, rename, and delete experiment files and plate setup folders).

Note: Completed experiments are downloaded into the default folder
Completed Experiments.

Note: To manage files, click Manage Instrument.

Use the File Manager to create, rename or delete folders for holding setup
files for starting a run or completed experiments for analysis.

To move setup files from one folder to the other, click Move and select the
setup folder you want to shift the setup file into.

IMPORTANT! To Manage and Monitor, you must move instruments from On
the Network to My Instruments or a custom group. You can start a run and
calibrate instruments present only in the My Instruments group or the
custom group(s) that you created.

Right panel The right panel of the Instrument Console displays:
¢ The name of the instrument whose instrument icon is selected.
¢ The run status of the selected instrument.
¢ The group the instrument belongs to.

* The calibration status, maintenance reminders and instrument properties of the
selected instrument.
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Status icons
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The calibration status is indicated by the Y icon. The icon appears in the Status
column of the Calibration Status table after the last reminder date before the
calibration expires.

You can monitor the instrument status and view calibration and other information in
the Instrument Console.

ViiA™ 7 Instrument status icon

The status of an instrument is represented by an icon in the top-right corner of the
thumbnail representation of the instrument on the Instrument Console. An instrument
displays the status when you place the instrument icon under My Instruments or
under the Group(s) that you created.

To monitor the instrument status:

1. On the Home tab ( ﬁ ), select Instrument Console. If you do not see an
instrument, click Refresh in the instrument console toolbar.

2. If needed, move the instrument from the On the Network group to a group which
can be monitored:

a. Click the instrument of interest, then click Assign to Group in the
instrument console toolbar.

b. Select the My Instruments or a personal group in the drop-down list. The
instrument is now monitored.

Icon Instrument status

|
ﬁ_ L4

fosmirajs1i01
READY

Ready

(no icon) Available on the network but cannot be
monitored because that instrument is not
under My Instruments or a group you created.

Run in process
(The time remaining for the run is shown to the
left of the icon.)

Unavailable

Incompatible firmware version

No longer connected to the network

Error occurred during run

0O X % E
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Load the reaction plate or array card into the instrument

C CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
temperature of the sample block(s) can exceed 100 °C. Keep your hands away
until the sample block(s) reaches room temperature.

Sample block

IMPORTANT! Wear powder-free gloves when you handle the reaction plate or array

card.

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who
have been warned of the moving parts hazard and have been adequately trained.

1. Touch E on the ViiA™ 7 Instrument touchscreen or click Open Door in the
Instrument Console screen of the ViiA™ 7 Software to allow the plate adapter to

come out from the instrument side.
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2. Place the reaction plate or array card on the plate adapter. Ensure that the reaction
plate or array card is properly aligned in the holder.

¢ Make sure the well Al is positioned at the top-left of the tray for any of the
plate formats.

* Make sure the barcode (for any of the plate formats) is facing the front of the
instrument.

¢ If using reaction tubes or tube strips, make sure you use adaptors. The
adaptors are attached to the plate transport arm. The tray containing the
tubes or tube strips must be placed on the adaptor and not into the sample
block directly.

IMPORTANT! For optimal performance with partial loads, load at least 16
tubes and arrange them in:

Adjacent columns of 8 tubes, using rows A through H. For example, use
wells in columns 6 and 7 (rows A through H).

Or

Adjacent rows of 8 tubes, using columns 3 through 10. For example, use
wells in row D (columns 3 through 10) and row E (columns 3 through 10).

C WARNING! Make sure that you use the flat caps for the 0.2uL tubes
and 0.1uL tubes. Use of rounded caps damages the heated cover.

3. Touch on the ViiA™ 7 Instrument touchscreen or click Close Door in the
Instrument Console screen of the ViiA™ 7 Software to retract the plate adapter
back into the instrument.

Enable or change the Notification Settings

42

You can configure the ViiA™ 7 Software to alert you by email when the ViiA™ 7
Instrument begins and completes a run, or if an error occurs during a run.

Note: For details on using the Notification Settings feature, refer to the Applied
Biosystems ViiA"™ 7 Real-Time PCR System User Guide (PN 4442661).
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Run the experiment

You can run the experiment in either of the following two ways:
e From the ViiA™ 7 Software

e From the ViiA™ 7 Instrument touchscreen

Note: The example experiments in each of the getting started guide booklets start a
run from the ViiA™ 7 Software.

IMPORTANT! Make sure that instrument calibration is up-to-date. If a calibration has
expired, you will get a warning when you start a run. For information on calibrating
the ViiA™ 7 Instrument, refer to Applied Biosystems ViiA"" 7 Real-Time PCR System User
Guide (PN 4442661).

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.

From the ViIA™ 7 1. In the ViiA™ 7 Software, click @  Runin the navigation pane.

Software
2. Click START RUN. Select the instrument for the run from the drop-down menu

of the instruments placed under My Instruments.

IMPORTANT! Make sure that the instrument to run the experiment on is in My
Instruments or the custom group, and that it is ready to run an experiment. If the
preferred instrument is not present under My Instruments or the custom group,
or if it is unavailable, clicking START RUN does not display instrument names in
the drop-down menu.

Run Status
' START RUM r
[ Fosmirajs1i01
SEAGUSANK1DOL
enggd
From the ViiA™ 7 1. Touch the ViiA™ 7 Instrument touchscreen to awaken it.
Instrument Note: If the touchscreen is not at the Main Menu screen, touch m

touchscreen
2. In the Main Menu screen, touch Browse Experiments.

3. In the Browse screen, touch . {fg} = Folders, to display the folders containing the
experiment setup files.

4. Touch any of the folder names to display the experiments in that folder.

5. In the Experiments screen, select the desired experiment, then touch View/
Edit to view or edit the experiment before starting the run.

Note: You can start a run immediately by clicking @ Start Run, then go to
step 8.

Getting Started with ViiA™ 7 System Experiments 43



1 Chapter 1 General Information and Instructions
Start the experiment

6.

7.

(Optional) Modify the experiment parameters as needed. You can use the:

o fir Add and "®E Delete buttons to add and delete a stage or step to the
thermal profile.

. ¥ Add Melt Curve button to add a melt curve to the thermal profile.

¢ Save button to save the experiment you modify.

In the Save Experiment screen, touch each field to edit the:
¢ Experiment name
¢ Folder to save the experiment
e Reaction volume
¢ Barcode Number
e Notes
When finished, touch @ Save & Start Run to start the experiment.

In the Start Run screen, touch each field as needed to modify the associated
parameter, then touch (@ Start Run Now to start the experiment.

Note: When the run is complete, touch E to unload the plate from the
instrument. You can download the results of the experiment from a computer if
the instrument is connected to a network, or copy the data to a USB device as
explained in “Transfer experiment results” on page 50.

Monitor the experiment

From the ViiA™ 7
Software Run screen

From the ViiA™ 7
Software Instrument
Console

44

Note: If there is loss of connection during an experiment, remove and then add the
instrument to the My Instruments list. You may then resume monitoring the
experiment.

You can monitor an experiment run in three ways:

From the ViiA™ 7 Instrument touchscreen, in the same way that you run the
experiment (see “From the ViiA™ 7 Instrument touchscreen” on page 43).

From the Run screen of the ViiA™ 7 Software, while the experiment is in
progress, as shown below.
From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment

started from another computer or from the ViiA™ 7 Instrument touchscreen) as
described in “From the ViiA™ 7 Software Instrument Console” on page 44.

Click Amplification Plot from the Run Experiment Menu to monitor the
amplification plot of the experiment you are running.

Note: For Melt Curve experiments, click Melt Curve Plot from the Run
Experiment Menu.

Click Temperature Plot from the Run Experiment Menu to monitor the
temperature plot of the experiment you are running.

. In the Instrument Console screen, select the icon of the instrument that you are

using to run the experiment.

Click Manage Instrument.

Getting Started with ViiA™ 7 System Experiments



Chapter 1
Start the experiment

3. On the Instrument Manager screen, click Monitor Running Instrument.

You can view the progress of the run in real time from the Run screen. During the run,
periodically view the Amplification Plot, Temperature Plot and Run Method (see page
46) available from the ViiA™ 7 Software for potential problems.

To...

Action

Stop the run

View amplification data
in real time

¢ In the ViiA™ 7 Software, click STOP RUN.
¢ In the Stop Run dialog, click one of the following:
- Stop Immediately to stop the run immediately.

- Stop after Current Cycle/Hold to stop the run after
the current cycle or hold.

- Cancel to continue the run.
Select Amplification Plot.

See “To monitor the Amplification Plot” on page 46.

View temperature data
for the run in real time

Select Temperature Plot.

See “To monitor the Temperature Plot” on page 47.

View progress of the run
in the Run Method
screen

Select Run Method.
See “To monitor the Run Method” on page 47.

Enable/disable the
Notification Settings

Select or deselect Enable Notifications.

See “Enable or change the Notification Settings” on page 42.

Note: The individual experiment booklets provide illustrations of the different

experiments in real time.

Note: For Melt Curve experiments, click Derivative Melt Curve from the Run

Experiment Menu.
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The Run screen for a Standard Curve experiment run looks like this:

Run Status

BECLER Y Fstimated Time Remaining:26 min 0 sec Instrument Name: fosmirajs1101

Run Status: Running
Temperature Plot Current Temperatures

- s @B v [ Caver 105°C
£ LAl

L o ~ Wlsample £0°C

Temperature Plot - Blork 80°C

Temperature

Temperature Plot

000000 000410 000820 01230 001640 002050 002500 on2a:10 003320 003730 00:41:40 004550 005000 005410 015820
Time
Fixed Wiew [~
i

Wien 1 Hour .

To monitor the Amplification Plot

To view data in the Amplification Plot, click Amplification Plot from the Run
Experiment Menu, select the Plate Layout tab, then select the wells to view.

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number.

The Amplification Plot screen is useful for identifying and examining abnormal
amplification, including;:
* Increased fluorescence in negative control wells.

* Absence of detectable fluorescence at an expected cycle (determined from
previous similar experiments run using the same reagents under the same
conditions).

Note: If you notice abnormal amplification or a complete absence of signal,
troubleshoot the error as explained in the ViiA™ 7 Software Help (click &2 or
press F1).
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To view data in the Temperature Plot screen, click Temperature Plot from the Run
Experiment Menu.

To monitor the Temperature Plot

During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in real-time.

To... Action

Add or remove temperature plots Select Cover or Sample Block to
view the presence of the
associated data in the plot.

Change the time to display in the plot From the View drop-down menu,
select the amount of time to
display in the plot.

Display a fixed time window during the instrument | Select Fixed View.
run

If the entire plot does not fit in the screen, the
screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
drop-down menu, the plot will show data for 10
minutes. If the Fixed View is:

e Deselected, the plot updates as the run
progresses even after 10 minutes.

e Selected, the plot does not update as the run
progresses even after 10 minutes.

The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for
abnormal behavior.

* The Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

¢ The Cover plot should maintain the constant temperature specified in the
method. A departure from the constant temperature may indicate a problem.

Note: If you notice abnormal temperature plot, troubleshoot the error as
explained in the ViiA™ 7 Software Help (click &4 or press F1).

To monitor the Run Method

To view data in the Run Method screen, click Run Method from the Run Experiment
Menu.

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run.

To... Action

Change the number of cycles In the Adjust # of Cycles field, enter the number
of cycles to apply to the Cycling Stage.

Add a melt curve stage totheend | Select Add Melt Curve Stage to End.
of the run
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To... Action

Add a Hold stage to the end of the | Select Add Holding Stage to End.
run

Apply your changes Click Send to Instrument.

If an alert appears, click the error for more information and troubleshoot the problem
as explained in the ViiA™ 7 Software Help (click & or press F1).

To view the run data

After a run is complete, you can view a run report by clicking View Run Data. The
View Run Data screen displays information about the completed run, as in the
following example from a Standard Curve experiment:

Run Data Report
Experiment Name: Viid7_384-Wel_Standard_Curve_Fxample

Start Time: 02-01-2010 06:25:14 PST
Stop Time: 02-01-2010 07:07:07 PST
Run Duration: 41 minutes 52 seconds
User ID: DEFAULT
Instrument Name:
Firrmware Version:
Software Version: N/A
Instrument Serial Number: 278880018
Sarmple Volume: 10.0
Cover Temperature: 105.0

Block Type: 384-wel Block

Errors Encountered:

The run report data helps in:

* Comparing two experiments of the same type run on two different instruments.

e Troubleshooting. For example, after a firmware upgrade, you can compare an
experiment run before and after the upgrade to determine if the upgrade affected

performance.
From the ViiA™ 7 The touchscreen displays the method for the experiment, the date and time at which
Instrument the run started, the time remaining in the run, and other information.
touchscreen
To... Action

Display the time Touch the € Time View tab, then touch [@ Experiment View

elapsed and the time tab to return to the Run Method screen.

remaining in the run

Stop the run Touch |[(SISE STOP to stop the protocol run immediately.
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Touch the status bar to display the events log.

To... Action

View the Events Log

The run method on the ViiA™ 7 Instrument touchscreen looks like this:

Experiment View

' @ | MylInstrument (384-well 20L) ﬁ?

Experiment: 2010-03-11-232013

Run Started: March 11 2010 - 11:20PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover: 105.0 °C
Heated Cover Set Point: 105.0 °C Time Remaining: 01:28:18

\

March 11 2010 - 11:20PM: Heated cover reached target temperature,

Time View

MyInstrument (384-well 20pL)

Experiment: 2010-03-11-232013

Run Started: March 11 2010 - 11:20PM Sample: 50.0 “°C
Reaction Volume: 20 pL

Stage [ Step: 1 /1
Heated Cover Set Point: 105.0 °C

Cycle: 1
Display Time: Remaiing () Elapsed

‘I\'Iurch 11 2010 - 11:20PM: Heated cover reached target temperature.
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Unload the instrument

When your ViiA™ 7 Instrument displays the Main Menu screen, unload the reaction
plate from the instrument and transfer the experiment data to the computer for
analysis.

Unload the reaction C CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
plate or array card temperature of the sample block(s) can exceed 100 °C. Keep your hands away
until the sample block(s) reaches room temperature.

1. Touch E on the ViiA™ 7 Instrument touchscreen or click Open Door in the
Instrument Console screen of the ViiA™ 7 Software.

2. Remove the reaction plate or array card from the plate adapter.

3. Touch E or click Close Door to retract the plate adapter back into the
instrument.

If the ViiA™ 7 Instrument does not eject the plate, remove the plate as follows:
a. Power off the ViiA™ 7 Instrument.

b. Wait for 15 minutes, then power on the ViiA™ 7 Instrument and eject the
plate.

c. If the plate does not eject, power off and unplug the ViiA™ 7 Instrument,
then open the access door.

d. Wearing powder-free gloves, reach into the ViiA™ 7 Instrument and remove
the plate from the heated cover, then close the access door.

e. Perform a background calibration to confirm that the sample block has not
been contaminated.

Transfer experiment results

You can transfer the experiment results in either of the following two ways:

Download the 1. In the ViiA™ 7 Software, select Instrument » Instrument Console.
experiment from the
ViiA™ 7 Instrument 2. Select the instrument icon of the ViiA™ 7 Instrument you just used to run the

over the network experiment from the My Instruments list.

3. Click Manage Instrument to open the Instrument Manager.
4. In the Instrument Manager, click Manage Files.
5. In the Experiments panel, select the experiment to download. Click Download.

6. In the Save dialog box, select the folder to hold the experiment results and click
Save. The experiments folder is located at:

<drive>:\ Applied Biosystems\ ViiA7 Software v1.1\ experiments\

where, <drive> is the computer hard drive on which the ViiA™ 7 Software is
installed. The default installation drive for the software is the D: drive.
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. If not already connected to the instrument, connect a USB drive to the USB port.

. Touch the ViiA™ 7 Instrument touchscreen to awaken it.
. If the touchscreen is not at the Main Menu screen, touch .
. In the Main Menu, touch Collect Results to save the data to the USB drive.

. Select one or multiple experiments (by touching them). Then touch ! Copy to

USB to copy selected experiments to the USB drive.

Note: If your instrument cannot find the USB drive, remove the USB drive, then
try again. If the instrument still does not recognize the USB drive, try another USB
drive.

. Touch VI to return to the Main Menu.

. Remove the USB drive from your instrument, then connect it to one of the USB

ports on your computer.

. In the computer desktop, use the Windows explorer to open the USB drive.

. Copy the example experiment file to:

<drive>:\ Applied Biosystems\ ViiA7 Software v1.1\ experiments\

where <drive> is the computer hard drive on which the ViiA™ 7 Software is
installed. The default installation drive for the software is the D: drive.
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About analysis results

Immediately after a run, the ViiA™ 7 Software automatically analyzes the data using
the default analysis settings, then displays the Amplification Plot screen.

Note: For auto-analysis of data, after a run, go to Tools » Preferences » Experiment
and select the Auto Analysis check box.

Note: For Genotyping experiments, the ViiA™ 7 Software displays the Allelic
Discrimination Plot screen.

To reanalyze the data, select all the wells in the plate layout, then click Analyze.

About the Analysis Settings Library

52

Analysis Settings are different for each experiment type. If the default analysis settings
in the ViiA™ 7 Software are not suitable for your own experiment, you can change the
settings in the Analysis Settings dialog box, then reanalyze your experiment.

You can save the changed analysis settings to the Analysis Settings Library so that you
can use them in other experiments.

In the Analysis Settings Library dialog box you can apply a filter to reduce the number
of settings protocols displayed.

You can access the Analysis Settings Library from the Tools menu. The Analysis
Settings Library dialog box looks like this:

PE Analysis Settings Library |

Select analysis settings or delete analysis settings. Apply a filker to reduce the Q’j

Enter a fitter query, then ciick "aApply Filter.”
TF |analysis Settmgsll |= LI [

(oo | |

Analysis Settifgs Experiment Type Comments Created On Last Modified
CCT-1 (Cormparative CT (AACT) 05-12-2010 15:36:08 55T |03-12-2010 15:36:22 SGT
P&-< PresencefAbsence 05-12-2010 15:48:33 SGT |05-12-2010 15:48:41 SGT
5C-12 Standard Curve 05-12-2010 15:52:34 56T |053-12-2010 15:53:02 5GT
SC-15 Relative Standard Curve 05-12-2010 15:53:46 56T |03-12-2010 15:53:59 S5GT
RSC-45 Relative Standard Curve 05-12-2010 15:53:46 55T |03-12-2010 15:54:13 5GT

Exit Analysis Settings Library

To change the analysis settings and to save them to the Analysis Settings Library:

1. From the Experiment Menu pane, select Analysis.
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2. On the Analysis screen, click Analysis Settings to open the Analysis Settings

3. Change the analysis settings as per your requirement.

4. Click Save to Library to save the changes you have made to the Analysis Settings

Library.

You can import the analysis settings you have previously saved to the Analysis
Settings Library, by clicking Load from Library in the Analysis Settings dialog box.

To override calibration

Each experiment file (.eds) stores the calibration data from the ViiA™ 7 Instrument it
was run on. The calibration data can affect the analysis results of an experiment.

If you have run multiple experiments on different ViiA™ 7 Instruments and prefer the
analysis results from a particular instrument, then you can choose to use the

To use the
calibration data of
another experiment

To revert to the
original calibration
data

calibration data from another ViiA™ 7 Instrument.

Open the experiment file (.eds), in which you want to import the calibration data
from another ViiA™ 7 Instrument, in the ViiA™ 7 Software.
Go to Analysis » Override Calibration » Use Calibration From Another File....

File Edit Instrument | Analysis | Tools  Help
Analysis Settings...

J Close B Import... - 4&® Create Slide..

Mew Experiment =

Browse to experiment file (.eds) from which you want to use the calibration data.

Analyze

Cwverride Calbration »

e Calibration From Another File...

Revert To Criginal Calibration ll

Note: You can choose to override the calibration data in an experiment with the
calibration data of only the same experiment type.

Click Open.

Open the experiment file (.eds), in which you want to import the original
calibration data, in the ViiA™ 7 Software.

Go to Analysis » Override Calibration » Revert To Original Calibration.

_ File Edit Instrument | Analysis | Tools  Help

ialv=Eleetino=2y J Close B Import... - 4&® Create Slide..

| Mews Experimant =

0

The experiment file will display analysis results as per the calibration data of the
ViiA™ 7 Instrument that the experiment was run on.

Analyze

Cwverride Calbration »

e Calibration From Another File...

| Revert To Criginal Calibration |
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To display wells

To display specific wells in the analysis plots, select the wells in the Plate Layout tab:

* To select wells of a specific type, use the Select Wells With drop-down menus:
Select Sample, Target, or Task, then select the sample, target, or task name.

¢ To select a single well, click the well in the plate layout.

¢ To select multiple wells, click and drag over the desired wells, press Ctrl-click, or
press Shift-click in the plate layout.

e To select all the wells, click the upper left corner of the plate layout.

The plate layout for a Standard Curve experiment looks like this:

b]  Plate Layout Well Table

o LR Ere Ere Hre Hre Hre [@re @re @re ke @k [@re @k @re @re @R ke @k e ke @re re @R k.

o LR Ere Hre Hre Hre Hre [@re @re @R ke @k [@re @k @re @re @R ke @k e ke @re re TR k.
p IR EHre Hre Hre Hre Hre @r: e @re @R (e @dre [ e e e (@ @R [@r e e e e (e 8

wels: [I] 268 [ 8o [ 16 0 Empty

Summary: wels in Plate: 384 wiglls Set Up: 334 wigls Analyzed: 284 wels Flagged: 0 wels omitted by Analysis: 0 wyells Omitted Manually: 0 Samplas Used: 2 Targets Used: 1

To display multiple plots

Use the Multiple Plots View screen to display up to four plots simultaneously. To
navigate within the Multiple Plots View screen, from the Experiment Menu pane,
select Analysis » Multiple Plots View.

e To display four plots, click 55 Show plots in a 2 X 2 matrix.

* Similarly, to display two plots in rows, click = Show plots in two rows. and to
display two plots vertically, click [|[| Show plots in two columns.

e To display a specific plot, select the plot from the drop-down menu above each
plot display.
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The Multiple Plots View screen for a Standard Curve example experiment looks like
this:

Multiple Plots View

Amplification Plot - Rn vs Cycle L‘ Amplification Plot - ARn vs Cycle LI

P AER I PP E B E

Amplification Plot Amplification Plot

0.1

Rn

0.001

Amplification Plot - C1 vs Well Number vI
B OE | R, IS
A L B g & iy

Multicomponent Plot

£ P B HhEE

Amplification Plot

*. == 1 X | S oS IR, | 3 B SRR L =5 @
10 2
@
)
=
=]
5 o [
0.1
Laged
oo, WFan W ROX
Well Number
Well Summary: In Plate: 384 Set Up: 354 Analyzed: 384 Flagged: 0 Omitted by Analysis: [ Crittad Manually: 0 Samples Used: 2 Targets Used: 1

To display an expanded view of a plot or wells

e Click 2 to expand the view of a plot, displayed on the left-hand side of the screen.
o Click & to expand the view of the Plate Layout or Well Table displayed on the

right-hand side of the screen.
To edit plot properties

Use the Plot Properties dialog box on the Analysis screen to edit plot settings such as
the font and color of the plot text, and the labels on the X axis and Y Axis.

~
1. Click on the Analyze screen (the icon appears above the plot) to open the Plot
Properties dialog box
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2. Edit the settings under the General, X Axis, and Y Axis tab.

* C(lick the General tab to edit the plot title text, font, or color. You can also
select whether to show the plot title.

¢ (lick the X Axis tab to edit the x axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

* C(lick the Y Axis tab to edit the y axis label text, font, or color; select the tick
marks and tick mark labels to display; and select the range to display.

3. Click OK.

To save current settings as default

You can change the Plot Settings for the different analysis plots, and save them as
defaults.

Select the Save current settings as the default check box on the respective plot screens
under the Analysis Experiment Menu.

Plot Settings
Flot Type: |£\Rn vs Cycle vl Graph Type: ILog 'I Flot Colar: |We|| 'I

||_ Sawe current settings as the default |

To publish the analyzed data

To... Click

Save a plot as an image file

Print a plot

[&] &

Copy a plot to the clipboard

@
="

I [.rl.r

Print a report e

Export data

To... Go to Then

Print the plate layout | File » Print... Select the background color, and
click Print

Create slides File » Send to PowerPoint... Select the slides for your
presentation, and click Create
Slides

Print a report File » Print Report... Select data for the report, and
click Print Report

56 Getting Started with ViiA™ 7 System Experiments



Chapter 1 1
Export an experiment

Export an experiment

About exporting an experiment

Export procedure

The Export feature of ViiA™ 7 Software allows you to export:

¢ Plate setup files for future experiments.

Plate setup files contain setup information such as the well number, sample name,
sample color, target name, dyes, and other reaction plate contents.

Analyzed data in different formats for further analysis.

The data can be exported in the ViiA™ 7 format, the 7900 SDS format, and the
RDML format.

The 7900 format is applicable only to Standard Curve, Relative Standard Curve,
Genotyping, Presence/Absence, and Melt Curve experiments.

The RDML export format is applicable only to Standard Curve, Relative Standard
Curve, Comparative Cp, and Melt Curve experiments. The RDML format is
available only in a single file format.

For Standard Curve experiments, you can also export the analyzed data from the
ViiA™ 7 Software to the external applications, TagMan® Protein Expression Data
Analysis Software and CopyCaller'" Software if they are installed on your
computer before the ViiA™ 7 Software is installed. The applications appear in the
Tools menu.

* Gene Expression studies to carry out a comparative analysis.

Note: If you choose the Auto Export option during experiment setup or before
running an experiment, the data is automatically exported to the location you
specified. If you did not set the Auto Export option, the analyzed data is not exported
automatically.

. Open the experiment file that contains the data to export, and from the

Experiment Menu, click

2. Select the format for exported data:

e ViiA™ 7 Format (supports .txt, .xls, and .xIsx data).

* 7900 Format - Single experiments are exported in the SDS 2.4 detector centric
export format of the 7900 Sequence Detecting System.
Studies are exported in the SDS 2.3 RQ manager detector centric export
format of the 7900 Sequence Detecting System
The 7900 format supports only the .txt type of data.

¢ RDML Format - Real Time Data Markup Language (supports only .xml type
of data).
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Export an experiment

4.

3. Select to export all data in one file or in separate files for each data type.
¢ One File - All data types are exported in one file.

— If you select the *.xIs format, a worksheet is created for each data type.

— If you select the *.txt format, the data are grouped by data type.

Separate Files - Each data type is exported in a separate file. For example, if

you select three different data types Results, Amplification, and
Multicomponent to export, three separate files (one each for Results,

Amplification, and Multicomponent) are created. You can select the type of

file (*.xlIs, *.xIsx or *.txt) to export from the File Type drop-down menu.

Note: You cannot use an exported *.xIs or an *.xIsx file when importing plate

setup information.

(Optional) Select the Open file(s) when export is complete check box to

automatically open the file when export is complete.

a.
b.

5. Enter a file name and location.

Enter a name for the export file in the Export File Name field.

Enter the Export File Location. Click Browse if you do not want to save the

export file in the default export folder.

Note: To set up the Export File Location, go to Tools » Preferences, and

select the Export tab. You can select the Use Last File Location or Use
Default Folder check box.

L T

Defaults

Startup Experiment Display Format SMTP Settings

7 Lz Last File Location

& Lsa Default Folder C:\Applied Biosystems\WiiA7 Software v1.0\experiments

oo

T T
| | o]

6. Select the data to export:

Select... To export...

Sample setup

Well, sample name, sample color, and target name of
samples in the plate

Raw data

Raw fluorescence data for each filter, for each cycle

Amplification data

Amplification results, such as Cy values, Rn, or ARn

Multicomponent data

Fluorescence data for each dye, for each cycle
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Select... To export...
Results Results information, such as Ct values, Rn, or calls
Technical Replicate Technical replicates information, such as Sample name,
Results (Tech. Rep. Target name, Task, or RQ
Results)
Biological Replicate Biological replicates information, such as Biogroup

Results (Bio. Rep. Results) | name, Target name, Task, or RQ

Clipped Data Information that is unique to the 7900 format. Data from
the last three raw data points per step (clipped from the
rest). The three data points are averaged to give you the
final fluorescence data value for each step.

Note: Results data are not available for export until the run status is complete and
the data are analyzed.

Note: The Technical Replicate Results, Biological Replicates Results, and Clipped
Data are available only in Relative Standard Curve and Comparative Cp
experiments.

7. (Optional) For Standard Curve experiments, select the external application,
TaqMan® Protein Expression Data Analysis Software or CopyCaller'" Software
if either Software is installed on your computer.

8. (Optional) After you have defined the export properties or after moving the table
headings order, you can save those export settings as an export set by clicking
Save Export Set As. Later you can import the heading order into another file by
clicking Load Export Set.

Note: It is advisable to keep the default order of the table headings if you are
using the external Applied Biosystems applications, TagMan® Protein
Expression Data Analysis Software or CopyCaller'" Software for further
analysis.

9. Click Start Export.
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The Export screen for a Standard Curve experiment looks like this:

I~ &uto Export Format :I\.’uA"‘ 7 - Expart Data To; @ One Fle ¢ Separate Files ¥ Open fle(s) when export is complete
Export File LDEat\Dn:IC'LAppIied BiosystemsWiiAT Software w1 Dlexperiments Export File Name: [viiA 75 GExport File Type: IF_Z'; (*.tut) Ll

[ sample Setup [ Raw Data [ amplfication

e —

Select Content |

wiel cele | Fam ROX |
I Al Fields 1 1 114,490.828 152,089,641 ﬁ!
W wel 2 1 109,242,531 146,209,531
3 1 115,170.742 154,477,922
P Cycle 4 1 110,922,109 150,321,562
=] 1 110,868.438 152,037.047
¥ FAM (s} 1 118,490,273 159,069,406
7 1 103,810.25 143,938.344
¥ ROX ] 1 111,164,242 155,736,562
9 1 101,719,242 141,151,297
10 1 106,640,398 148,698,031
11 1 104,925,547 147,221,641
12 1 95,424,195 130,935.641
13 1 104,884,328 144,060,078
14 1 103,273.062 143,474.641
15 1 108,450.594 148,834,062
15 1 100,280,164 141,466,984
17 1 104,955.25 146,886,953
13 1 97,516,766 140,240,438
19 1 99,431,375 142,312,224
20 1 08,064.43  140,001.781
21 1 95,670.594 139,633.078
22 1 96,225,141 140,462,933
23 1 86,768.719 125,335,984
24 1 81,606.094 113,596.859
25 1 110,705,766 152,552,422
26 1 109,678.875 139,745,906
27 1 109,723,633 147,609,100
=8 1 123,267.297 166,668,203
29 1 118,390,227 162,164,022
30 1 113,178.914 158,342.688
31 1 119,153.945 162,386,906
32 1 112,994,156 155,622,438 ;I
The exported file when opened in Notepad looks like this:
M=
Fle Edit Format ‘View Help
F Block Type = 384-Well Block -
* Calibration Expired = No
* Chamistry = TAQMAN
* Experiment File Mame = C:\Applied BiosystermsiFinal _Example_data‘\02feb10_RnaseP_10ul_Fast_QY.eds
* Experiment Mame = 02feb10_RnaseP_10ul_Fast_0QY
™ Experimant Run End Time = 2010-02-01 15:02:10 PM 5CT
* Experiment Type = Standard Curve
* Instrument Type = ViiA 7
* Passive Reference = ROX
* Signal Smocthing On = false
* Stage/ Cycle where Analysis is performed = Stage 2, Step 2
[Results]
iiall Sample Name Targer Mame Task Reporter Quencher CT Ct Mean Cr 3D CQuantity Quantity Mean
Quantity 50 Automatic Ct Threshold Ct Threshaold Automatic Baseline Baseline Start Baseline End
1 RMAse P MNTC FARM MFQ-MCEUndetarminad true
0.1968  true 3 9
2 RMAse P STANDARD F A MFO-MGE30.605  30.5682 0.0866 1250 1250 true
01968  true 3 3
3 EMAse P STANDARD FAM MFO-MGEZ29.6043 29,5153 00753 2500 2500 true
0,198 true 3 4
4 RMAse P STANDARD F b MFO-MGE28.5971 28.6109 0.0545 5000 5000 true
01968  trus 3 3
5 EMAse P STANDARD A MFQ-MGE27.5688 27.6459 0.,0568 10000 10000 true
0.1968  true 3 2
6 RMAse P STANDARD F b NFO-MGE26.5667 26,5532 0.0486 20000 20000 trus
0.1968  true 3 1
7 SK RMAsa P LIMKMOWN FAmM MFO-MGEZ28.6264 28,5816 0.0634 43358163 4994,9341
2224516 true 0.1368  true 3 23
3 SK EMAse P LINKNOWN FAM MFO-MGE28.5486 28,5816 0.0634 51065386 4934,9241
2224516 true 01968  true 3 24
9 5K RMAsa P LIMKMOWN FAmM MFQ-MGEZ28.651 28,5816 0.0634 47551675 4994,9941
222.4516 true 0.1368  true 3 23
10 SK REMNAse P LINKNOWN FAM MFO-MGE28.6199 28,5816 0.0634 48578833 4994,9341
2224516 true 01368 true 3 23
11 SK RMAse P LINKMOWN FAmM NFO-MGE28.6825 28.5816 0.0634 46487275 4994,93941
2224516 true 0.1368  true 3 23 =
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CHAPTER 2

Experiment Shortcuts

This chapter provides you with shortcuts to use in the ViiA™ 7 Software after you

have learned experiment basics.
General Information and

Instructions You can reuse experiment settings and plate setup information by: directly importing
and editing a template, using the QuickStart feature with a template, importing
experiment setup information, or importing a sample definition file; you can also
prepare several experiments at once or create a new experiment using the ReadiApp
feature.

The chapter covers:

Create an experiment from atemplate ..................... ... ... ... ..., 62
Run an experiment with QuickStart ............. ... ... ... .ol 63
Import plate setup for an experiment . ........ ... ... ... 65
Import sample information. ........ ... ... ... 66
Chapter 2
Use a template to create a batch of experiments ........................... 69
Experiment Shortcuts
Create an experiment using ReadiApp.................... ... ... .. ..., 71
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Create an experiment from a template

You can use a template to create a new experiment. Templates are useful when you
want to create many experiments with the same experiment parameters.

You can create an experiment from a template from the ViiA™ 7 Software and from the
ViiA™ 7 Instrument touchscreen.

Note: To access the ViiA™ 7 Software example templates, navigate to the templates
folder located at <drive>:\ Applied Biosystems\ ViiA7 Software v1.1\ config.

To create a template

1. Login to the ViiA™ 7 Software and, from the Home screen, open an existing
experiment, or create a new experiment.

Note: To create a new experiment using the Experiment Setup, see “Set up an
experiment” on page 13.

2. Select File » Save As Template.

3. Enter a file name, select a location for the template, then click Save and 5 Close.

You can use that experiment as a template for similar experiments.

To create a new experiment using a template

1. From the Home screen, click | - Template.

2. Locate and select the template file, then click Open.
A new experiment is created using the setup information from the template.

3. Edit the experiment properties, plate definitions, plate assignments, and run
method before you prepare the reactions and run the experiment.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.

To create an experiment using a template on the ViiA™ 7 Instrument touchscreen

You can run experiments using templates from the ViiA™ 7 Instrument touchscreen
by importing the templates from the ViiA™ 7 Software instrument console or a USB
drive. You can also modify the experiment parameters in the templates as per your
requirement.

To run a pre-existing 1. Touch View Template on the Home screen of the ViiA™ 7 Instrument
template touchscreen.

2. Select a pre-existing template from the templates list on the View Templates
screen.

3. Touch View to see the run profile before you start a run.

62 Getting Started with ViiA™ 7 System Experiments



Chapter 2 2
Run an experiment with QuickStart

4. After confirming the template setup is correct, touch ¥ to go back to View
Template screen. Touch Start Run.

To edit a template 1. Touch &= Create Experiment on the View Templates screen to create a new
before running the experiment from the existing template.
experiment Note: Select a template before you touch Create Experiment.

2. Edit the experiment parameters in the Create New Experiment screen.

3. Touch Save & Exit to save and exit the experiment or touch @ Save & Start
Run to save and start an experiment run.

Run an experiment with QuickStart

You can use a template to run an experiment with the ViiA™ 7 Software QuickStart
feature:

QuickStart from the ViiA™ 7 Software

1. Prepare the reactions.

2. Login to the ViiA™ 7 Software and, from the Home screen, click ) QuickStart
to access the QuickStart dialog box.

3. In the QuickStart dialog box, enter or select the:

. Instrument icon of the instrument to perform the run on.

a

b. Experiment name.

c. Experiment template file.
d

. (Optional) Barcode and User Name for the experiment.

4. (Optional) To review the experiment or to make changes to any of the experiment
parameters, click Experiment Setup.

Getting Started with ViiA™ 7 System Experiments 63



Chapter 2 Experiment Shortcuts
Run an experiment with QuickStart

The QuickStart dialog box looks like this:

I QuickStart [ el x|
_—:Q Select an instrument and an experiment template file ko run a new experiment. Load the reaction plate into the instrument, then dick Start Run, Q,

Select Instrument

|
i_./

fosmirajs1l01
READY

Enter Experiment Name and Location

* Experiment MNarme: |201 0-04-15 124807

Barcode (Optional);

User Name (Optional): |

Location: I:f‘tware v1.O\experiments\2010-04-15 124807.eds -

| Comments (Optional};

L

Select Experiment Template

* Experiment Termplate File:

=

Sample

=

Yiou may import a plate setup file or a sample definition text file, Alternatively, you may
directly edit the sample names in the table to the left, or copy and paste sample names
fram a spreadshest,

| Experiment Setup [ STARTRUM B _

5. Proceed to running the experiment and analyzing the data.

QuickStart from the ViiA™ 7 Instrument touchscreen

Start an experiment
using a pre-defined
template

Start an experiment
with a pre-defined
short-cut button

64

You can QuickStart an experiment from the ViiA™ 7 Instrument touchscreen in the
following ways:

e Start an experiment using a pre-defined template.
e Start an experiment with a pre-defined short-cut button.

You can use a pre-existing template from the default experiments folder or use a
custom template from another folder to start a run.

The ViiA™ 7 Instrument touchscreen displays up to 18 shortcut buttons to templates
or folders that contain experiments to be run. The shortcut buttons are present under
MY SHORTCUTS on the Home screen. To start a run, touch any of the pre-defined
experiment or folder buttons.

To create a shortcut button for a preferred experiment or a folder that contains
experiments:

1. Touch Settings to open the Settings Menu.
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2. Touch Set Up Shortcuts to list the Shortcut Targets.

3. On the Shortcut Targets list screen, select an existing template Shortcut Target
button or an unused button.

4. Touch Set Shortcut. If you selected an unused button, then touching Set Shortcut
will list out the templates and folders to set the shortcut for.

5. Under the [ From Templates tab, select the templates for which you are
creating the shortcut button.

6. (Optional) Create a shortcut button to show the templates or experiments in a
particular folder for quick access, from those listed under the From Folders tab.
You can touch Edit to create or edit shortcut buttons.

Import plate setup for an experiment

You can import the plate setup for a new experiment from an exported file with one of
the following formats:

* *itxt - Text format

e *xml - XML format

* *.csv - Comma separated values format

e *sdt- Sequence detecting system (sds) template files format

* *sds-7900 v2.3 format

IMPORTANT! Make sure the file you select contains only plate setup data and that the
experiment types match.

Note: For instructions on exporting an experiment, see “Export an experiment” on
page 57.

To Import the plate setup data:
1. Create a new experiment or open an existing experiment.

2. In the Experiment Setup screen, select File » Import Plate Setup or access the
Import drop-down menu in the toolbar and select Import Plate Setup.

3. Click Browse, locate and select the file to import, then click Select.

Import Plate Setup i x|

Select the plate setup file to import, then click Start Import. Q,

Select File:

Getting Started with ViiA™ 7 System Experiments 65



2 Chapter 2 Experiment Shortcuts
Import sample information

4.

Click Start Import. The setup data from the exported text file is imported into the
open experiment.

Note: If your experiment already contains plate setup information, the software
asks if you want to replace the plate setup with the data from the import file. Click
Yes to replace the plate setup.

After importing plate setup information, use Experiment Setup to set up your
experiment, and then run the experiment.

Note: You can import plate setup information from a 96-well plate into a 384-well

plate, provided that the file you are importing the information from is a .txt file.

Import sample information

You can import sample information from a sample definition file to include in the plate
setup for your experiment. A sample definition file is a comma-delimited file (*.csv) or
a tab-delimited text file (*.txt) that contains the following setup information: well
number, sample name, and custom sample properties.

Note: Make sure that the sample definition file you select contains only sample
information.

Create a sample definition file

1.

2.

66

Open a text editing program such as Notepad.

Enter the following column headers in the first row (press the Tab key between
each entry if you are saving the file as *.txt or enter a comma between each entry if
you are saving the file as *.csv):

o Well
* Sample Name

* (Optional) Column header names for up to six user-defined custom fields (for
example, Custom 1, Custom 2, etc.)

For each subsequent row, enter the well number, press the Tab key or enter a
comma, then enter the sample name. Optionally, press the Tab key, then enter the

custom properties for the sample.

Save the file with the .txt or .csv file extension.
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An example sample definition, saved with the .csv extension, file looks like this:

A B | E | ©

1 el Sample Mame Sex HairCaolar | Smaoker
2| 1 Zample 1 1 22 Female 25 black es
3| 2 Sample 2 2 25 Male 26 brawn Mo
4 3 Sample 3 3 45 Female S0 blonde  Yes
48| 4 Sample 4 4 31 Male 33 red es
B 5 Sample 5 5 29 Female 46 grey Mo
7 G Sample & g 26 Male 35 black Mo
8 | 7 Sample 7 7 31 Female 33 black es
9 g Sample 3 g 32 Male 67 black Mo
1o 9 Sample 9 9 32 Female 55 brawn es
AN 10 Sample 10 10 33 Male 44 blonde  Yes
12 11 Sample 11 11 34 Female 25 red Mo
13 12 Sample 12 12 34 Male 26 grey Mo
14 13 Sample 13 13 35 Female a0 black es
15 14 Sample 14 14 35 Male 33 black Mo
= 15 Sample 15 14 36 Female 46 black es
17 16 Sample 16 16 36 Male 35 brawn es
=l 17 Sample 17 17 37 Female 33 blonde Mo
18 18 Sample 18 13 37 Male 67 red Mo
a0 19 Sample 19 19 38 Female 55 grey Yes
21 20 Sample 20 20 358 Male 44 black Mo

Import sample information from a sample definition file

1. Create a new experiment or open the experiment to receive the setup data (select
File » Open, select the file to open, then click Open).

2. From the open experiment, select File » Import Plate Setup.

3. Click Browse to browse your computer for a sample definition text file (*.csv).
After you locate the file and select it, click Select.

4. Click Start Import.

5. If your experiment already contains plate setup information, the software asks
you if you want to replace the plate setup with the data from the file. Click Yes to
replace the plate setup information.

The samples appear in the Samples table for the experiment. All samples and well

assignments in the experiment are replaced with those in the file. If defined, the

custom sample properties also appear in the Well Table of the Analysis Section, and
also in the Plate Layout tooltips in both the Setup and Analysis screens. The custom
fields can be exported with the results data.

Note: You cannot edit the custom sample properties from within the Well Table. To
modify this information, edit the custom fields in the sample definition file and import
the file again. All of the sample information in the experiment is replaced with the

information in the new file.
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The Assign screen with information from the above sample definition file looks like
this:

Samples Samgpls 1
. Custam Property:
o i
Age: =
- Si: Farnak
Weight: &
Hair Coor : black
(4 Smpker: e e

ppElnEiEiziEEkl

Dibogica Grougs

4 | _*]:J

wels: [{flo Ee o 364 Empty

The Well Table in the Analysis section looks like this:

* [ wall | [ o7 LT Mean [ £T 50 | Quaritry Ouemny...[ummrtj...|cornrnents[ "] | Age | Sem | “walght Halrcolor[ Smeher_l

1 om 1 = Femak = blark e -

2 a2 2 =] Mk E] brom [

3 3 45 Femake =1 bionde R (=1

4 Aq 4q 31 Make k= el AL

5 a3 g =] Feamale 48 ey g

6 a6 G ] Pl = black o

T a7 7 31 Femzle Ex] blzck AL

8 a8 ] =z Ml &7 black o

9 A 9 = Famals ] (=] AL

1 aib 10 3 Maka L2l béond=s A1

11 11 24 Famala -] red Mo

12 ME 1= £ ik Sl =] ]

13 a1z 12 = Femake 1l black e

M Al 14 =} ik Es| bodack ]

15 A5 1= E] Famale 45 bdack Vs

hL 1] i = Kl = bnown Vi

17 a1r 17 o Femake 3 biand= 3

d alE i= ko ke &7 rescl o

13 AlF 1= ] Famal =] (== AL

. [ a0 = Mk 44 bolark Lin

21 A1

22 3z

1 23

29 1024

25 Bl

20 B2

27 B3

23 B4

A B

0 B

31 BY

i = =)

- =)

34 BI1O

3 Bil

o =

L1} |

Wiell Surmemary: In Fale 284 Sef Upi 284 Al 394 Flagged [ vt by Arelysii 0 airited Weraaly 0 Sanphes Used, 354 T geebs Lhseck [
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Use a template to create a batch of experiments

Use the batch experiment utility to create multiple experiment files from the same
template without using Experiment Setup.

1. In the menu bar, select Tools » Batch Experiment Setup.The Batch Experiment
Setup Utility dialog box looks like this:

Batch Experiment Setup Utility Ol x|

Provide input files, select the file naming convention, and export location, then click Create Experiments |

€

1. Import Files
* Experiment Template Fie: [:d Biosystems\ViiA7 Software v1.0\config\templatesWiiA7_TagMan_Array_Comparative_Ct_Fast Template.edt

Assay Information File: |
Flate Setup File: |

2. Barcode{s) and Naming Convention

Create Experiment Files Using: ¢ Barcode: |

& Specify Mumber of Files: IE

File Namne: Format: Attribute | Include | custom Mame Fisld: |
Custorn Mame Field icd ] )
Plate Barcode ] l Move Up File: Marne Preview:
in] 3 Custorn Marme Field_ID

Move Down

l

3. Export Location

* Export Setup Files to: |C:\Applied Biosystems\ViiA7 Software v1.0\experiments
Create Experiments W

2. Select the file(s) to use to create the new experiments:
a. Click Browse in the Experiment Template File field.
b. Locate an *.edt file to import, then click Select.

C. (Optional) Repeat steps 2a and 2b for the remaining setup file types to import
(Assay Information File (*.txt or *.xml), Plate Setup File (*.txt)).
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3. Select the option to create experiment files. The selected option determines the
number of experiment files created:

Specify Number of Files - Enter a number from 1 to 100.

Barcode - Click Browse and select a Barcode File (*.txt) to import. The
software automatically adds the Plate Barcode attribute to the file name
format. The number of experiments created equals the number of barcodes
present in the barcode file.

Note: A Barcode File contains one barcode per line. An example Barcode File
looks like this:

P BarCode_Template 384Wb.txt - Notepad [_ O] x|
File Edit Format ‘iew Help

Batcode (384W) =
AZDISTINT
A3DISTIL
A3DISTIY
ABDIETW
AZDISTINK
A30DISTIY
A30DISTWZ
ABDIETHO
ABDIETHL
A3DIETHZ
AZDISTW
AZDISTW
AZDISTIK
A3DISTIL
AZDISTIM
AZDISTWO
A3DISTIR
A3DISTIR
AZDIETIS
ASDISTIWH
A30DISTIG
AZDISTWE
AZDISTWD
AZDISTIC

E

4. (Optional) Edit the file name format. Use the File Name Preview to verify your
settings.

Select the check box to include or exclude the Custom Name Field attribute
from the file name. If included, click the Custom Name Field and enter up to
100 letters and/or numbers to identify the batch of experiments.

Note: The file name can contain a total of 100 characters, including all file
name attributes.

Click Move Up or Move Down to change the order of the selected file name
attributes.

5. Select the location for the experiment files to be created:

a.
b.

Click Browse in the Export Setup Files to: field.

Review the location for the experiment files. Navigate to a new location if
you do not want to export the experiment files to that folder, then click
Select.

6. Click Create Experiments. A confirmation message appears when the batch of
experiments has been created.
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Create an experiment using ReadiApp

You can use the ReadiApp feature to set up an experiment in the ViiA™ 7 Software.
The ReadiApp feature provides a shortcut to create experiments for the assays
purchased from Applied Biosystems.

The default ReadiApp templates available in the ViiA™ 7 Software include:
* TagMan® Gene Signature Array Cards
e Custom TaqgMan® Array Cards
e TagMan® Gene Expression Assays
e TagMan® Drug Metabolism Assays
* TagqMan® array MicroRNA Cards
e TagMan® Copy Number Assays (CNV)
e TagMan® SNP Genotyping Assays

1. Log in to the ViiA™ 7 Software and, from the Set Up menu on the Home screen,
click ReadiApp.

2. Click the assay to use to set up an experiment.

Note: Click Cancel to exit the ReadiApp dialog box.

Pll Readifpp |

Select your experience:

[ TagMan® Array MicroRNA Cards ”")] [ TagMan® Gene Signature Array Cards ]
[ TagMan® Copy Number Assays (CHY) ] [ Custom TagMan® Array Cards ]
[ TagMan® SNP Genotyping Assays ] [ TagMan® Gene Expression Assays ]
[ TagMan® Drug Metabolism Assays ]

3

A new experiment is created using the setup information from the template.

3. (Optional) Edit the experiment properties.

4. Proceed to preparing reactions, running the experiment, and analyzing the data.
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CHAPTER 1

About Standard Curve Experiments

This chapter covers:

Chapter 1
About Standard Curve B Before youbegin. .............uiuuun 6
Experiments B About the exampleexperiment ............. ... ... il 7
I IMPORTANT! First-time users of the ViiA™ 7 System please read Booklet 1, Getting

Started with ViiA™ 7 System Experiments and Booklet 7, ViiA™ 7 System Experiments -
Appendixes of this binder thoroughly. The booklet provides information and general
instructions that are applicable to all the experiments described in this binder

Design the Experiment Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking &3
in the toolbar, or selecting Help » ViiA™ 7 Software Help.

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments 5



II Chapter 1 About Standard Curve Experiments
Before you begin

Before you begin

The Standard Curve method is used for determining absolute target quantity in
samples. With the standard curve method, the software measures amplification of the
target in samples and in a standard dilution series. Data from the standard dilution
series are used to generate the standard curve. Using the standard curve, the software
interpolates the absolute quantity of target in the samples.

Assemble required components

¢ Sample - The tissue group that you are testing for a target gene.

e Standard — A sample that contains known quantities of the target; used in
quantification experiments to generate standard curves.

¢ Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

PCR Options
When performing real-time PCR, choose between:
¢ Singleplex and multiplex PCR (below)
and
¢ 1-step and 2-step RT-PCR (page 7)
Singleplex and You can perform a PCR reaction using either:
Multiplex PCR ¢ Singleplex PCR - In singleplex PCR a single primer set is present in the reaction

tube or well. Only one target or endogenous control can be amplified per reaction.
or

¢ Multiplex PCR - In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.
Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

0 O BE [ Target Primer Set
&
— 9\ 0o (O Endogenous Control
7 Primer Set
. ~-~ cDNA
Singleplex PCR Multiplex PCR

6 Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



Chapter 1 II
About the example experiment

1- and 2-Step You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
RT-PCR separate reactions (2-step). The reagent configuration you use depends on whether

you are performing 1- or 2-step RT-PCR:

¢ 1-step RT-PCR- In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR master mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

¢ 2-step RT-PCR - 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be

used to prevent carryover contamination.

Note: The Standard Curve example experiment is designed for singleplex PCR,
where every well contains a primer/probe set for a single target; the reactions are

set up for a 2-step RT-PCR.

About the example experiment

To illustrate how to perform Standard Curve experiments, this guide leads you
through the process of designing and performing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize

yourself with the ViiA™ 7 System.

The objective of the Standard Curve example experiment is to determine the quantity

of the RNase P gene in two populations.

In the standard curve example experiment:

* The samples are genomic DNA isolated from two populations.

¢ The target is the RNase P gene.

* One standard curve is set up for the RNase P gene (target). The standard used for
the standard dilution series contains known quantities of the RNase P gene.
Because a single target is being studied, only one standard curve is required.

Note: In experiments where multiple targets are being studied, a standard curve

is required for each target.

* Three replicates of each sample and each dilution point in the standard curve are

performed to ensure statistical significance.

* The experiment is designed for singleplex PCR, where every well contains a

primer/probe set for a single target.
* Reactions are set up for 2-step RT-PCR.

* Primer/probe sets are from Applied Biosystems RNase P assay.

Note: The human RNase P FAM™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene

Expression Assay (PN 4331348).

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



1 Chapter 1 About Standard Curve Experiments
About the example experiment
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CHAPTER 2

Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.
About Standard Curve

Experiments This chapter covers:
B Define the experiment properties. .............. ... i 10
Define targets, samples, and biological replicates. ......................... 11
l B Assign targets, samples, and biological groups............. ... ... o oo 12
B Setuptherunmethod........ ... ... .. 15
Chapter 2
. . B Order materials for the experiment................... ... ... .. ... ... 16
Design the Experiment
B For moreinformation.......... ... ... i 16
Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more

information on Auto Export, refer to Chapter 1in Booklet 1, Getting Started with ViiA™
7 System Experiments.

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments 9



2 Chapter 2 Design the Experiment
Define the experiment properties

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
ViiA™ 7 Software. Enter:

Field or selection Entry
Experiment Name ViiA7_384-Well_Standard_Curve_Example
Barcode Leave field empty
User Name Example User
Comments Standard Curve example
Block 384-Well Block
Experiment Type Standard Curve
Reagents TagMan® Reagents
Ramp speed Fast

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

T Experiment Mame: via? 384-well standard Curve Example Corrments: [Standard Curve examnle o

Barcode;

User Mame! |Example User x

Which blodck are you using to run the experiment?

s 384-well Blodk | Arvay Card Block | o6-Well Block (0.2mL} ] | Tast 96-Well Blodk (0.1mL)

What type of experiment do you want to set up?

£ standard Curve Relative Standard Curve ] | Comparalive Cr (AACH) J Melt Ciirve |
Ganotyping i Presencefahsance

Which reagents do you want to use to detect the target sequence?

F TaaMan® Reagents | SYBR® Greon Reagents | Other J

What properties do you want for the insbrument run?

standard J F Fast |

10 Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



Chapter 2 2
Define targets, samples, and biological replicates

Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

1. Targets

Target name Reporter Quencher Color

RNaseP FAM NFQ-MGB

2. Samples

Sample name Color

5K

10K

3. Dye to be used as a Passive Reference
ROX

Your Define screen should look like this:

Target Name Reporter Quencher Color Sample Name Color
RNAse P FAM ~ |NFQ-MGB v ‘ g ‘ 5K -
10K ~

Biological Replicate Groups

Hew

Biclogical Group Name Color Comments

Passive Reference

ROX v

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments 1



2 Chapter 2 Design the Experiment
Assign targets, samples, and biological groups

Assign targets, samples, and biological groups

Click Assign to access the Assign screen.

1. Define and set up standards.
a. Click Define and Set Up Standards on the Assign screen.
b. Select a target.

Field Select

Select a target for this standard curve RNaseP

c. Define the standard curve.

Field Enter
# of Points 5
# of Replicates | 16
Starting Quantity ' 1250.0
Serial Factor 2x

d. Select and arrange wells for the standards.

Field Select

Use Wells Let Me Select Wells

12 Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



e. Click Apply, and then Close.

Chapter 2 2

Assign targets, samples, and biological groups

Your Define and Set Up Standards dialog box should look like this:

[ Define and Set Up Standards

Select a karget From the list of targets in the reaction plate. Define the standard curve, select wells For the standards, then click Apply. Repeat for each standard curve in the reaction plate, then click Close ko return to plate setup. QJ

Select a target

* Select the target for this standard curve: |RNAse P ow

x|

= Required

Define the standard curve = Required
* # of Points: |5 (5 Recommended)

* # of Replicates: |1Ei

(3 Recommended)

* Starting Quantity: |125EI.EI

(Enter the highest or lowest standard quantity for the standard curve.)

* Serial Factor; |2x

LI (Select a value from 1:10 to 10x.)

5 Points ¥ 16 Replicates = 20 Required Wells

Standard Curve Preview

Use wels: { Automatically Select Wels for Me & Let Me Select wells

12 3 4 5 & |7[a|0o[10]1112[13]14]15 16 |17 [18 1920 |21 |22 [23 |24

[FPezz=rrscczTnnmonw=

Select and arrange wells for the standards

80 Required Wells / 80 Selected Wells

A2,83,A4,40,A0,82,B3,B4,B5,B0,C2,03,04,05,06,02,03,04,05,06,E2,E3,E4,E5,E6,F2,F3,F4,F3,F5,
G2,G3,54,65,G0,H2,H3,H4,H3,HE,12,13,14,15,16,12, 13,14,15, J6,K2,K3,K4,K3,K6,L2,L.3,L4,L35,LE,M2,M

(3,14, 15, MB, N2, M3, N4, NS,M6,02,03,04,035,00,F2,P3,P4,P35, PO

2. Assign targets and samples.

Target Well Task Quantity Sample
name number name
RNaseP | A1 - P1 Negative None None
(column 1)
RNaseP A2 - P2 Standard 1250 None
(column 2)
RNaseP A3 - P3 Standard 2500 None
(column 3)
RNaseP A4 - P4 Standard 5000 None
(column 4)
RNaseP A5 - P5 Standard 10000 None
(column 5)
RNaseP A6 - P6 Standard 20000 None
(column 6)

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments

13



2 Chapter 2 Design the Experiment
Assign targets, samples, and biological groups

Target Well Task Quantity Sample
name number name
RNaseP | A7 - P15 Unknown Determined 5K
(columns by run
7 -15)
RNaseP | A16 - P24 Unknown Determined 10K
(columns1 by run
6 - 24)

Your Assign screen should look like this:

., Define and Set Up Standards
Targets [

E' iew Legend

<l
=
=
=
&
[l
el
-

A E R AL S A E A A EAR A ER E ES A N
A |9 9 50 I S 0 CE0P 0 CE CEN P CE CENP P CE [ O O
o [T 53 [ 5 5 53 0 CE CENP 0 0 CE0 P CE P C
< e 0 0 ) 0 O C
o |1 0 3 5 0 CE 0 C P C
— = | |3 0 e o e Y
rlﬁﬁ| | 3 v e 00 1
1ok | (= | 0 3 [ 0 % 0 0 CE C P 0 !
1 | Com o o 0 0 0 0 0
o0 3 0 N U O O
> o0 o 0 ) 0 O
. « |C0m [ o e 0 0 CE
Bm@ | o o o o o e e e
v o0 3 0 0 X U
v o0 0 ) U CE O
o |1 0 3 0 N CE 0 0 CE
o0 3 0 0 U O O
_We"s:i!lzse EHeo[d16 0 Empty
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Chapter 2
Set up the run method

Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the

Graphical View tab. Enter:

* Reaction Volume Per Well: 10ul
¢ Thermal Profile

Stage Step Ramp rate | Temperature Time
Hold Stage Step 1 1.9°C/s 95°C 20 seconds
PCR Stage Step 1 1.9°C/s 95°C 1 second
Number of Cycles: 40 | Step 2 1.6 °C/s 60°C 20 seconds
(default)

Enable AutoDelta:
Unchecked (default)

Starting Cycle:
Disabled when Enable
AutoDelta is unchecked

Your Run Method screen should look like this:

Run Method

Reaction Wolurmne per wel | 10 pL
Graphical View
Hold Stage PCR Stage
Murnber of Cycles: |4D :’
[T Enable AutoDelta
Starting Cycler |1 3:
100 * ]
95.0 *C 935.0 *C
00:20 L9°Cls pmog
75 G| T8 °Cfs
60.0 “C
B 00:20
50 0|
25 °C_|
[
Step1 Stepl Stepz
4 »
Legend
" Data Collection On = Data Collection Off A AutoDelta On A AutoDelta Off

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments
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2 Chapter 2 Design the Experiment
Order materials for the experiment

Order materials for the experiment

The recommended materials are:
* MicroAmp® Optical 384-Well Reaction Plate
e MicroAmp® Optical Adhesive Film
e TagMan® Fast Universal PCR Master Mix
* Applied Biosystems RNase P> assay (PN 4316831)

Note: The human RNase P FAM"™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene
Expression Assay (PN 4331348).

Your Materials list screen should look like this:

Find Assay

Enter Geng Name I Find Assay Enter a gene name, then dick Find Assay to search the Applied Biosysterns Store for a gene expression assay,

Experiment Materials List

Add Selected Items to Shopping List Display : IAII Ttems ;I

™ check Al Ttern Part Mumber Description

Includes: Human DA standard curve dilution series from 0.6 to 12.0 ngful |[=
, unknowen DMA contral,  -actin Probe (FAM™ Probe), & -actin Forward

r TaoMan@ DNa Template Reagents 401970 Prirner, B -actin Reverse Primer. Sufficient for 100 reactions at 50 uL
reaction volume.
Includes 10 % PN N2030234, TagMan® Reverse Transcriptase Reagents.
r TaqMan® Reverse Transcription Reagents (10 Pack) 4304134 Sufficient for 2000 Reverse Transcriptase reactions at 10 pL reaction

volume,

An optically-clear adhesive film used to seal the samples into the wels of a
- Microarmp™ Optical Adhesive Filrm (100 filns) 4311971 96-well ricroplate. This will reduce the possibility of cross-contarmination
hetween sample wells and heln ensure consistent Real-Time PCR data.

The MicroAmp™ Multi-Removal Tool makes it easier to remove caps from

r MicroAmp™ Multi-Removal Tool (1 tool) 4313950 tubes, microplates from therrnal cyclers and ruch maore, _I
-

Experiment Shopping List (0 items)

Remove Selected Items from Shopping List Shopping Basket Narme |02feb10 RhaseP 10ul Fast Basket

[ Check al Itemn Part Murber Quantity

For more information

For more information on... Refer to... Part number

Consumables Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System LLA1434
Experiments

Appendix A in Booklet 7, ViiA™ 7 System Experiments - Appendixes

16 Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



For more information

Chapter 2

Part number

For more information on... Refer to...
Using other quantification Booklet 3, Running Relative Standard Curve and Comparative Cy LLL434
methods Experiments.
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note
LLLA34

Using Alternative Setup

Chapter 2 in Booklet 1, Getting Started with ViiA™ 7 System
Experiments

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments
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2 Chapter 2 Design the Experiment
For more information
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CHAPTER 3

Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Standard Curve

example experiment.
About Standard Curve

Experiments This chapter covers:
B Assemble required materials ......... ... .. i 20
Prepare the sample dilutions ............... ... . ... . o il 20
B Prepare the standard dilutionseries . ................. ... ... o i i 21
B Prepare the reaction mix (“cocktail mix”)........... ... ... L. 21
Design the Experiment B Preparethereactionplate ............ ... i 22
B For moreinformation.......... ... ... i 25

|

Chapter 3

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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3 Chapter 3 Prepare the Reactions
Assemble required materials

Assemble required materials

e Ttems listed in Booklet 1, Getting Started with ViiA™ 7 System Experiments
e Samples - Human Raji cell line-derived cDNA samples (100 ng/pL)
¢ Example experiment reaction mix components:

— TaqMan® Fast Universal PCR Master Mix

— RNase P Assay Mix (20X) (PN 4316831)

Prepare the sample dilutions

To determine the quantity of the RNase P gene in the example experiment, dilute the
samples (as directed below) before adding the samples to the final reaction mix.

The stock concentration of each sample is 100 ng/uL. After dilution, the sample Popl
has a concentration of 6.6 ng/pL and Pop 2 has a concentration of 3.3 ng/uL. Add 2uL
to each reaction.

Use this table for sample dilution volumes for the example experiment.

Samble Stock Sample Diluent | Totalvolume
nan?e concentration volume volume of diluted
(ng/upL) (uL) (uL) sample (pL)
Pop1 100.0 25 355 380
Pop2 100.0 12.5 367.5 380

Note: For your own experiment, adjust the input amounts of the template depending
on the template type and target abundance.

1. Label a separate microcentrifuge tube for each diluted sample:
e Popl
e Pop2

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume
(pL)
1 Pop 1 355
2 Pop 2 367.5

3. Add the required volume of sample stock to each tube:

Tube Sample name Sample volume
(pL)
1 Pop 1 25

20 Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



Chapter 3 3
Prepare the standard dilution series

Tube Sample name Sample volume
(uL)
2 | Pop2 125

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series

The standard concentration in stock is 20,000 copies/pL:

I Source Diluent Total Standard
Standard name Dilution .
(labeled tube) point Source volume volume volume conce_ntratmn
(L) (L) (L) (copies/uL)

RNase P Std. 1 1 (20,000) Stock 18 18 36 10,000
RNase P Std. 1 2 (10,000) Dilution 1 18 18 36 5,000
RNase P Std. 1 3 (5,000) Dilution 2 18 18 36 2,500
RNase P Std. 1 4 (2500] Dilution 3 18 18 36 1250
RNase P Std. 1 5 (1250) Dilution 4 18 18 36 625

1. Prepare five standard dilutions:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge the
RNase P Std. 1 tube briefly before pipetting stock into the tube.

For each dilution:

a. Use a new pipette tip to add 18 pL of source to the tube containing the
standard.

b. Vortex the tube for 3 to 5 seconds, then centrifuge the tube briefly.

2. Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

For the RNase P assay (Standard Curve example experiment), the following table lists
the universal assay conditions (volume and final concentration) for using the TagMan®
Fast Universal PCR Master Mix.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments 21



Chapter 3 Prepare the Reactions
Prepare the reaction plate

Volume for 1 Volume for 384
Reaction component . reactions + 10% excess
reaction (pL)
(pL)
TagMan® Fast Universal PCR Master Mix Kit 5 2115
RNase P Assay (20X] 0.5 211.5
Water 3.5 1480.5
Total reaction mix volume 9 3807

1. Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.

2. Add the required volumes of each cocktail mix component to the tube.

Note: Do not add the sample or standard at this time.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to preparing
individual reaction mixes for each sample.

Prepare the reaction plate

Example experiment reaction plate components

22

The reaction plate for the Standard Curve example experiment contains:

* A MicroAmp® Optical 384-Well Reaction Plate
® Reaction volume: 10 puL/well

e 288 Unknown wells [I]

e 80 Standard wells [&]

e 16 Negative control wells []

Applied Biosystems ViiA™ 7 System Getting Started Guide for Standard Curve Experiments



The plate layout looks like this:

bl FPlate Layout Well Table

-

Chapter 3
Prepare the reaction plate
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To prepare the reaction plate components

1. Prepare the negative control reactions for the target:
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a. To an appropriately sized tube, add the volumes of reaction mix and water

listed below.
. . Reaction mix | Watervolume
Tube Reaction mix
volume (uL) (L)
1 RNase P reaction mix 157.5 17.5

b. Mix the reaction by gently pipetting up and down, then cap the tube.

c. Centrifuge the tube briefly to remove air bubbles.

d. Add 10 pL of the negative control reaction to the appropriate wells in the
reaction plate.
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3 Chapter 3 Prepare the Reactions
Prepare the reaction plate

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

Standard Reaction Reaction mix Standard
Tube . L Standard volume
reaction mix volume (uL)
(uL)
1 RNase P RNase P 157.5 RNase P 17.5
Std 1 reaction Std 1
mix
2 RNase P RNase P 157.5 RNase P 17.5
Std 2 reaction Std 2
mix
3 RNase P RNase P 157.5 RNase P 17.5
Std 3 reaction Std 3
mix
4 RNase P RNase P 157.5 RNase P 17.5
Std 4 reaction Std 4
mix
5 RNase P RNase P 157.5 RNase P 17.5
Std 5 reaction Std 5
mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the standard reaction to the appropriate wells in the reaction
plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below.

Reaction Samble
Unknown Reaction miXx P
Tube . . Sample volume
reaction mix volume (uL)
(uL) K
1 RNase P RNase P 1422 pop1 158
pop1 reaction mix
2 RNase P RNase P 1422 pop2 158
pop2 reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.
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Chapter 3 3
For more information

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

7. Until you are ready to perform the run, place the reaction plate at 4 °C, in the
dark.

For more information

For more information on... Refer to... Part number

Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System LLA1434

components Experiments

Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System LLA1434
Experiments
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For more information
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CHAPTER 4

Run the Experiment

This chapter explains how to run the example experiment on the ViiA™ 7 Instrument.

About Standard Curve This Chaptel‘ covers:
Experiments
B Starttherun. .. ... ... .. e 28
B Monitor the run. . ... ... e 28

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

Design the Experiment

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.

Prepare the Reactions

!

Chapter 4

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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4 Chapter 4 Run the Experiment
Start the run

Start the run

Monitor the run

. Open the Standard Curve example file that you created using instructions in

Chapter 2.
Load the reaction plate into the instrument.

Start the run.

Monitor the example experiment run:

From the ViiA™ 7 Software using the Run screen, while the experiment is in
progress.

From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment
started from another computer or from the ViiA™ 7 Instrument touchscreen).

From the ViiA™ 7 Instrument touchscreen.

From the Instrument Console of the ViiA™ 7 Software

28

. In the Instrument Console screen, select the instrument icon.

Click Manage Instrument or double-click on the instrument icon.

On the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.
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Chapter 4 4
Monitor the run

View the You can view the progress of the run in real time. During the run, periodically view all
Amplification Plot the three plots available from the ViiA™ 7 Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Plate Layout

Amplification Plot

= ELL' = E-h-:u.-ir.'u'-.-'ell: v selectwels v ] View Lagend
Amplification Plot 12 5 5567 8900121341505 1718 3D 22
= 8 s 1S s s DU NI B B B O B B OO B B B B O B B O B B
o | 50 5 S 5 0 . o
c | 90 0 0 9 e e
o |7 0 30 30 5050 0
e | 9 9 0 e e
e |0 30 0 0 5 0 A0 P 1 O
o |0 59030 0 0 . 1 e
5 5 S5
v o 9 e 3 e e
|0 92 0 0 0
|0 590 0 0 e
v | 5 0 e
[ 3 55 5 . e e e
G e
o {0 5 30 9 0 S
K |1 30 720 30 30 P 2
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4 Chapter 4 Run the Experiment
Monitor the run

View the Click Temperature Plot from the Run Experiment Menu.

Temperature Plot The figure below shows the Temperature Plot screen as it appears during the example

experiment.

Temperature Plot current Temperatures

® > B iy & & I [ caver
e = |_ l ~ Wsamiple
Temperature Plot - Block
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e n e —snas
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PR S s
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e
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e e
s
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[ ——
o e
i ———
j —
§ =y v
g <t ot S
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o

45

40

a5
30
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5

5 Temperature Plot
00:00:00 00:04:10 00:08:20 00:12:30 00:16:40 00:20:50 00:25:00 00:29:10 00:33:20 00:37:30 00:41:40 00:45:50 00:50.00 00:54:10 00:58:20 y

) Wigny 1 Hour -
Time
Fixed view [~

4 F

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
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View the Run
Method

experiment.

Run Method

Click Run Method from the Run Experiment Menu.

Chapter 4
Monitor the run

The figure below shows the Run Method screen as it appears in the example

Edit Run Method

Adiust # of Cycles:

[T &dd Melt Curve Stage to End

[T 2dd Haolding Stage to End

7 2dd Infinite Hold to End

[

Hold Stage PCR Stage
MNurmber of Cycles: |4D :I
7 Enable AutoDelta
Starting Cycle: |1 3:
100 ¢ |
95.0 =C 95.0 =C
00:20 L9Cfs oot
= . = L}
TE | 1 °C,|’S
G0,0 *C
8o 00:20
50 _|
25 ¢ _|
o°Cc__|
Stept Step1 Step2
4
Legend
" Data Collection On ~ = Data Collection Off A AutcDelta On - A AutoDelta Off

View the run data

Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example
experiment.

Run Data Report

Experiment Mame:
Start Time:

Stop Time:

Rur Duration:

User ID:

Errors Encountered:
Instrument Mame:
Firmuware Wersion:
Software Wersion:
Tnstrurmnent Serial Mumber:
Sample volume:
Cover Temperature:

Elock Type:

02feb10_RnaseP_10ul_Fast_Qy
02-01-2010 22:25:14 5GT
02-01-2010 22:07:07 56T

41 minutes 52 seconds

278880018

10.0

105.0

284-well Flate (16x24)
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4 Chapter 4 Run the Experiment
Monitor the run

From the ViiA™ 7 Instrument touchscreen

You can also view the progress of the run from the touchscreen of the ViiA™ 7
Instrument.

The Run Method screen on the ViiA™ 7 Instrument touchscreen looks like this:

Experiment View T : _

Experiment: 2010-03-11-232013

D Experiment View g;

Run Started: March 11 2010 - 11:20PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover: 105.0 °C

Heated Cover Set Point: 105.0 °C Time Remaining: 01:28:18

Time View = S
@ | MyInstrument (384-well 20pL) E

Experiment: 2010-03-11-232013

Run Started: March 1172010 - 11:20PM Sample: 50.0 °C
Reaction Volume: 20 pL Stage /[ Step: 1 /1
Heated Cover Set Point: 105.0 °C Cycle: 1

Display Time: Remaiing () Elapsed

‘March 11 2010 - 11:20PM: Heated cover reached target temperature.
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CHAPTER 5

Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

About Standard Curve
Experiments

This chapter covers:

Section 5.1 Review Results ....... ...t 35
B Analyze the example experiment. ............ ... ... . ... ..o 35
View the Standard Curve Plot ........ ... .. ... 35
Design the Experiment B Assess amplification results using the Amplification Plot................... 38
B Identify well problems using the Well Table .............................. 45
B Confirm accurate dye signal using the Multicomponent Plot................ 49
B Determine signal accuracy using the Raw DataPlot ....................... 51
B Review the flagsinthe QCSummary ................. ... ... . ........ 53
B For more information. ........... ... o i 55
Prepare the Reactions
Section 5.2 Adjust parameters for re-analysis of your own experiments. . ....... 57
B Adjust analysissettings. . ... 57
B Improve Cp precision by omittingwells................ ... ... .o oo 61
B For more information. . ............... e 62

Run the Experiment

|

Chapter 5

Review Results and
Adjust Experiment
Parameters

Export Analysis Results
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SECTION 5.1

5 1 Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as
standards. The ViiA™ 7 Software calculates the quantity of an unknown target from
the standard curve.

Purpose

The purpose of viewing the standard curve for the example experiment is to identify:
¢ Slope and amplification efficiency
e RZvalue (correlation coefficient)

e Cyvalues

To view and assess the Standard Curve Plot

1. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.

3. Enter the Plot Settings:

Menu Selection
Target Al
Plot Color Target
E Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
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5 Chapter 5 Review Results and Adjust Experiment Parameters
View the Standard Curve Plot

4. View the values displayed below the standard curve.

Menu Selection
Slope -3.289
R2 0.997
Amplification efficiency 101.414%
Error 0

5. Check that all samples are within the standard curve. In the example experiment,
as shown below, all samples (blue dots) are within the standard curve (red dots).

Well Table

Standard Curve Plate Layout

Plot Settings

Target |al VI Plot Color |Target: vl

™ Save current. settings as the default

|

o

1 12 13 14 15 15 17 18 19 20 21 22 23 24
o U, B, B, B B B B, B, B B B B

P oL a = |
Standard Curve

30.5
30.0
205 F
200
285 :
280 M
275
27.0
265 3

CcT

Quantity k

Target: RNAse P Slope: -3.289 Y-Inter: 40.743 R_zg 0.997 Eff%g: 101.414 Error: 0

A & gt & & & & & & & & 2 & @l A A=
di a J@ A 4 A @ & & 4 ar & ar @ ar -
di a J3 4 4 A @ & & a ar & ar & a4’ & e
di a J@ A A A @ & & 4 ar & ar g ar 4 -
di a J@ 4 4 A @ & & 4 ar & a & a4 M-
di a J@ 4 4 A @ & & 4 ar & a & a4 & -
=D - - N - - - - - (- [ (- - - - | (]
=D A= - N (- - - - - (- [ (- - - - | (-
=D A~ - N (- - - - - (- [ (- - - - | (-]
d d 4 4 3 O 4 4 4 4 4 4 4 4 3

1
L |
L |
L |
n
L |
L |
n
L |
L |
L |
n
L |
L |
A
n
L |

Legend
. Standard . Unknown . Unknown (Flagged)

wils: [T 288 [ 80 [ 16 0 Empty

well Summary: In Plate: 284 Set Up: 384 Analyzed: 354 Flagged: 0 Oritted by Bnahysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1

6. Check the C values:
a. Click the Well Table tab.

b. From the Group By menu, select Replicate.
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Section 5.1 5
View the Standard Curve Plot

c. Look at the values in the C column. In the example experiment, the Cy
values fall within the expected range (>8 and < 35).

e e
Well Table

Plate Layout

Showe in Table ¥

OCERUAR S Group By w +| Expand Al = Collapse Al

Towomk Alars

!
# | Wel\l Orrit | Flag |Sample Na...lTarget Na...| Task | Dyes | Cr | CT Mean Cr S0 | Quanitity |Quant\ty.‘.|Quantity So Commentsl

17 a7 F r -
18 AlS r 10K RMase P UNKNOWN - FAM-NFO-,.. 27,638 27678 009 9662687 9,414,698 572,472
10 Al19 r 10K RMase P UNEMOWN - FAM-NFO-... 27.627 27.678 0.09 9,738.641  9,414.698 S72.472
20 A20 [ 10K RMAse P UMENOWMN - FAM-NFOQ-... 27,684 27.678 0.09 9352924 9,414,608 572472
21 A2l r 10K RMase P UNKMOWN - FAM-MNFO-,.. 27,601 27 678 0.0 9,913,157 9,414,608 572,472
22 A2 r 10K RMNase P UNKNOWN - FAM-NFO-,.. 27,778 27678 009 87388358 9,414,698 972,472
23 A23 r 10K RMase P UNENOWN - FAM-NFQ-... 27.758 27.678 0.09 855884947 0,414.608 S72.472
24 424 [ 10K RMAsa P UMKNOWMN - FAM-NFQ-... 27.78 27.678 0.09 8,744.812 09,414.608 572472
40 Bl6 r 10K RMase P UNKNOWN - FAM-NFO-,.. 27,731 27 678 009 9,051,584 9,414,698 572,472
41 B17 - 10K RMase P UNEMNOWMN - FAM-NFO-... 27.653 27.678 0.09 9,559.844  9,414.698 S72.472
42 Bl18 r 10K RMase P UNENOWN - FAM-NFQ-... 27,664 27.678 0.09 9485763 9,414.608 S72.472
43 B19 [ 10K RMAse P UMKNOWMN - FAM-NFQ-... 27,576 27.678 0.09 10,087.83 9,414.692 Sr2.472
44 Bz0 r 10K RMase P UNKNOWN - FAM-NFQ-,.. 27,674 27 678 009 9,420,996 9,414,698 572,472
45 B21 - 10K RMase P UNEMNOWN - FAM-NFO-... 27.713 27.678 0.09 9,164.339  9,414.698 S72.472
45 B22 r 10K RMAse P UMENOWMN - FAM-NFQ-... 27.688 27.678 0.09 9331501 9,414.608 572472
47 B23 r 10K RMase P UNKMOWN - FAM-MNFO-,.. 27,731 27678 003 9,054,931 9,414,608 572,472
42 B24 r 10K RMNase P UNKNOWN - FAM-NFQ-... 27,733 27678 009 9,041,301 9,414,698 972,472
64 Cl6 - 10K RMase P UNENOWN - FAM-NFQ-... 27.75 27.678 0.09 8,020.64 9,414,608 S72.472
65 C17 r 10K RMAse P UMENOWMN - FAM-NFQ-... 27651 27.678 0.09 9575573 09,414.608 S72.472
66 (18 r 10K RMase P UNKNOWN - FAM-NFO-,.. 27,636 27678 009 9677329 9,414,698 572,472
67 C19 r 10K RMase P UNEMNOWN - FAM-NFO-... 27.562 27.678 0.09 10,188.251  9,414.698 S72.472
68 C20 [ 10K RMase P UMENOWN - FAM-NFQ-... 27.62 27.678 0.09 9,720.839 09,414.608 572.472
69 21 r 10K RMAse P UMKNOWMN - FAM-NFQ-... 27,654 27.678 0.09 9554082 9,414.698 Sr2.472
70 2z r 10K RMase P UNKNOWN - FAM-NFO-,.. 27,606 27678 009 9883055 9,414,698 572,472
71 23 r 10K RMase P UNEROWN - FAM-NFO-... 27.631 27.678 0.09 9,710.744  9,414.698 S72.472 LI
- — 1 ARla-m VISR E AR R 7 eca e AAA A AR AmE A oAda 2 E7m amm
well Summary: In Plate: 354 Set Up: 384 Analyzed: 384 Flagged: 0 Omitted by Analysis: O Omitted Manwally: 0 Samples Used: 2 Targets Used: 1

Tips for analyzing your own experiments

When you analyze your own standard curve experiment, look for:

* Slope and amplification efficiency values — The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope
close to —3.3 indicates optimal, 100% PCR amplification efficiency. Factors that
affect amplification efficiency:

— Range of standard quantities — For accurate and precise efficiency
measurements, use a broad range of standard quantities, 5 to 6 logs
(105 to 100 fold).

— Number of standard replicates — For accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification
efficiency.

* R2values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual Ct data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and
the data points. An R? value >0.99 is desirable.

* Cy values — The threshold cycle (Cr) is the PCR cycle number at which the
fluorescence level meets the threshold.

— A Cyvalue >8 and <35 is desirable.
— A Cpvalue <8 indicates that there is too much template in the reaction.

— A Cyvalue >35 indicates a low amount of target in the reaction; for C values
>35, expect a higher standard deviation.
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Assess amplification results using the Amplification Plot

If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Improve Cp precision by omitting wells” on page 61).
Or

* Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected
wells. There are three plots available:

* ARnvs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. Use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. Use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose
The purpose of viewing the amplification plot for the example experiment is to
identify:

¢ Correct baseline and threshold values
e Qutliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.
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Section 5.1 5
Assess amplification results using the Amplification Plot

2. Display the RNase P wells in the Amplification Plot screen. Click the Plate Layout

tab. Enter the Plot Settings:

Menu Selection

Select Wells With Target » RNaseP

wisls: [ zae [ 8o [ 16 0 Empty
well Summary: In Plate: 384 Set Up: 384 Analyzed: 304 Flagged: Oritted by Anabysis: 0 Ornitted Manually: Sarnples Used: 2 Targets Used: 1
3. In the Amplification Plot screen, enter:
Menu Select
Plot Type ARn vs Cycle
Plot Color Well (default)
E Check (default)
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the baseline values.
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot <
Plot Settings

Plat Tvpe:laRn vs Cycle vl Graph Type: |Linear x| Plot CDIDr:lWeH 2l

[T Save current settings as the default

Amplification Plot

250
225
2.00
1.75
1.50
1.25

ARn

1.00
073
0.50
025

0.00 = = =

Options
Target: |RNAse P ¥ | Threshold: W Auto |0126751 F Auto Baseline

Show: I~ Threshold — W Baseline Start: wel B0 Target .« Baseline End: Wel (M Target a.

well Summary: In Plate: 304 Set Up: 384 Linalyzed: 384 Flagged: 0 Omitted by Analysis: 0 Ornitted Marwally: 0 Sarnples Used: 2 Targets Used: 1

5. View the threshold values.

Menu Select

Graph Type Log
Target RNaseP

a. Select the Threshold check box to show the threshold.
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Section 5.1 5

Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the

threshold is in the exponential phase.

Ampilification Plot

Plot Settings

Flot Type: [iRn vs Cycle =] Graph Type:flog =] Plot Color: fwvel 4|

[ Save current settings as the default

Amplification Plot

0.196751

ARn

Options

Target: [RMAsa P vl Threshold: W Auto |0186761 ¥ 2uto Basaling

Show: W Threshold — [T Baseline Start: Well B0 Target 4 Baseline End: Well (M Target 4

Well Summary: In Plate: 384 Set Up: 334 Analyzed: 384 Flagged: Critted by Analysis: 0 Oritted Manually: 0

6. Locate outliers:

Samples Used: 2 Targets Used: 1

a. From the Plot Type drop-down menu, select Ct vs Well.
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Assess amplification results using the Amplification Plot

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for RNase P.

Amplification Plot 4
Plot Settings
Flot Type: [C7 vs wel vl Graph Type: ILinear vl Plot Colar: |We|| vl
™ Save current settings as the default
P P B E
Amplification Plot
40 - > . - v 1] > -
35
© oy % K i Yy
23
—
© 20
15
10
B
5 10 1520 25 30 35 40 45 50 55 60 65 70 75 80 85 90 951001051 108 151 201251 301351 AN 451500 S51600651 700 751 801 85 0195052 102 1 52X P304 004 S0P SENGI06S TR 7 SFSPREFNPAsI0R0E 108 182002 5338 037580
Well Mumber
Optiohs
Target: [RMAse P Vl Threshold: | auto |01 86741 ¥ &uto Baseline
show: [T Threshold — ¥ Baseline Start: vel B0 Target 4. Baselne End: Well (M Target 4
well Summary: In Plate: 304 Set Up: 304 Analyzed: 204 Flagged: 0 Ormitted by Anahysis: 0 Crrnitted Manually: O Sarnples Used: 2 Targets Used: 1

Tips for analyzing your own experiments

When you analyze your own standard curve experiment, look for:

Outliers

* A typical amplification plot — The ViiA™ 7 Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a
typical amplification plot. A typical amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline
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Assess amplification results using the Amplification Plot

A typical amplification plot should look like this:

Amplification Plot
Plot Settings

Plot Type: [4Rn vs Cydle =] Graph Type:flog =] Flot Color: [wel =l

™ Save current settings as the default

Amplification Plot

0.196751

0.1 4

LRn

0.01

0.001

Options
Target: |RNAse P VI Threshald: ¥ suta (0196751 ¥ Auto Baseline

Shaw: W Threshold — ¥ Baseline Start: Well B Target 4 Baseline End: Well ‘B Target 4.

well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Omitted by Analysis: 0 Omitted Marwally: 0 Samples Used: 2 Targets Used: 1

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the ViiA™ 7 Software. Applied Biosystems
recommends that you examine the Amplification Plot screen and review the
assigned baseline and threshold values for each well after analysis.

¢ Correct threshold values:

Threshold Set Correctly 10

The threshold is set in the
exponential phase of the
amplification curve. 0196751

LRN

Threshold settings above or
below the optimum increase
the standard deviation of the
replicate groups.
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Assess amplification results using the Amplification Plot

Threshold Set Too Low

The threshold is set below the
exponential phase of the
amplification curve. The
standard deviation is b
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar up into the
exponential phase of the curve.

Threshold Set Too High e

The threshold is set above the
exponential phase of the !
amplification curve. The

standard deviation is Z o4
significantly higher than that

for a plot where the threshold -
is set correctly. Drag the s
threshold bar down into the
exponential phase of the curve.

2555412

A N\~ -\ A%
x & o X XA n o= 3 k- u &
Cycle

0.001

e Correct baseline values:

Baseline Set Correctly 0

The amplification curve begins
after the maximum baseline.

ARN

0.1

o.oo1 =3
24 ® n » 34 k- 3| &

Cycle

Baseline Set Too Low 10

The amplification curve begins
too far to the right of the
maximum baseline. Increase
the End Cycle value.

4 & L] 10 12 14 16 18 2 =2 2 x » a 2 ) ¥ = il
Cycle
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Section 5.1 5
Identify well problems using the Well Table

Baseline Set Too High 10

The amplification curve begins
before the maximum baseline.
Decrease the End Cycle value.

e — il
="TWA, A

0001 S i ¥ . )
0 12 14 16 W W R M A

Cycle

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve Cy precision by omitting wells” on page 61).
Or

* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 57).

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:

* The sample name, target name, task, and dyes

* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity
values

e Comments

e Flags

Purpose

The purpose of viewing the well table is to identify:

* Quantity values
e Flags
e (g values (including Ct standard deviation)

View the well table

1. From the Experiment Menu pane, select Analysis, then select the Well Table tab.
Note: If no data are displayed, click Analyze.

2. Use the Group By drop-down menu to group wells by a specific category. For the
example experiment, group the wells by replicate, flag, or C value.

Note: You can select only one category at a time.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

To group by replicate  From the Group By drop-down menu, select Replicate. The software groups the
replicate wells: negative controls, standards, and samples. In the example experiment,
note that the quantity values within each replicate group are similar.

Note: In the example experiment, the Quantity, Quantity Mean, and Quantity SD
columns have been moved from their default locations to the beginning of the Well
Table. To move a column, click and drag on the column heading.

Tarpet Nawre
¥ : T (R P, ity Mean | Guantiky 50 [ Ehome | Taget Hame | Tek cr | CrWean | crsn o
25 uE r o, | adlaEm Sr2ATEIN Friass P LT 227t Zam o 2
e r AA4L4.058 STZ.ATE10N Ri-Ase= P LT AONATY == =Tama a.0e8
40 Bi5 r | 4l4608  STRATZA Rtetsa P LHHTIOWI 755 =757 0.

i 817 T EEd QALLEN  ST2A7EI0N e P VNN =lr ] o] a.m
4z E18 C rhan | mdlamee  Srzavzie RAE P LRETIIAT . T Fel ] .
43 813 r - 4146 GTZATZIK Frios P LTI =713 =7 am 0.8
“ IO r JErva— I ERIE R STZ.ATE10K Rl P LR AONATY = =Tam a.0e
45 B21 r 9AL4600  BT2.47EI0K R P LTI 773t =7 a7 0.0
46 @3 f U= L) | odaem  sr2aiza RisE P UM @ T 0.0
47 E3: C “whell Poiion {Cokamriy Adla.ees 572,472 10K RHAs P LRETICTAT . T Tara 0.
48 B24 r Hens: | AL ST2.47 210K Frusa P LAHNCIAT 27 E31 27 a7 0.8
[ B =) r A T | AA4L4.058 STZ.ATE10N Ri-Ase= P LT AONATY og=x 1 =Tama a.0e8
85 €17 | 10,1E6. 251 9AL4600  ST2.472I0K R P LTI 52 ] 0.,
86 €13 T 9,7E0ETD QALLEN  ST2A7EI0N e P VNN T o] a.m
&7 C19 C 955,002 AlLEE  STZATEI RAE P LRETIIAT . T Fel ] .
BB €20 r 3 EES055 ERIERE=] G747 Frunsa P LHMNCIAT 27 &G 2767 0.08
e 21 r 9, TLO.T+H ERIE R STZ.ATE10K Rl P LR AONATY A3l =Tam a.0e
m r 9,455,335 9AL4600  BT2.47EI0K R P LTI =7 554 =7 a7 0.0
7L f 9,705,506 AL ST272I0K R P VNN . @A o] am
72 o = 2060 AlLEEE  STZATEIE R P LRETIIATY . T Felrl 0.mw
BB a6 r 10,157,434 414,650 ST2.47 210K Frusa P LAHNCIAT 2751 27 a7 0.8
B D17 r 10, 077892 AA4L4.058 STZ.ATE10N Ri-Ase= P LT AONATY =TI =Tama a.0e8
W DB r 9,554, 107 9AL4600  ST2.472I0K R P LTI =753 ] 0.0
9L Dug f 9,700,192 AL ST27I0N R P VNN a2 ZEM am
W D@ C 0 EEE2TS QAR STZATEIDE RHAmE P LRETICIAT . TEaL Fel T .
%5 D r 11,246.75 asl468 BTZETEAN Firdass B LTI 27534 2767 0.8
£ r 4.EEn I ERIERE) STZATZI0E Fi-lhse P LR IONATY L BT AT ZTama a.0e
% D23 r 445,933 FALLEM  ST247EI0K FlAm P LTI 278 27 A 0.0e
9% Det f 7,764,318 AL ST27RI0N R P UMHTICAT o g ZEM a.m
112 El8 C 10,065 235 QAR STZATEIDE RHAmE P LRETICIAT . = Fel T .
115 E17 r ERE Y asl468 BTZETEAN Firdass B LTI 2271 2767 0.8
14 E18 r 9,E06.131 ERIERE) STZATZI0E Fi-lhse P LR IONATY . ET AT ZTama a.0e
U5 E1F r 3,928 FALLEM  ST247EI0K FlAm P LTI =T 27 A 0.0e
115 EX0 f 9,424.22 AL ST27RI0N R P UMHTICAT ofor | ZEM a.m
17 En C Rt QAR STZATEIDE RHAmE P LRETIIAT Felersl Fel T um .
1| | il |

m.&lw: I P 394 Tl U 339 Frwbend: 304 Fegoadi O Omttad by Anabea: 0 Swnpha Loed: 2 Torgealoe 1

The well table looks like this:
> b Larysuk: wal Tapls

- winll | amit Task Chas LF CT Mgan CT 5O Quartey | Quantit..  Quandt...  Comme..
~
16 Alf LRKNOWH 26:307 9,5501178° 9532951
17,417 10K FRaze B LEKNOUM 26007 26007 0083 0,512733 G53I3051 534707
18 ALB 10K FriAze P LEiENOWH 555 26,507 0,080 5206665 533851 525757
A a1e 10K FhiAsa B LPEROWH .. 20,548 f.007 O.0E0 Q9IEAIE RE33ON 24797
o A20 1K FliAse P LRENOH 26,582 26,307 0083 9028357 5350951 524,797
21 Ad% 10K Fiiaze P LRHkHOIN 26,851 26,807 O.080 8397218 9533351 524,797,
21 a3 10K Flifze P LRMKHOWN 25074 26:007 0080 D,080458 $E3ITUEL 5248707
23 A23 10K Friase P LREMOH X875 26,807 0en | B,074.062 %533851 528997
23 A 1K FliAse P LP{KNOWH 21T 6007 0080 QA 32 9SI30% 524797
40 Bl 10K FliAse P LRKHOEH i IGELE 26.807 0.083 945958 9533951 524797
41 B17 10K FriAze P LEKNDAH 6799 26:307 0083 10,267 638 935330951 524797
1 BB 10K FHAze B LPKNOWH 26034 26.907 0080 B407.755 OEIZ0E1 534,797
43 B9 10K Friaze P LEikNOwH 530 26,507 Oi00  BI08513 H532.851 525797
S| H4CE 10K FHi&sa P LAENTWH 26,033 26007 0020 0ALOEDT BR300 s2a70T
Fl 45 B 1K Friase P LRiKHOWH <o 26,853 26,307 0060 8219666 9533051 524.797
46 10K FiiAse P LriKHOAH - 26.840 26,307 0.080 B,2408Y7 9533351 534,797
47 B 1K Frigze P URERDWAH 26,972 26,507 0.080  H092796 HEIRGEl  §GTT
48 Po% 10K FHAzE P LAENOWH 26,671 26,507 0.0 B,762B08. 9533351 529797
84 s K FTiAse P LEKNDAHN i E.EFD 26.007 0.020 0722380 9323031 529797
A5 17 10K FiiAse P LEKHOWH 6822 26307 0,080 10107170 $5335.951 524797
ne Ci8 10K FliAse B LEiKNOwH 26,8032 26,307 D080 9,374.992 SSANE% 329797
LI ) 10K FliAze P URiKHO 26,522 26.507 0.080  %432.732 H533950 529797
B8 00 LIK FHAsE P LRIKHOWH 26,863 26.507 0080 -9,8300B51 $EINEE1 829797
ng 1 10K FriAsa P LREROWH 26,521 26007 0.020 10,112.306. BE23.091 29707
S =3 1K Friase P LRikHOWH 6522 26,307 0080 5423159 $533.951 524,797
e ] 10K FTiAse P R T 6.880 26907 0080 3704001 9553585 329797
72 10K Friase P URKNOWN 26.507 0080 9,244.162  5533.951 524797
b D16 10K Folfze P LMENOWH 26,800 0,090 10,354.792 9,533,861 525797
8 017 K FriAse P LIKNDEMN 26.007 0.080 10,130.340  %523.051 520797
‘9 - p1e 10K FiiAse P LEEHOWH 6851 26907 0080 896796 $533.951 529997
ar o1s 10K FTiAae P Leiknowe - BT 26,307 0080 - 9,7IZ06E  $SINET 3297
-2 - D2 10K Fri&se P URKHDWH 26,509 26.907 0.080 9507545 9533950 524797
43 DA 10K FriAze P LRKNOWN 26,792 26,800 0,080 10,321120° 9,533,051 524797
0q o2z 10K FRiAz B LRIKROWH 604 26,007 0080 0,142233 9523051 LB erd
a5 03 10K FriAze B LRIENOWH Zm3 26,907 0.080  B,BIA055 %533.851 524,797 e
Wiall Summary: I= o= 284 Sl L 354 f-pyzed: 304 Flaggad: 0 Oiebbed by Areabyoms [ Clvtied Uarnady O Sempim Ume 2 Targate Umedt L
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To group by flag

»| PFlate Layout

‘well Table

Section 5.1 5
Identify well problems using the Well Table

From the Group By drop-down menu, select Flag. The software groups the flagged

and unflagged wells. In the example experiment, there are no flagged wells.

in Table ¥ Expand Al
Target Name
# | Wl | Ormit | itity Mean | Quantity SO | Sample Name | Target Name Task T CT Mean CT 5D | Cc
T Sample Name o T T Pt oy FTTosE TR T 7T I T =ua; ;I
9 A9 r Task 4,954,894 222,452 5K RMase P UMEMOWEN 28,651 28.582 0.063
10 Al0 r Replicate 4,994,994 222,452 3K RMase P UMEMOWEN . 28.62 28,582 0.063
11 411 r 4,904,094 222.4525K RMase P UMEMOWN . 28.682 28.582 0.053
12 a12 r bre 4,994,994 222,452 5K RMAse P UMEMOWT . 28475 28,582 0.062
13 413 r . ig 4,994,994 222,452 5K RMase P UMM . 28,575 28,582 0.063
14 414 - CT 4,904,094 222.4525K RMase P UMKMOWN - FAM-NFO-... 28.624 28.582 0.053
15 AlS r Comments 4,994,034 222.4525K RMAsE P UNKNOWN  FAM-NFQ-... 28.649 23582 0.063
15 Al6 r well Position (Row) 9,414,692 572,472 10K RMAse P UMEMOWN - FAM-MFQ-... 27.638 27.678 0.09
17 A17 r 9,414,698 572,472 10K RMase P UMKMOWM  FAM-NFQ-.., 27.627 27.678 0.09
18 18 [l tiell Posicion (Columin} 9,414,595 572,472 10K RiMAse P UMEMCHWM FAMAMFQ-... 27684 27678 0.09
19 419 r Mone 9,414,698 572,472 10K RMAse P UMEMOWN - FAM-MFQ-... 27.601 27.678 0.09
20 A20 | 8,798,838 9,414,698 572,472 10K RMase P UMEMOWM  FAM-NFQ-.., 27.778 27.678 0.09
21 421 r 8,884,947 9,414,698 S572.472 10K RMase P UMKMOWN - FAM-NFO-... 27.758 27.678 0.09
22 A22 r 8,744.812 9,414,698 572,472 10K RMaze P UMEMOWN - FAM-NFQ-... 27.78 27.678 0.09
23 &23 r 0,051,594 9,414,698 572,472 10K RMAse P UMEMOWN - FAM-MFQ-... 27.731 27.678 0.02
24 424 r 9,359,844 9,414,698 572,472 10K RMase P UMEMOWM  FAM-NFQ-.., 27.853 27.678 0.09
25 Bl r RMase P NTC FAM-NFQ-... Undetermi...
26 B2 r 1,250 1,250 RMAse P STAMDARD  FAM-MFQ-... 30.401 30,568 0,087
27 B3 r 2,500 2,300 RMase P STANDARD  FAM-NFO- 29,452 20,515 0.075
28 B4 r 5,000 3,000 RMase P STAMDARD  FAM-NFQ-... 28.569 28.611 0.054
289 BS r 10,000 10,000 RMase P STAMDARD  FAM-MFQ-... 27.584 27.646 0.057
30 BB r 20,000 20,000 RMAse P STAMDARD  FAM-MFQ-... 26.467 26,553 0.049
31 B7 r 5,160,045 4,994,994 222,452 5K RMase P UMEMOWN  FAM-NFQ-.., 28.534 28,582 0.063
32 BB - 5,114,345 4,904,094 222.4525K RMase P UMKMOWN - FAM-NFO-... 28.546 28.582 0.053
33 B9 r 4,843.689 4,904,094 222.4525K RMase P UMEMOWN  FAM-NFQ-... 28.624 28.582 0.053
24 Bl0 r 4,609,773 4,994,994 222,4525K RMAse P UMEMOWMN - FAM-MFO) 28.695 28,582 0.062
35 Bll r 4,678,537 4,994,994 222,452 5K RMase P UMKEMCWH FAM-NFO- 208,674 28,582 0.063
36 Bi2 - 4,990,247 4,904,994 222.4525K RMase P UMEMOWN - FAM-MFO). 28.582 28.582 0.083
37 Bl3 r 4,778,531 4,904,894 222,452 5K RMAse P UMEMOWN - FAM-MFQ-... 28,643 28,582 0,053
38 Bl4 | 4,736,198 4,954,994 222,452 5K RMase P UMEMOWMN  FAM-NFOQ-.., 28.856 28.582 0.063
39 B13 r 3,170,109 4,994,994 222,452 5K RMase P UMEMOWEN  FAM-NFQ-.., 28.531 28.582 0.063
40 Bl6 - 0,485,763 9,414,598 S72.472 10K RMase P UMEMOWN - FAM-NFQ-... 27.664 27.678 0.09
41 B17 r 10,087,823 0,414,692 572,472 10K RMAse P UMEMOWN - FAM-MFQ-... 27.578 27.678 0.09
42 B18 | 9,420,995 9,414,698 572,472 10K RMase P UMEMOWH  FAM-NFQ-.., 27.674 27.678 0.09
43 B19 r 0,164,339 9,414,698 572.472 10K RMase P UMKEMOWWN FAM-MFO). 27.713 27.678 0.09 _l;l
| | »
well Summary: In Plate: 284 Set Up: 384 Analyzed: 384 Flagged: 0 Oritted by &nahysis: 0 Omitted Manually: O Samples Used: 2 Targets Usad: 1
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Identify well problems using the Well Table

To group by Ct value  From the Group By drop-down menu, select Cr. The software groups the wells by Cr
value: low, medium, high, and undetermined. In the example experiment, the Cy
values are within the expected range (>8 and <35).

—
»| Plate Layout e

Table ¥ Group By Expand Al B Collapse All
Target Name
# | well | Omit | tity Maan | Quantity SO | Sample Mame | Target Mame Task | Dyes | T CT Mean CT 5D | Cc
=20 T Sample Name Mazane TrE S IO N [ =n K e s e L T =0, ;I
o3 D21 I Task 9,414,608 572,472 10K RMAse P UMKMOWMN - FAM-MFO-.,, 27 554 27.678 .02
94 D22 r Replicate 9,414,698 372,472 10K RMAse P UMKNOWN - FAM-MNFQ-.,, 27 757 27.678 0.09
95 D23 r 9,414,598 57247210k RMAze P UMKNOWN - FAM-NFO-... 27.828 27.678 0.09
96 D24 r bye 9,414,692 57247210 RMAze P UMNKMNOWN - FAM-MNFQ-... 27.95 27.678 0.09
99 E3 r Flag 2,500 RMAse P STANDARD  FAM-MFQ-... 29,429 29.515 0.075
100 E4 r cr h 5,000 RMAse P STANDARD FAM-MNFO-... 28.649 28.611 0.054
101 ES r —— 10,000 RlAse P STANDARD  FAM-NFQ-.. 27 662 27 645 0.057
102 E6 r Wl Position (Row) 20,000 RMAse P STAMNDERD  FAM-MNFQ-.. 26,533 26,553 0.049
103 E7 r 4,954,994 222,452 5K RMAse P UMKNOWN - FAM-MFQ-.., 28,584 =28.582 0.063
104 E8 r el Position {Columr) 4,994,994 222,452 5K RMAse P UNKMOWN  FAM-MFOQ-... 28,543 28.582 0.063 J
105 E9 r Mone 4,994,094 222,452 5K RMAze P UNEMNOWN - FAM-NFO-.,, 28,524 28.582 0.063
106 E10 r 4,860,265 4,994,994 222,452 5K RMAse P UMKMOWMN - FAM-MNFO-.,, 28,619 =28.582 0,062
107 E11 r 4,743,296 4,954,994 222,452 3K RMAse P UMKNOWN - FAM-MNFQ-.., 28,653 28.582 0.063
108 E12 r 4,860,692 4,994,004 222452 5K RMAze P UMKNOWN - FAM-NFQ-... 28,616 28.582 0.063
109 E13 r 4,783,282 4,994,094 222,452 5K RMAze P UNKMNOWN - FAM-NFQ-.,, 28,642 28.582 0.0632
110 E14 r 5,098,292 4,954,994 222,452 5K RMAse P UMKNOWN - FAM-MFO-.,, 28,551 28.582 0,063
111 E15 r 5,181.023 4,994,904 222,452 5K RMAse P UMKNOWN - FAM-NFO-... 28,528 28.582 0.063
112 E16 r 10,065,235 9,414.698 572472 10K RMAze P UNKMNOWN - FAM-MNFQ-... 27.58 27.678 0.09
112 E17 r 0,138,209 9,414,698 572472 10K RMAze P UMNKMNOWN - FAM-NFO-.,, 27,718 27.678 0.09
114 E18 r 9,806,181 9,414,698 572,472 10K RMAse P UMKNOWN - FAM-MFQ-.., 27 617 27.678 0.09
115 E19 r 9,142.86 9,414.698 57247210k RMAse P UMKNOWN - FAM-NFO-... 27717 27.678 0.09
116 E20 r 9,424.23 9,414,698 572472 10K RMAze P UNEMNOWN - FAM-NFO-.,, 27,673 27.678 0.09
117 E21 I 8,763,623 9,414,608 572,472 10K RMAse P UMKMOWMN  FAM-MNFO-.,, 27 777 27.678 .02
118 E22 r 9,333,755 9,414,698 372,472 10K RMAse P UMKNOWN - FAM-MNFQ-.., 27,654 27.678 0.09
119 E23 r 8,161.914 9,414,608 57247210k RMAze P UMKNOWN - FAM-NFQ-... 27,870 27.678 0.09
120 E24 r 7,265,062 0,414,692 572,472 10K RMAze P UMNKMNOWN - FAM-NFQ-.,. 28,045 27.678 0.09
123 F3 r 2,500 2,500 RMAse P STANDARD FAM-MFQ-... 29,485 29.515 0.075
124 F4 r 5,000 5,000 RMAse P STANDARD FAM-MFO-... 28.625 28.611 0.054
125 F5 r 10,000 10,000 RMAze P STANDARD FAM-NFQ-... 27.612 27.6456 0.057
126 F& r 20,000 20,000 RMAse P STAMNDERD  FAM-MNFQ-.. 26,543 26,553 0.049
127 F7 r 4,672,368 4,954,994 222,452 5K RMAse P UMKNOWN - FAM-MFQ-.., 28676 =28.582 0.063
128 F8 r 5,241.754 4,994,994 222,452 5K RMase P UMKMNOWN - FAM-NFG-... 28511 28.582 0.063
129 F9 r 4,766,071 4,994,094 222,452 5K RMAze P UNEMNOWN - FAM-NFO-.,, 28,647 28.582 0.063
120 F10 r 4,806,276 4,994,994 222,452 5K RMAse P UMKMOWN - FAM-MNFO-.,, 28,625 =28.582 0,062
131 F11 | r 5,342,352 4,954,994 222,452 5K RMAse P UMKNOWN - FAM-MNFOQ-.., 28484 =28.582 | 0.063 _ILI
4 »
well Summary: In Plate: 234 Set Up: 384 Analyzed: 384 Flagged: 0 Ornitted by Analysis: 0 Omitted Manually: O Samnples Used: 2 Targets Used: 1

Tips for analyzing your own experiments

* Replicate — The software groups the wells by replicate: negative controls,
standards, and samples. Look in the Quantity columns to make sure the quantity
values for each replicate group are similar indicating tight Ct precision.

¢ Flag - The software groups the flagged and unflagged wells. A flag indicates that
the software has found a potential error in the flagged well. For a description of
the ViiA™ 7 Software flags, see “Flag Settings” on page 59.

® Ct - The threshold cycle (Cr) is the PCR cycle number at which the fluorescence
level meets the threshold. A Ct value >8 and <35 is desirable. A Cy value <8
indicates that there is too much template in the reaction. A Ct value >35 indicates
a low amount of target in the reaction; for Cy values >35, expect a higher standard
deviation.
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Section 5.1 5
Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose

In the standard curve example experiment, you review the Multicomponent Plot
screen for:

e ROX™ dye (passive reference)

* FAM'" dye (reporter)

* Spikes, dips, and/or sudden changes

¢ Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click E Show a legend for the plot (default).
Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Confirm accurate dye signal using the Multicomponent Plot

6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process; increase in FAM dye signal indicates
normal amplification.

Multicomponent Plot

Plot Settings
Flot Color [Dye VI
I Save current settings a5 the default 102|345 6|7 89|10 11 12 13|14 151617 18|19 |20 |21 |22 |25 |24 |
. , _ CEE N A L L A L L A L e e L L L T TR T
P pamx = ||
= || | < < P 0 LRl | n
Multicomponent Plot {5 P PP P 7 [ o
500,000 | | Y P [ P | P [ P
460,000 E_|77777llllllllllllllllllllllllllllllllllllll
00.000 | | T [P Y [ [ A
350,000 G“|77777llllllll|llllllllllllllllllllllllllll
4] B
3 H
£ 300,000 F |y | | = | | 7 |
2
& 250,000 | ;| < < < P 7 |
5
E} 1~ |
i 200,000 | | e = = 0 i 7 ol o |
150,000 | < < Y 7l |
100,000 | < << < Y il [
50,000 o | | = = P Y i 7l [
0 1o | < < < 0 0 P 7 |
a2 4 @8 & 10 12 14 1@ 1@ W 2 M MH B N I M ¥ ]| 40 L [ " |
Cycle | < = 0 7l |
Logerd [ < < Y 7 |
M Fen lROX 1"
wls: [ 288 [E 8o [ 16 0 Ernpty
well Summary: In Plate: 30 Set Up: 304 Analyzed: A0 Flagged: 0 Orvitted by Analysis: (1 Omitted Marwally: Samples Used: 2 Targets Used: 1

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Multicomponent Plot

Plot Settings
Plot Color IDYB - H
[ Save current settings as the default 1 B | 3 | 4 | 5 | 5 | B | 3 | 9 | 0 | 11 | 1z |
£ e oa il g = || OwEEn e N e e o e =
Multicomponent Plot NIRE sl CIsEls s qur 0
600,000
460,000 (RS s P s Al S RS Pl o I
400,000
N s sElsElls s Bl s Bl [
g 300,000 :
2 50000 o SIS PSP S| Pl S PSPl I
& 200000 B nE|sEsElsElsElsEl vl [
0000 ———
,—————————  ————— A WL s fis ] s s B u I
50,000
, M sE|sEsElsElsElsEl vl [
a 2 4 8 a 10 12 1 1w 1@ W W ¥ X MW W Z oM ¥ ¥ ou o
Cycle
ot o [N s il s Ealis B s il S Bl o B ol
B o Il RO { | _’|_I
wiels: [ 288 [£ 80 [ 16 0 Ermpty
well Summary: In Flate: 354 Set Up: 384 Analyzed: 384 Flagged: 0 Citted by Analysis: 0 Omitted Manually: 0 Samples Used: 2 Targets Used: 1
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Determine signal accuracy using the Raw Data Plot

Tips for confirming dye accuracy in your own experiment

When you analyze your own standard curve experiment, look for:
* Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.
Purpose

In the standard curve example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click E Show a legend for the plot (default). The legend displays the color code
for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).
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Determine signal accuracy using the Raw Data Plot

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

Raw Data Plot

550,000
500,000
450,000
400,000
350,000
300,000

@
=
=
E 250,000

200,000
150,000
100,000
50,000 e =
. I
®1 :rl': x2-‘-||1 *3-m3 x4 I-rld x5- :;|5
Filter
Legend
(-A.E C D H:c HrF Hc HH ;l‘
=]
Options
Show Cycle 40 f]
T T T T e R e T R e e T
1 3 10 15 20 25 3o a5 40
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 0 Ornitted by Analysis: 0 Omitted Manualhy: 0 Samples Used: 2 Targets Lised: 1

The filters used for the example experiment are:

PCR Filter =

Emission Fitter
ml(520+15) m2(558=11) m3(586+10) ma(623=14) mo(682+14) m&(711=12)
x1(470+15)

¥2(520+10)

¥3(550+11)

Excitation Filter

¥4(580+10)

¥5(640+10)

¥6(662+10)

Melt Curve Filter =

Emission Filter
ml(520+15) m2(558+11) m3{586+10) md(623x14) mS(682+14) m&(711+12)
x1(470£15)

¥2(52010)

X3(550+11)

Excitation Filter

¥x4(58010)

¥5(640£10)

XB(662+10)
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Review the flags in the QC Summary

Tips for determining signal accuracy in your own experiments
When you analyze your own standard curve experiment, look for the following in each
filter:

¢ Characteristic signal growth
* No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the ViiA™ 7 Software flags, including the
flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.
3. In the Flag Details table, click each flag with a frequency >0 to display detailed

information about the flag. In the example experiment, the Frequency column
displays O for all flags.
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Review the flags in the QC Summary

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

QU summary <
Flay ounniary |
Total wells: 284 | Processed wels: 224 Manually omitted wells: 0 | Targets Used: 1 ‘
wiells Set Up: 384 | Flagged wels: 0 Analysis Omitted wells: 0 | Samples Used: 2
Flag: Name Frequency Wels
AMPHC Arnplification in negative contral 0
EADROK Bad passive reference signal 0
(OFFSCALE Fluorescence is offscale ]
HIGHSD High standard deviation in replicate group 0
MNOAMP o arnplification 0
NOISE Moise higher than others in plate 0
SPIKE Moise spikes 0
NOSIGHAL Mo signal in wel 0
OUTLIERRG Cutlier in replicate group ]
EXPFAIL Exponential algorithm failed 0
ELFAIL Baseline algorithm failled 0
THOLDFAIL Thresholding algorithm faled 0
CTRAIL CT algorithrn failed 0

Flag: AMPNC—Amplification in negative control

Flag Detail: A sequence amplified in a negative control
reaction.

Flag Criteria: CT < 35.0
Hagged wWells: Hone
View AMPINC Troubleshooting Information

Summary: wels in Plate: 284 wells Set Up: 384 wiglls Analyzed: 384 ‘wells Flagged: 0 wells Omitted by Analysis: 0 wglls Ornitted Manually: O Sarmples Used: 2 Targets Used: 1

Possible flags

The flags listed below may be triggered by the experiment data.
Note: To change the flag settings, refer to “Flag Settings” on page 59.

Flag Description

Pre-processing flag
OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification

NOISE Noise higher than others in plate
SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed
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For more information

Flag Description
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cy algorithm failed

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD . High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System LLLN4A34
Experiments
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For more information
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SECTION 5.2

5 2 Section 5.2 Adjust parameters for re-analysis
: of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options.

If the default analysis settings in the ViiA™ 7 Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then
reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
® (Cp Settings
¢ Flag Settings
* Advanced Settings
¢ Standard Curve Settings
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Adjust analysis settings

The Analysis Settings dialog box for a Standard Curve experiment looks like this:

U Analysis Settings for YiiA7_384-Well_Standard_Curve_Example

( gs Flag Settings Advanced Settings Standard Curve Settings

sis of targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default

— Data Step Selection Algorithm Settings

Select the step and stage to use for Ct analysis. Only stage/step combinations for which data suitable for CT Select the algorithm to calculate Cr.

analysis have been collected are displayed.
Baseline Threshold «
Stage 2, Step 2 (v

~— Default Ct Settings
Default CT settings are used to calculate the C1 for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO  Baseline Start Cycle: AUTO Baseline End Cycle: AUTO

~— Select a Target ~— Ct Settings for RNAse P
Target Threshold Baseline Start Baseline End Cr Settings to Use: Default Settings
RNAse P AUTO AUTO AUTO &

pissrs ]
[E[e] End cyce: [157¢]

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings w

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis settings

Ct Settings * Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

* Algorithm Settings

You can select the algorithm that determines the Cp values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.
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Adjust analysis settings

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.

° Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

* Crp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the ViiA™ 7 Software.

To adjust the flag settings:
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.
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Adjust analysis settings

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

I'fl Analysis Settings for ViiA7_38

Flag Description Use Attribute Condition Value Reject Well
AMPNC Amplification in negativ... I3 CT i b i35 [
BADRCH Bad passive reference ... v Bad passive reference ... |» v iD.Eu -
BLFAIL Baseline algorithrn failed 73 O
CTFAIL CT algaorithrn faled I [l
EXPFAIL Exponential algorithm f... I O
OFFSCALE Fluorescence is offscale 2 O
HIGHSD High standard deviatio... ¥ CT standard deviation S v ”D.S O
MNOAMP Mo amplification ~ Amnplification algorithm .| < b4 iD.l O
MNOISE lMoisa higher than othe... ™2 Relative noise > v !4 O
SRIKE lMNoise spikes v Spike dgorithrn result > w il O
MNOSIGMAL Mo signal in well ~ O
CUTLIERRG Cutlier in replicate group v i
THOLDFAIL Thrasholding algorithm. . 2 [

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

Advanced Settings Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold algorithm.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
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Standard Curve

Section 5.2
Improve Cr precision by omitting wells

Use this tab to review the settings of the current standard curve experiment or to

Settings import the standard curve from an external experiment (with the same samples and

targets) and apply it to the current experiment.

Note: The run method must be the same. Applied Biosystems recommends using the
standard curve from the current experiment.

For the example experiment, the settings from the current experiment have been used.

'l Analysis Settings for YiiA7_384-Well_Stand I
CT Settings Flag Settings Advanced Settings Standard Cury
Review the standard curve plots for ach target. To use a standard curve From another experiment, click Inmport.
~—Override Standard Curve

& \Jse the standard curve from this experiment

" se a standard curve imported from anather experiment Linpart: Delete

~—Standard Curve View
3075
3050
3025
3000
2975
2850
2925
29.00
2875
2850
2825
2800
2775
2750
2725
27.00
2675
26.50

100 200 1000 10000 T000(
Reporter Target Slope Y-ntercept R Squared Efficancy(%)
FamM RHAse P F3.280 40.743 0.997 101.414 ;l
Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

Improve Ct precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Cr precision, omit the outliers from the analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Inthe Amplification Plot screen, select C vs Well from the Plot Type drop-down

menu.

3. Select the Well Table tab.
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For more information

4. In the Well Table, view outliers:
a. From the Group By drop-down menu, select Replicate.
b. Look for any outliers in the replicate group (make sure they are flagged).

. Select the Omit check box next to outlying well(s), as shown below.

Callspre Al

+ | Wil | Omit; | Flag Sarnple Ma...| Target MNa... Task | Dyes | T T Mean CTSDh | Quantity | Quantity ... |Quant\ty SD | Cornments

1 a1 r RMase P MTC FAM-NFQ-... Undetermi... -

2 A2 r RM&se P STAMDARD  FAM-MFQ-... 29.846 29.801 0.024 1,250

3 A3 I RMAse P STANDARD  FAM-NFQ-... 28,856 28.762 0.071 2,500

4 A4 r RMase P STAMDARD  FAM-MF(Q-... 27.837 27.858 0.055 5,000

5 A5 r RMase P STAMDARD FAM-MNFQ-... 26,825 26,891 0.053 10,000

6 A6 r RM&se P STAMDARD  FAM-MFQ-... 25,831 25,804 0.047 20,000

7 A7 I 5K RMAse P UMKNCWN - FAM-NFO-.,, 27,88 27.828 0.065 4,803.257 4,989.372 220,799

8 4B r Sk RMase P UNKMOWN - FAM-NFQ-... 27.806 27.828 0.065 5,059.929 4,980,372 220.799

9 A2 r S RMase P UMNKMNOWN - FAM-NFQ-... 27,909 27.828 0.065 4,708,362 4,980,372 220.799

0 A1D r S RM&se P UMEMNOWN - FAM-MFQ-... 27875 27.828 0.065 4,823.036 4,989,372 220,799

11 A1 r 5K RMAse P UMKNCWN - FAM-NFQ-.., 27,931 27.828 0.065 4,634.604 4,989.372 220,799

1z a1z r Sk RMase P UNKMOWN - FAM-NFQ-... 27.705 27.828 0.0685 5,433.725 4,980.372 220.799

13 al3 r S RM&se P UMEMNOWN - FAM-MNFQ-... 27,823 27.828 0.065 4,999525 4,980,372 229,799

14 A14 I 5K RMAse P UNEMCHWN - FAM-NFQ-.., 27,900 27.828 0.065 4,709.555 4,089.372 220,709

15 A15 r K RMAse P UNENCWN - FAM-NFG-.., 27,894 27.828 0.065 4,757.323 4,989.372 229,799

16 416 r 10K RMase P UNKMOWN - FAM-NFQ-... 26,902 26.907 0.0z 9,550,178 9,533.951 524.797

17 Aal7 r 10K RM&se P UMENOWN - FAM-MFQ-... 26,907 26,907 0.0z 9,523.245 9,533,951 524.797

18 A18 I 10K RMAse P UMKNCWN - FAM-NFQ-.., 26,955 26,907 008 5,206,665 9,533.951 524,797

19 419 r 10K RMase P UNKMOWN - FAM-NFQ-... 26,840 26.907 0.08 9,912618 9,533.051 524.797

20 A20 r 10K RMase P UMNKMNOWN - FAM-NFQ-... 26,982 26.907 0.0z 9,02835F 9,533.051 524.797

21 221 r 10K RM&se P UMNEMNOWN - FAM-MFQ-... 26,991 26,907 0.0z 8977218 9,533.951 524,797

22 A22 r 10K RMAse P UMKNCWN - FAM-NFGQ-.., 26,974 26,907 008  9,080.47 9,533.951 524,797

23 AZ23 r 10K RMase P UNEMOWN FAM-NFQ-... 26,975 26.907 0.08 9,074082 9,533.0951 524.797

24 A24 r 10K RM&se P UMEMNOWN - FAM-MNFQ-... 26,915 26,907 0.0z 9484632 9,533.951 524,797

25 Bl I RMAse P NTC FAM-NFQ-... Undetermi..,

26 B2 r RMAse P STAMDARD  FAM-NFQ-.. 29,654 29.801 0.084 1,250

27 B3 r RMase P STAMDARD FAM-NFQ-... 28,695 28.762 0.071 2,500

28 B4 r RM&se P STAMDARD  FAM-MFQ-... 27.820 27.858 0.055 5,000

29 BS I RMAse P STAMDARD  FAM-NFQ-.. 26,85 26,891 0.053 10,000

30 Bo r RMAse P STAMDARD  FAM-NFQ-.. 25,731 25.804 0.047 20,000

31 B7 r Sk RMase P UNEKMOWN - FAM-NFQ-... 27.774 27.828 0.085 5,175.613 4,980,372 220.799

32 BB r S RM&se P UMEMNOWN - FAM-MNFQ-... 27,796 27.828 0.065 509728 4,989,372 229.799

33 B9 I 5K RMAse P UMKNCWN - FAM-NFQ-.., 27,871 27.828 0.065 4,834493 4,989.372 220,799

34 B10O r Sk RMase P UNKMOWN - FAM-NFG-... 27.94 27.828 0.065 4,606,265 4,980.372 220.799

35 Bl1l r S RMase P UMNKMNOWN - FAM-NFQ-... 27,935 27.828 0.065 4,623.702 4,980,372 220.799

36 Bl2 r S RM&se P UMEMNOWN - FAM-MFQ-... 27,859 27.828 0.065 4,876,215 4,989,372 220,799 LI
well Summary: In Plate: 324 Set Up: 284 Analyzed: 354 Flagged: 0 Cmitted by Analysis: 0 Ormitted Manually: 0 Samnples Used: 2 Targets Used: 1

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.

For more information

For more information on Refer to Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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About Standard Curve
Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

l

Chapter 5.

. In the Experiment Menu, click

CHAPTER 6

Export Analysis Results

. Open the Standard Curve example experiment file that you analyzed in

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

Select ViiA™7 Format.

Complete the Export dialog box as shown below:

Field or Selection

Entry

Select Data to Results
export/ Select

Content

Export Data To One File
Export File Name ViiA7SCexport
File Type * txt

Export File Location

<drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments

Chapter 6

Export Analysis Results
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Chapter 6 Export Analysis Results

Your Export screen should look like this:

Experiment; ViiA7_384-Well_Standard_Curve_Example Type: Standard Curve Reagents: TagMan® Reagents | Export 3
I Auto Export Forrnat :IViiA"‘ 7 LI Expart Data To: & One File © Separate Files [ Open file(s) when export i complete
Esxport File Location:|C:\Applied Biosystems\WiiA7 Software v1.0\experiments Export File Marne:|VilA7SCexport File Type: I[‘:_;'; (*.txt) j
[ sample Setup [] Raw Data [ AmplFication [ Multicompenent

Select Content

Well Sample ... | Target N... Task Reporter | Quencherl CT | Ct Mean Ct SD | Quantity |Quant
K all Fields = e RMAsEP  NTC Fam NFQMGE  Undeteri... -
' well 2 RMAze P STANDARD  FAM MFQ-MGE 30,605 30,568 0.087 1,250 1,230
2 RMAse B STANDARD  FAM MNFO-MGE 20,605 25i515 0.075 2,500 2,500
W sarnple Namne 4 RM&se P STANDARD FAM NFQ-MGE 28,597 28611 0.054 5,000 5,000
i=] RMNAse P STAMDARD  FAM MNFQ-MGE 27.560 27.646 0.057 10,000 10,000
¥ Target Mame (5] RMNase P STAMDARD  FAM MNFQ-MGE 26.567 26.553 0.049 20,000 20,000
7 5K RMase P UMKNOWN - FAM NFQ-MGE 28,626 28.582 0.0632 4,835,817 4,994.¢
W Task 5 sK RMNAse P URKNOWN  FAM MFQ-MGE 28548 29,552 0.063 5,106,599 4,904.¢
¥ Reporter el 5K RMase P UREMNOWN - FAM NFQ-MGE 28.651 28.582 0.063 4,753,167 4,994.¢
10 5K RMase P UMNKMNOWN - FAM NFQ-MGE 28.62 28.582 0.063 4,857.883 4,994.¢
¥ Quencher 11 oK RMAse P URKNOWH - FAM MNFJ-MGE 28682 28.582 0.063 4,649,728 4,994t
12 Sk RMAse P UKNOWH - FAM MFJ-MGE 28,475 28.582 0.063 5,378,547 4,994t
VT 13 Sk RMAse P UKNOWH FAM MFJ-MGB 28575 28.582 0.063 5,011679 4,994
14 Sk RMAse P URKNOWH - FAM MNFO-MGE 28,624 28.582 0.063 4,843,773 4,004.¢
¥ Ct Mean 15 5K RMN&se P UNKNOWM  FAM NFQ-MGE 28,649 28,552 0.063 4,760,378 4,994.¢
¥ CtsD 16 10K RMAse P UMEMOWN  FAM MNFQ-MGE 27.638 27.678 0.09 9,662,697 9,414
17 10K RMNAse P UMKMOWE FAM MNFQ-MGE 27.627 27.678 0.09 9,738,641 9,414
V¥ Quantity 12 10K RMase P UMNEMNOWN - FAM MNFQ-MGE 27.684 27.678 0.09 9,352,924  9,414¢
19 10K RMase P UMEMNOWR FAM NFO-MGE 27.601 27.678 0.09 9.913.167 9.414:T
¥ Cusantity Mean =l = | _’iJ

W Save Export Set As Load Export Set

Your exported file when opened in Notepad should look like this:

il

File Edit Format Wisw Help
" Block Type = 384-Well Block j

* Calibration is expired = Mo

* Calibration petrformed on = 2010-01-14 11:44:13 AM 5CT

™ Calibration Background is expirad = MNo

* Calibration Background performed on = 2010-01-2% 11:40:55 AM SCT
* Calibration FAM is expired = Mo

* Calibration FAM performed on = 2010-01-29 12:00:34 PM 5CT

* Calibration ROl is expired = Ne

* Calibration ROl performed on = 2010-01-29 11:11:13 AM SCT

* Calibration ROX is expired = Mo

™ Calibration ROX performed on = 2010-01-29 12:22:51 PM SCT

* Calibration Uniformity is expired = ho

* Calibration Uniformity performed on = 2010-01-29 11:50:22 AM SGT
* Chemistry = TAQMAN

™ Expariment File Mama = CiiAppliad Biosystams \WiiA7 Software v1.0\experiments \examplas WilA7 _384-Wall_Standard _Curve_Example.eds
* Experiment Name = ViiA7_384-Well_Standard_Curve_Bample

* Experiment Run End Time = 2010-02-01 15:02:10 PM 5CT

* Experiment Type = Standard Curve

* Instrument Mama = A

* Instrument Serial Mumber = 278830018

* Instrument Type = ViiA 7

™ Passive Reference = ROX

* Quantification Cycle Method = Ct

* Signal Smoothing On = false

* Stagef Cycle whera Analysis is performed = Stage 2, Step 2

[Results]

el Sample Name Target Mame Task Reporter Quencher CT Ct Mean Ct 5D Quantity Quantity Mean
Quantity 50 Automatic Ct Threshold Ct Threshold Automatic Baseline Baseline Start Baseline End Custoeml
CustomZ Custom3 Customd CustomS Customé

1 RMAse P NTC FAhd MNFO-MGE Undetermined true
0.1365  true 3

2 RMAse P STANDARD Fam MFO-MCE30.605 30,5682 00868 1250 1250 true
0.1968  true 3

3 RhAse P STANDARD FAM MFO-MGE29.6049 295153 00753 2500 2500 true
0.1968  true 3 24

4 RMAse P STANDARD Fapa MFO-MCE2E.5971 286108 0.0%45 5000 5000 Trug
0.1968  true 3

5 RMNAse P STANDARD FAM MFO-MGE27.5688 276453 0.0%68 10000 10000 true
01968 true 3 22
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Review Results and Adjust
Experiment Parameters

Export Analysis Results

CHAPTER 1

About Relative Standard
Curve Experiments

This chapter covers:
B About Relative Standard Curve experiments. ...................... ... ..., 12

B About the example experiment .............. ... ... i i, 13

IMPORTANT! First-time users of the ViiA™ 7 System, please read Booklet 1, Getting

Started with ViiA™ 7 System Experiments and Booklet 7, ViiA™ 7 System Experiments -
Appendixes of this binder thoroughly. The booklets provide information and general
instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking ) in
the toolbar, or selecting Help » ViiA™ 7 Software Help.
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II Chapter 1 About Relative Standard Curve Experiments
About Relative Standard Curve experiments

About Relative Standard Curve experiments

The Relative Standard Curve method is used to determine relative target quantity in
samples. The ViiA™ 7 Software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution
series. Measurements are normalized using the endogenous control. Data from the
standard dilution series are used to generate the standard curve. Using the standard
curve, the software interpolates target quantity and endogenous control quantity in
the samples and the reference sample. For each sample and reference sample, the
target quantity is normalized by endogenous control quantity (quantity of target/
quantity of endogenous control). The normalized quotient from samples is divided by
the quotient from the reference sample to get relative quantification (fold change). The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

Relative Standard Curve experiments are commonly used to:

¢ Compare expression levels of a gene in different tissues.
e Compare expression levels of a gene in a treated sample and an untreated sample.
* Compare expression levels of wild-type alleles and mutated alleles.

* Analyze the gene expression changes over time under specific treatment
conditions.

Assemble required components

PCR options

12

e Sample - The tissue group that you are testing for a target gene.

* Reference sample (also called a calibrator) — The sample used as the basis for
relative quantification results. For example, in a study of drug effects on gene
expression, an untreated control is an appropriate reference sample.

e Standard — A sample that contains known quantities of the target; used in
quantification experiments to generate standard curves.

¢ Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

¢ Endogenous control — A gene that is used to normalize template input
differences, and sample-to-sample or run-to-run variation.

¢ Replicates — The total number of identical reactions containing identical
components and identical volumes.

* Negative controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

When performing real-time PCR, choose between:

¢ Singleplex and multiplex PCR (below)
and
* 1-step and 2-step RT-PCR (page 13)

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Singleplex and
Multiplex PCR

1- and 2-Step RT-
PCR

Chapter 1 II
About the example experiment

¢ Singleplex PCR - In singleplex PCR a single primer and probe set is present in
the reaction tube or well. Only one target or endogenous control can be amplified
per reaction.

Or

* Multiplex PCR - In multiplex PCR, two or more primer and probe sets are
present in the reaction tube or well. Each set amplifies a specific target or
endogenous control. Typically, a probe labeled with FAM™ dye detects the target
and a probe labeled with VIC® dye detects the endogenous control.

You can perform a PCR reaction using either:

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

] O =E [ Target Primer Set
=
s 3 ©o (O Endogenous Control
-~ Primer Set
. ~~ cDNA
Singleplex PCR Multiplex PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether
you are performing 1- or 2-step RT-PCR:

¢ 1-step PCR-In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or
the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

e 2-step PCR- 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.

About the example experiment

To illustrate how to perform a Relative Standard Curve, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with the ViiA™ 7 System.

The objective of the Relative Standard Curve example experiment is to compare the
expression of the FAS transcriptional factor (an oncoprotein that activates the
transcription of growth-associated genes) in Human cDNA tissues.
In the Relative Standard Curve example experiment:

* The samples are kidney, liver, brain, and heart.

* The target is FAS.

¢ The endogenous control is HPRT.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 13
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1 Chapter 1 About Relative Standard Curve Experiments
About the example experiment

® The reference sample is brain.
* One standard curve is set up for FAS. The standard used for the standard dilution
series is a Human cDNA sample of known total concentration.

* One standard curve is set up for HPRT (endogenous control). The standard used
for the standard dilution series is a Human Male Raji cDNA sample of known
total concentration.

* Reactions are set up for 2-step RT-PCR. The Invitrogen VILO Kit is used for
reverse transcription; the TagMan® Gene Expression Master Mix (2X) is used for
PCR.

* Select primer and probe sets from the Applied Biosystems TagMan® Gene
Expression Assays product line:

— For the target assay (FAS), select assay ID Hs00907759_m].
— For the endogenous control assay (HPRT), select assay ID Hs99999909_m1.

14 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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CHAPTER 2

Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.
About Relative Standard

Curve Experiments This chapter covers:

B Define the experiment properties. ........... ... ... i 16

Define targets, samples, and biological replicates. ......................... 17

l B Assign targets, samples, and biological groups............. ... ... o o 19

B Setuptherunmethod........ ... ... .. 21

Chapter 2
B Order materials for the experiment................... ... ... ... ..... 22
Design the Experiment

B Tips for designing your own experiment ................................. 22

B For more information. .......... ... oo 23

I Note: To automatically export the analyzed data to a specified location, select the Auto

Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1 in Booklet 1, Getting Started with
ViiA™ 7 System Experiments.

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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2 Chapter 2 Design the Experiment
Define the experiment properties

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
ViiA™ 7 Software. Enter:

Field or Selection Entry
Experiment Name ViiA7_384-Well_Relative_Standard_Curve_Example
Barcode Leave field empty
User Name Example User
Comments Relative Standard Curve example
Block 384-Well Block
Experiment Type Relative Standard Curve
Reagents TagMan® Reagents
Ramp speed Standard

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

¥ Experimant. Hame: i-_-1|1-.:f_3Ea-wEI|_Helaﬁ.-a_s‘.an:lan:_cuwe_Ex:mple

iq' 3a4-Wedl Block | Anzy Card Blodk J ui-Well Blodk (0. 2mL) ] [ Fast 96-Wel Blodk (0. LmL)

[ Standard Curve < Relate Standard Curve | ( Comparative Cy (AACT) ] l Melt Curve

l Genabypng Prisana/ Absenc |

| 7 TaqMan® Reagents | SYRRE Green Reagents J other

[ standard | Fast

16 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Define targets, samples, and biological replicates

Click Define to access the Define screen. Enter:

Chapter 2

Define targets, samples, and biological replicates

1. Targets
Target name Reporter Quencher Color

FAS FAM NFQ-MGB [

HPRT VIC NFQ-MGB [}
2. Samples

Sample name Color

Brain

Heart [ ]

Kidney [}

Liver [ ]
3. Dye to be used as a Passive Reference

ROX
4. Analysis Settings
Field Select
Reference Sample Brain
Endogenous Control HPRT

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct
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2 Chapter 2 Design the Experiment
Define targets, samples, and biological replicates

Your Define screen should look like this:

Samples

Rsporer GQuencher Calor Sampla Mame Color
= -
:Hs FaM » [NFQMGE w _ v | |Bran I v
I
HERT Hile v lHFaMGE v h 2 [ I.. v
Kdney [- v

Biological Replicate Groups Analysis Seltings

Biolagical Group Mame Color Comments

Refarence Sample; Brain_
Endagenaus Controt HPRT

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.

18 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Chapter 2

Assign targets, samples, and biological groups

Assign targets, samples, and biological groups

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct

Experiments

Click Assign to access the Assign screen.

Note: To automatically set up and assign standards, clic

the Define and Set Up Standards dialog box.

To assign the targets and samples:

1. Setup the standards.

2. For the first standard for the FAS target:
a. Click-drag to select wells A9-Al6.
. Check check box next to FAS in the Targets list.

. Select S in the Task drop-down menu.

b
o
d. Enter 625 in the Quantity column.
e

k | ™. Define and Set Up Standards

. Repeat steps a through c for each of the standards for the FAS target,
selecting the wells listed in the table below, and entering the corresponding
quantity.

3. Repeat step 2 for each standard for the HPRT target.

! to open

Target Well number Task Quantity Sample
name name
FAS Al - A8 Negative None None
E1-E12 Unknown Determined by Kidney
run
E13 - E24 Unknown Determined by Heart
run
11-112 Unknown Determined by Liver
run
113 - 124 Unknown Determined by Brain
run
A9 - A16 Standard 625 None
A17 - A24 Standard 2,500 None
C1-C8 Standard 312.50 None
C9 - C16 Standard 1,250 None
C17 - C24 Standard 5,000 None

19



2 Chapter 2 Design the Experiment
Assign targets, samples, and biological groups

Target Well number Task Quantity Sample
name name
HPRT P1-P8 Negative None None
H1 - H12 Unknown | Determined by Kidney
run
H13 - H 24 Unknown | Determined by Heart
run
L1-L112 Unknown Determined by Liver
run
L13 - L24 Unknown Determined by Brain
run
N1 - N8 Standard 165.25 None
N9 - N16 Standard 625 None
N17 - N24 Standard 2,500 None
P9 - P16 Standard 312.50 None
P17 - P24 Standard 1,250 None

Your Assign screen should look like this:

£ Well Table
Targets

E.FAS =] 1 [ 2 [ 3 [+ s [s |78 |9 [0 [12[13[w4][15[16 |17 |18 |19 2021|2223 [z4)]
T T | | [ | e o e P P P P P P P

., Define and Set Up Standards

=]

Sﬁ“m”'gs—g P T T T T i I T N P TN RN TN N PN TN TN N T T
r.K\dney

- fwer

[N ;rain FE e e e e e e e e e e e T T T T T . T T .
™ [ileart PN P P N T T T T T N P PN N T T T T T N P T T T

Biological Groups ——————— (Ta)
B s s s s s e ey s s s s e e, e, e, e e e s e e e e

Biological Group

1:|O|z|3|r—|x‘|_.‘>—~ I|m|T||rr|

s s e e e s s e e e e e e e e Jle e e e e fle fie e |

wels: [I] 96 80 [ 16 192 Empty
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Set up the run method

Graphical View

Chapter 2
Set up the run method

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 10puL

e Thermal Profile

Stage Step Ramp rate | Temperature Time
Hold Stage Step 1 1.6 °C/s 50 °C 2 minutes
Step 2 1.6 °C/s 95°C 10 minutes
PCR Stage Step 1 1.6 °C/s 95°C 15 seconds
Number of Cycles: 40 Step 2 1.6 °C/s 60°C 1 minute

Enable AutoDelta:
Unchecked (default)

Starting Cycle: Disabled
when Enable AutoDelta is
unchecked

Your Run Method screen should look like this:

Run Method

Reaction Wolume per wel: | 10 pL

Optical Filters

Save Run Method Revert ta Default

Hold Stage PCR Stage
Murber of Cycles: |4E| :I
7 Enable AutoDelta
Starting Cyrle: m
180 7 — 95.0 °C 05.0 °C
10:00 16 °C/s D15 \6
T L/
1.6 °Cfs 60,0 *C
80 %] R 01:00
0200
1.6 *Cfs =
25 °C ]
oeC
Stept Step2 Step1 Step2
A »
Legend
" Data Collection O~ = Data Collection Off A AutoDelta On A AutoDelta Off
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2 Chapter 2 Design the Experiment
Order materials for the experiment

Order materials for the experiment

The recommended materials are:
* MicroAmp® Optical 384-Well Reaction Plate
e MicroAmp® Optical Adhesive Film
» TagMan® Gene Expression Master Mix (2X)
e FAS target assay
e HPRT target assay

Your Materials List screen should look like this:

Find Assay

Enter Geng Name I Find Assay Enter a gene name, then click Find Assay to search the Applied Biosysterns Store for a gene expression assay.

Experiment Materials List

Add Selected Items to Shopping List Display : [l Iterms LI

[T Check &l Itemn Fart humber Description

Includes 10 x BfM N3080234, TagMan@ Reverse Transcriptase Reagents. i’
- TagMani® Reverse Transcription Reagents (10 Pack) 4304134 Sufficient for 2000 Reverse Transcriptase reactions at 10 L reaction
yaolume,

An optically-clear adhesive film used to seal the samples into the wells of 3
[l Microarnp™ Optical Adhesive Fim (100 films) 4311971 96-wel microplate, This will reduce the possibility of cross-contamination
hetween sample wels and help ensure consistent Real-Time PCR data,

Tha MicraAran ™ MlF_Barmowesl Tanl rslac it ascdar a0 ramewe cane from

Experiment Shopping List (3 items)

Remove Selected Items from Shopping List Shopping Basket Marme [WVilA7 354 Well Relative S Basket
[T Check &l Ttern Part Mumber Cluantity
r TagMan® RMase P Control Reagents (VICE Dye) 43166844 1
r TagMard® Gene Expression Master Mix (2 x S mL) 4369514 1
r Microsmp™ Optical Adhesive Fim (25 films) 4360954 1

Tips for designing your own experiment

Applied Biosystems recommends that you:

* Setup a standard curve for each target assay in the reaction plate.

¢ Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

¢ Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.

* Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally
in all sample types, regardless of treatment or tissue origin (examples of
endogenous controls are -actin, GAPDH, and 18S ribosomal RNA [185 rRNA]).
The endogenous control is used to normalize the PCR results; the endogenous
control corrects for variable sample mass, nucleic acid extraction efficiency,
reverse transcription efficiency, and pipette calibration errors.

Note: Each sample type (for example, each tissue in a study comparing multiple
tissues) requires an endogenous control.
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For more information

* Enter at least five dilution points for each standard curve in the reaction plate.

¢ Enter at least three replicates (identical reactions) for each point in the standard
curve and for each sample reaction.

* Enter at least three negative control reactions for each target assay.

¢ Carefully consider the appropriate range of standard quantities for your assay
because the range of standard quantities affects the amplification efficiency
calculations:

— For more accurate measurements of amplification efficiency, use a broad
range of standard quantities, spanning between 5 and 6 logs. If you do so,
use a PCR product or a highly concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-
copy number transcript, or known to fall within a given range, a narrow
range of standard quantities may be necessary.

* Minimally run a five-point curve of 1:10 dilutions to minimize the effects of small
pipetting errors.

¢ Select a reference sample from your previously defined samples. Amplification
results from the samples and from the reference sample are compared to
determine relative expression.

* Select an endogenous control from your previously defined target assays.
Amplification results from the endogenous control are used to normalize the
amplification results from the target for differences in the amount of template
added to each reaction.

For more information

For more information on... Refer to... Part number

Consumables Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments

Appendix A in Booklet 7, ViiA™ 7 System Experiments - Appendixes

Using other quantification Booklet 2, Running Standard Curve Experiments and Part 2 of Booklet LA4L1434
methods 3, Running Relative Standard Curve and Comparative Ct Experiments.
Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays Application 127AP05-03
Note
Using Alternative Setup Chapter 2 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments
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For more information
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CHAPTER 3

Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Relative Standard

Curve example experiment.
About Relative Standard

Curve Experiments This chapter covers:
B Assemble required materials .......... ... . i 26
Preparethetemplate ........ ... ... ... 26
B Prepare thesampledilutions .............. ... . ... o il 26
B Prepare the standard dilution series for FAS and HPRT assays.............. 27
B Prepare the reaction mix (“cocktail mix”)........... ...t 28
Design the Experiment
B Preparethereactionplate .......... .. ..o i 29
B Tips for preparing reactions for your own experiments. . ................... 32
l B Formore information. . ........ ..ottt 32
Chapter 3
Prepare the Reactions
Run the Experiment
Review Results and Adjust
Experiment Parameters
Export Analysis Results
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Assemble required materials

Assemble required materials

e Items listed in Booklet 1, Getting Started with ViiA™ 7 System Experiments
e Samples - Total RNA isolated from kidney, heart, liver, and brain tissues.
¢ Example experiment reaction mix components:

- TaqMan® Gene Expression Master Mix (2X)

— FAS Assay Mix (20X)

— HPRT Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions (both samples and standards) using one of
the Invitrogen VILO kits, SuperScript® VILO™ cDNA Synthesis Kit (PN 4453650).

Example experiment settings

For the Relative Standard Curve example experiment, the template for the PCR

reactions is cDNA reverse-transcribed from total RNA samples using the Invitrogen
VILO Kkits.

To prepare the template

Use the Invitrogen VILO kits to reverse-transcribe cDNA from the total RNA samples.
Follow the procedures in the Invitrogen VILO Kits Protocol (PN 100002284) to:

1. TIsolate total RNA from cells using an Ambion® sample preparation kit
appropriate to the tissue or cell type.

2. Quantify and perform quality control on the RNA.

3. Convert the RNA to cDNA via reverse transcription.

Prepare the sample dilutions

For the Relative Standard Curve example experiment, no more than 10% of your
reaction should consist of the undiluted cDNA.

1. Label a separate microcentrifuge tube for each diluted sample:
¢ Kidney
¢ Heart
e Liver

¢ Brain
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Prepare the standard dilution series for FAS and HPRT assays

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Kidney 76
2 Heart 76
3 Liver 76
4 Brain 76

3. Add the required volume of sample stock (100 ng/uL) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Kidney 4
2 Heart 4
3 Liver 4
4 Brain 4

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the standard dilution series for FAS and HPRT assays

The same standard materials are used to prepare the exact same dilutions for both the
target genes. The prepared standards are then used to generate the two standard
curves.

* The stock concentration for cDNA is 100 ng/uL.

¢ The volumes calculated for both the FAS and HPRT assays are:

Standard Standard
name Dilution Source Diluent Total volume .
. Source concentration
(Labeled point volume (pL) = volume (pL) (uL)
(ng/uL)
tube)
Std. 1 1 Stock 20 20 40 100
Std. 2 2 Dilution 1 20 20 40 50
Std. 3 3 Dilution 20 20 40 25
Std. 4 4 Dilution 3 20 20 40 12.5
Std. 5 5 Dilution 4 20 20 40 6.25
1. Label ten separate microcentrifuge tubes for each diluted standard:
e FAS (FAS Std. 1 - FAS Std. 5)
e HPRT (HPRT Std. 1 - HPRT Std. 5)
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Prepare the reaction mix {“cocktail mix”]

2. Prepare five standard dilutions each for FAS and HPRT:

Note: For dilution 1, first vortex the stock for 3 to 5 seconds, then centrifuge both
the Std. 1 tubes briefly before pipetting 10 pL stock into each Std. 1 tube.

3. For each subsequent dilution, add source to the standard:

a. Use a new pipette tip to add 10 pL of source to the FAS and HPRT tubes
containing the standard.

b. Vortex the tubes for 3 to 5 seconds, then centrifuge the tubes briefly.

4. Place the standards on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
¢ FAS Reaction Mix
¢ HPRT Reaction Mix

2. For the FAS assay, add the required volumes of each component to the FAS
Reaction Mix tube:

Volume (pL) for 1 Volume_ (uL) for 96
Component . reactions (plus
reaction
10% excess)

TagMan® Gene Expression 5 530
Master Mix (2X]

FAS Assay Mix (20X) 0.5 53
Water 3.5 371
Total Reaction Mix Volume 9 954

Reaction Mix tube:

3. For the HPRT assay, add the required volumes of each component to the HPRT

Volume (pL) for 1 Volume (uL) for 96
Component . reactions (plus
reaction
10% excess)

TagMan® Gene Expression 5 530
Master Mix (2X.)

HPRT Assay Mix (20X 0.5 53
Water 3.5 371
Total Reaction Mix Volume 9 954

4. Mix the reaction in each tube by gently pipetting up and down, then cap each
tube.

5. Centrifuge the tubes briefly to remove air bubbles.
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Prepare the reaction plate

6. Place the reaction mixes on ice until you prepare the reaction plate.

Note: Do not add the sample or standard at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Relative Standard Curve example experiment contains:
e A MicroAmp® Optical 384-Well Reaction Plate
¢ Reaction volume: 10uL/well
e 96 Unknown wells [
* 80 Standard wells [
* 16 Negative control wells [1]
¢ 192 Empty wells

The plate layout for the example experiment looks like this:

bl Flate Layout Well Table

t [z [ s [« [ s [ & [ 7 [ 8 [ o [w | un [ 12 |13 |14 [ 15 & |17 [18 [19 [0 [ 2 [z [23 ]2 |

A mhmmmmnmumumumumumumumum

o Ju Jo Ju Jo o Ju Jo Jo Jo Ju Jo Jo Ju Jo Jo Jo o Jo Jo Jo Jo Jo Jo |

ICER R D D R [ R R R D ) [

o o Ju Jo Ju ju ju jo Jo o Ju juo Jo Jo o Jo jo Jo o o Jo jo Jo o |

ICEN N [CEDY (N [ DV MY [N (N [N D (NG (N [ N (DG (N (N Y DY (R [ [ [

(75 g [ [ v CJrm CJee I 7w I e e e e e e e R CTam S S S e e

wielks: [ 96 [ 80 [ 16 192 Empty

[=]ef=]=]~]~[=[~J=z]a]m][n]o|a]®"
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Prepare the reaction plate

To prepare the reaction plate components

1. For each target, prepare the negative control reactions:

a. To an appropriately sized tube, add the volumes of reaction mix and water
listed below.

. . Reaction mix Water volume
Tube Reaction mix
volume (pL) (uL)
1 FAS Reaction Mix 79.2 8.8
2 HPRT Reaction Mix 79.2 8.8

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 10 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard

listed below.
Standard Reaction Standard
Tube . Reaction mix | mixvoulme Standard volume
rection
(pL) (uL)
1 FAS Std. 1 FAS Reaction 79.2 FAS Std. 1 8.8
Mix
2 FAS Std. 2 FAS Reaction 79.2 FAS Std. 2 8.8
Mix
3 FAS Std. 3 FAS Reaction 79.2 FAS Std. 3 8.8
Mix
4 FAS Std. 4 FAS Reaction 79.2 FAS Std. 4 8.8
Mix
5 FAS Std. 5 FAS Reaction 79.2 FAS Std. 5 8.8
Mix
6 HPRT Std. 1 | HPRT 79.2 HPRT Std. 1 8.8
Reaction Mix
7 HPRT Std. 2 | HPRT 79.2 HPRT Std. 2 8.8
Reaction Mix
8 HPRT Std. 3 | HPRT 79.2 HPRT Std. 3 8.8
Reaction Mix
9 HPRT Std. 4 = HPRT 79.2 HPRT Std. 4 8.8
Reaction Mix
10 HPRT Std. 5 | HPRT 79.2 HPRT Std. 5 8.8
Reaction Mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.
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Prepare the reaction plate

d. Add 10 pL of the standard reaction to the appropriate wells in the reaction

plate.

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample
listed below:

Reaction Sample
Unknown . . .
Tube . Reaction mix | mixvolume & Sample volume
reaction
(uL) (pL)
1 FAS Kidney FAS Reaction 118.8 Kidney 13.2
Mix
2 FAS Heart FAS Reaction 118.8 Heart 13.2
Mix
3 FAS Liver FAS Reaction 118.8 Liver 13.2
Mix
4 FAS Brain FAS Reaction 118.8 Brain 13.2
Mix
5 HPRT HPRT 118.8 Kidney 13.2
Kidney Reaction Mix
6 HPRT Heart | HPRT 118.8 Heart 13.2
Reaction Mix
7 HPRT Liver HPRT 118.8 Liver 13.2
Reaction Mix
8 HPRT Brain | HPRT 118.8 Brain 13.2
Reaction Mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 10 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

7. Until you are ready to perform the run, place the reaction plate at 4 °C, in the

dark.
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Tips for preparing reactions for your own experiments
Tips for preparing reactions for your own experiments

Tips for preparing templates

When you prepare your own Relative Standard Curve experiment, Applied
Biosystems recommends the following templates:

¢ Complementary DNA (cDNA) - cDNA reverse-transcribed from total RNA
samples.

¢ Genomic DNA (gDNA) - Purified gDNA already extracted from tissue or
sample

Tips for preparing sample dilutions
When you prepare your own Relative Standard Curve experiment, for optimal

performance of TagMan® Gene Expression Assays or Custom TagMan® Gene
Expression Assays, use 10 to 100 ng of cDNA template per 10uL reaction.

Tips for preparing the reaction mix

If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.

Tips for preparing the reaction plate

When you prepare your own Relative Standard Curve experiment, make sure the
arrangement of the PCR reactions matches the plate layout displayed in the ViiA™ 7
Software.

For more information

For more information on... Refer to... Part number
Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System LLL4A34
components Experiments
Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments
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CHAPTER 4

Run the Experiment

This chapter explains how to run the example experiment on the ViiA™ 7 Instrument.

About Relative Standard This Chaptel‘ covers:
Curve Experiments
B Startthe run. .. ... e 34
B Monitorthe run. . . ... o e 34

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

Design the Experiment

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.

Prepare the Reactions

!

Chapter 4

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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Start the run

Start the run

Monitor the run

. Open the Relative Standard Curve example file that you created using

instructions in Chapter 2.
Load the reaction plate into the instrument.

Start the run.

Monitor the example experiment run:

From the ViiA™ 7 Software using the Run screen, while the experiment is in
progress.

From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment
started from another computer or from the ViiA™ 7 Instrument touchscreen).

From the ViiA™ 7 Instrument touchscreen.

From the Instrument Console of the ViiA™ 7 Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. In the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.
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Monitor the run

View the You can view the progress of the run in real time. During the run, periodically view all
Amplification Plot the three plots available from the ViiA™ 7 Software for potential problems.

To view data in the Amplification Plot screen, click Amplification Plot from the Run
Experiment Menu, and select the Plate Layout tab, then select the wells that you want
to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Amplification Plot

/® p é 'LE \g 'i—-j_lh, ;: o _ %A
e B =
Ampliﬁcation Plot 1 2 3 ¢ 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
10 - Ly T e e e e e e e £ e e e £ ) e S £ e e e £ e e
B
1 [ e e e e $r e e T £ £ e T £ £ e e £ £ e e 5 e
D
.1 Fomn remm oot e pe e s o P e I e B s 4 e e £ s e s 4
F
0.01 a
% e T e e el
0.001 1 ] e s e e s s e e P e e T P R R TR P PR R IR P R e
X
)
0.0001 41 K
e S S S S S S S 0 G, P, G, g P,
0.00001 - ..I i M
| o, G 5, B, B B, I, N, B B, o, T B I B, S 5 I
0.000001 Fo]
Cycle P s e i mam v v em mam s e s S WS WSTT ST SN WSS WSYT TSI WSE NE T
View the To view data in the Temperature Plot screen, click Temperature Plot from the Run
Temperature Plot Experiment Menu.
The figure below shows the Temperature Plot screen as it appears during the example
experiment.
Estimated Time Remaining: 00:00:00 Instrument Name: None
Run Status: Run Started at: 12,/10,/09 6:58 PM Run Complete at:8:29 PM

Temperature Plot current Temperatures

- = s [ v [ cover 104.8°C
£ P el |"E

v Ml sample 25.1°C
Temperature Plot -+ Block 24.9°C

80 ¢ — -—J-Jj:—-r—J.’n—Jh— —] L i L ] L

Temperature

Temperature Plot

s}
00:33:20 00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20 01:02:30 01:08:40 01:10:50 01:15:00 o1:1@:10 01:23:20 01:27:30 01:31

. Wiew 1 Hour hd
Time
. | Fixed Wigw [
Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 35

Experiments



4 Chapter 4 Run the Experiment
Monitor the run

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

View the Run To view data in the Run Method screen, click Run Method from the Run Experiment
Method Menu.
The figure below shows the Run Method screen as it appears in the example
experiment.

Run Method

Edit Run Method

Adjust # of Cyclas:
Hold Stage PCR Stage
Mamber of Cycles: I4D :I [T &dd Melt Curve Stage to End
7 Enable AutoDelta 7 &dd Holding Stage to End
Starting Cycle: |1 = [T add Infirite Hold to End
10:00 16T oois \6
: : 1.5
16 gy B0 °C
500 °C 0100
02:00
1.6 *Cfs s
Stept Step2 Step1 Step2
4 »
Legend
Data Collection On = Data Colection Off A AutoDelta On A AutoDelta OfFf
View run data To view the run data, click View Run Data from the Run Experiment Menu.

Your View Run Data screen should look like this:

Run Data Report
Experiment Mame:  viid7_324-Wel_Relative_Standard_Curve_Example

Start Time:  12-10-2009 19:00:01 SGT
Stop Time:  12-10-2009 20:31:44 5GT
Run Duration: 91 minutes 42 seconds
User ID:
Errors Encountered:
Instrument Mame:
Firmuware Wersion:
Software Wersion:
Instrurnent Serial Mumber: 278880013
Sample volume: 10.0
Cover Temperature:  105.0

Elock Type: 324-well Plate (16x24)

36 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
Experiments



Chapter 4
Monitor the run

From the ViiA™ 7 Instrument touchscreen

You can also view the progress of the run from the touchscreen of the ViiA™ 7
Instrument.

The Run Method screen on the ViiA™ 7 Instrument touchscreen looks like this:

Experiment view T : _

Experiment: 2010-03-11-232013

D Experiment View g;

Run Started: March 11 2010 - 11:20PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover: 105.0 °C

Heated Cover Set Point: 105.0 °C Time Remaining: 01:28:18

Time view = —
@ | MyInstrument (384-well 20pL) E

Experiment: 2010-03-11-232013

Run Started: March 1172010 - 11:20PM Sample: 50.0 °C
Reaction Volume: 20 pL Stage /[ Step: 1 /1
Heated Cover Set Point: 105.0 °C Cycle: 1

Display Time: Remaiing () Elapsed

‘March 11 2010 - 11:20PM: Heated cover reached target temperature.
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CHAPTER 5

Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

About Relative Standard
Curve Experiments

This chapter covers:

B Section5.1 ReviewResults .............ooooiiiiiiiiiiiiiiiiiii i, 41

Analyze the example experiment. ............ ... ... oo i 41

B View the Standard Curve Plot ........ .. ... ... ... o i il 41

Design the Experiment B Assess amplification results using the Amplification Plot................... 44

B Assess the gene expression profile using the Gene Expression Plot. .......... 51

B Identify well problems using the Well Table .............................. 53

B Confirm accurate dye signal using the Multicomponent Plot................ 55

B Determine signal accuracy using the Raw DataPlot ....................... 57

B View the endogenous control profile using the QCPlot .................... 59

Prepare the Reactions B Review the QC flags in the QC Summary ............ ... ..., 60

B For moreinformation.......... ... .. i 62

B Section 5.2 Adjust parameters for re-analysis of your own experiments .... 63

B Adjust analysissettings. ... 63

B Improve Cp precision by omittingwells................ ... ... . o o 68

B For more information. . ............... e 69

Run the Experiment
Cha&er 5
Review Results and
Adjust Experiment
Parameters

Export Analysis Results
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SECTION 5.1

Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.
You can also access the experiment to analyze from the Home screen.

View the Standard Curve Plot

The Standard Curve Plot screen displays the standard curve for samples designated as
standards. The ViiA™ 7 Software calculates the quantity of an unknown target from
the standard curve.

Example experiment standard curve values

In the standard curve example experiment, you review the Standard Curve Plot screen
for the following regression coefficient values:

¢ Slope/amplification efficiency
e R2value (correlation coefficient)

e (Cypvalues

To view and assess the Standard Curve plot

1. From the Experiment Menu pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Standard Curve Plot screen by clicking the upper left
corner of the plate layout in the Plate Layout tab.

3. Enter the Plot Settings:

Menu Selection
Target All
Plot Color Default
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View the Standard Curve Plot

Menu

Selection

(This is a toggle button. When the legend

is displayed, the button changes to Hide
the plot legend.)

Check (default)

4. View the values displayed below the standard curve. In the example experiment,
the values for each target fall within the acceptable ranges:

Amplification

2

Target Slope R4 Value efficiency (EFf%)
FAS 3.38 0.998 97.612
HPRT -3.652 0.983 87.858

5. Check that all samples are within the standard curve. In the example experiment,
all samples (blue dots) are within the standard curve (red dots).

Standard Curve <

[ Save current settings as the default

Plot Settings

Target IAII hd Plot Color IDefauIt hd

Standard Curve

30
&)
29
28
27
II.]] 20 1000 10000
Guantity
Tarqet: FAS Sloper -2.38 ¥-Inter: 39.356 2 0,998 Eff%o: 97.612 Error; 0.022
Tarqet: HPRT Slope: -3.652 ¥-Intar: 40.028 g2 0.983 Eff%o: 87.858 Error; 0.077
Legernd
Ml stardard [l Urknown Unknown (Flagged)
well Summary: In Plate: 304 Set Up: 192 Linalyzed: 102 Flagged: 0 Oritted by Analysis: 0 Ornitted Marwally: 0 Samples Used: < Targets Used: 2

42

6. Check the Ct values:
7. Click the Well Table tab.

8. From the Group By drop-down menu, select Replicate.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
Experiments



»| Plate Layout

Well Table

Section 5.1 5
View the Standard Curve Plot

9. Look at the values in the Ct column. In the example experiment, the Cr values fall
within the expected range (>8 and <35).

Show in Table ¥ Selectiiells ¥  Group By ¥ Expand all B Collapse Al
# | wel I omit | Flag ISamp.‘.I Target Name Task Dyes ‘1| T T Mean CT 5D I Cuantity I Mormalize. .. | Mormalize... | Efficiency
209 117 r 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 28,935 29,035 0.071 1,093.478 1.037 97,39~
210 118 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 29.038 209.035 0.071 1,019.329 1.037 97.39
211 119 r 1,000 RMase P LIMKMNOW M FAM-MFQ-MGE | 29,009 29.035 0.071 1,032,701 1.037 97.39
212 120 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 20,048 29.035 0.071 1012421 1.037 97,39
213 121 r 1,000 RMHase P LINKMNOW N FAM-NFO-MGE | 29,073 29,033 0.071 995,587 1.037 97,39
214 122 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 29.055 209.035 0.071 1,007.571 1.037 97.39
215 123 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 29,151 29.035 0.071 943,913 1.037 o739
215 124 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29,064 29,035 0.071 1,001.774 1.037 97,39
229 113 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 28.973 29.035 0.071 1,065.29 1.037 97.39
230 114 r 1,000 RMase P UIMKMNOW FaM-MFQ-MGE | 28.832 209.035 0.071 1,172.701 1.037 97.39
231 115 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 28,935 29.035 0.071 1,078.69 1.037 o739
232 J16 r 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 28,932 29,035 0.071 1,051.813 1.037 97,39
233 117 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 29.029 209.035 0.071 1,025.679 1.037 97.39
234 118 r 1,000 RMase P UIMKMNOW FAM-MFQ-MGE | 29.002 209.035 0.071 1,044.77 1.037 97.39
235 119 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 29.044 29.035 0.071 1,015.042 1.037 o739
235 J20 r 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29.04 29,035 0.071 1,018.366 1.037 97,39
237 121 r 1,000 RMase P UMKNOW FaM-MFQ-MGE | 29.009 209.035 0.071 1,039.876 1.037 97.39
238 122 r 1,000 RMase P LIMKMNOW M FAM-MFQ-MGE | 29,085 29.035 0.071 987.252 1.037 o739
239 123 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29,21 29.035 0.071 906,946 1.037 97,39
240 124 r 1,000 RMHase P LINKMNOW N FAM-NFO-MGE | 29,071 29,033 0.071 995,517 1.037 97,39
233 K13 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 28.959 209.035 0.071 1,068.005 1.037 97.39
254 K14 r 1,000 RMase P LIMKMNOWI FAM-MFQ-MGE | 29,092 29.035 0.071 981,744 1.037 o739
255 K15 I 1,000 RMase P LINKMNOWH FAM-NFO-MGE | 29.018 29,035 0.071 1,033.374 1.037 97,39
256 K16 r 1,000 RMase P UMKNOW FAM-MFQ-MGE | 28.984 29.035 0.071 1,057.409 1.037 97.39
IET K17 1 I ‘ml 1 nnn Rhlaca O [N NI N FAMLRIET- SR 20 NdR 20 NS nn7 1N1d 225 1m27 O'FELI

well Summary: In Plate: 384 Set Up: 283 Analyzed: 283 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

Tips for analyzing your own experiments

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct
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When you analyze your own Relative Standard Curve experiment, look for:

¢ Slope/amplification efficiency values — The amplification efficiency is calculated
using the slope of the regression line in the standard curve. A slope close to 3.3
indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

— Range of standard quantities — For more accurate and precise efficiency

measurements, use a broad range of standard quantities, 5 to 6 logs

(105 to 106 fold).

Number of standard replicates — For more accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

PCR inhibitors — PCR inhibitors in the reaction can alter amplification
efficiency.

* R2values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual Cy data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and
the data points. An R? value >0.99 is desirable.

* Cpvalues — The threshold cycle (Cy) is the PCR cycle number at which the
fluorescence level meets the threshold.

A Cyvalue >8 and <35 is desirable.

A Cy value <8 indicates that there is too much template in the reaction.

A Cp value >35 indicates a low amount of target in the reaction; for Ct values
>35, expect a higher standard deviation.
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Assess amplification results using the Amplification Plot

If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Improve Cp precision by omitting wells” on page 68).
Or

* Rerun the experiment.

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected
wells. There are three plots available:

* ARnvs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. Use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. Use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. Use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose
The purpose of viewing the amplification plot for the example experiment is to
identify:
¢ Correct baseline and threshold values
¢ Outliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the FAS wells in the Amplification Plot screen:
a. Click the Plate Layout tab.
b. From the Select Wells drop-down menu, select Target, then FAS.

L4 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Assess amplification results using the Amplification Plot

The Plate Layout screen should look like this:

Well Table

Plate Layout

g g g g g Fryge g g g Y Frg g O TS S g i i i g g i e

wels: [ 96 [ 8o [ 16 192 Empty

well Summary: In Plate: 254 Set Up: 192 Anahyzed: 192 Flagged: 0 Oritted by Analysis: 0 Oritted Manualy: 0 Samples Used: 4 Targets Used: 2

3. Inthe Amplification Plot screen, enter:

Menu Selection
Plot Type ARn vs Cycle (default)
Plot Color Well (default)
|t Check (default]

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.

b. Select the Baseline check box to show the start cycle and end cycle.
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Assess amplification results using the Amplification Plot

. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot

Plot Settings
Plot Type: [ARN vs Cycle vI Graph Type:lunear vI Flot calar:lw'ell vI
I™ Save current settings as the default
AL alg I
Amplification Plot
033
0.30 -
0.25
o 020
i
<
0.15 -
0.10
0.05
2 4 & k3 0 2 14 {3 & 20 22 M4 35 8 a0
Cycle
Options
Target: [FAS | Threshold: W &uta |0, [ &uto Baseline
Show: [T Threshold — W Baseline Start: Well B0 Target 4. Baseline End: Well /B Target £
well Summary: In Plate: 384 SetUp: 192 Analyzed: 102 Flagged: 0 Omitted by Analysis: 0 Omitted Manwally: O Samples Used: 4 Targets Used: 2
5. View the threshold values:
Menu Select
Graph Type Log
Target FAS

a. Select the Threshold check box to show the threshold.
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Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Amplification Plot
Plot Settings

Plot Type: |ARN vs Cycle | Graph Type: |Log vI Plot Color: [well vI

I Save current settings as the default

®
v
i
Rl
L=F:'.°
i

Amplification Plot
1ED1

1EQD

0.1
0.m
]
[
0.001

0.0001 -

0.00001

0.000001

Cycle

Options
Target: |FAS 'I Threshold: ' auto

[ suto Baseline

Show: ¥ Threshold — T Baseline Start: well B0 Target 4. Baseline End: Wel (B Target <

well Summary: In Plate: 284 Set Up: 192 Analyzed: 102 Flagged: 0 Oritted by &nahysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

6. Locate outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for FAS.

Amplification Plot
Plot Settings

Plot Type: [CT vs Well vl Graph Type: Iunear vl Plot Color: IWE” vl

™ Sawe current settings as the default

Amplification Plot

400 fum
75
350
325
300 { pvalt o
275 e
250
225
200
175
150
125
100
75
50
25
0.0

5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 95100105 10 15120025 306 35140145 501 SHEM6517 0075 801 55 SN SPHI0D 121 DIPIDILIDAP4 DS SDEPES T ET RHPEPHPIRO00S 108 153 B2 D3 BB

Well Mumber

well Summary: In Plate: 384 Set Up: 192 Analyzed: 192 Flagged: 0 Ornitted by Analysis: 0 Ornitted Marually: 0 Sarmnples Used: Targets Used: 2

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct
Experiments

47



5 Chapter 5 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot
7. Repeat steps 2 through 6 for the HPRT wells.

Tips for analyzing your own experiments

When you analyze your own Relative Standard Curve experiment, look for:

e Qutliers

* A typical amplification plot — The ViiA™ 7 Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a
typical amplification plot. A typical amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline

A typical amplification plot should look like this:

Ampilification Plot
Plot Settings

Flot Type:lARn vs Cycle »| Graph Type:|Log | Plot Color: fwel hd

[~ Save current settings as the default

A L alElE

Amplification Plot
1E01

1E0D

01

om

ARR

0.001
ooom {/|

f
0.00001

0.000001

Options

Target: IAII VI Threshald: 7 Auto [T Auto Baseline

Show: ¥ Threshold — ¥ Baseline Start: wel ®0 Target 4. Baseline End: Well M Target .

Well Summary: In Plate: 304 Set Up: 200 Lnalyzed: 200 Flagged: 0 Omitted by Analysis: 0 Oritted Manualby: 0 Sarnples Used: 4 Targets Used: 2
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Assess amplification results using the Amplification Plot

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the ViiA™ 7 Software. Therefore, Applied
Biosystems recommends that you examine the Amplification Plot screen and
review the assigned baseline and threshold values for each well after analysis
completes.

¢ Correct threshold values.

Threshold Set Correctly 1€01

The threshold is set in the
exponential phase of the
amplification curve.

1E00

Threshold settings above
or below the optimum
increase the standard
deviation of the replicate
groups.

Threshold Set Too Low \

The threshold is set below 01
the exponential phase of
the amplification curve.
The standard deviation is bk B
significantly higher than aont {{gFAAEA
that for a plot where the oo SV I
threshold is set correctly. VI
Drag the threshold bar up oo
into the exponential phase

of the curve.

Threshold Set Too High \

The threshold is set above 04
the exponential phase of
the amplification curve.
The standard deviation is
significantly higher than oot {jf
that for a plot where the
threshold is set correctly. i
Drag the threshold bar i
down into the exponential
phase of the curve.

ARN

VIV

0.001 {58

0.0t

& :
L ooo

ooooot {1
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Assess amplification results using the Amplification Plot

e Correct baseline values

Baseline Set Correctly 1

The amplification curve
begins after the maximum 01
baseline. 001

ARN

0001
0.0001 {1

|
0.00001 1}

0.000001

Baseline Set Too Low 10

The amplification curve
begins too far to the right o
of the maximum baseline. 001
Increase the End Cycle &
value.

AR

0.001
0.0001 {f

0.00001

0.000001
2 04 B B 10 12 14 W@ 1@ oMW 2 oM M ON N OB M N W L

Cycle
Baseline Set Too High . n

The amplification curve ;
begins before the o1 g
maximum baseline. ..
Decrease the End Cycle
value.

ARR

0.001

0.0001

0.00001

0.000001

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve Cy precision by omitting wells” on page 68).

Or
* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 63).
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Section 5.1 5
Assess the gene expression profile using the Gene Expression Plot

Assess the gene expression profile using the Gene Expression
Plot

The Gene Expression Plot screen displays the results of relative quantification
calculations in the gene expression profile. There are two plots available:

¢ RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the linear, log10, Ln,
and log?2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

" Plot Sattings

Plot Type: RQ vs Target s Graph Type: Linaar (= Oriantstion: [Vartical Bars

[ Sawe current: sattings as the defaul:

‘&
g

]
&

RQ vs Target

8.0
58
541G
5.0
&

4.0

e

RO
5

1.503

1
1.0 BE1S
el i
a.e

o
Targst
|—.—P-‘E_-mn W seare I wodney I Cher
Well Summary: I Rles 384 SetUp: 152 Anehyzad: 163 Flagged:= 0 nted by Anakess Owntad Kanuslt Samplas ed; 4 Targete Used: T
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Assess the gene expression profile using the Gene Expression Plot

* RQ vs Sample — Groups the relative quantification (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the linear, log10, Ln,
and log?2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Gene Expression t4
(" Plat Settings

Mot TTJS'-:HQ w5 Sample | Graph Type: El_ir\nar v ?O.—-eﬂ:suun: ertical Bars -

[[1%ave current settngs as tha defauk

RQ vs Sample

R
a

1oy 0,813
N - -
na

= o

Bampla

e
W rs

wall sSummary: In Pisks: 354 Sab U 102 Brahsd: 102 Flsgzrasi: ) ot iy Anahyms: [ Eimttacl Marvaty: | Saryeles Linsdd:= 4 Targeis Lissdd: 2

Example experiment values

Review each target in the Gene Expression Plot screen for the expression level (or fold
change) of the target sample relative to the reference sample.

View the Gene Expression Plot

1. From the Experiment Menu pane, select Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen:
a. From the Plot Type drop-down menu, select RQ vs Sample.
b. From the Graph Type drop-down menu, select Log10.

c. From the Orientation drop-down menu, select Vertical Bars.

3. Click [~ Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Identify well problems using the Well Table

In the example experiment, the expression level of FAS in heart, kidney, and liver is
displayed relative to its expression level in the reference sample (brain). Since the
reference sample is compared to itself, the relative expression level is 1. When the
result is displayed in the Log10 graph type, the expression level of the reference
sample appears as 0 in the graph (log10 of 1 =0).

<
Plot Settings
....... — ——— - 1
Plat Type: RO ws Sample v Graph Type: Logl = Qrentation:[Vartical Bars - ‘
| [ Save currant settings a5 the dafauk |
2P A KE I
RQ vs Sample
080
ey oToe
a.7o 4
0.5
o.en
0.66 1
0.50
048
E =X [
o os3s
g aan
0.26 1
D0.205
0.20
uis
o
0.0 1
oo | y
005
R AL 005
4
o & & T
Sample
e
|
Wall Symmary; In Pizten 384 Satup 102 Anziyzeds 197 Faggad: () Otz e Anafyss: Ombed Manuaty: [} Samples Usod:= 4 Targets Usedi 2

Assessing the gene expression plot in your own experiments

When you analyze your own Relative Standard Curve experiment, look for differences
in gene expression (as a fold change) relative to the reference sample.

Identify well problems using the Well Table

The Well Table displays data for each well in the reaction plate, including:

* The sample name, target name, task, and dyes
® The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity
values

Flags

Example experiment values and flags

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct

Experiments

Review the Well Table to evaluate the Ct precision of the replicate groups.
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Identify well problems using the Well Table

View the well table

1. From the Experiment Menu pane, select Analysis » Amplification Plot, then click
the Well Table tab.

2. From the Group By drop-down menu, select Replicate.

3. Look at the Ct SD column to evaluate the Ct precision of the replicate groups. In
the example experiment, the Ct SD have the expected value of <0.5.

Group By ¥ Expand &l B ol

Sample Na... | Target Name Quantity | Normaliz... Efficiency
Brain - FAS - UN
205 113 I UMEMOWN FAM-MFO-MGE 1,058,359
206 114 r Fas UNKMOWN FaM-MNFO-MGE 29,199 20.182 0.059 | 1,010.662 1.04 9O7.612
207 115 r Fas UNEMOWN FaM-MNFOQ-MGE 20,139 20.182 0.059 | 1,052.721 1.04 97.612
208 116 r Fas UMNEMOWIN FAM-MNFQ-MGE 29,156 29,182 0.052 | 1,040,639 1.04 07.612
209 117 r F&S UMEMOWN FAM-MNFOMGE 29,066 29,182 0.059 | 1,108,298 1.04 97,612
210 118 r Fas UNEMOWN FaM-MNFO-MGE  29.186 20.182 0.059 | 1,019.635 1.04 9O7.612
211 119 r F&s UMEMOWIN FAM-MFQ-MGE 29,16 209,182 0.059 | 1,037.892 1.04 o7.612
212 120 I F&S5 UMNEMOWN FAM-MNFOMGE 20,2 29,182 0.059 | 1,009,953 1.04 907,612
213 121 r F&S5 UMEMOWN FAM-MFOMGE 29,222 29,182 0.058 995,076 1.04 97.612
214 122 r Fas UNEMOWN FaM-MNFO-MGE 20,204 20.182 0.059 | 1,007.341 1.04 9O7.612
215 123 r F&s UMEMOWIN FAM-MNFQ-MGE 29,305 209,182 0.052 940,462 1.04 o7.612
216 124 I F&S UMEMOWY FAM-MNFOMGE 29,217 29,182 0,059 098,492 1.04 97,612
277 L13 r Erain HFRT UNEMOWN VIC-NFQ-MGE 300252 30.438 0.205 475.135 g7.858
278 L14 r Erain HFRT UMNEMOWIN VIC-NFQ-MGE 20,681 30,438 0.205 362.578 g87.858
279 L15 I Erain HFRT UMEMOWN WIC-MFQ-MGE 30,201 30,438 0.205 490,889 87,658
280 L16 r Erain HFRT UNKMOWN YIC-NFQ-MGE  30.265 30.438 0.205 471.341 §7.858
281 L17 r Erain HFRT UNEMOWN VIC-MNFQ-MGE  30.352 30.438 0.205 446.114 g87.858
282 L18 r Erain HFRT UMNEMOWIN VIC-MNFQ-MGE 30,232 30,438 0.205 481.19 g87.858
2683 L19 r Erain HFRT UMEMOWN WIC-MFQ-MGE 30,746 30,438 0.205 348.027 87,658
284 L20 r Erain HFRT UNEMOWN YIC-NFQ-MGE 300312 30.438 0.205 457.733 57.858
285 L21 r Erain HFRT UMEMOWIN VIC-NFQ-MGE 20,68 30,438 0.205 262.814 g87.858
286 L22 I Erain HFRT UMNEMOWN WIC-NFQ-MGE 30,422 30,438 0.205 426,906 87,658
AT 122 4| mul Przirm HCORT T IRIERICh AR WTTRIET RGP M 420 il =i n2ns 4’i'§ na a7 asa _’l;l
well Summary: In Plate; 354 Set Up: 192 Analyzed: 192 Flagged: Cmitted by Analysis: 0 Cmitted Manually: 0 Samples Used: ¢ Targets Used: 2

Note: To show or hide columns in the Well Table, select or deselect respectively the
column name from the Show in Table drop-down menu.

Assessing the well table in your own experiments

When you analyze your own Relative Standard Curve experiment, look for standard
deviation in the replicate groups (Ct SD values). If needed, omit outliers (“Improve Cy
precision by omitting wells” on page 68).
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Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose

In the Relative Standard Curve example experiment, you review the Multicomponent
Plot screen for:

e ROX™ dye (passive reference)

» FAM" dye (reporter for RNase P)

* VIC® dye (reporter for IPC)

* Spikes, dips, and/or sudden changes

* Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent
Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click i Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Confirm accurate dye signal using the Multicomponent Plot

5. Check the FAM and VIC dye signals. In the example experiment, the FAM and
VIC dyes signal increase throughout the PCR process, indicating normal
amplification.

Multicomponent Plot
Plot Settings

Plot Color |Dye vl —
™ Save current settings as the default 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

= 'y o . 5 A
s P iy &2 &y i
B
Multicomponent Plot [P 5 5 5 5 5 o
550,000 -
D
500,000
E
450,000 y
400.000 F_
@ 350,000 : G
2 i
& 300,000 { = = H
£ asuom0 | & = 1 8 3 3 3 o ol ol ol ol e ol |
2 ——

200,000

150,000 —

100,000 —

50,000

s}
a2 4 & & W 12 14 18 @ N 2 M B W W B M B M 40 2

Cycle
Legerd [P [P o o o o o o P P P P P P P P P P P P P P P P
M For ROy IO
wels: [ 96 [ 80 [ 16 192 Ermpty
well Summary: In Plate: 384 Set Up: 192 Analyzed: 192 Flagged: 0 Omitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

6. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process indicating typical data.

7. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in any of the negative control wells.

Multicomponent Plot
Plot Settings

Plot Color |Dye hd l

I Save current settings as the default 1 2 3 4 5 6 7 8|9 |10[10|12 |13 |14 |15 |16 |17 |18 |19 |20 |21 |22 |23 |24
. . _ (= = = = = = s s s s s s (s (s =]

£ P a8l ]

= = N :

Multicomponent Plot

= 0= 0= = = = 0= = 0= = = i= = 0= = 0= = s fs fs s s s = ]
550.000
o P O P O O 9 '3 3 [ 3 [ [ N 1 I s
400,000

350,000

300,000

250,000

Fluorescence

200,000

150,000

100,000

50,000

0 il R S | S | | S |

0z 4 4 & 0 12 14 18 1@ N 2 ¢ ¥ M N B M ¥ M 4 2

o O|2|3‘-—|x|._.|-—- :\:|m|-n|rn|o|m|m :ol

Cycle
Leged rlﬂﬂﬂﬂﬂﬂﬂ'r’ﬂﬂﬂmﬂmﬂmﬂﬂﬂﬂﬂﬂﬂ
W Fa ErOx I vIC
will: [ o6 [5]80 [ 16 192 Empty
well Summary: In Plate: 384 Set Up: 192 Analyzed: 192 Flagged: Ornitted by Anabysis: 0 COmitted Manually: 0 Samples Used: 4 Targets Used: 2
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Determine signal accuracy using the Raw Data Plot

Tips for confirming dye accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for:
* Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Relative Standard Curve example experiment, you review the Raw Data Plot
screen for a stable increase in signal (no abrupt changes or dips) from the appropriate
filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click E Show a legend for the plot (default). The legend displays the color code
for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).
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Determine signal accuracy using the Raw Data Plot

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot
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The filters used for the example experiment are:
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View the endogenous control profile using the QC Plot

Tips for determining signal accuracy in your own experiment

When you analyze your own Relative Standard Curve experiment, look for the
following in each filter:

¢ Characteristic signal growth

* No abrupt changes or dips

View the endogenous control profile using the QC Plot

In the Relative Standard Curve experiment, the QC Plot screen displays the
Endogenous Control Profile plot for all the targets in the experiment. The QC Plot
serves as a tool to help users choose the best endogenous control for that experiment.
The endogenous control profile plot is a visual display of the Cr level of the
endogenous control across the sample. You can view up to four endogenous controls
at a time. The sample is plotted on the X-axis, and the Cr is plotted on the Y-axis. The
expression is viewed as a color and shape combination in the plot. Endogenous
controls are also known as reference genes.

To view the QC Plot:

1.

From the Experiment Menu pane, select Analysis » QC Plot.
Note: If no data are displayed, click Analyze.

In the QC Plot screen, click Target Table to select a target to profile:

a. In the Candidate Control column, select the check box of the target of the
endogenous control profile to plot. In the example experiment, the
endogenous control is HPRT.

b. Select a color from the Color drop-down menu.

c. Select a shape from the Shape drop-down menu.
Click the View Replicate Results Table.
Select the check box of the samples you want to plot.

Click [= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Review the QC flags in the QC Summary

The QC Plot in the Relative Standard Curve example experiment looks like this. Note
that the endogenous control, HPRT is expressed at the same level in all the four
samples:

Target Table

- o . . =— ¥ Candidate Control | Target | Color Shape
£ P BB = s .
2 HPRT I | 2] I~ |

Endogenous Control Profile

s '7/_'.\./-

cr

AV

View Replicate Results Table

Viiew Biclogical Groups

Brain Heart Kidney Liver
Sample Selected? Sample | Target | CT Mean ACT Mean |
Vv Kidney FAS 26,817 12,384 «
& FAS @ HFRT cd Heart FAS 20.525 1.966
i Liver FAS 28.49 3878 |
] e e e e YR
well Summary: In Flate: 384 Set Up: 192 Bnalyzed: 192 Flagged: 0 Ornitted by Analysis: Oritted Marwally: 0 Samples Used: 4 Targets Used: 2

This example experiment does not define Biological Groups.

Review the QC flags in the QC Summary

The QC Summary screen displays a list of the ViiA™ 7 Software flags, including the
flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is > 0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are no flagged wells.
3. In the Flag Details table, click each flag with a frequency > 0 to display detailed

information about the flag. In the example experiment, the Frequency column
displays 0 for all flags.

60 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
Experiments



Section 5.1
Review the QC flags in the QC Summary

4. (Optional) For those flags with frequency > 0, click the troubleshooting link to
view information on correcting the flag.

The QC Summary screen for the example experiment looks like this:

QC Summary <
Flag Details
Flag: Description Freguency Wells
AMPNC Arnplification in negative control o -
BADRCX Bad passive reference signal o
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard dewiation in replicate group o
MOAMP Mo amplification o
MNOTSE Moise higher than others in plate 0
SPIKE Mnise spikes 0
MOSIGNAL Mo signal in well 0
OUTLIERRG Cutlier in replicate group 0 |
EXPFAIL Exponential algorithm failed 0
BLFAIL Baseling algorithrn failed 0 -
Total wels: 334 | Processed wels: 192 Manually Omitted wiells: 0 | Targets Usad: 2
wiells Set Up: 192 | Flagged welks: 0 Analysis Omitted wlls: 0 | Samples Used: 4
Well Summary: In Plate; 204 Set Up: 102 Analyzed: 102 Flagged: 0 Cmitted by Analysis: 0 Crnitted Marwally: 0 Sarnples Used: 4 Targets Used: 2

Possible flags

The flags listed below may be triggered by the experiment data.

Flag

Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX . Bad passive reference signal

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed

BLFAIL Baseline algorithm failed

THOLDFAIL Thresholding algorithm failed

CTFAIL Cy algorithm failed
Secondary analysis flags

OUTLIERRG Outlier in replicate group
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For more information

Flag Description
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number
Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™7 System 4441434
Experiments.
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Section 5.2 Adjust parameters for re-analysis
of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options.

If the default analysis settings in the ViiA™ 7 Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then
reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
® (Cp Settings
¢ Flag Settings
¢ Relative Quantification Settings
* Advanced Settings
¢ Standard Curve Settings
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Adjust analysis settings

The Analysis Settings dialog box for a Relative Standard Curve experiment looks
like this:

Pl Analysis Settings for ViiA7_384-Well_Relative_Standard_Curve_Example

( i Flag Settings Relative Quantification Settings Advanced Settings Standard Curve Settings
of targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default
— Data Step Selection Algorithm Settings
Select the step and stage to use for Ct analysis. Only stage/step combinations for which data suitable for CT Select the algorithm to calculate Cr.
analysis have been collected are displayed.
Baseline Threshold
Stage 2, Step 2 (v
y
~— Default Ct Settings
Default CT settings are used to calculate the C1 for targets without custom settings. To edit the default settings, dick Edit Default Settings.
Threshold: AUTO  Baseline Start Cycle: AUTO Baseline End Cycle: AUTO
~— Select a Target ~— CT Settings for FAS
Target Threshold Baseline Start Baseline End Cr Settings to Use: Default Settings
FAS AUTO AUTO AUTO A
HPRT 0.04 AUTO AUTO l:l
v
Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings w

3.

View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis settings

Ct Settings * Data Step Selection
Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.
* Algorithm Settings
You can select the algorithm that determines the Ct values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.
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Adjust analysis settings

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.

¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

* Crp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the ViiA™ 7 Software.

To adjust the flag settings
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of C1 SD. For some flags, analysis results calculated before
the well is rejected are maintained.
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Adjust analysis settings

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

Flag Description Use Attribute Condition Value Reject Well
BMPRC ismplification in negative... 2 CT =z w |35 @
BADROY Pad passive reference si... I*2 Bad passive reference al... = - iD.S ]
BLFAIL Easeline algarithm faled 2 [
CTFAIL ICT algorithrn failed ¥ O
EXPFAIL Exponential algorithm fa... 2 |
OFFSCALE Fluorescence is offscale ¥ ]
HIGHSD High standard deviation ... 2 CT standard daviation = w» (0.5 | [
NOAMP Mo arnplification W~ Arnplfication algorithrm e, |« w !D.l | [0
NOISE Moise higher than other... 2 F.elative noise = - |4 @
SPIKE Moise spikes I*2 Spike algorithm result = w |I1 ]
MOSIGHAL Mo signal in wel 2 [
OUTLIERRG Outlier in replicate group W~ O
THOLDFAIL Thresholding dlgarithm f... 2 |

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings |

Relative Use the Relative Quantification Settings tab to:
Quantification » Change the type of analysis, singleplex or multiplex.
Settings .

Change the reference sample and/or endogenous control.
* Reject Outliers with ACy values less than or equal to the entered value.

Note: The Outlier Rejection settings apply only to multiplex reactions.

* Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.

Advanced Settings Use the Advanced Settings tab to change baseline settings well-by-well.
Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.
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Adjust analysis settings

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter

the baseline start cycle and baseline end cycle.

Standard Curve
Settings

Use this tab to review the settings of the current standard curve experiment or to
import the standard curve from an external experiment (with the same samples and
targets) and apply it to this current experiment.

Note: The run method must be the same. Applied Biosystems recommends using the

standard curve from the current experiment.

For the example experiment, the settings from the current experiment have been use

I'fl Analysis Settings for ViiA7_384-Wel

Ct Settings Flag Settings Relative Quantification Settings Advanced Settings

a standard curve from another experiment, click Import,

the standard curve plots For each target. To us

~—Dverride Standard Curve

@ Use the standard curve from this experiment

Import | Delets |

7 Use a standard curve imported from another experiment

—Standard Curve View
32.0 .

318 3 z
310 - T~

305 -
30.0 -
205 |

28.0

285 -

280 - e
275 L —

7.0 ]
.

100 i) 1000 10000

ird_Cury x|

d.

Reporter

Target

Slope

Y-Intercept

R Squared

Efficency(%)

FAM

FAS

-3.381

139,356

0,993

97612

WIC

HFRT

-3.652

40,028

0,933

27858

Save to Library Load from Library

Revert to Default Analysis Settings

Apply Analysis Settings
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Improve Cr precision by omitting wells

Improve Ct precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Cp precision, omit the outliers from the analysis.

Note: In the Relative Standard Curve example experiment, there are no outliers. No
wells need to be removed from analysis.
1. From the Experiment Menu pane, select Analysis » Amplification Plot.
Note: If no data are displayed, click Analyze.

2. Inthe Amplification Plot screen, select Ct vs. Well from the Plot Type drop-down
menu.

3. Select the Well Table tab, select replicates to omit:

4. In the Well Table:
a. From the Group By drop-down menu, select Replicate.
b. Look for outliers in the replicate group (make sure they are flagged).

. Select the Omit check box next to outlying well(s), as shown below.

Plate Layout

Expand &l =

205 113 r UNEMOWN FAM-NFQ-MGE 1,058.359

206 114 r Erain FAS UNEROWN FAM-MFQ-MGE 28,199 20,182 0058 1010662 1.04 97.612

207 115 r Erain FAS UMENOWN FAM-MNFOMGE 28,139 29,182 0058 1052721 1.04 97612

208 116 I Brain FAS UMKNOWN FAM-NFO-MGE 29,156 29,182 0059  1,040.639 1.04 97.612

209 117 r Brain FAS UNEMOWN FAM-NFO-MGE  29.066 29,182 0039  1,106.298 1.04 97.612

210 118 r Erain FAS UNEROWN FAM-MFQ-MGE 28,186 20,182 0058  1,019.635 1.04 97.612

211 119 r Erain FAS UMENOWN FAM-MNFQ-MGE 29,16 29,182 0058 1,037.892 1.04 97612

212 120 I Brain FAS UMKNOWN FAM-NFO-MGE  29.2 29,182 0059 1,009.953 1.04 97.612

213 121 r Erain FAS UNEROWN FAM-MFO-MGE 28,222 29.182 0.058 995.076 1.04 97.612

214 122 r Erain FAS UMW FAM-MNFQ-MGE 28,204 29,182 0058 1007341 1.04 97.612

215 123 r Erain FAS UMKNOW!N FAM-MNFO-MGE 29,305 20,182 0.058 040,462 1.04 07612

216 124 I Brain FAS UMKMNOWN FAM-NFO-MGE 29,217 29,182 0,059 998,492 1.04 97.612

277 L13 r Erain HPRT UMENOWN WIC-MNFQ-MGE 30,252 30,438 0.205 475,135 87.858

278 L14 I Brain HFRT UMKMOWN WICNFQ-MGE 20,681 30,432 0,205 362.578 87.858

279 L15 r Brain HFRT UNEMOWN WIC-NFQ-MGE 30,201 30.438 0,205 490,889 87.858

280 L16 r Erain HPRT UNEROWN WIC-NFQ-MGE 30,265 30.438 0.205 471.341 87.858

281 L17 r Erain HPRT UMENOWN WIC-NFQ-MGE 30,352 30,438 0.205 445,114 g27.858

282 L18 I Brain HFRT UMKNOWN WIC-NFQ-MGE 30,232 30.438 0,205 481.19 87.858

283 L19 r Brain HFRT UNEMOWN WIC-NFQ-MGE 30,746 30.438 0,205 348.027 87.858

284 L20 r Erain HPRT UNEROWN WIC-NFQ-MGE 30,312 30.438 0.205 457,733 87.858

285 L21 r Erain HPRT UMENOWN VIC-MNFQ-MGE  20.62 30,438 0.205 362.814 g27.858

286 L22 I Brain HFRT UMKNOWN WIC-NFQ-MGE 30,422 30.438 0,205 426,906 87.858

== ] A r Przim HORT TIRIRITATRL REArg NI W T =) an 4240 N 438 n2ns A’TI"—_. na a7 Asa _l;l

| »
well Summary: In Plate; 384 Set Up: 1092 Analyzed: 192 Flagged: 0 Omitted by Analysis: 0 Cmitted Marwally: 0 Samples Used: 4 Targets Used: 2
5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.
Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.
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Section 5.2
For more information

For more information on

Refer to

Part number

Amplification efficiency

Amplification Efficiency of TagMan® Gene Expression Assays

Application Note

127AP05-03
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For more information
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About Relative Standard
Curve Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

l

Chapter 5.

CHAPTER 6

Export Analysis Results

. Open the Relative Standard Curve example experiment file that you analyzed in

In the Experiment Menu, click E? Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

Select ViiA™7 Format.

Note: Select 7900 Format if you want to export the Clipped Data.

Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name ViiA7RSCexport

File Type *.txt

Export File Location

<drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments

Chapter 6

Export Analysis Results
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Your Export screen should look like this:

[~ Auta Export Format @ [Viia™ 7 hd Export Data To: @ One Fle ¢ Separate Files [~ Open file(s) when export is complete
Expart File LucatiUn:IC:\Apphed Biosystems\iiA7 Software v1.O\experiments Expart File Name:lVi\A?RSCexpm‘c File Type: IF_Z'E (*ut) LI

E] Amplification Multicomponent E] Tech, Rep. Results E] Bio. Rep. Results

[ sample Setup [ Raw pata

Select Content

Well Sample ... ITarget ... Task Reporter | Quencharl RQ | RQ Min | RQ Max | CcT | Ct M
¥ Al Fields = {1 F&5 NTC FamM NFQ-MGE Undetermi,.. -
= wel 2 Fas NTC Fam NFOQ-MGE Undeterri...

3 FAS NTC FAM NFE-MGE Undeterrmi...
¥ Sample Mame 4 FAS NTC FAM MNFOQ-MGE Undetermi...
5 FAS NTC FaM NFE-MGE Undeterri...
¥ Target Mame 5 FAS MTC FamM MFQ-MGE Undetermi...
7 FAS NTC FaM NFQ-MGE Undetermi...
¥ Task 5 FAS NTC FaM NF)-MGE Undeterrmi..
¥ Reporter 9 FAS STANDARD  FAM NFQ-MGE 20,885 29,922
10 FAS STANDARD  FAM NFE-MGE 29,937 20,022
¥ Quencher 11 FAS STANDARD  FAM NFQ-MGE 20,839 29,922
12 FAS STANDARD FAM NFE-MGE 29,981 29,922
¥ RQ 13 FAS STANDARD  FAM NF-MGE 20,817 20,022
) 14 FAS STANDARD FAM NFQ-MGE 29,877 20,022
¥ RQ Min 15 FAS STANDARD  FAM NFQ-MGE 29,963 20,022
¥ RQ Max 16 Fas STANDARD FAM NFOQ-MGE 29,975 29,922
17 FAS STANDARD FAM NFE-MGE 27.842 27.883
wcT 18 FAS STANDARD  FAM NF-MGE 27,84 27,383
19 FAS STANDARD FAM NFE-MGE 27.952 27.863
¥ Ct Mean 20 FAS STANDARD  FAM NF)-MGE 27,895 27,883
21 FAS STANDARD FAM NFQ-MGE 27.887 27.983
¥ CtsD il =] FAS STANDARD  FAM NF)-MGE 27.926 27,383
¥ Quantity 23 Fas STANDERD FAM NFQ-MGE 27,909 27,383
24 FAS STANDARD  FAM NFE-MGE 27,812 27.883
% Quantity Mean 49 FAS STANDARD  FAM NFQ-MGE 30,082 30,917
50 FAS STANDARD FAM NFE-MGE 30,991 30,917
¥ Quantity 5D 51 FAS STANDARD  FAM NF-MGE 31012 30,917
52 FAS STANDARD FAM NFQ-MGE 30,853 30,917
¥ Automatic Ct Threshold 53 F45 STANDARD  FAM HFQ-MGE 30877 30,917
54 Fas STANDARD FAM NFOQ-MGE 30,02 30,917
B4 Ct Threshold 55 FAS STANDERD FAM NFQ-MGE 30.945 30917 7|
¥ A stnmatic Rasaline d 4 | L4

W Save Export Set As || Load Export Set

Your exported file when opened in Notepad should look like this:

=
Flle Edit Format  Wiew Help
* Block Type = 384-Wall Block -
* Calibration Expired = No
™ Chemistry = TAQMAN
* Experiment File Mame = C:\Applied BiosystemsFinal ¥iiA7 Bxample
Data-Marl0, 20104RUOVVIIA7_384-Well _Relative_Standard _Curve_BExample.eds
* Experiment Mame = ViiA7_384-Well_Relative_Standard _Curve_Example
* Experiment Run End Time = 2009-12-10 20:2%:36 PM 50T
* Experiment Type = Relative Standard Curve
* Instrument Type = ViiA 7
™ Passive Reference = ROX
* Signal Smoothing On = false
* Stage/ Cycle where Analysis is performed = Stage 2, Step 2
[Results]
il Sample Name Target Mame Task Reporter Quencher CT Ct Mean Ct 3D CQuantity Quantity Mean
CQuantity 50 Automatic Ct Threshold Ct Threshald Automatic Baseline Baseline Start Baseline End
Customl Custom2 Custom3 Customd CustomS Customé
1 RMaze P NTC FAM MFO-MGCE Undeatermined True
0.1293  trus 3 39
2 RMase P MNTC FARM MFQ-MCEUndetarminad true
01293 trus 3 33
3 RMase P NTC FAM MFO-MGCE Undetermined true
01233 true 3 33
4 RMase P MNTC FARM MFQ-MCEUndetarminad trug
0.1293  trus 3 39
5 RMase P NTC Fah MFO-MGE Undetermined trus
01293 trus 3 33
[ RMase P MNTC FAM MFO-MGCE Undeatermined true
0.1293  true 3 34
7 RMaze P NTC FAM MFO-MGE Undetermined true
01293 trus 3 33
g RMaze P MNTC FAM MFO-MGCE Undsatarmined Trus
0.1293  true 3 E
9 RMase P STANDARD FAM MNFO-MGE29.7347 29.771e 00515 625 true
01293 trus 3 25
10 Rhase P STAMDARD Fam MFO-MCEZ23.7858 297716 0.0515 625 True
0.1293  trus 3 25
=
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Chapter 7

About Comparative Ct
Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

Design and Analyze a Gene
Expression Study

CHAPTER 7

About Comparative C; Experiments

This chapter covers:
B About Comparative Cpexperiments. .............. ..., 76

B About the example experiment .............. ... ... i i, 77

IMPORTANT! First-time users of the ViiA™ 7 System, please read Booklet 1, Getting

Started with ViiA™ 7 System Experiments and Booklet 7, ViiA™ 7 System Experiments -
Appendixes of this binder thoroughly. The booklets provide information and general
instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking ) in
the toolbar, or selecting Help » ViiA™ 7 Software Help.
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About Comparative Cr experiments

About Comparative C; experiments

The Comparative CT (AACt) method is used to determine the relative target quantity
in samples. With the comparative Cy method, the ViiA™ 7 Software measures
amplification of the target and of the endogenous control in samples and in a reference
sample. Measurements are normalized using the endogenous control. The software
determines the relative quantity of target in each sample by comparing normalized C
(ACr) in each sample to normalized Cy (ACry) in the reference sample.

Comparative C experiments are commonly used to:

* Compare expression levels of a gene in different tissues.
e Compare expression levels of a gene in a treated sample and an untreated sample.
* Compare expression levels of wild-type alleles and mutated alleles.

* Analyze the gene expression changes over time under specific treatment
conditions.

Assemble required components

PCR options

76

e Sample - The tissue group that you are testing for a target gene.

* Reference sample (also called a calibrator)- The sample used as the basis for
relative quantification results. For example, in a study of drug effects on gene
expression, an untreated control is an appropriate reference sample.

¢ Endogenous control — A gene that is used to normalize template input
differences, and sample-to-sample or run-to-run variation.

¢ Replicates — The total number of identical reactions containing identical
components and identical volumes.

¢ Negative controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

When performing real-time PCR, choose between:

¢ Singleplex and multiplex PCR (below)
and
* 1-step and 2-step RT-PCR (page 77)
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About the example experiment

Multiplex PCR ¢ Singleplex PCR - In singleplex PCR a single primer and probe set is present in
the reaction tube or well. Only one target or endogenous control can be amplified
per reaction.

Or

* Multiplex PCR - In multiplex PCR, two or more primer and probe sets are
present in the reaction tube or well. Each set amplifies a specific target or
endogenous control. Typically, a probe labeled with FAM™ dye detects the target
and a probe labeled with VIC® dye detects the endogenous control.

Singleplex and You can perform a PCR reaction using either:

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

o O Em [ Target Primer Set
L]
o 3 ©o (O Endogenous Control
~ Primer Set
. ~~ cDNA
Singleplex PCR Multiplex PCR
1- and 2-Step RT- You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
PCR separate reactions (2-step). The reagent configuration you use depends on whether

you are performing 1- or 2-step RT-PCR:

¢ 1-step RT-PCR- In 1-step RT-PCR, RT and PCR take place in one buffer system.
Using one buffer system provides the convenience of a single-tube preparation
for RT and PCR amplification. However, you cannot use Fast PCR Master Mix or

the carryover prevention enzyme, AmpErase® UNG (uracil-N-glycosylase), to
perform 1-step RT-PCR.

¢ 2-step RT-PCR- 2-step RT-PCR is performed in two separate reactions: First, total
RNA is reverse-transcribed into cDNA, then the cDNA is amplified by PCR. This
method is useful for detecting multiple transcripts from a single cDNA template
or for storing cDNA aliquots for later use. The AmpErase® UNG enzyme can be
used to prevent carryover contamination.

About the example experiment

To illustrate how to perform comparative Cy experiment, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with the ViiA™ 7 System.

The objective of the comparative Ct example experiment is to compare the expression
of GH1, LPIN1, LIPC, GAPDH, and ACTB in liver, heart, brain, and lung tissues.

® The samples are liver, heart, lung, and brain tissues.

* The targets are GH1, LPIN1, LIPC, GAPDH, and ACTB.

* The reference sample is brain.

¢ The endogenous control is ACTB.

* The experiment is designed for singleplex PCR, where the targets and
endogenous control assays are performed in separate wells.
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About the example experiment

* Reactions are set up for 2-step RT-PCR. The Invitrogen VILO Kit is used for
reverse transcription; the TagMan® Fast Universal PCR Master Mix is used for
PCR.

* Primer and probe sets are selected from the Applied Biosystems TagMan® Gene
Expression Assays product line:

— GH1 Assay Mix: Hs00236859_m1

— LPIN1 Assay Mix: Hs00299515_m1
— LIPC Assay Mix: Hs00165106_m1

— GAPDH Assay Mix: Hs99999905_m1
— ACTB Assay Mix: Hs99999903_m1

78 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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CHAPTER 8

Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.
About Comparative Cy

Experiments This chapter covers:
B Define the experiment properties. ........... ... ... i 80
1 B Define targets, samples and biological replicates .......................... 81
B Assign targets, samples and biological groups ............. ... ... . oL 83
Chapter 8
B Setuptherunmethod........ ... ... .. 84
Design the Experiment . .
B Order materials for the experiment................... ... ... ... ..... 85
I B Tips for designing your own experiment ................................. 86
B For more information. .......... ... oo 87

Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more

Prepare the Reactions information on Auto Export, refer to Chapter 1in Booklet 1, Getting Started with ViiA™
7 System Experiments.

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

Design and Analyze a Gene
Expression Study
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Define the experiment properties
Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
ViiA™ 7 Software. Enter:

Field or Selection Entry
Experiment Name ViiA7_384-Well_Comparative_Ct_Example
Barcode Leave field empty
User Name Example User
Comments Comparative Cy example
Block 384-Well Block
Experiment Type Comparative Ct (AAC)
Reagents TagMan® Reagents
Ramp speed Fast

Save the experiment.
Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* BExpariment Nama: WIAT_384-Well_Comparative Gl Esample Comments: | Comparatie CT example

‘ Vg 364 well Block Array Card lock [ 96 well Block (0.2mt) ( Tast 96 Wedl Black (0.1mL)

What type of experiment do you want to set up?

‘ Standard Curve ] | Ralative Standard Curva i Comiparative C7 (AACT) h { Malt Curve

GanotyEmg Prosenc Absencn

Which reagents do you want to use to detect the target sequence?

‘ ( Taql“l.ama R.eagenrj SYIRE: Green Reagents other

What properties do you want for the instrument run?
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Define targets, samples and biological replicates

Define targets, samples and biological replicates

Click Define to access the Define screen. Enter:

1. Targets
Target name Reporter Quencher Color
ACTB FAM NFQ-MGB [ |
GAPDH FAM NFQ-MGB [}
GH FAM NFQ-MGB  m
LPIN1 FAM NFQ-MGB
LIPC FAM NFQ-MGB [}
2. Samples
Sample Name Color
Brain [
Lung [ |
Liver [
Heart

3. Dye to be used as a Passive Reference

ROX

4. Analysis Settings

Field Select
Reference Sample Brain
Endogenous Control ACTB

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct
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Define targets, samples and biological replicates

Your Define screen should look like this:

Samples

Save to Library Import from Library Mew Save to Library Import from Library Celete

Target Name Reporter Quencher Color Sample Name Color

ACTB FaM « |nFg-mas vh | [Brain ‘_ v
(GAPDH FaM « |nFg-mas vh v [Luna ‘_ v
(GH1 FAM « [NFQ-mGB vh ol fuwver ‘_ v
LPINL FaM « |nFg-mas vI v | [eart ‘l v
LpC Fal « |nFq-mes vh v

Biological Replicate Groups Analysis Settings

Mew

Biological Group Name Color Comments

Reference Sample: [Brain v
Endogenous Control: [ACTE v

Passive Reference

ROX -
Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.
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Assign targets, samples and biological groups

Assign targets, samples and biological groups

Click Assign to access the Assign screen. Enter the targets and samples:

Target name Well number Task S:::::e
ACTB A1, A2, A3 Unknown Brain
C1, C2, C3 Unknown Heart
E1, E2, E3 Unknown Lung
G1, G2, G3 Unknown Liver
A24 Negative None
GAPDH A5, A6, A7 Unknown Brain
C5, C6, C7 Unknown Heart
E5, E6, E7 Unknown Lung
G5, G6, G7 Unknown Liver
C24 Negative None
GH1 A9, A10, A11 Unknown Brain
C9, C10, C11 Unknown Heart
E9, E10, E11 Unknown Lung
G9, G10, G11 Unknown Liver
E24 Negative None
LPIN1 A13, A14, A15 Unknown Brain
C13, C14, C15 Unknown Heart
E13, E14, E15 Unknown Lung
G13, G14, G15 Unknown Liver
G24 Negative None
LIPC A17, A18, A19 Unknown Brain
C17, C18, C19 Unknown Heart
E17, E18, E19 Unknown Lung
G17, G18, G19 Unknown Liver
124 (Row |, Column 24) Negative None
Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 83
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Set up the run method

Your Assign screen should look like this:

Biohagical Groups

Set up the

84

EHENENENERE |

2 [a [ s |5 [& ]2 [6&[=2[wl[u 2 [ |18 [15 [ |7 | s
MEME. T I T e, M M. IETHEN TR T ma
- i . [T T T [T T T Me! M. Mk YIRS [T T ma
e [EOEE e o000 Ceceos rm
T T T T T T T T3 [T m=. e O lu Ju Ju i
1 |
J_ I
— K
o
wists: [T] 60 [ 5 318 Erpty
run method

Click Run Method to access the Run Method screen. Set the thermal profile under the

Graphical View tab. Enter:

¢ Reaction Volume Per Well: 10ul

e Thermal Profile

Ramp

Stage Step rate Temperature Time
Hold Stage Step 1 1.9 °C/s 95°C 20 seconds
PCR Stage . Step 1 1.9 °C/s 95°C 1 second
Number of Cycles: 40 . Step 2 1.6 °C/s 60°C 20 seconds

Enable AutoDelta:
Unchecked (default)

Starting Cycle: Disabled
when Enable AutoDelta is
unchecked

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Your Run Method screen should look like this:

Chapter 8

Order materials for the experiment

Reaction volume per well: | 10 L

Save Run Methad

100 °C__|

75 0|

0 °C__|

25 °C |

Hold Stage PCR Stage
MNurmber of Cycles: |4D i’
[T Enable AutoDelta
Starting Cycle: |1 3:
935.0 °C 95.0 *C
020 L°C/s  anni \
1E20)s
60.0 =C
8k 020
Stepl Stepl Stepz

4

’— Legend

Data Collection On -~ =

Data Collection Off A AutoDelta Cn A AutoDelta Off

Order materials for the experiment

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct
Experiments

The recommended materials are:

MicroAmp® Optical 384-Well Reaction Plate

MicroAmp® Optical Adhesive Film
TagMan® Fast Universal PCR Master Mix (2X), No AmpErase® UNG
GH1 Assay Mix: Hs00236859_m1
LPIN1 Assay Mix: Hs00299515_m1
LIPC Assay Mix: Hs00165106_m1

GAPDH Assay Mix: Hs99999905_m1

ACTB Assay Mix: Hs99999903_m1
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Tips for designing your own experiment

Your Materials List screen should look like this:

Find Assay

Enter Geng Name |

T e Enter a gene name, then click Find Assay to search the Applied Biosystems Store for a gene expression assay.

Experiment Materials List

Add Selected Items to Shopping List Display @ Jall Ttems LI
[~ Check al Item Fart humber Description

Includes 10 x PfM M8080234, TagMan® Reverse Transcriptase Reagents. i’

- TagMani® Rewerse Transcription Reagents (10 Pack) 4304134 Sufficient for 2000 Reverse Transcriptase reactions at 10 plL reaction
volume,
An optically-clear aghesive film used to seal the samples into the wells of a

[l Micro&mnp™ Optical Adhesive Fim (100 films) 4311971 oe-wel microplate, This will reduce the possibility of cross-contamination
betwesn sample wels and help ensure consistent Real-Time PCR data,
Tha Mirradran™ Molb_Rarmmwal Tanl malac it aacdar e rarnewa cane feamn X

Experiment Shopping List (3 items)

Remove Selected Items from Shopping List

Shopping Basket MName I\IiiA? 394 Wiell Comparativ Basket | Order Mate t

[~ check &l Ttem Part: humber Quantity
r TagMand® Fast Universal PCR Master Mix (2X), No... 4352042 1
r Microsmp™ Optical Adhesive Fim (25 films) 4360954 1
r Protocol: High Capacity RMA-to-cDMA Master Mix 4377474 1

Tips for designing your own experiment
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Applied Biosystems recommends that you:

Identify each target assay with a unique name and color. You can enter up to 100
characters in the Target Name field.

Identify each sample using a unique name and color. You can enter up to 100
characters in the Sample Name field.

Select an endogenous control for each sample. The endogenous control is a target
that is present in all samples under investigation. It should be expressed equally
in all sample types, regardless of treatment or tissue origin (examples of
endogenous controls are B-actin, GAPDH, and 18S ribosomal RNA [185 rRNA]).
The endogenous control is used to normalize the PCR results; the endogenous
control corrects for variable sample mass, nucleic acid extraction efficiency,
reverse transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple
tissues) requires an endogenous control.

— If samples are spread across multiple plates, each plate must have an
endogenous control. Additionally, every plate must include an endogenous
control for every sample type on the plate.

Select an endogenous control from your previously defined target assays.
Amplification results from the endogenous control are used to normalize the
amplification results from the target for differences in the amount of template
added to each reaction.

Select a reference sample from your previously defined samples. Amplification
results from the samples and from the reference sample are compared to
determine relative expression.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Chapter 8
For more information

For more information on Refer to Part number
Consumables Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 4LLA1434
System Experiments
Appendix A in Booklet 7, ViiA™ 7 System Experiments
- Appendixes
Using the Standard Curve quantification | Booklet 2, Running Standard Curve Experiments. 4441434
methods
Using the relative standard curve Part 1 of this booklet 4441434
quantification method
Selecting an endogenous control Application Note Using TagMan® Endogenous Control 127AP05-03
Assays to Select an Endogenous Control for
Experimental Studies
Reference samples (also known as User Bulletin #2: Relative quantification of Gene 4303859
calibrators) and endogenous controls Expression
Using alternative setup Chapter 2 in Booklet 1, Getting Started with ViiA™ 7 4441434

System Experiments
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For more information
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CHAPTER ¢

Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Comparative Cy

(AACt) example experiment.
About Comparative Cy

Experiments This chapter covers:
B Assemble required materials .......... ... . i 90
Preparethetemplate ........ ... ... ... 90
B Prepare thesampledilutions .............. ... . ... o il 90
B Prepare the reaction mix (“cocktail mix”)........... ... ... L. 91
Design the Experiment .
B Prepare thereactionplate.............. ... ... ...l 92
B Tips for preparing reactions for your own experiments. . ................... 93
1 B For moreinformation. .......... ... .. i e 93
Chapter 9
Prepare the Reactions
Run the Experiment
Review Results and Adjust
Experiment Parameters
Export Analysis Results
Design and Analyze a Gene
Expression Study
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Assemble required materials
Assemble required materials

e Items listed in Booklet 1, Getting Started with ViiA™ 7 System Experiments
e Samples - Total RNA isolated from liver, heart, brain, and lung tissues.
¢ Example experiment reaction mix components:

- TaqMan® Fast Universal PCR Master Mix (2X.)

— ACTB Assay Mix (20X)

— GAPDH Assay Mix (20X)

- GHI1 Assay Mix (20X)

— LIPN1 Assay Mix (20X)

— LIPC Assay Mix (20X)

Prepare the template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse
Transcription Kit or one of the Invitrogen VILO kits to carry out the reverse
transcription.

Example experiment settings
For the Comparative Cp example experiment, the template for the PCR reactions is

cDNA reverse-transcribed from total RNA samples using one of the Invitrogen VILO
kits, SuperScript® VILO™ cDNA Synthesis Kit (PN 4453650).

Prepare the template

Use the Invitrogen VILO Kkits to reverse-transcribe cDNA from the total RNA samples.
Follow the procedures in the Invitrogen VILO Kits Protocol (PN 100002284) to:

1. Prepare the RT master mix.
2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Prepare the sample dilutions

For the Comparative Cp example experiment, no more than 10% of your reaction
should consist of the undiluted RT product.

1. Label a separate microcentrifuge tube for each diluted sample:
e Liver
¢ Heart
¢ Brain

* Lung

90 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Prepare the reaction mix (“cocktail mix”)

Chapter 9

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample name Diluent volume (pL)
1 Liver 19
2 Heart 19
3 Brain 19
4 Lung 19

3. Add the required volume of cDNA sample stock (100 ng/uL) to each empty tube:

Tube Sample name Volume (pL)
1 Liver 1.0
2 Heart 1.0
3 Brain 1.0
4 Lung 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:

e ACTB Reaction Mix

e GAPDH Reaction Mix
¢ GHI1 Reaction Mix

e LPIN1 Reaction Mix

e LIPC Reaction Mix

2. For the ACTB assay, add the required volumes of each component to the ACTB

Reaction Mix tube:

Component

Volume (pL) for 1

Volume (pL) for 13
reactions (plus

reaction 10% excess)
TagMan® Fast Universal PCR 5.0 75.0
Master Mix (2X]
ACTB Assay Mix (20X) 0.5 7.5
Water 3.5 52.5
Total Reaction Mix Volume 9.0 135.0

3. Mix the reaction mix in each tube by gently pipetting up and down, then cap each

tube.

4. Centrifuge the tubes briefly to remove air bubbles.
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Prepare the reaction plate

5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat steps 2 through 5 for the GAPDH, GH1, LPIN1, and LIPC assays.
Note: Do not add the sample at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Comparative Ct example experiment contains:
* A MicroAmp® Optical 384-Well Reaction Plate
* Reaction volume: 10pL/well
* The reaction plate contains:
— 60 Unknown wells
- 5 Negative control wells [
— 319 Empty wells

The plate layout for the example experiment looks like this:

Jul

~ | IETH T T [TH [T T [ S o P ) [ ITiiEs [ee (e |
e |

| T - [TI [T T [T [T [T M eer. | M e [ [TIES e [T = |
o]

e | T T T I T . o o | o o e ImiiEs [Tl s |
n
:ﬂ-ﬂ- [TIN [T T o | M er.. | M e [T .. U] [eer..
e

A =

[=]o]=T=]-]~T=

wels: [ 60 [ 5 319 Empty

To prepare the reaction plate components

1. Add 1pL of each cDNA to the appropriate wells.
2. Pipette 1L of sterile water into the NTC wells.

3. Add 8pL of the appropriate assay-specific cocktail to the wells.
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Tips for preparing reactions for your own experiments

4. Seal the reaction plate with optical adhesive film.

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

7. Until you are ready to perform the run, place the reaction plate at 4 °C, in the
dark.

Tips for preparing reactions for your own experiments

Tips for preparing templates

When you prepare your own Comparative Cp experiment, Applied Biosystems
recommends the following templates:

¢ Complementary DNA (cDNA) - cDNA reverse-transcribed from total RNA
samples.

¢ Genomic DNA (gDNA) - Purified gDNA already extracted from tissue or
sample.

Tips for preparing the reaction mix

If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.

Tips for preparing the reaction plate

When you prepare your own Comparative Ct experiment, make sure the arrangement
of the PCR reactions matches the plate layout displayed in the ViiA™ 7 Software.

For more information

For more information on... Refer to... Part
number
Assigning the reaction plate | Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System Experiments LLL1434
components
Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System Experiments LALLN434
Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 93

Experiments



Chapter 9 Prepare the Reactions
For more information
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About Comparative Cy
Experiments

Design the Experiment

Prepare the Reactions

!

Chapter 10

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

Design and Analyze a Gene
Expression Study

CHAPTER 10

Run the Experiment

This chapter explains how to run the example experiment on the ViiA™ 7 Instrument.
This chapter covers:
B Starttherun........ ... .. 96
B Monitortherun. ... ... .. 96

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.
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Start the run

Start the run

Monitor the run

. Open the Comparative Cy example file that you created using instructions in

Chapter 8.
Load the reaction plate into the instrument.

Start the run.

Monitor the example experiment run:

From the ViiA™ 7 Software using the Run screen, while the experiment is in
progress.

From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment
started from another computer or from the ViiA™ 7 Instrument touchscreen).

From the ViiA™ 7 Instrument touchscreen.

From the Instrument Console of the ViiA™ 7 Software

1. In the Instrument Console screen, select the instrument icon.
2. Click Manage Instrument or double-click on the instrument icon.
3. In the Manage Instrument screen, click Monitor Running Experiment to access
the Run screen.
96 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
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Monitor the run

View the You can view the progress of the run in real time. During the run, periodically view all
Amplification Plot the three plots available from the ViiA™ 7 Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells t to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Ampiification Plot <
|®
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View the Click Temperature Plot from the Run Experiment Menu.

Temperature Plot The figure below shows the Temperature Plot screen as it appears during the example

experiment.

Temperature Plot Current Temperatures

» p BB 2 B I [ cover
» P = B  Wlsarile
Temperature Plot Block

A

0
00:00:00 000410 0D:08:20 00:12:30  00:16:40 00:20:50  00:25:00 00:29:10 00:33:20 0037:30 004140 004550 005000 00:5410 00:58:20
Time
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&0
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R

20

10

Temperature Plot

Wiew 1 Hour -
Fixed Wigw [T

4 F

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
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Monitor the run

View the Run Click Run Method from the Run Experiment Menu.
Method . . :
The figure below shows the Run Method screen as it appears in the example
experiment.
Run Method Edit Run Method
adust # of Cycies: |
Hold Stage PCR Stage et R LyEes
Murmber of Cycles: |4D :’ I Add Melt Curve Stage to End
I Enable AutoDelta I Add Holding Stage to End
Starting Cycle: |1 : [T add Infirite Hold to End
o0:20 1e°cfs ooy \6
: : LE~2C
80.0 °C
9°Cfs 00:20
Stepl Stepl Stepz
4 »
Legend
Data Collection On = Data Collection Off A AutoDelta On A AutoDelta OFf
View Run Data Click View Run Data from the Run Experiment Menu.

Your View Run Data screen should like this:

Run Data Report

Experiment Mame: ViA7 Comparative Ct Example 1
Start Time: 10-01-2010 17:38:10 PDT
Stop Time: 10-01-2010 18:20:04 PDT

Run Duration: 41 minutes 53 seconds
User ID: DEFAULT

Instrument Name: Yankees_Rule

Firmware Version: 1.0.3

Software Version: ViiA7 Software v1.0.0

Instrument Serial Number: 278880012
Sample Volume: 10.0
Cover Temperature: 105.0

Block Type: 384-Well Block

Errors Encountered:
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Monitor the run

From the ViiA™ 7 Instrument touchscreen

You can also view the progress of the run from the touchscreen of the ViiA™ 7
Instrument.

The Run Method screen on the ViiA™ 7 Instrument touchscreen looks like this:

Experiment view ——————————

Experiment: 2010-03-11-232013

D Experiment View g;

Run Started: March 11 2010 - 11:20PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover: 105.0 °C
Heated Cover Set Point: 105.0 °C Time Remaining: 01:28:18

Time View )

@ | MyInstrument (384-well 20,1L) : ﬁ

Experiment: 2010-03-11-232013

Run Started: March 1172010 - 11:20PM Sample: 50.0 °C
Reaction Volume: 20 pL Stage /[ Step: 1 /1
Heated Cover Set Point: 105.0 °C Cycle: 1

Display Time: Remaiing () Elapsed

‘March 11 2010 - 11:20PM: Heated cover reached target temperature.
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Monitor the run
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Experiments

CHAPTER 11

Review Results and Adjust
Experiment Parameters

In Section 11.1 of this chapter you review the analyzed data using several of the
analysis screens and publish the data. Section 11.2 of this chapter walks you through
the process of modifying experiment parameters to troubleshoot problems with
experiment results before rerunning an experiment.

This chapter covers:

B Section11.1 Review Results ......... ..ottt 103
Analyze the example experiment. ............. ... ... . o i 103
Design the Experiment B Assess the gene expression profile using the Gene Expression Plot. ......... 103
B Identify well problems using the Well Table ............................. 105
B Assess amplification results using the Amplification Plot.................. 107
B Confirm accurate dye signal using the Multicomponent Plot............... 114
B Determine signal accuracy using the Raw DataPlot ...................... 116
Prepare the Reactions B View the endogenous control profile using the QCPlot ................... 118
B Review the flags in the QC Summary ........... ... ..., 119
B For moreinformation. .......... ... ... i 121
B Section 11.2 Adjust parameters for re-analysis of your own experiments .. 123
B Adjustanalysissettings.......... ... ... .. 123
un the Experiment B Improve Cy precision by omitting wells............................ . ... 127
!
Chapter 11
Review Results and Adjust
Experiment Parameters
'
Export Analysis Results
Design and Analyze a Gene
Expression Study
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SECTION 11.1

1 1 1 Section 11.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 10.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

Assess the gene expression profile using the Gene Expression
Plot

The Gene Expression Plot screen displays the results of relative quantification
calculations in the gene expression profile. There are two plots available:

* RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the linear, log10, Ln,
and log?2 graph types. The Gene Expression plot when viewed as a linear graph
type looks like this:

Plot Settings |

Plot Twa:!FlQ w5 Targat W |Graph Type; |Linear [ | Onientation:|Vertical Bars [

[iSave current setings as tha defaukk

RQ vs Target

oo § 530,871

RO
o
H

1 2.232 1.261 0174 1 1.053 o181 o2 1 0501 0.501 1 O.48d 0.84a3 a.3

aﬂf o K &

Target

-
W | Heat Eluve IlLng

Well Summarny: En Patan 384 Sat U 65 Anayzad: 65 Fagged: 3 Coriitteed bry Anabysis [} Conidthead Manuay e () Samples Used: 4 Targes Useds 5
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Assess the gene expression profile using the Gene Expression Plot

* RQ vs Sample — Groups the relative quantification (RQ) values by sample. Each
target is plotted for each sample. You can view the plot as the following graph
types: linear, log10, Ln, log2.

Gene Expression <
Plot Settings |

Fiot Type: BG us Sample [»| Graph Type: Linear a Orentation: Vertical Bars |

[l 5ave cument seftings as the default

AP a i =

RQ vs Sample

&60 4 s3gar

RQ

b 1 1 1 1 2.232 1083 a.501 0.40a 1.351 D1E1 o.AanE a174 one1l a1 0.z
o n
& o o &
Sample
- Lo
i. carod llevt Euec | e
Well Summany: In Plale: 354 54 Upt 65 Anatvzadi G5 Flaggad: 3 Cvitted By Anadvsis: [} Ot Manialy: [) Saniphes Usadi Targess Usadi 5

Example experiment values

Review each target in the Gene Expression Plot screen for the expression level (or fold
change) of the target sample relative to the reference sample.

View the Gene Expression Plot

1. From the Experiment Menu pane, select Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen, select:

Menu Selection
Plot Type RQ vs Sample (default)
Graph Type Log10
Orientation Vertical Bars

3. Click [~ Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Gene Expression
"~ plot Settings

Section 11.1 1 1
Identify well problems using the Well Table

In the example experiment, as shown below, the expression level of each target gene in
liver, heart, and lung is displayed relative to its respective expression level in the
reference sample (brain). Since the reference sample is compared to itself, the relative
expression level is 1. When the result is displayed in the Log10 graph type, the
expression level of the reference sample appears as 0 in the graph (log10 of 1 =0).

[l Save cumant sattings as tha default

PiOt Type: G us Sample | Graph Tyge: Lagl0 = Orentation: Vertical Bars [

200 |
)
&80 ¢
LR
xoa |
1.76 1
180
i.351
1.00 1
(R
0,50 ¢
p.2a
g

logl 0RO

oL R
-n.ag

75 |
-1.00+4

=
s
=
=

RQ vs Sample

al

Wl

£

8

N
;i

-0.529

~ L

Sample

I.GmPDH Wcit Wurec [em

wiell Summary: In Clele: 354

Assessing the gene expression plot your own experiments

Identify well problems using the Well Table

Set Uhp: 55 Arahaec: §5

* The sample name, target name, task, and dyes

Flagged: 3 Crmittac! by Anshyus: O

Samples Ussd: 4 Targets Lineci: 5

When you analyze your own Comparative Ct experiment, look for differences in gene
expression (as a fold change) relative to the reference sample.

The Well Table displays data for each well in the reaction plate, including;:

* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity

values
e Flags

Example experiment values and flags

Review the Well Table to evaluate the Ct precision of the replicate groups.
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Identify well problems using the Well Table

View the well table

1. From the Experiment Menu pane, select Analysis » Amplification Plot, then click
the Well Table tab.

2. From the Group By drop-down menu, select Replicate.
3. Look at the Ct SD column to evaluate the Ct precision of the replicate groups. In

the example experiment, there are three outliers. You will omit these wells in the
troubleshooting section (“Improve C precision by omitting wells” on page 127).

well | omit Flag Sample ... | Target ... | Task Dyes [y g CT Mean | CT 5D ACT ACT Me_.| ‘ACT SE AACT RO} RS Min BV

153 69 I GHL UHRHOWHN  FAM-HFO-.. 36.234 35.576 0642 16.385 0.374 2467 0.18L 0.088

134 Gl0 1 Livar GHL UHKNCOWWH  FAM-NFQ-... 34.951 35.575 0642 16385 0.379 TAET o.1a1 o.088

135 611 al Livay GHL UHKNOWH  FAM-NFQ-.. 23.543 35376 .642 16.385 0.379 2.467 0181 0083

ad VWelk

1. Al Ij Brain ACTH UNENDIWN - FAM-NFD-... 17.339 17.281 0.050

2 A2 | Brain ACTE UHEROWH - FAMARFG-.. 17245 17.281 0,050

2 M [ Bram ACTE UHERSWH  FAM-HFQ-.. 17.200 17281 0050

CEE |l

5. A5 1 Brain GAFDH UHKHOWH  FAM-HFG-... 17627 17631 a.oin 06345 0.030 0060 1.000 0245

6 AR @ Bram GAPDH UNKNOWH - FAM-NFG-., 17622 17.631 010 0,349 0. 030 (.00 1,000 0,945

7. AT ] Brain GAPDH UHKRHOWH  FAM-HFD-.. 17.642 17631 0.oLn 0349 0.030 0000 L.ooo 0.545

B AR (|

o AN ] Brain GH1 UHERCWH  FAMANEG-, . 31.215 33:200 0211 13819 0.135 0,000 L.000 0785

10 AlID 1 Brain GHL UHHNOWHN  FAM-NFQ-.. 31.403 31.200 0211 13919 0.125 o.oon L.aoo 0.786

1L ALY I: Brain GH1L UHKNOWH  FAM-HFQ-... 30.982 31200 (1535 § 13919 0125 0.000 1.000 0785

12 A12 ]

13 a1 ] Brzin LPINL UNKNOWHN  FAM-NFQ-.. 21,765 21819 1047 4.537 0,040 0000 L.000 n.ode

14 AI4 | 0 Brain LPINL UNKNOWH  FAM-NFQ-... 21 839 21.81% 0.047 4537 0.040 o.oon L.000 0926

15 415 Ll Brain LFHL UNKNGWN  FAM-NFG-... 21.853 21.819 0.047 4.537 0,040 1.000 1.000 0,926

16 AlG i

17 A7 "1 Brain LIPC UNHENDWH - FAM-NFD-... 29.293 29235 0.053 118953 0.042 0.0on L.oog 0922

18 ‘Al8 [ Brain IR UNKHOWHN  FAM-HFQ-... 28.224 20,235 0.053 11853 0.042 0.000 t.000 0522

19 Alg a Bran Lpc UHERCOWH FAMANFG-,, 20.188 20.235 0.053 11052 0.042 0,000 1,000 0922

2] AZD Ll

21 AN ]

2 a1 O

23| 1A23 il

29 A4 O ACTE NTC FAM-NFQ-... lindetermi_..

25 Bl O hd

B i |

Well Summary: In Piates 354 Sat Upa 65 Anatyzadi 65 Faggd: 3 Dvivittiat bry Anabysisi Citiad Manuaihvi [} Sanipis Ui 4 Targsls Usd: 5

Note: To show/hide columns in the Well Table, select/deselect the column name from
the Show in Table drop-down menu.

Assessing the well table in your own experiments

106

When you analyze your own Comparative C experiment, look for standard deviation
in the replicate groups (Ct SD values). If needed, omit outliers (see “Improve Cy
precision by omitting wells” on page 127).
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Assess amplification results using the Amplification Plot

Assess amplification results using the Amplification Plot

Amplification plots available for viewing

The Amplification Plot screen displays amplification of all samples in the selected
wells. There are three plots available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence signal generated
by the reporter at each cycle during the PCR amplification. This plot displays ARn
as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs Well — Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

Purpose
The purpose of viewing the amplification plot for the example experiment is to
identify:
* Correct baseline and threshold values
* OQutliers

View the Amplification Plot

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the LP1IN1 wells in the Amplification Plot screen:
a. Click the Plate Layout tab.
b. From the Select Wells drop-down menus, select Target, then LPIN1.
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Assess amplification results using the Amplification Plot

The Plate Layout screen should look like this:

.
.
[
.
| N I T I T [T in Aw 2w e
H
- s
]
n]
o]
e |
wels: [ 60 [ 5 319 Empty
‘Well Summary: In Plste: 384 Set Up: 65 Anzhyzed: §5 Flagged: 3 Omitted by Anahysis: 0 Omitted Manualhy: Samples Used: 4 Targsts Used: 5
3. In the Amplification Plot screen:, enter:
Menu Selection
Plot Type ARn vs Cycle (default)
Plot Color Well (default)
F Check (default)
(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)
4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.
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Assess amplification results using the Amplification Plot

. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.

Amplification Plot <
¢ Plot Settings

Plot Typa: &R ws C\i_:i Graph Type: Unea'_:l Plot Colorz|Well il

[T Save current sethings as the dafaul

2 LAl

Amplification Plot

1.2

144

140

=R

aa

av+ ——

a8 e

ARn
1
|
|

as- -

0.4 f,’)?..

a3+ # 2
-~

a2 -

-
a1+ //
i ] i ] 1 "

Options

Well Summary: In Fiste: 384 St iipi 65 mnahrad: 65 Faggedi 1 Ovevtted by Amabpsis 0 Ciimed Manualy O Sampiss Usad 4 Tangsts Ussd: 5

5. View the threshold values:

Menu Select

Graph Type Log
Target LPTN1

a. Select the Threshold check box to show the threshold.
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Assess amplification results using the Amplification Plot

b. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

Ampiification Plot <
Plot Settings |
Piot Typa: BFn s Cpole = Graph Type:log % Pk Color:[Wall -
7] smve curment setonos 35 tha oefauk
o T R TR e
£ P A ig i E
Amplification Plot
1EQT
1E0AQ
E a1
5" Lasnss
o.a1
oool =
H [ 3 a S T = 0 2 2 2 P Y iz B 5 3 o
Cycle
(" Options
Target: LPINL | Threshoid: [ Aute [0.081458 ] Auto Bassine
| Show: [#] Threshold — ] Hasal S Wel 8 Target o Basslng End: Wal M Tagat «.
wall Summary: I Dinbe: 354 Sat Lip= 65 birabyed: 65 Fagyged:3 Cirsithec by Brnatymic (] Cimibed Maruaty: 1 Sarrpien Lived: & Tarets Lived= 5

6. Locate any outliers:
a. From the Plot Type drop-down menu, select Cy vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for LP1IN1.

Amphfication Plot
/" Plot Sethtings

Plot Type:CT us Well ¥ | Graph Type: Piot Colors Vel w

[ Save current sethngs as the dafaut

P s A mR i

Amplification Plot

40.0 n

Cr

U I 50 AP0 930450 S S 370 P 7 0250 T S5 R OV 1T MR 2 0 S e B 2 P T TR S

Wl Mumbar

18R T SEr e I R 1) - SR ) 70 7 S

Well Summary: In iste: 334 et Up: 65 Anaiyzed: 65 Flagged: 3 Cmittad by Anshyme: O Cvittad Wanusiys 0 Samplas Ussdsd Targen Usedi 5
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Assess amplification results using the Amplification Plot

7. Repeat steps 2 through 6 for the GH1, TGFB1, LIPC, GAPDH, 18S, and ACTB
wells. In the example experiment, there is one outlier for 18S. You will omit these
wells in the troubleshooting section (“Improve Cy precision by omitting wells” on
page 127).

Tips for analyzing your own experiments

When you analyze your own Comparative Ct experiment, look for:

e Qutliers

* A typical amplification plot — The ViiA™ 7 Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a
typical amplification plot. A typical amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)
— Baseline
A typical amplification plot should look like this:

Amplification Plot £
(" Phot Settings:

Piot Tya: BRn vs Cycle = Graph Type:[og | Plot Calors [Wall =

[ save cument settngs &5 the defauk

Amplification Plot

1EQT

=7 LS ;

a J L] ] L 2 4 AL AL an a2 =1 ) £ m a2 R 3 >E 490
Cycle

("options ™
Targetz LPINL (s | Threshold: []Auto |3.061456 [[] Auto Baseine

it el 0 Target - Basefne End: Wel ‘M Target £

well Summary: In Pabe: 354 Set Up: B Arabped: 55 Flagged:3 Crrvitted by Anatyua: [ Omittec Marroalyy- ) Sl Laed: 4 Targets Usec: 5

IMPORTANT! Experimental error (such as contamination or pipetting errors)
can produce atypical amplification curves that can result in incorrect
baseline and threshold value calculations by the ViiA™ 7 Software.
Therefore, Applied Biosystems recommends that you examine the
Amplification Plot screen and review the assigned baseline and threshold
values for each well after analysis completes.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 111
Experiments



1 II Chapter 11 Review Results and Adjust Experiment Parameters
Assess amplification results using the Amplification Plot

e Correct threshold values

Threshold Set Correctly 1801

The threshold is set in the
exponential phase of the

e . 1E00
amplification curve.

Threshold settings above or
below the optimum increase
the standard deviation of the
replicate groups.

ARRN
I

a
0.061456
0.01

Threshold Set Too Low 101

The threshold is set below
the exponential phase of the
amplification curve. The
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the
threshold bar up into the B e

exponential phase of the \ " 4
curve.

Threshold Set Too High 1e01

The threshold is set above
the exponential phase of the \eo
amplification curve. The f.605555 g
standard deviation is
significantly higher than that
for a plot where the threshold
is set correctly. Drag the

1E00

ARN

o1

ARN

o1

threshold bar down into the i
exponential phase of the
curve.
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Assess amplification results using the Amplification Plot

e Correct baseline values

Baseline Set Correctly 1E01

The amplification curve
begins after the
maximum baseline.

1E00

ARN

o1

Baseline Set Too Low 1E01

The amplification curve
begins too far to the
right of the maximum
baseline. Increase the
End Cycle value.

1E00

AR
o

Baseline Set Too High 1EDT

The amplification curve
begins before the
maximum baseline.
Decrease the End Cycle
value.

1E00

ARN

o1

* View the analyzed data using the relative threshold settings

The ViiA™ 7 Software provides the Relative Threshold method to view the
analyzed data. The relative threshold algorithm lets you compare the data per
well and per target. These options allow analysis of a single gene across samples
or, alternatively, a single sample across genes with no dependency on targets,
thereby reducing variability.

To view the analyzed data using the relative threshold settings, see “Adjust
analysis settings” on page 123.

If your experiment does not meet the guidelines above, troubleshoot as follows:

*  Omit wells (see “Improve Cy precision by omitting wells” on page 127).

Or
* Manually adjust the baseline and/or threshold (see “Adjust analysis settings” on
page 123).
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Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose

In the Comparative Cy example experiment, you review the Multicomponent Plot
screen for:

ROX™ dye (passive reference)

FAM™ dye (reporter)

Spikes, dips, and/or sudden changes
Amplification in the negative control wells

View the Multicomponent Plot

1.

From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

. Display the unknown and standard wells one at a time in the Multicomponent

Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

From the Plot Color drop-down menu, select Dye.

Click |7— Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Section 11.1 1 1

Confirm accurate dye signal using the Multicomponent Plot

5. Check the FAM dye signals. In the example experiment, the FAM dye signal
increases throughout the PCR process, indicating normal amplification.

Fiot Cokr Dye

~|

[T] Save cumment settngs 2: the dafauk

B [a [ fizis (s |15 [48 [17 [ 16 [19 [0 |21 [or [25 |2+ |

100,000
18a.000
173000
180000
150.000
140000
130.000

Muiticomponent Plot

 ADEED 1o [1 [tz [13 ]3| 3519
POF 300 003 111 D00

popoaRERE ||
B

MNN MNE [EE 0040 [N 8 |

e 0D DOD 11l DO W 0@

120,000
110,000
100.000
=0.000
a71.000
7a.000
aa.n0o0
50,000
4000
30,000
‘M.000
10,000

Fluorascents

= 2 ;!l!lll WA L0 AL [+ [ [ae

o

e

Cycle

e B ROX

| wals: [If 60 [ 5 319 Erpty |

Well Summary:

Multicompaonent Plot
“Plot Ssttings |

En Plare: 3684

Set s G5 Arabyzc: 65 Fingged: 3 Carmted by Arahpui: 0 ot Maruafoy: 0 Samapien Livadt= Targeta Linact: 5

6. Select the negative control wells one at time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.

Plat Color |Dye

-

[] Sava cument sattings as the default

a [ 8 (10 (11 {1z (s |1 15|46 [47 [48 [ 19 oo |

Fluoreseence
=]
-3

Multicomponent Plot

| OOF 111 T 2@

EI.EI.!I 1 1y | n..n..n._ i T _ H

PR PP 111 TOO
Mmmm g

=2

103

—

a

e 2
W Fa Il RO

Wek; i}ﬁn_. 5 319 Ermoby

Well Summary:

In Plala: 354

Sat Vol 65 Angivzadi G5 Flaggad: 3 Qroitted by Anatvas: O Omilted Hanuziys () Samphas Led: 4 Targets Usnds §
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Determine signal accuracy using the Raw Data Plot

Tips for confirming dye accuracy in your own experiment

When you analyze your own Comparative C experiment, look for:

* Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Comparative Cy example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.
Note: If no data are displayed, click Analyze.

2. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click |7— Show a legend for the plot (default).
Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate (see
the legend in the Raw Data Plot shown below).
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Determine signal accuracy using the Raw Data Plot

11

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 40. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot
T50.000
7o oo
050,000 \
mO0.0o0 [
A5, 000
600, 100 f 5
480000
& 400 000
=
=
S 320,000
=
a0, 100
250, 000
200,000
160,000
100, 000

210,000 f

D —

Kl a2z a3 - x%.ms

Filler
WA MG EC D Mc M- MG MK =
W OE) MK L Ey Ey o B -
Dptions
Show Cycle 40 5
1 5 in i5 20 25 an a5 40
Well Sumimary: En Ploter 384 Set Upa 85 Anshzeds G5 Fogged: 3 Drvitted by Anahyss: rvéfied Meeuahy: O Sernples Used: 4 Targei= Uzech 5
The filters used for the example experiment are:
PCR Filter Ca) &
Emisson Flar
m1l(520+15) mz[s58+11) m3{586E£10) mA(E23£14) ms[EB2x14) mEIT11 £12)
AL(4TC£15)
& ¥2(520410)
% HGE0HLL)
g #H{5A0410)
25 E4010)
HE(BE2410)
Mielt Curve Filker e
Emission Fler
ml(320=15) m2[S39=11) maSEG =101 mE23=14) EGEZENEH mBi71l1=12)
a1 {dT0E15)
= 2(S20410)
1=
g 011
5 24{5E0E10)
H3(GA0E10)
BE(BEZEL0) w
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View the endogenous control profile using the QC Plot

Tips for determining signal accuracy in your own experiment

When you analyze your own Comparative Ct experiment, look for the following in
each filter:

¢ Characteristic signal growth
* No abrupt changes or dips

View the endogenous control profile using the QC Plot

In the Comparative Cy experiment, the QC Plot screen displays the Endogenous
Control Profile plot for all the targets in the experiment. The QC Plot serves as a tool to
help you choose the best endogenous control for that experiment. The endogenous
control profile plot is a visual display of the Cy level of the endogenous control across
the sample. You can view up to four endogenous controls at a time. The sample is
plotted on the X-axis, and Cr is plotted on the Y-axis. The expression is viewed as a
color and shape combination in the plot. Endogenous controls are also known as
reference genes.

Example experiment settings

In the example experiment, you can view the endogenous control profile of ACTB,
GAPDH, GH1, and LPIN1 the QC Plot screen.

View the QC Plot

1. From the Experiment Menu pane, select Analysis » QC Plot.
Note: If no data are displayed, click Analyze.

2. In the QC Plot screen, click Target Table.

a. In the Candidate Control column, select the check box of the target of the
endogenous control profile to plot. In the example experiment, the
endogenous controls selected are ACTB, GAPDH, GH1, and LPIN1.

b. Select a color for each target, from the Color drop-down menu.

C. Select a shape for each target, from the Shape drop-down menu.
3. Click the View Replicate Results Table.

4. Select the check box of the samples to plot. In the example experiment, all the four
samples, Brain, Heart, Liver, and Lung are selected.

5. Click [~ | Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
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Review the flags in the QC Summary

The QC Plot in the Comparative Ct example experiment looks like this:
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Note: This example experiment does not define Biological Groups.

Review the flags in the QC Summary

Targets Lised: 5

The QC Summary screen displays a list of the ViiA™ 7 Software flags, including the
flag frequency and location for the open experiment.

Review the QC Summary screen in the Comparative C1 example experiment for any

flags triggered by the experiment data. Wells G9, G10, and G11 have data that

triggered the HIGHSD flag.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is > 0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are seven flagged wells.
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Review the flags in the QC Summary

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment. The HIGHSD flag appears
three times, in the wells G9, G10, and G11, indicating high standard deviation in

the replicate group.

Note: The HIGHSD flag appears because the Ct values exceed the expected range
due to low expression of the GH1 gene in the Liver sample.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

The QC Summary for the example experiment looks like this:

QC Summary <
lag Details
Flag: Description Frequency Wells
AMPHC Amplification in negative control 0
BADROX Bad passive reference signal [i]
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard deviation in replicate group 3 G9, G10, G11
MOAMP Mo amplification [i]
NOISE Moise higher than others in plate [i]
SPIKE MNoise spikes [i]
MOSIGHAL Mo signal in well 1]
QUTLIERRG Qutlier in replicate group [i]
EXPFAIL Exponential algorithm failed [i]
BLFAIL Baseline algorithm failed 0
THOLDFAIL Thresholding algorithm failed 0
CTFAIL Cr algorithm failed [i]
Flag: HIGHSD—High standard deviation in replicate group
Flag Detail: The Ct standard deviation for the replicate group exceeds the flag
setting.
Flag Criteria: Ct standard deviation = 0.5
Flagged Wells: G9, G10, G11
View HIGHSD Troubleshooting Information
Total Wells: 384 | Processed Wels: 65 Manually Omitted Wells: 0 | Targets Used: 5
Wells Set Up: 65 Flagged Wells: 3 Analysis Omitted Wels: 0 | Samples Used: 4
Well Summary: In Plat=: 384 Set Up: 65 Anafyzed: 65 Fiagged: 3 Omitted by Analysis: 0 Omitied Manualy: 0 Samples Used: 4 Targets Used: 5
The flags listed below may be triggered by the experiment data.
Flag Description

120

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal

NOAMP No amplification

NOISE Noise higher than others in plate

SPIKE Noise spikes

NOSIGNAL No signal in well

EXPFAIL Exponential algorithm failed
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For more information

Flag Description
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cy algorithm failed

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD . High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number
Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™7 System LALN4A34
Experiments.
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For more information
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SECTION 11.2

Section 11.2 Adjust parameters for
re-analysis of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and advanced options.

If the default analysis settings in the ViiA™ 7 Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then
reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
® (Cp Settings
¢ Flag Settings
¢ Relative Quantification Settings
* Advanced Settings
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Review Results and Adjust Experiment Parameters

Adjust analysis settings

The Analysis Settings dialog box for a Comparative C experiment looks like this:

— Data Step Selection

i_Stage 2, 5tep 2 ;|

Flag Settings Relative Quantification Settings Advanced Settings

* Review the default settings for analysis of targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default
Settings, then change the settings.

Select the step and stage to use for Ct analysis. Only stage/step combinations for which data suitable for C1
analysis have been collected are displayed.

Algorithm Settings N
Select the algorithm to calculate Cr,

{E!aseline Threshold » |

— Default Ct Settings

Default CT settings are used to calculate the C1 for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO  Baseline Start Cycle: AUTO Baseline End Cycle: AUTO

— Select a Target — CT Settings for ACTB——M—
Target Threshold Baseline Start Baseline End CT Settings to Use: Default Settings
ACTE AUTO AUTO AUTO e
GAPDH AUTO AUTOD AUTO T ‘7|
GH1 AUTO AUTO AUTO el
LIPC AUTO AUTO AUTO 3k
LPIH1 AUTO AUTO AUTO
el

Save to Library | Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis settings

Ct Settings

124

e Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

* Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.
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Adjust analysis settings

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.

¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

* Crp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the ViiA™ 7 Software.

To adjust the flag settings
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of C1 SD. For some flags, analysis results calculated before
the well is rejected are maintained.
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Adjust analysis settings

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.

The Flag Settings tab looks like this:

j Analysis Settings for ViiA7 Comparative Ct Example 1

? Relative Quantification Settings Advanced Settings
Flag Description Use Attribute Condition Value Reject Well
AMPNC Amplification in negativ... cr < w [35.000 O
BADROX Bad passive reference ... Bad passive reference ... |> ~ |0.600 O
BLFAIL Baseline algorithm failed ]
CTFAIL Cr algorithm failed O
EXPFAIL Exponential algorithm f... O
OFFSCALE Fluorescence is offscale [l
HIGHSD High standard deviatio... Cr standard deviation > w |0.500 O
NOAMP Mo amplification Amplification algorithm ...|< w |0.100 O
NOISE Moise higher than oth... Relative noise > w |4.000 O
SPIKE Moise spikes Spike algorithm resutt  |= w [1.000 O
MNOSIGNAL Mo signal in well O
OUTLIERRG Qutlier in replicate group O
THOLDFAIL Threshalding algorithm... O
Revert to Default Analysis Settings Apply Analysis Settings

Relative Use the Relative Quantification Settings tab to:
Quantification » Change the type of analysis, singleplex or multiplex.
Settings .

Change the reference sample and/or endogenous control.

* Reject Outliers with ACpvalues less than or equal to the entered value.

Note: The Outlier Rejection settings apply only to multiplex reactions.

¢ Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.

Advanced Settings Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.
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Improve Cr precision by omitting wells

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.

Improve Ct precision by omitting wells

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce Cy values that differ significantly from the average for
the associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements; to ensure Cp precision, omit the outliers from the analysis.

In the Comparative Cy example experiment, there are seven outliers. To remove these
wells from analysis.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Ct vs. Well from the Plot Type drop-down
menu.

3. Select the Well Table tab.

4. In the Well Table, identify outliers:

a. From the Group By drop-down menu, select Replicate.
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Improve Cr precision by omitting wells

b. Look for outliers in the replicate group (make sure they are flagged). In the
example experiment, wells G9, G10, and G11 have outliers.

Plate Layout

= Wwall | Omit Flag Sampla ... Targat .. | Task Dvas Cr Cr Mean | C1 SO ACT ACT Ma... | ACT BE HACT RC R Min RQ N
149 65 O Liver GAPDH UMKHOWH  FAM-NRG-., 19,113 19217 0032 026 0.071 £0.323 1.251 109 ’_‘_
150 GB ! LT GAFDH UMEND'WI  FAM-NFQ-... 19.230 9.a7 0oz o026 0071 4.323 1251 .o
151 'G7 I~ Liver GAPDH UNKNOWTM  FAM-HEQ-... 19.288 16217 0.032 1.026 0.071 -0.323 1.251 1.061

B ar - GHI
153 G2 1 1 Liwer. GHL URKNOWH  FAM-NFJ-... 36.234 35578 0842 16.385 0.374 2467 0.181 0.038
154 Gi10 11 § Liver GH1 UMENOWH  FAM-NFQ-... 34951 25576 0642 16,385 0374 2467 181 o.08e
155 G611 ] I Liver GH1 UMKHOWH  FAM-NFD-.., 35,593 35376 0642 16.385 0,374 2467 0.181 0.088 —
161 Gi17 7] Liwet LPC LRKNO™ Ff\-M-NFq-__. 219793 22097 0107 2,901 0.07a 5052 S30.871 456.875 &
162 618 A Liver LIRC URKHEAH FAM-HFD-.., 22.181 22092 0107 2901 0078 0,052 530.871 156,875 B
163 G519 ] Lhver LIPC UMENOWH  FAM-NFQ-... 22.122 22,092 0.107 23900 n.a7e 2052 S530.871 4568875 B
i 157 613 [} Lwver LA UNENCOWH FAM-NRG-.., 24.180 24322 0127 3131 0087 0,583 (1663 0.560
158 G1+ " | Lnver. LPINL UNKNOWN  FAM-NFQ-... 24361 24322 0127 5131 0:087 0.593 0.ee3 0.560
159 G15 [] Lhtr LPm1 URKHOWT  FAM-HFQ-... 344324 24322 0127 3.13L 0.087 0.593 0.663 0.360
57 EL & Lung ACTB UMENOWHM  FAM-NFQ-... 13.151 18210 0.054
58 EZ a Lung ACTH UMKNOWH  FAM-NRG-. 18.202 18210 (6813
9 B3 I | Lung ACTR URKHOAWWT  FAM-HRD-.., 18.278 18210 0.064
101 E5 i Lung GARDH URKHOWH  FAM-NFQ-__. 21.082 1084 0.085 2874 0.053 2.535 0.174 0457
102 E6 I Lung GARDH UNKEHERT FAM-NR-.., 21080 1,084 0065 2.874 0053 2.525 1.174 0157
103 E7 i1 Lung GAPDH URKHO'WE  FAM-NFQ-... 21.150 Z21.084 0.065 2.874 0.053 2.525 0174 0.157
= Lung - GH1
105 E¥ O Lung GH1 UNKHOM®  FAM-HFQ-.., 32.836 32837 0.030 14626 0041 0.707 0612 0.566
106 EID0 & Lung GHI UMKNO'WH  FAM-NFJ-... 32802 32,837 0.030 14,626 0041 .77 o.el2 0.566
107 EN1 D LLing GH1 UNKNOWN  FAM-HEQ-_. 32,851 32.837 0.030 14.626 0.041 0707 0612 0.566
B Lung - LIPC
113 EL7 & Luang LIFC: UMKHOWM  FAM-NFQ-.. 31.081 31162 0133 12,952 071 0.558 0.301 0436
114 E18 |:| Lung LPC UMKHOWH  FAM-NFQ-__. 31281 31.162 0105 12952 0071 D.o0a 0.501 0.436 i
4 *
Well Summam In Pl 384 St Upa 65 Anzhyzed: 65 Faggad: 3 Omtad by Anavek: () Owmatad Manuatly: ) Sampis Used: 4 Targats Usedi §

Plate Layout
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113 E17
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Well Summany:
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C. Select the Omit check box next to outlying well(s).

arouphy W

Omt Flag Sampla ... Targat .. | Task [y T Cr Mean | C1 50 ACT ACT Ma... | ACT S5E ARCT RC R Min RO M
O Liver GARDH URKHOAS PAM-HRG-.., 10,113 19.217 0,032 1,026 0.071 -0.%33 1.251 1.001 =]
@ Liver GAFDH UMKNO'WH FAM-NFJ-... 13.Z50 18217 0.8z 0.026 0071 0,323 1.251 Los
] Lt GAFDH UNKNOWH  FAM-HEQ-. 19788 18297 0032 0.026 0.071 -0.323 1.251 1.0

1 Liver. GHL UMENOWM  FAM-NFQ-.. 36.234 35.576 0642 16,385 0.374 2487 0.181 Q.oas
1 Liver GH1 UMKHOWT  FAM-HFQ-.. 344951 35.576 0642 16,385 0374 2467 mdEd o.0ag
LIMERCAT

[ Liwnst LPC UNKNGYM  FAM-HFG-... 21.973 22092 0137 2,901 0078 -9.052 S30.871 456,875 &
O Liver LpC UNKHOWH  FAM-HFQ-.., 22.181 E3 003 0.107 2,901 0078 0,052 S20.871 456,875 &
-] Liver LPC UMKNOWE  FAM-HFQ-... 22132 22092 0.107 2.30L n.a7e -3.052 530.871 456.875 &
= Livar - LPIH1
Liver P UNKHOWH  FAM-NRD-., 24,180 24322 0137 5131 0087 0,593 [LE63 0,560
Lnver. LPINL UMNENOWT  FAM-NFQ-.. 24381 24322 0127 5131 087 0.593 063 0.380
Lbwnér LRI URKHOWT  FAM-HFQ-__. 34 434 24323 0127 5131 0087 0.593 0.663 0.560
Lung ACTB UMENCWUT FAM-NFQ-... 18.151 18210 0.064
Lung ACTR UNKHOWT  FAM-NPQ--.. 18.202 18210 0.084
Lung ACTR URKHOWT  PAM-HFG-.., 18378 18,210 0,064
= Lung - GAPDH
=] Luing GATDH URKNOWH  FAM-HFG-... 21.082 z1.084 0.085 2.874 0.053 2.535 0.174 0457
O Lung GAPDH UMKHOMWH  FAM-NFD-.., 21020 21,084 0,065 2,874 D053 2.525 0.174 0157
1 Lung GAPDH URKHOWP  FAM-NFQ-... 21.150 Z21.084 0.065 2.874 0.053 2.525 0174 0.157
= fung - GH
O Lung GH1 UNKHOWH FAM-HRG-., 32856 32,837 0,030 14,626 0041 0,707 G2 0,566
& Lung GHI UMEND'WT FAM-NFQ-... 32802 32,837 0.030 14,626 0041 [+ Prjivg 0.l 0.586
D Lung GHL UNKHOWT  FaM-HPQ-... 32851 I2.837 0.030 14.626 0.041 0707 0612 0.586
8 wp-vc______________________________________ |
a Lung LIFT URKNOWH  FAM-NFJ-... 31.0B1 3L.1e62 0103 12952 D71 9.558 0.501 0.436
I | Lung LPc URKHOWH  FAM-HFQ-... 31.2B1 31162 0.105 12.952 0071 D.o08 o501 0.936 e
< 3
in Pt 364 Sak Upa 5 Anahyzed: 65 Faengad: 3 Omitted by Analveka () Omitad Manuatly: 0 Saracis Lsed: 4 Targats Used: §
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Improve Cr precision by omitting wells

5. Click Analyze to reanalyze the experiment data with the outlying well(s)
removed from the analysis.

Note: You can also omit undesirable wells in an experiment from the Plate Layout
screen. To omit a well from the Plate Layout screen, right-click the well and select
Omit.
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About Comparative Cy
Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

!

Chapter 11.

CHAPTER 12

Export Analysis Results

. Open the Comparative Cy example experiment file that you analyzed in

In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

Select ViiA™7 Format.

Note: Select 7900 Format if you want to export the Clipped Data.

Complete the Export dialog box as shown below:

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name ViiA7RQexport

File Type *.txt

Export File Location

<drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments

Chapter 12

Export Analysis Results

Design and Analyze a Gene
Expression Study
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Your Export screen should look like this:

[[] Auta Expart Expart Data To: &) Ane Fle ) Saparate Flas [¥] apen fis(s) when axport & complets

Export Fle Location: CApplied BiosystermsiVilAT Software v 1\experments

Export Fle Mame: VilATRQe xport i Az Type: =|'-_'| =) e

[Deempes=nn | C1rawDaa ] amphficatian ] Mukicamponent [C] ech: Rep. Resits [ 8. Rep. Resiits W chpp=d

Stk Canbent Wall Sample ... Delta Ct...| Target .. | Task Reporter | Quancher RO RO Min R Max T CtMegan | CtsD
2] Al Fredds & 1 Bra ACTB UHKHOWN  FAM HFQ-MGE 17,339 17.281
@lwal 2 Bran ACTB UNKNOWN  FAM HFQHHGE 17,245 17,281
gadAh 3 Brain ACTH LIHKNOWHN  FAM WFQAGE 17,260 17.281
7] samale riame 5 Bran 0050 GAPDH  UHKNOWN  FaM HFQ-MGE 1.000 0.045 1.099.17,627 17.631
6 Brain 0,051 GAPDH UNKNOWH  FAM HFQ-MGE 1000 545 1.053 17.622 17,631
7 Brah 0.051 GARDH LHKNCAH FAM HFQGE 1.000 0.345 1.058 17.642 17.631
2 Brain 0.217 GHL UNKNCWN  FAM NEQ-MGE 1.000 0.786 127331215 31200
101 Brain 0.217 GHL UNKNCWWH  FAM HFO-MGE 1.000 0.786 1.27331.403 3200
¥ Repartar 11 Brain 0.217 GHL UNKNCIWN  FAM NEQ-MGE 1000 0.785 1.273 30,982 31200
i 13 8ran 0.089 LFIHL UNKNOWH FAM HFO-MGE 1.000 0.526 1.0B0.21.785 21.819
7] Guenchar 14 Bran 0.058 LFINL UNKNOWGN  FAM NEG-MGE 1.000 0.526 1.060 71839 21318
15 Bran 0,088 LFINL UNKHCWH  FAM HFQGE 1.000 0.526 1.060 21,653 21.818
jmav] 17 Bran 0.073 LIFC UHKNCWH  FAM HEQMGE 1.000 0.522 1.085 38,293 28,735
) 18 Bran 0,073 LFC UNKHCWH  FAM HFQHGE 1.000 0.522 1.085 28,224 29,235
[#1RQ Min 1% Bran 0.073 1PC UNENOWN. FAM HFQGE 1.000 0022 1.085 20.188 20235

%] RO Max 23 ACTH NTC FaM NFCGE Undatermi..

= 4% Heart ACTB UHKNOWN  FAN NFQ-FGE 16,088 1089
et 5 Heart ACTE LIHENOWN  FAM NFQ-MGE 18.024 18,089
i 51 Heart ACTE UHKHOWN  FAM HEQMGE 18,154 18,080
[¥] £t Mear: 53 Heart 0,101 GAPDH UHKNOWN  FAM HFQHGE 2.232 1,596 2,496 17,281 17,280
54 Heart 0.101 GARDH UHENOWH. FAM NFQ-MGE 2.232 .06 2486 17,203 L7280
[Fcrso 55 Heart 0.101 GAPDH UHKNOWH  FAM NFQ-HGE 2.232 L.096 2.496.17.356 L7.280
T , 57 Heart 0.271 GHL LHKHOWN  FAM HFQ-MGE 1.053 0.730 1422 32191 31933
2] quantity 58 Heart 0.271 GHL LNKNCAN  FAM NFQAGE 1.053 0.780 143231 63t 31.933
7] Dalts Gt Mesn - Eaiaae PR mnensni ras wrn aen 4 nza e P .

T

Your exported file when opened in Notepad should look like this:

port.txt - Notepad

File Edit Format View Help
* Block Type = 384-well Block ~
= chemistry = TAQMAN =1
* Experiment File Name = C:‘Applied Biosystems\viia7 Software vl.1l'experiments'examples'wiia7_384-well _Comparative Ct Example.eds
* Experiment Name = ViiA7_384-Well_comparative_Ct_Example|
= experiment Run End Time = 2010-10-01 17:18:50 PM PDT
* Experiment Type = Comparative CT (AACT)
* Instrument Name = Yan EES_RH1E
* Instrument Serial Number = 278880012
® Instrument Type = ViiA 7
* passive Reference = ROX
= quantification cycle method = ct
® signal smoothing on = false
* stage/ Cycle where Analysis is performed = Stage 2, Step 2

[Results]
well Sample Name Target Name Task Reporter quencher RQ RQ Min RQ Max CT Ct Mean Ct 5D
quantity pelta Cct Mean pelta ct sD pelta Delta ct Automatic ct Threshold ct Threshold Automatic Baseline
Baseline start Baseline End efficiency Customl Custom2 Custom3 Customd Customs Customd HIGHSD
i Brain  ACTB UNKNOWN FAM NFQ-MGB 17.339 17.281 0.050
True 0.057 true 3 13 1.000 N
2 Brain ACTE UNKNOWN FAM NFQ-MGE 17.245 17.281 0.050
true 0.057 true 3 13 1.000 N
3 Brain  ACTB UNKNOWN FAM NFQ-MGB 17.260 17.281 0.050
true 0.057 true % E3 1.000 N
o Brain GAPDH UNKNOWN FAM NFQ-MGE 1. 000 0.945 1.059 17.627 17.631 ©.010 0.349 0.051 0. 000
True 0.076 true 3 13 1.000 N
[ Brain GAPDH UNKNOWN FAM NFQ-MGE 1.000 0.945 1.059 17.622 17.631 0.010 0.349 0.031 0. 000
true 0.076 true 3 13 1.000 N
7 Brain GAPDH UNKNOWN FAM NFQ-MGE 1.000 0.945 1.059 17.642 17.631 0.010 0.349 0.051 0. 000
true 0.076 true ES 13 1.000 N
g Brain GHL UNKNOWN FAM NFQ-MGE 1.000 0.786 1.273 31.215 31.200 0.211 13.91% 0.217 0. 000
true 0.046 true 3 28 1.000 N
10 Brain GHL UNKNOWN FAM NFQ-MGE 1.000 0.786 1.273 31.403 31.200 0.211 13.91% ©.217 0. 000
true 0.046 true 3 28 1.000 N
11 Brain GHL UNKNOWN FAM NFQ-MGE 1.000 0.786 1.273 30.982 31.200 0.211 13.919 0.217 0. 000
true 0.046 true 3 28 1.000 N
13 Brain LPINL UNKNOWN FAM NFQ-MGE 1. 000 0.926 1.080 21.765 21.819 0.047 4,537 0.069 0. 000
True 0.061 true 3 13 1.000 N
14 Brain LPINL UNKNOWN FAM NFQ-MGE 1.000 0.926 1.080 21.839 21.819 0.047 4,537 0.069 0.000
true 0.061 true 3 18 1.000 N
15 grain LPINL UNKNOWN FAM NFQ-MGE 1.000 0.926 1.080 21.853 21.819 0.047 4,537 0.069 0. 000
true 0.061 true E; 18 1.000 N

7 Brain LIPC UNKNOWN FAM NFQ-MGE 1. 000 0.822 1.085 29.293 29.235 0.053 11.953 0.073 0. 000
True 0.110 true 3 24 1.000 N
18 Brain LIPC UNKNOWN FAM NFQ-MGE 1.000 0.922 1.085 29.224 29.233 0.0533 11.953 0.073 0. 000

w
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CHAPTER 13

Design and Analyze a Gene
Expression Study

The ViiA™ 7 Software can combine the analysis of experiments that use the Standard
Curve, the Relative Standard Curve, or the Comparative Ct (AACt) quantification
methods into a Gene Expression study. A study provides a wider range for analyzing
and comparing target behavior across multiple experiments. This chapter explains
how to design and analyze multiple Comparative C experiments as a study.

About Comparative Cy
Experiments

Note: You can import different types of quantification experiments into a single Gene
Expression study, but make sure the run method is identical for all the experiments in
that study.

Design the Experiment
Note: When you design a Gene Expression study, make sure that each experiment in
that Gene Expression study has a unique name. Absence of a unique name, leads to
failure of the run.

This chapter covers:

B About Gene Expression studies . ............ ... 134
Prepare the Reactions
About theexamplestudy ........... ... . i 134
B Designastudy........ ... .. 135
B Analyze the examplestudy.......... ... .. i 140
B View theanalysissettings.............. ... ... ... . ...l 143
: B Assess amplification results using the Amplification Plot.................. 147
Run the Experiment
B Assess the gene expression profile using the Gene Expression Plot. ......... 150
B Confirm accurate dye signal using the Multicomponent Plot............... 158
B View the QC Plots. . ..o oot e e e e 160
B View the QCSumMmary ............uuuiiiiiiiiiiiiiiiiien.. 168
Review Results and Adjust B Compare analysis settings. . .. ... 170
Experiment Parameters
B Exportthestudy............ ... ... . . 175
B For moreinformation. ........... ... oo i 178
Export Analysis Results
Chapter 13
Design and Analyze a
Gene Expression Study
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About Gene Expression studies

In a Gene Expression study, you can... You cannot...
 Specify the endogenous control(s) and e Create, add, or modify samples.
reference sample for the study. e Create, add, or modify targets.
 Set individual efficiency values for each e Change assay tasks.
target.

You can perform these operations in

e Select the control type when applicable. individual experiments.

e Set baseline and threshold values and
confidence levels, or set the number of
standard deviations for Comparative ¢1
Min./Max.

e Omit wells individually or together

through their association with replicate
groups (technical or biologicall.

About the example study

In the Comparative Cy example study:

* Two reaction plates (experiments) are used.

* Experiments that you add to the study are two Comparative C experiments that
have already been analyzed.

¢ The cDNA was prepared from total RNA that was isolated from the following
4 samples:

— Heart
— Liver
— Brain
— Lung
* Five targets (assays) are used:
— LIPC: Hs00165106_m1
— GAPDH: Hs99999905_m1
— ACTB: Hs99999903_m1
— LP1INI1: Hs00299515_m1
— GH1: Hs00236859_m1
¢ The reference sample is Brain.
* The endogenous control is ACTB.

¢ Each experiment in the study was designed for singleplex PCR, where the target
and endogenous control assays are run in separate wells.

e For each experiment in the study, reactions were set up for 2-step RT-PCR:

— The cDNA was reverse-transcribed from total RNA samples using
Invitrogen VILO Kit.

— The reactions were prepared using TagMan® Fast Universal PCR Master Mix
(2X).
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Design a study

Create a new study

To create a new study in the ViiA™ 7 Software, from the Home screen, click E New
Gene Expression Study. “

Set up the study in the Study Properties screen

1. In the Study Menu pane, select Setup » Study Properties

2. In the Study Properties pane, click the Study Name field, then enter ViiA7_384-
Well_Comparative_Ct_with_Bioreplicates_Study_Example.

3. Click the Comments field, then enter Example Comparative Ct Study for the
Comparative Ct Experiments.

4. In the Setup Experiments pane, click Add Experiment(s).

5. In the Open dialog box, browse to the ViiA7 Comparative Ct Example 1.eds and
ViiA7 Comparative Ct Example 2.eds files at:

<drive>:\ Applied Biosystems\ ViiA7 Software v1.1\experiments\examples
The ViiA™ 7 Software displays the details of the experiment in the Properties pane.

Your Study Properties screen should look like this:

* Study Name: Viia7_384-Well Comparative_Ct_with_Bioreplicates_Study Example Comments (Optional): ~
User Mame (Qptional): DEFAULT

Last Modified: Thu Oct 07 09:57:01 PDT 2010

Humber of Experiments: 2 >

Set Up Experiments (2)
Add Experiment(s) Remove Selected Experiment(s) W

Enter 2 filtter query, then click "Apply Fiter."

IF Experiment Name v ||= ~ [W
Experiment Name Number of Tar.41| Number of Sa... | Operator Run Date Properties: ViA7 Comparative Ct Example
[] viia7 Comparative Ct Example 1 5 4 10/01/2010 16:36:55 PDT e
[] ViA7 Comparatve Ct Example 2 5 4 10/04/2010 12:27:52 POT Lo L IS
HH rH HH tHH
HH ' HH tH
s s s tH
e tH e tHH
tH tH tH tH
tH tH tH tH
tHH tHH tHH tHH
tH tH tH tH
tH tH tH tH
@ Negative Control wel
@ standard wel
@ Unknown Well
@ Empty wel
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Filter the experiments in the study
To narrow your search for an experiment, define and apply a filter:
1. In the left-most drop-down menu, select an experiment attribute to query.
2. In the center drop-down menu, select an operator for the query.

3. In the right-most field, enter the condition to look for, then click Apply Filter.

After you apply a filter, click Hide Filter/Show Filter to hide or show the filter tool, or
click Remove Filter to remove the filter.

Define Replicates

In the Define Replicates screen, create biological replicate groups and use them to
associate samples for the analysis. Biological replicates allow you to assess the
representative nature of your results as they relate to the population being studied.
Including biological replicates can give insight into any natural variation that is in the
population.

Example study settings

The Gene Expression example study contains four biological replicate groups. These
are lung, heart, brain, and liver. Each biological groups consists eight replicates.

To define replicates

1. In the Study Menu pane, select Setup » Define Replicates.

2. Click Add Biological Group to open the Add Biological Replicate Group dialog
box.

3. Define the biological replicate group:
a. Click the Biological Group Name field, then enter Heart.
b. In the Color field, select the color.

c. Click the Comments field, then enter Example Biological Replicate Group
for the Example Comparative Ct Study.

4. Add technical replicates:

a. From the Select Plate drop-down menu, select ViiA7 Comparative Ct
Example 1.eds.

b. In the plate layout, select wells A1, A3, A5, A7, A9, A11, A13, A15, A17, and
A19, then click [ggzgll to add the technical replicate wells that are associated
with the selected well to the biological group.

c. Click OK.

d. Perform steps a through c to add the remaining technical replicate wells
associated with the selected well to the biological group.

136 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr
Experiments



Chapter 13
Design a study 1 3

5. On the Set Up Biological Replicates screen, select the Heart biological group that
you just added to the study. The ViiA™ 7 Software displays the details of the

biological group in the Properties pane.

11 Add Biclogical Replicate Group

Wy Instructions: Enter 3 nama for the bickgesl replcate group, than add tachnical repicata groups ta tha new biokgical repicste group a5 neadac,

pefine Biokgical Replicate Group

Blokogical Grouo Marmes | Heart I EEE
N ical o fi moat
Commants {Opeonal); | SXAMee Buingical Repicate Groug for the Bamgle Camparthe O Study
Add technical replicates o the new biological replicate group:
For each experment n the study, select the pite, then salect the welks of the plzte that contam semples assocatad weh the new biioges! replace group.
s you salect tachnicsl replcates, the softwara sutomabically sdds the sssoosted repleate wals to tha biolbgeal repicate group,
saect Plta: WIAT Comparative Ot Exammpls 1 Technical Replitate Groups Added to Blolegial Replicate Groug:
# of Repicates in Group: 5
Sample Target
Brain IACTE
10 () L2 5330 1+ DLEY L6 S33S 18 LB 20 21 (22 (3 Bran GAPDH
Brair GHL
&
Brain ILPINL
& | Bran oee
NN W WM 3900 DN
o]
1
M WEE RN 111 WHN
F|
1 - F "
- [ 12 100 WM W
| hiii
1| @ |
’|
€|
L
W | Used on Pltals):2
—1 ! ! | = WilAT Comparatve CEExample 1
w| + VilAT Comparative Ct Example 2
o
e
|
wei Moe Bolls 319 Ergty

Save and Add Another Group

Set Up Biological Replicate Groups

| ki Brogral Grou |t Bobouical Grou | Dot kool Grows |

|
T =500 1 Einlogical Group Name: Heart
Bran 5.000 | cobr: [
Lung 5.000 |
— 3 Comments:

# of Rapiatas: 5

Hearr S.000

Samola Target
Heart (5[4
Heart GAPDH
Hear LFI1
Haart ACTE
Heart: GH1

Usad on Platals): 2
= VAT Comparative Ct Example 1
= VIAT Cormgarative CC Example 7
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6. Click Analyze, then close the study:
a. Select File » Close.
b. At the prompt, click Yes to save the changes.

. Inthe Save Study as dialog box, click Save to accept the default file name and
location. The example study is saved and closed, and you are returned to the
Home screen.

Edit a Biological Replicate Group

1. Open the study of interest.
2. In the Study Menu pane, select Setup » Define Replicates.

3. Click Edit Biological Group to open the Edit Biological Replicate Group dialog
box.

4. Edit the group information:
a. From the Biological Group Name drop-down menu, select the group to edit.
b. To change the group name, click Edit, enter a new name, then click OK.

c. To change the color, select a color from the drop-down menu.

o

. (Optional) Enter comments.
5. From the Select Plate drop-down menu, select the experiment of interest.

6. Add samples to the biological group:

a. In the Plate Layout, select the well(s) of the plate that contain samples to add
to the biological group.

b. Click [MEEM to add the samples that are associated with the selected wells to
the biological group.

7. Remove samples from the biological group:

a. Inthe Technical Replicate Groups Added to Biological Replicate Group pane,
select a sample. You can select only one sample at a time.

b. Click

to remove the sample from the biological group.
8. Repeat steps 5 through 7 for the other experiments in the study.

9. Click OK to save the changes and return to the study; click Cancel to exit the
dialog box without saving the changes.

Remove Biological Replicate Groups

1. Open the study of interest.

2. In the Study Menu pane, select Setup » Define Replicates.
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3. In the Define Replicates screen, select the group to remove, then click Delete
Biological Group.

4. Click Yes to remove the group from the study; click No to keep the group in the
study.

Tips for designing your own study

¢ Enter a study name that is descriptive and easy to remember. You can enter up to
100 characters in the Study Name field. The study name is used as the default file
name.

You can only use the alpha-numeric, period (.), hyphen (-), underscore ( _) and
spaces ( ) characters in the Experiment Name field.

* (Optional) Enter comments to describe the study. You can enter up to
1000 characters in the Comments field.

* Use the default user name, or enter a new user name, to identify the owner of the
study. You can enter up to 100 characters in the User Name field.

Note: If security is enabled, the User Name field is automatically populated with
the name you selected at log in.

* You can add an unlimited number of experiments (reaction plates) to the study.
Click Add Experiment (s) or Remove Selected Experiment(s) to add or remove
experiments to or from a study. Note the following;:

— Each experiment in the study must:

— Have one or more common endogenous control(s). The endogenous
control(s) must be present on each reaction plate within the study.

— Have identical thermal cycling parameters (the same number of steps
and cycles). The ViiA™ 7 Software cannot combine in the same study
experiments that use Fast and Standard thermal cycling conditions.

— Have the same passive reference.

— As the default, the ViiA™ 7 Software assigns the endogenous control and
reference sample for a study based on the analysis settings of the first
experiment that you added to the study.

— If experiments that contain biological replicate groups are added to a study,
the ViiA™ 7 Software automatically merges the matching biological groups.

— The ViiA™ 7 Software automatically analyzes a study after you add more
than one experiment to it. Consequently, to ensure that the software uses the
correct settings, Applied Biosystems recommends that you review the
analysis settings of your study after adding multiple experiments.

¢ When adding experiments to the study, Ctrl-click multiple experiments in the
Open dialog box to add them to the study.

* Select an experiment that has been added to the study to view its properties in the
Properties pane.

 Filter the experiments added to the study to simplify the list for easier review. See
“Filter the experiments in the study” on page 136.

¢ Enter a biological replicate group name that is descriptive and easy to remember.
You can enter up to 100 characters in the Biological Group Name field. You can
only use the alpha-numeric, full-stop (.), hyphen (-), underscore ( _) and space ()
characters in the Experiment Name field.
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¢ (Optional) Enter comments to describe the biological replicate group. You can
enter up to 1000 characters in the Comments field.

* You can add an unlimited number of technical replicates to a biological group.

IMPORTANT! A sample cannot belong to more than one biological group.

— Click-drag over the desired wells, or Ctrl-click or Shift-click in the plate
layout to select multiple wells.

— Click the upper-left corner of the plate layout to select all wells.

* You can change the name of a biological replicate group, change its color
identification and description, and add or remove technical replicates. See “Edit a
Biological Replicate Group” on page 138.

* You can remove an existing biological replicate group. See “Remove Biological
Replicate Groups” on page 138.

IMPORTANT! After you remove a biological replicate group from a study, you
cannot restore it.

Analyze the example study

This section explains how to use the ViiA™ 7 Software to analyze the Gene Expression
example study. It also describes Applied Biosystems recommended best practices as
you perform the analysis.

Note: The Comparative Ct Study Example.edm file demonstrates the use of biological
replicate groups. An additional example study that does not use biological replicate
groups is provided with the ViiA™ 7 Software.

Access the example study

For the Gene Expression example study, open the data file that is installed with the
ViiA™ 7 Software. The data file was created with the same design parameters that are
provided in “About Gene Expression studies” on page 134.

You can find the data file for the example study on your computer at:

<drive>:\ Applied Biosystems\ ViiA7 Software v1.1\experiments\examples\
ViiA7_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example.edm

where:

<drive> is the computer hard drive on which the ViiA™ 7 Software is installed. The
default installation drive for the software is the D drive.

View the experiment data and well results

140

The Experiment Data and Well Results Data panes appear in the Amplification Plot,
Multicomponent Plot, and Multiple Plots View screens.
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The Gene Expression screen displays the Replicate Results Data and the Well Results
Data panes.

Only the Well Results Data pane appears in the QC Plots View screen.

¢ To display or hide columns in the Experiment Data pane— from the Show In Table
drop-down menu, select or deselect one or more options: Experiments,
# of Targets, # of Samples, Run Date.

Experiment Data

Show In Table ¥

l

RS Experment |- # of Tar...| # ofSa... | Run Date
|| #ofTargets It Ex... 5 4 0ct 1, 2010
v #ofsamples It Bx... 5 4 0ct 4, 2010
z Run Date

* To display a subset of the study data in the plots— Select one or more rows in the
Experiment Data pane or the Well Results Data pane, then select the Hide
unselected data from plot check box appearing in the plot pane to display data
only from the selected rows.

The Experiments Data pane lists each reaction plate (experiment) that is added to a
study. The data that are displayed in the Well Results Data pane depend on which tab
you select in the Experiment Data pane:

Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 141
Experiments



1 3 Chapter 13 Design and Analyze a Gene Expression Study
Analyze the example study

Tab Description Illustration
Well Table When you select one or more experiments in the
tab Experiment Data pane, the well table displays the —
wells that make up the selected experiment(s). ' .
# | Experiment # of Tar...| # of Sa... | Run Date
1 ViA7 Comparative Ct Ex... 5 4 0Oct 1, 2010
2 ViA7 Comparative Ct Ex... 5 4 Oct 4, 2010

Well Results Data

Plate Layout

Show In Table ¥ | Group Results By ¥

# Sample Target Experim...| Omit Flag RQ [ |
ACTE ViA? O O S
Brain ACTB Viid? O
Brain ACTB Viid? O
Brain  ACTB ViA7 ]
Brain GAPDH Viih? J 0.4552979!
Brain  GAPDH Via7 ] 0.4552972!
Bran  GAPDH ViiA7 O 0.4552979!
Brain GH1 ViiA7 | 0.993406
Bran  GH1 Vid7 ] 0.993406
Bran  GH1 Viaz '] 0.993406.
— e o = p———
< >

Plate When you select one experiment in the
Layout tab | Experiment Data pane, the plate layout displays —

the plate layout for the selected experiment.

. . # | Experiment # of Tar...| # of Sa... | Run Date
If you select more than one experiment in the 1 VIAT7 Comparative Ct Ex... 5 40ct 1, 2010
2ViA7 Comparative CE Ex... 5 40ct4, 2010

Experiment Data pane, only the plate layout for
the first experiment is displayed in the Plate

Layout tab.
Well Results Data
Well Table Plate Layout

1 22 23 2¢
A
B
C
D
E
F
G
H v
B 5

142 Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Cr

Experiments



Chapter 13 II 3
View the analysis settings

View the analysis settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cy), flags, and relative quantification. If the default analysis settings in the ViiA™ 7
Software are not suitable for your study, you can change the settings in the Analysis
Settings dialog box, then reanalyze your study.

Note: In the Comparative Ct example study, the default analysis settings are used
without changes.

To adjust the analysis settings

1.

2.

From the Study Menu pane, select Analysis.
Click Analysis Settings to open the Analysis Settings dialog box.

Select the Relative Quantification Settings tab, then view the default reference
sample and endogenous control. In the example study, the default reference
sample is brain and the default endogenous control is 18S.

Select the Ct Settings tab, then the Flag Settings tab. In the example study, the
default analysis settings are used in each tab.

Note: When you use the Relative Threshold option, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they
appear in the QC Summary (by default, a 0 is displayed in the Frequency column
for each flag

View and, if necessary, change the analysis settings. For more information on the
changes to analysis settings, refer to “Tips for analyzing your own study” on
page 144.

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings by clicking Revert to
Default Analysis Settings.

Click Analyze.
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The Analysis Settings dialog box for a Comparative C Study looks like this:

Pl Analysis Settings for ViiA7_384-Well Comparative_Ct_with_Bioreplicates_Study Example

( ings Flag Settings Relative Quantification Settings
sis of targets in this experiment. To use different settings for a target, select the target from the table, deselect Use Default Settings, 3
~— Data Step Selection Algorithm Settings
Select the step and stage to use for CT analysis. Only stage/step combinations for which data suitable for Ct analysis have been collected are displayed. Select the algorithm to calculate CT.
Stage 2, Step 2 v Baseline Threshold

~— Default Ct Settings
Default CT settings are used to calculate the C1 for targets without custom settings. To edit the default settings, dick Edit Default Settings.

Threshold: AUTO  Baseline Start Cycle: AUTO Baseline End Cycle: AUTO | Edit Default Settings

~— Select a Target ~— Ct Settings for ACTB
Target Threshold Baseline Start Baseline End CT Settings to Use: Default Settings
ACTB AUTO AUTO AUTO A
GAPDH AUTO AUTO AUTO l:l
GH1 AUTO AUTO AUTO
LIPC AUTO AUTO AUTO EE [5z]
LPIN1 AUTO AUTO AUTO
w

Save to Library Load from Library Revert to Default Analysis Settings

Tips for analyzing your own study

Unless you have already determined the optimal settings for your study, use the
default analysis settings in the ViiA™ 7 Software. If the default settings are not suitable
for your study, change the settings as described below.

Ct Settings * Data Step Selection
Use this feature to select multiple locations of analysis, in case several are chosen.
* Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.
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¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

* Crp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
e Above the background.
e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline-Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings Use the Flag settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the ViiA™ 7 Software.

To adjust the flag settings
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of C1 SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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The Flag Settings tab looks like this:

i - Analysis Settings for YiiA7_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example

F Relative Quantification Settings
@ Configure the flags and filtering. In this panel you can enable, disable, and configure flags, and indicate if a wel is to be rejected when & flag s raised.
Flag Description Use Attribute Condition Value Reject Well
AMPNC Amplification in negati... cr < « |35.000 O
BADROX Bad passive reference ... Bad passive reference ...|> w |0.600 [}
BLFAIL Baseline algorithm failed O
CTFAIL Ct algorithm failed O
EXPFAIL Exponential algorithm ... O
OFFSCALE Fluorescence is offscale O
HIGHSD High standard deviatio... Ct standard deviation = w |0.500
MOAMP No amplification Amplification algorichm... [< w |0.100
MNOISE Noise higher than oth... Relative noise > ~ [4.000 L}
SPIKE MNoise spikes Spike algorithm result  |> « |1.000 O
MOSIGHAL No signal in well |
QUTLIERRG Qutlier in replicate group O
THOLDFAIL Thresholding algorithm... O
Revert to Default Analysis Settings W W
Relative Use the Relative Quantification Settings tab to:
Quantification ¢ Change the reference sample and/or endogenous control. As the default, the
Settings ViiA™ 7 Software assigns the endogenous control and reference sample for a
study based on the analysis settings of the first experiment added to it. You can
add multiple endogenous controls to a study.
* Correct the amplification efficiency. You can enter a percentage value between 1%
and 150% for each target. When you set an assay to have a value that differs from
100% efficiency, the software uses the relative standard curve algorithm.
¢ (For multiplex reactions) Specify the ACy value at which to reject replicates
(outlier rejection).
* Select the algorithm to use to determine the relative quantification minimum and
maximum values (error bars):

— Confidence Level - Select to calculate the RQ minimum and maximum
values based on the selected confidence level. Select the confidence level to
use.

— Standard Deviations - Select to calculate the RQ minimum and maximum
values based on the selected number of standard deviations. Select the
number of standard deviations to use.
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Assess amplification results using the Amplification Plot

In the comparative Cy example study, you review each target in the Amplification Plot
screen for correct baseline and threshold values.
1. From the Study Menu pane, select Analysis » Amplification Plot.
Note: If no data are displayed, click Analyze.

2. Inthe Experiment Data pane, select all of the experiments (click and drag to select
all rows in the table).

3. In the Amplification Plot pane, set the parameters for the plot:
a. From the Plot Type drop-down menu, select ARn vs Cycle.
b. From the Plot Color drop-down menu, select Well.
c. Click F Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.

d. From the Target drop-down menu, select ACTB to highlight all ACTB wells
in the study.

4. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.

b. Select the Show Baseline check box to show the start cycle and end cycle.
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. Verify that the baseline is set correctly: The end cycle should be set a few

cycles before the cycle number where significant fluorescence is detected. In
the example study, the baseline is set correctly.

Note: The data shown in the screenshot below is of the example experiment.
Results vary depending on the experiment setup.
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5. View the threshold values:
a. From the Graph Type drop-down menu, select Log.

b. Deselect the Show Baseline check box, then select the Show Threshold
check box to show the threshold.
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. Verify that the threshold is set correctly. In the example study, the threshold
is in the exponential phase.
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6. Repeat steps 3 through 5 for the remaining targets.

Tips for assessing amplification in your own study

Ensure that your study meets the following requirements:

* A typical amplification plot — See the amplification plot examples in the
Chapter 5 and Chapter 11.

¢ Correct baseline and threshold values — See the threshold examples and the
baseline examples in Chapter 5 and Chapter 11.

If your study does not meet these requirements, you can:

* Manually adjust the baseline and/or threshold. See “View the analysis settings”

on page 143.
* Omit individual wells from the analysis. See “Omit wells from the analysis” on
page 175.
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Assess the gene expression profile using the Gene Expression
Plot

The Gene Expression Plot screen displays the results of the relative quantification
calculations in the gene expression profile. Three plots are available:

* RQ vs Target — Groups the relative quantification (RQ) values by target. Each
sample is plotted for each target. You can view the plot as the following graph
types: linear, log10, Ln, log?2.

* RQ vs Sample — (displayed only when the Technical Replicates tab is selected in
the Replicate Results Data pane) — Groups the relative quantification (RQ) values
by sample. Each target is plotted for each sample. You can view the plot as the
following graph types: linear, log10, Ln, log?2.

* RQ vs BioGroup — (displayed only when the Biological Replicates tab is selected
in the Replicate Results Data pane) — Groups the relative quantification (RQ)
values by biological replicate group. Each target is plotted for each sample. You
can view the plot as the following graph types: linear, log10, Ln, log2.

About the example study
In the Comparative Cy example study, you review each target in the Gene Expression

Plot screen for the expression level (or fold change) of the target sample relative to the
reference biological replicate group.

View the Gene Expression Plot

1. From the Study Menu pane, select Analysis » Gene Expression.

2. In the Gene Expression Plot pane, set the parameters for the plot:
a. In the Plot Type drop-down menu, select RQ vs BioGroup.
b. In the Graph Type drop-down menu, select Log10.
. In the Orientation drop-down menu, select Vertical Bars.
d. Click |7— Show a legend for the plot.

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.
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In the example study, the expression levels of multiple targets in the biological
replicate group are displayed relative to the expression levels of the same targets
in the reference biological replicate group (universal). Because the reference
sample is compared to itself, the relative expression level is 1. When the result is
displayed in the Log10 graph type, the expression level of the reference sample
appears as 0 in the graph (log10 of 1 =0).
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3. Select multiple endogenous controls:
a. In the Replicate Results Data pane, select the Technical Replicates tab.
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b. From the Endo Controls drop-down menu, select GAPDH, GH1, and LIPC,
then deselect ACTB.

Note: You can also select the endogenous controls in the Analysis Settings
dialog box. See “View the analysis settings” on page 143.

l{ Replicate Results Data

| Show In Table ¥ | Add BioGroup  Endo Controls g “ Ref Sample ¥

Sample Target ACT Me... | ACT SE iy

1 Brain ACTB A~
2 Brain ACTB
3 O Brain GAPDH
4 O Brain GAPDH 0.3144583 0.03370482
5 O Brain GH1
6 O Brain GH1 13.828029 0.1315035 0.0
7 O Brain LIPC 28 0920208 11.664282 0.0410995... -1
8 O Brain LIPC
9 O Brain LPIN1 21.73203 4.467014 0.0398248... -1
10 O Brain LPINT
11 Heart ACTB 18.136377
12 Heart: ACTB
13 Heart GAPDH
14 Heart: GAPDH 17.315718 -0.8206588 0.0384727... v

< >

> Repﬁcate Results Data

Biological Replicates

| Show In Table ¥ | Add BioGroup | hdo Controls ¥ | Ref Sample ¥

# | Omit Sample Target CT Mean | ACT Me... | ACT SE AACT RQ RGQ Min RG Max [
1 Brain ACTB 17.265017 s
2 O Brain GAPDH 17.579475 0.31445832 0.03370482 1.135117 0.45529795 0.43082792 0.48115784
2 ¥ Brain GH1 31.093044 13.828029 (.13150350.0095443... 0.9934062 0.8007919 1.2323499
4 O Brain LIPC 28.920208 11.6642820.0410995... -1.1238337 2.1792520 2.0372863 2.3311124
& ] Brain LPIN1 21.73203 4.467014 0.0398248... -1.1272674 2.1844450 2.0464118 2.3317904
6 Heart ACTB 18.136377
7 Heart GAPDH 17.315718 -0.8206588 0.0384727... 0.0 1.0 0.9388889 1.0650887
8 Heart GH1 31.95480 13.818484 0.08681472 0.0 1.0 0.8873678 1.1529135
9 Heart LIPC 30.924492 12.7881155 0.0554872... 0.0 1.0 0.9130675 1.0952092

10 Heart LPIN1 23.730658  5.5894281 0.0346003... 0.0 1.0 0.94486696 1.0583501

14l Liver ACTB 19.201889

12 O Liver GAPDH 19.181273 -0.020617... 0.05293955 0.8000416 0.5743326 0.5265989 0.626309326

13 F Liver GH1 35.452633 16.25408 0.23876446 2.4355955 0.18484712 0.12329351 0.277131

14 ] Liver LIPC 21.993778 2.701889 0.0500186... -9.996226 1021.32495 940.9349 1108.5833

15 ] Liver LPINI 24.238232 5.036343 0.0514922... -0.55793786 1.4721634 1.3530152 1.601804

16 Lung ACTE 18.253523

117 T Lung GAPDH 21.026237 2.772716 0.0286501... 3.5933747 0.08284883 0.07904831 0.08683208

18 1 Lung GH1 32.66009 14.40657 0.04504969 0.5880864 0.6652247 0.61787546 0.7162023 b’

Well Results Data

| Show In Table ¥ | Group Results By ¥

# Sample Target Experim...| Omit Flag RQ RQ Min RO Max Flags cT ACT ACT Me... | ACT SE AACT
Brain ACTB VilAT (] 17.265799 NaM
Brain ACTE ViAZ | 17.170822 MNal
Brain ACTB ViA7 O 17.186127 Mal
Brain ACTB iA7 O 17.404074 MNalM
Brain ACTB ViiA7 O 17.216125 Nal
Brain ACTB ViA7 O 17.34715 Mal
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b Replicate Results

Chapter 13 II 3
Assess the gene expression profile using the Gene Expression Plot

4. Click Analyze. In the example study shown below, all samples for the
endogenous controls GAPDH, ACTB, and LIPC have no values (with the
exception of the Ct Mean value), and the RQ values for the remaining samples
change. For example, in the example study, the RQ value for the brain sample
changes from 1.0 (with 18S as the endogenous control) to none with the new
endogenous controls.

| Show In Table ¥ | Add BioGroup | Endo Controls ¥ | Ref Sample ¥

# | Omit Sample Target CT Mean | ACT Me... | ACT SE AACT RQ RGQ Min RQ Max [
i ¥ Brain ACTB 17.265017 -8.602256 0.0818908% -0.006942... 1.0048238 0.8922643 1.1315829 -~
2 Brain GAPDH " 17.579475
% Brain GH1 31.093044
4 Brain LIPC 28.029208
| ] Brain LPIN1 21.73203 4.1352425 0.07943937 -1.1342009 2.1949832 1.9560475 2.4631054
6 Heart ACTB 18.136377 -8.595313 0.06349747 0.0 1.0 0.9119953 1.0064960
7 Heart GAPDH 17.315718
8 Heart GH1 31.95486
9 Heart LIPC 30.924492

10 Heart LPIN1 23.730658 -3.0010324 0.0645663% 0.0 1.0 0.91058207 1.0981987

il [l Liver ACTB 19.201889 -5.7585125 0.13895898 2.8368008 0.13997093 0.11432851 0.1713646

12 Liver GAPDH 19.181273

1 Liver GH1 35.452633

1 Liver LIPC 21.993778

15 ] Liver LPIN1 24.238232 -0.7191273 0.14233042 2.2819052 0.20562604 0.16713315 0.25298434

16 O Lung ACTB 18.253523 -0.9706745 0.03890908 -1.375361 2.5943282 2.45193093 2.7440856

17 Lung GAPDH 21.026237

18 Lung GH1 32.66008 b

red

Well Results Data

| Show In Table ¥ | Group Results By ¥

Brain
Brain
Brain
Brain
Brain
Brain

# Sample

Target

GAPDH
GAPDH
GAPDH
GAPDH
GAPDH
GAPDH

Experim...| Omit

ooooog

Flag RQ RQ Min RQ Max Flags cT
17.508966
17.504078
17.523808
17.681126
17.656763
17.602106

ACT ACT Me... | ACT SE LDACT
Nal
Mal
NaM
Nal
Nal
Mal

Tips for assessing the gene profile in your own study

Look for:

* Differences in gene expression (as a fold change) relative to the reference sample.

¢ Standard deviation in the replicate groups (Ct SD values).

If needed, you can omit outliers. See “Omit replicates from the analysis” on page 158.

Note: To display a subset of the study data in the Gene Expression Plot pane, select
one or more rows in the Technical Replicates tab or the Biological Replicates tab, then
select Hide unselected data from plot to display data only from the selected rows.
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View the replicate results data and the well results data

The Replicate Results Data pane lists each reaction plate (experiment) that is added to
a study. The results of the study are arranged by technical or biological replicate

association.

The data that are displayed in the Well Results Data pane depend on which tab you
select in the Replicate Results Data pane:

Technical Replicates Tab

Biological Replicates Tab

This tab arranges the results of the relative quantification
analysis by technical replicate group. The ViiA™ 7 Software
displays the results for each sample/target combination as
a row in the table.

You can view the members of a technical replicate group by
selecting the appropriate row in the table. When a row is
selected, the Well Results Data pane displays the wells that
make up the selected technical replicate group.

j Rephcate Resulls Data

Cr Mean | ACr Me.. MCTSE A

17265017 ~

Sargle
Brain ACTH

Tanget

1
2 [0 s GARTH 1TIHTS 0344383 DRITMED
3 [ oben GHL
d 0O fan LPC
5 0O B=n LPIHL
5 Heart acTe 7
7 Hear GAFTH 7315718 16206368 0.0384727...
4 Heart GHL 3135455 L3B16464 D.[EGE1472
] Heart LpC 0804400 10, 7BEL1S5 055
1 Heart LPI ST 5.5MIEL 00
1 Lk ACTE 197188
19161573 0.0206L7... 005283 0

HATIGE 1623408 022976436 1w
¥

045525795 0]
43526795 (]
043520795 0
4352075 1)
[LA4532075 1)
AF520795 1)

i o s i £

This tab arranges the results of the relative quantification
analysis by biological replicate group. The ViiA™ 7 Software
displays the results for each biological group as a row in the
table (each row displays a biological sample with its target).

You can view the members of a biological replicate group by
selecting the appropriate row from the table. When a row
is selected:

e The Biological Replicate Details table displays the
technical replicate groups that make up the selected
biological replicate group.

e The Well Results Data pane displays the individual
members of the technical replicate groups that make up
the selected biological replicate group.

Terfruca Fepheater
£ | it Biglogic., | Target £ Fepli... | CrMean | ACT
1 BrEn ACTB 117268017 -BG0A
2 Brain GAPDH 1 105075
El Brain GH1 1 31083044 -

t )

Bifagical Repbrate Details

Edit BicGroug

£ | Qmit Sample | Target | 7 Mean | ACT Me. | ACT SE
it [0 EBmn ALTH 1735017 860325 0.081800
i Bran GAFIH 17.575475

{ |

(E=3

z Sarple  Target | Experimu, Omit Flag BQ

B ACTE Fl A
BN ACTE O
b ACTE 0
Brsin  ACTE O

Brain ACTR
Ban ACTE Vid?

Column descriptions

The table below provides definitions for the column headings that appear in the tables
in the Technical Replicates and Biological Replicates tabs.

Note: To show or hide columns in a table, select or deselect the column name from the
Show In Table drop-down menu.
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Column

Description

Act

The calculated Act value for the replicate group associated with the test
sample.

Note: The ACy value is calculated only for multiplex experiments and is
calculated at the well level (that is, the individual technical replicate level] by
subtracting the target Cy value from the endogenous control ¢ value.

ACt Mean

The arithmetic average of the technical replicate Cy values for the sample
replicate group.

Note: The ACt Mean value is calculated at the reaction plate level and
represents the mean difference between the target 1 values and the
endogenous control Cy values for all the technical replicates for that sample
that are present on the plate.

ACy SE

The Standard Error of the mean associated with the reported Mean ACy
value.

Note: The Act SE value is calculated differently for multiplex and singleplex
experiments. For multiplex experiments, the calculation is at the well level.
For singleplex experiments, the calculation combines the plate-level o1 value
variation between the target and the endogenous control.

Note: If you select the Standard Deviation option in the RQ Min/Max
calculations on the Relative Quantification Settings in the Analysis Settings
dialog box, Act SD, that is the Standard Deviation values are calculated by the
ViiA™ 7 Software.

AACy

The calculated AAqt value for the replicate group associated with the
reference sample.

# Replicates

The number of biological replicate groups in the study.

Biological The name of the biological replicate group.
Group
Cr Threshold cycle; the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot.
Ct Mean The arithmetic average of the technical replicate 7 values.
Experiment | The name of the experiment file (for example, heart.eds).
Flag The number of QC flags that the well generated as listed in the . symbol.
Omit Indicates the omission status of the members of the associated technical or
(Replicate biological replicate groupl(s):
ResultsData | & A check mark (v) indicates that all replicates have been removed from the
pane] analysis.
* A hyphen (-] indicates that one or more replicates have been removed
from the analysis.
Omit (Well Indicates the omission status of the well. A check mark (/] indicates that the
Results Data | well has been removed from the analysis.
pane)
RQ The calculated relative level of gene expression for the replicate group that

is associated with the test sample.
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Column Description

RQ Max The maximum relative level of gene expression in the test samples
calculated using the confidence level set in the Analysis Settings dialog box.

Note: The maximum includes the variability associated with the endogenous
control and targets in only the test samples.

RQ Min The minimum relative level of gene expression in the test samples calculated
using the confidence level set in the Analysis Settings dialog box.

Note: The minimum includes the variability associated with the endogenous
control and targets in only the test samples.

Sample The sample associated with the data displayed in the row.
Target The target assay associated with the data displayed in the row.
Well The location of the well in the reaction plate.

About the example study

In the Comparative Cy example study, you review the Replicate Results Data pane and
the Well Results Data pane to evaluate the Cy precision of the replicate groups and
view related RQ information.

View the results data

1. From the Study Menu pane, select Analysis » Gene Expression.
2. Click 4 at the top left of the Replicate Results Data pane.

3. View the technical replicates:
a. Click the Technical Replicates tab. The table displays the results by technical
replicate group.
b. In the Technical Replicates table, select the following groups:
® Brain/GAPDH (row2)
¢ Brain/LIPC (row 4)
® Brain/LPIN1 (row 5)

The Well Results Data pane displays all wells that make up the selected
groups.

4. View the values in the Well Results Data pane:

a. From the Group Results By drop-down menu, select Target.
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b. View the Ct, ACt Mean, and ACt SE values to evaluate the Cy precision of
the replicate groups. In the example study, the low ACy SE values indicate
these replicates have good Cr precision.

bd Replicate Results Data

Technical Repli
| Show In Table ¥ | Add BioGroup | Endo Controls ¥ | Ref Sample ¥
# | Omit Sample Target CT Mean ACT Me... ACT SE AACT RQ RQ Min RQ Max [
1 Brain ACTB 17.265017 ~
2 [] Brain GAPDH 17.570475 0.3144583 0.03370482  1.135117 0.45529795 0.43082792 0.48115784
3 ] Brain GH1 31.093044 13.828029 0.13150350.0095443... 0.9934062 0.8007919 1.2323499
4 ] Brain LIPC 28.929298 11.664282 0.0410995... -1.1238337 2.1792529 2.0372863 2.3311124
5 [] Brain LPIN1 21.73202  4.4670140.0398248... -1.1272674 2.1844450 2.0464118 2.3317004
6 Heart ACTB 18.136377
7 Heart GAPDH 17.315718 -0.8206588 0.0384727... 0.0 1.0 0.9388889 1.0650887
8 Heart GHL 31.95486 13.818484 0.08681472 0.0 1.0 0.8673678 1.1520135
9 Heart LIPC 30.924492 12.7881155 0.0554872... 0.0 1.0 0.9130675 1.0952092
10 Heart LPIM1 23.730658 5.594281 0.0346003... 0.0 1.0 0.94486696 1.0583501
17 Liver ACTB 19.201889
12 O Liver GAPDH 19.181273 -0.020617... 0.05293955 0.8000416 0.5743326 0.5265989 0.62639326
13 ] Liver GH1 35.452633 16.25408 0.23876446 2.4355955 0.18484712 0.12329351 0.277131
14 ] Liver LIPC 21.093778 2.7018890.0500186... -0.006226 1021.32495 040.9340  1108.5833 b

»
1

Well Results Data

Show In Table ¥ || Group Results By ¥

# Sample Target Experim...| Omit Flag RQ RQ Min RQ Max Flags cT ACT ACT Me... | ACT SE AMCT

=l GAPDH 4
Brain GAPDH ViiA7 O 0.45529795 0.43082792 0.48115784 17.508966 0.3144583 0.033704821.1351171...
Brain GAPDH ViA7 |l 0.45529795 0.43082792 0.48115784 17.504078 0.3144583 0.033704821.1351171...
Brain  GAPDH ViA7 O 0.45529795 0.43082792 0.48115784 17.523808 0.3144583 0.033704821.1351171...
Brain GAPDH WiiA7 ol 0.45529795 0.43082792 0.48115784 17.681126 0.3144583 0.033704821.1351171...
Brain  GAPDH ViiAZ O 0.45520795 0.43082792 0.48115784 17.656763 0.3144582 0.033704821.1351171...
Brain  GAPDH ViiA7 O 0.45520795 0.43082792 0.48115784 17.602106 0.3144582 0.033704821.1351171...

= LIPC
Brain LIPC ViiA7 O 2.1792529 2.0372863 2.3311124 29.059116 11.664282 0.0410995...-1.123833... v

Tips for viewing replicate results in your own study

* Select the Technical Replicates tab or the Biological Replicates tab to organize
and view the sample data according to the associated technical replicate group or
biological replicate group.

* View all wells for a technical or biological replicate group by selecting the
appropriate row in the table. When a row is selected, the Well Results Data pane
displays the wells that make up the group. Ctrl-click to select multiple rows.

* Change the endogenous control by clicking Endo Control, then selecting a new
target.

* Change the reference sample by clicking Ref Sample, then selecting a new
sample.

* Add biological replicate groups by clicking Add BioGroup.

* Omit biological or technical replicates from the analysis. See “Omit replicates
from the analysis” on page 158.

Note: The Comparative Ct Study Example.edm file demonstrates the use of
biological replicate groups. An additional example study that does not use
biological replicate groups is provided with the ViiA™ 7 Software. You can find
this study file on your computer at:

<drive>:\ Applied Biosystems\ ViiA7 Software

v1.1\experiments\examples\ ViiA7 Gene Expression Study Example.edm.
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Omit replicates from the analysis

To omit a technical or biological replicate from the analysis:

1.

2.

From the Study Menu pane, select Analysis » Gene Expression.

Select the Technical Replicates or Biological Replicates tab according to the type
of replicate that you want to omit.

In the replicate table, scroll to the biological or technical replicate of interest, then
select the corresponding check box in the Omit column.

Click Analyze when you finish omitting wells.

IMPORTANT! You cannot omit all technical replicates that belong to a reference
sample or a reference biological group, or that serve as the endogenous control for
a study.

Note: You can also omit the biological replicates in the Biological Replicate
Details table at the bottom of the Biological Replicates tab.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye over the duration of the PCR run in a selected well of any experiment that is added
to the study.

About the example study

In the comparative Ct example study, you review the Multicomponent Plot screen for:

ROX™ dye (passive reference)
FAM™ dye (reporter)
Spikes, dips, and/or sudden changes

Amplification in the negative control wells

View the Multicomponent Plot

1.

2.

From the Study Menu pane, select Analysis » Multicomponent Plot.

In the Experiment Data pane, select the ViiA7 Comparative Ct Example 1.eds
experiment.

Display the unknown wells one at a time in the Multicomponent Plot pane:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot pane.
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Multicomponent 4 Experiment Data

Chapter 13
Confirm accurate dye signal using the Multicomponent Plot

Note: If you select multiple wells, the Multicomponent Plot pane displays the
data for all selected wells simultaneously.
In the Multicomponent Plot pane, set the parameters for the plot:
a. From the Plot Color drop-down menu, select Dye.
b. Click F Show a legend for the plot.
Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.

Check the FAM dye signal. In the example study, the FAM dye signal increases
throughout the PCR process, which indicates normal amplification.

Check the ROX dye signal. In the example study, the ROX dye signal remains
constant throughout the PCR process, which indicates typical data.

Repeat steps 2 through 6 for the remaining experiments in the study.
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Tips for confirming dye-signal accuracy in your own studies

Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

Irregularities in the fluorescence — There should not be any spikes, dips, and/or
sudden changes in the fluorescence.

Negative control wells — There should not be any amplification in the negative
control wells.
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If your study does not meet the guidelines above, you can omit individual wells from
the analysis. See “Omit wells from the analysis” on page 175.

View the QC Plots

The QC Plots screen displays the endogenous control and replicate analysis results for
each reaction plate (experiment) added to the study. The following plots are derived
from the experiments added to a study:

¢ Endogenous Control Profile

* Box Plot

¢ Technical Replicates Correlation

* Biological Replicates Correlation

View the Endogenous Control Profile plot

The QC Plots screen displays the Endogenous Control Profile plot for the endogenous
controls used in the experiments added to a gene expression study. The endogenous
control profile plot displays how much of the endogenous control is expressed in a
sample. The sample is plotted on the X-axis, and the Cy is plotted on the Y-axis. The
expression is viewed as a color and shape combination in the plot.

In the example study, you view four potential endogenous controls expressed in four
samples. The potential endogenous controls are:

e ACTB

e GH1

e LIPC

e LPIN1

The samples are brain, heart, lung, and liver.
1. From the Study Menu pane, select Analysis » QC Plots.
2. In the QC Plots pane, click Endogenous Control Profile.

3. In the Candidate Endogenous Controls pane, select the check boxes of those
Targets whose profile you want to view in the plot pane. In the example study, the
Target ACTB is chosen to be the endogenous control because it is expressed at
similar levels in three out of four of the given samples.

4. In the Replicate Results Data pane, view results by replicate group.

a. Click the Technical Replicates tab. The table displays the results by technical
replicate group.
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b. Click the Biological Replicates tab. The table displays the results by

biological replicate group.
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View the box plots

The Box Plot displays the Cy distribution of a particular Target in samples. You can see
the individual Cy values/ raw data with this plot.

In the example study, you view the box plots of five targets in four different samples:

e LPIN1

e GAPDH
e LIPC

e GH1

e ACTB

The samples are Heart, Liver, Lung, and Brain.

1. In the QC Plots pane, click Box Plots to access the Replicate Results Data pane.

2. In the Replicate Results Data pane, click the Technical Replicates tab. The table
displays the results by technical replicate group.

w

replicate group.

»

Click the Experiments tab to select the experiment whose Box plot to view.
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5. View the values in the Well Results Data pane. View the Ct, ACt Mean, and ACt
SE values to evaluate the Ct precision of the replicate groups. In the example
study, the low ACy SE values indicate these replicates have good Cy precision.
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View the Technical Replicates Correlation plot

The Technical Replicates Correlation plot displays the correlation between the target
genes in one or more samples.

The Technical Correlation Group plot is made of two components, the scatter plot and

the heat map.
Scatter Plot The scatter plot shows the —
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If a correlation b /

(represented by R? or the
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among the targets in the
samples, the targets
appear on or along the
line of reference. If the
correlation is weak or not
present, the targets appear
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View the QC Plots

It o 2 &
e R?=/=1, then the Scatter Plot
correlation is Study: ViiA7_384.Well_Comparative_Ct_with_Bioreplicates_Study_Example, Heart vs Liver, RO = 0.03
strong :; "
e R2<1, then the -
correlation is weak i
e R2=0, then there is &

no correlation
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The heat map shows the variation of coefficient determination for different scatter
plots. Each cell of the heat map represents a different scatter plot, and therefore a
different value for R?. The cells inclined to red represent a lower R? value; the cells
inclined to green represent a higher R? value.

In the example study,
you view the scatter
plots and heat maps of
five targets in four
different samples:

e LPIN1

e GAPDH
e LIPC Heart
e GH1

e ACTB

Erain

The samples are Brain,
Heart, Kidney and
Lung.

Liver

1. In the QC Plots
pane, click Lung
Technical
Replicates
Correlation to
access the Heat Map.
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2. In the Heat Map, click the cell with a correlation value, R2=/=1. The

corresponding scatter plot pane displays the scatter plot of the targets in that
technical replicate group along the line of reference.
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3. Click the cell with a correlation value, R? =/= 0. The corresponding scatter plot

pane displays the scatter plot of the targets in that technical replicate group away
from the line of reference.
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View the Biological Group Correlation plot

Scatter Plot

Chapter 13 II 3
View the QC Plots

The Biological Group Correlation plot displays the correlation between the target
genes in one or more biological group samples. Biological groups provide a broader

set of samples, with the same targets.

Note: If the experiments in your study do not use biological replicate groups, see
“Define Replicates” on page 136 to create a new biological group.

The Biological Group Correlation plot is also made of two components, the scatter plot

and the heat map.

The scatter plot shows the
distribution of ACt of
targets for different
biological groups. If a
correlation (represented by
RZ or the coefficient of
determination) exists
among the targets in the
biological groups, the
targets appear on or along
the line of reference. A
weak correlation or no
correlation is represented
by the targets being
scattered in the plot and
away from the line of
reference.

Note: The line of reference
is fixed in the ViiA™ 7
Software.

delta Ct Heart

Study: ViiA7_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example, Heart vs Heart, RO =1

Scatter Plot

P L E R

delta Ct: Heart

= ACTE = GAPDH = GH1 = LIPC = LPIN1
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If:

e R2=/z1, then the
correlation is strong

e R2<1, then the
correlation is weak

e R2=0, then there is
no correlation

Heat maps

The heat map shows the
variation of coefficient
determination for different
scatter plots. Each cell of
the heat map represents a
different scatter plot, and
therefore a different value
for R2. The dull green cells
represent a lower R2 value;
the bright green cells

represent a higher R? value.

In the example study, you
view the scatter plots and
heat maps of eight targets
across four biological
groups:

e LPIN1

* GAPDH

e LIPC

* GHI1

e ACTB

Chapter 13 Design and Analyze a Gene Expression Study
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Technical replicate samples of Brain cDNA belong to the biological group Brain, those
of Lung cDNA belong to biological group Lung, technical replicate samples of Liver
cDNA belong to the biological group Liver, and those of Heart cDNA belong to the

biological group Heart.
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1. In the QC Plots pane, click Biological Group Correlation to access the heat map.

To view the Biological Group Correlation plot:

2. In the Heat Map, click the cell with a correlation value, R2=/=1. The
corresponding scatter plot pane displays the scatter plot of the targets in that
biological replicate group along the line of reference.
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3. Click the cell with a correlation value, R? =/= 0. The corresponding scatter plot

pane displays the scatter plot of the targets in that biological replicate group away
from the line of reference.

PP BREE
Scatter Plot
Study: VAT _384-Well_Comp . Ct_with_Biorep _Study | Heart vs Liver, RO - 0,549
T
1a L
it} Heark:
= Lirg <A 09779
3
:
Bram
A 8 1 @ 5 4 5 & 1 & 8w W 2 1 14 s
dezita Ot H2art
®wAZTE ® GAPDH = &Hi wLIPC = LPIRA
Applied Biosystems ViiA™ 7 System Getting Started Guide for Relative Standard Curve and Comparative Ct 167

Experiments



1 3 Chapter 13 Design and Analyze a Gene Expression Study
View the QC Summary

Tips for viewing your own scatter plots and heat maps

When you analyze your study, look for scatter plots and heat maps that display a
correlation value that is =/= 1 for samples that come from the same source or tissue
(technical or biological replicates). If the replicates do not correlate well, that could be a
sign that there is a problem with a sample.

If your study does not meet the guidelines above, you can omit individual wells from
the analysis. See “Omit wells from the analysis” on page 175.

View the QC Summary

The QC Summary screen displays a list of the ViiA™ 7 Software flags, and it includes
the flag frequency and location for any experiment that is added to a study.

About the example study

In the Comparative Cy example study, you review the QC Summary screen for any
flags generated by the study data. In the example study, several wells produced data
that generated flags.

View the QC Summary

1. From the Study Menu pane, select Analysis » QC Summary.
Note: If no data are displayed, click Analyze.

2. In the Flags Summary table, look in the Frequency column to determine which
flags appear in the study. In the example study. The EXPFAIL flag appears 10
times and the NOAMP flag appears once.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the study.

3. For each flag that appears in the study, click the flag row to display details about
the flag in the Flag Details table. In the example study, the NOAMP flag indicates
no amplification and the EXPFAIL flag indicates that the exponential algorithm
failed.
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4. Consider removing the NOAMP well from the analysis. See “Omit wells from the
analysis” on page 175.

b4 Flag Summary

Flag Name Freguency

=1 Experiment Flags - 2 of 11 Found
SPIKE Noise spikes [1]
BADROX Bad passive reference signal [1]
NOAMP Mo amplification il
CTFAIL C1 algorithm failed 0
BLFAIL Baseline algorithm failed [1]
EXPFAIL Exponential algorithm failed 10
HIGHSD High standard deviation in replicate group 0
NOSIGHNAL No signal in well [1]
NOISE Moise higher than others in plate [1}
OFFSCALE Fluorescence is offscale 0
AMPHC Amplification in negative control [1]

= Replicate Flags - 0 of 2 Found
THOLDFAIL Thresholding algorithm failed 1]
QUTLIERRG Qutlier in replicate group [1]

iaw
Flag Details
Flag: NOAMP—No amplification
Flag Detail: The sample did not amplify
Flag Criteria: Amplification algorithm result < 0.1
View NOAMP Troubleshooting

Information

| Show In Table ¥ || Group Results By ¥

# Sample Target Experim... Flag RQ RQ Min RQ Max Flags Ct ACT ACT Me... | ACT SE AACT well Omit
VA7 D 0.18484712 0.12329351  0.277131 NOAMP Undetermi... 16.25408 0.238764462.4355956... G11 ]

Possible flags

For Comparative Cr studies, the flags listed below may be generated by the study
data.

If a flag does not appear in the study; its frequency is 0. If the frequency is >0, the flag
appears somewhere in the study, and the associated well position is listed in the
Wells column.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL | Cy algorithm failed
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Flag Description

Secondary analysis flags

OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

Tips for using flags to evaluate your study

¢ In the Flag Summary table, click each flag that has a frequency >0 to display
details about the flag in the Flag Details table. If needed, click the troubleshooting
link in the Flag Details table to view information on correcting the flag.

Note: In the Flag Details table, the numbers on each flag symbol indicate the
number of flags generated for that well. For example, 2 indicates that two flags
have been generated for that well.

* You can change the flag settings. For more information, see “Flag Settings” on
page 145:

— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the ViiA™ 7 Software.

* You can omit individual wells from the analysis. See “Omit wells from the
analysis” on page 175.

Compare analysis settings

Use the Compare Settings screen to perform a side-by-side comparison of analysis
settings for a comparative 1 study. You can change one or more of the analysis
settings, then compare the new results with the previous results. For example, you can
compare the effects of:

¢ Using multiple endogenous controls versus a single endogenous control.

¢ Changing the amplification efficiency of a specific target versus keeping it at
100%.

About the example study

In the comparative Cy example study, you change the endogenous control to LPIN1,
then compare results.
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Modify comparison criteria

1. From the Study Menu pane, select Analysis » Compare Settings. When the
Compare Settings screen is initially displayed (before you make any changes):

¢ In the Settings Comparison pane, the green column is titled “Current
Analysis Settings,” the white column is titled “Comparison Analysis
Settings,” and the Use Comparison Analysis Settings button is under the
green column.

¢ In the Results Comparison pane, values in the white columns and values in
the green columns are the same.

¢ The Gene Expression Comparison plot is the same plot that is displayed in
the Gene Expression screen (Analysis » Gene Expression).

2. In the Settings Comparison pane, click Edit in the green column to open the
Comparison Analysis Settings dialog box.

Gene Expression Comparison *| Settings Currant Anakyss Settings [ Edit... Comparion Analyss Sattings [ Edi...
1200 = Target Settings (Threshol, Baselne Start, Baselne End) -
i GH1 2 AUTA, AUTD, AUTO AUTD, AUTS, AUTD
- GAPDH IAUTO. AUTO, AUTG . IAUTO, AUTO, AUTD
H10a4 LPIHT AUTG, AUTOD, AUTO AUTD, AUTG, AUTD
1050 ACTE ALITS, AUTO, AUTD AUTO, AUTD, AUTD
LR AUTI, AUTD, AUTOD AUTD, AUTD, AUTD
1000 = Flag Settnas
o5 SRHE USED Spke algomthm resuts1.0 USED Spike aigarthm resul=1.0
a00 BADROY USED Bad passie 1 ce algorkhim ... USED 8ad passive raference algorithm ...
HOAMP USED Ampication algodthm resul<0.... USED Armplfication algorthm result<0....
el CTFAL UISED 1J5ED
Bg BLFAILL USELD USED
Lt SRl (B i A,
Toa Lise Comgp ¥
B3 F
2
-
Entera fitar quary, then cick “Apoly Fiter,”
530 - - Bl O, e
o) T [sample “| |- = |
400 4 .
s VALY
a0 E Sample Tanget C7 Mea.. | CT Mea.. | ACT Me_.. | ALT Ma... | ACTSE 1 | ACT SE 2 | BACT 1 BACT 2
250 | 1 Brain ACTE 17.265 17265 o
2 Brain GAPDH 17.579 17579 0,314 0314 0.024 0024 1.135 I
rd 3 Bram GH1 .09% 31,093 13828 13.828 0132 0,132 0.0t |
150 4 Bam L 28920 ZB.920 11,664 11,664 0041 041 -1.134 -1,
il 5 Brain LPIML 21,732 21732 4,467 4467 0.04 0.4 1.127 -1
& Heart ACTE 1E.136 1B.136 =
5a 7 ‘Heart: GAPDH 17.316 L7316 0.821 0821 0.038 0.038 1]
a Es= L3 Heart GHL 31455 31855 L3.81a iaaia 0.087 0.087 o
& e Ed Heart: LrG 30,924 30524 12,788 12,768 0.055 0,055 e}
h > 10 Hagrt LrTht 23.731 2373 5.504 5594 0.025 0,035 o =
Sample s { S T LY
3. In the Comparison Analysis Settings dialog box, change the endogenous control:
a. Select the Relative Quantification Settings tab.
b. In the Endogenous Control(s) pane, select LIPN1 from the Endogenous
Control drop-down menu.
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c. Click Analyze to analyze the data and close the dialog box.

i | Analysis Settings for ViiA7_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example

71 Settings Flag Settings

@ Comparative CT Analysis Settings

~ Analysis Type
Select the type of analysis to perform.

(® Singleplex
— fi ce 5)
Select reference samples for the biological and/or technical replicate groups of this study.
Biological Replicate Group Reference Sample:  |Brain Technical Replicate Group Reference Sample: |Heart
.~ Endog Control(s)
Select the target to use as the endogenous control for this experiment.
Endogenous Control: |LPIN1 v
~— Efficiency
Target Efficien... | Efficien... | Owerride Std/Rsc ...
ACTB 100.0 0.0 A
Enter percentage values between 1 and 150% |GAPDH 100.0 0.0
GH1 100.0 0.0
LIPC 100.0 0.0
LATR 1inn.n non v

.~ Outlier Rejection
Select to reject replicates with ACT values less than or equal to the value entered below, These analysis settings apply only to multiplex reactions.

[[] Reject Replicates with specified ACT

~~ RQ Min/Max Calculations
Select an algorithm to determine RQ Min and Max values {error bars).

(& Confidence Level: 95.0 v %

() Standard Deviations:

Save to Library Load from Library Revert to Default Analysis Settings W W

4. In the Settings Comparison pane, click Use Comparison Analysis Settings under
the green column, then compare the results:

¢ In the Settings Comparison pane, the white column is titled “Comparison
Analysis Settings,” the green column is titled “Current Analysis Settings,”
and the Use Comparison Analysis Settings button is under the white
column.

¢ In the Results Comparison pane, values in the white columns are based on
the default analysis settings, and values in the green columns are based on
the modified analysis settings. In the example experiment, changing the
endogenous control to 18S affects the RQ values. To view the RQ values,
scroll to the left. If desired, you can click and drag the RQ column headings
so that they appear first in the table.

* The Gene Expression Comparison plot displays the default analysis settings
(the values from the white columns).

Note: The Gene Expression Comparison plot has limited functions. For
example, you cannot change to log scale and you cannot view by target.
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RQ
i
5

Sample

Chapter 13
Compare analysis settings

13

Note: The default analysis settings are the settings automatically made by
the software when the study is initially analyzed.

i Settings Current Anakyss Settinos
= Target Sethings (Thrashold, Baseine Stert, Baseina End)
GH1 AUTO, AUTO, AUTD
GAPCH AUTD, AUTD, AUTD
LPINL AUTD, AUTO, AUTD
ACTH AUTD, AUTO, AUTD
AUTO, ALUTO, AUTD

LPC
= Aag 5attings

SPIKE LISED Spike sigorthm result=1.0
BADRCX USED Bad passive reference zigonthm
NOAMP USED Amplfication slgarkim result:
CTFAIL USED

BLFAIL LISED

EXFFAILL

LISED

Companson Analyss Settngs

AULTO, AUTD, AUTO
AUTD, AUTD, AUTO
ALTO, AUTD, AU TO
ALTO, AUTO, AUTO
ALTD, AUTD, AUTO

UISED Spika algorihm rasult=1.0

. JJSED Bad passwa refarence aigorkhm ...
..o USED Ampficetion algarithm resuk=[....

USED
USED
USED

Ertar 2 fiter quary, then dick “Apply Fiter.”

IF |Sampla ¥ = » W
[Grow i i v
# Sampla Target CT Mea.. | Cr Mea.. | ‘ACT Me... || ACT Me.., | ACTY SE L | ACY SE 2 | AACT 1

E Bran ALCTB 17.265 4467 0.04 1.127

I3 Bran GAPDH 7.579 17.57%2 +4.153 o314 0.027 0.034 2.262

3 Brain GHI 31.093 31.0831 9361 13828 a1z 0.132 1.137

(4 Brah LIPC 28923 28.92% 7.197 L1.664 0036 0041 0.003

5 Brain LPTH1 21.732 21.732 4467 n.04

& Heark ACTB 18.13% 18.136 -3.094 0,035 a

r Hear GAPDH 17.316 17.316 &415 {821 004 0.038 a
| |E Haar GH1 31.055 31.0955 8.234 13.818 0.088 0.087 a

) Heam LPC 30.925 30.924 7.194 12.788 0.057 0.055 a

16 Heam LFPIN1 23711 23731 5.594 0.035

ArCT 2

5. From the Study Menu pane, select Analysis » Gene Expression to view the gene
expression plot using the modified analysis settings.

Note: In the Gene Expression screen you can view the modified data in log scale,

by target, and so on. See “Assess the gene expression profile using the Gene

Expression Plot” on page 150.

6. (Optional) View the data in the other analysis screens. All other analysis screens
for the study display the data using the modified analysis settings.

7. Close the study.

Or

* Save your changes before closing the study.

* C(Close the study without saving your changes. If you do not save your

changes, the software reverts to the default analysis settings the next time

you open the study.
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Compare analysis settings

Tips for managing your own comparison

¢ Edit the comparison analysis settings as desired. For information on editing the
settings, see “View the analysis settings” on page 143.

¢ After making your first round of changes to the analysis settings, you can
continue making changes using one of the following methods:

— (Recommended) Revert to the saved analysis settings, then make new
changes. To do this: In the Settings Comparison pane, click Use Comparative
Analysis Settings (now under the white column) to revert to the saved
analysis settings, then repeat steps 2 through 6 above. This method ensures
that you do not lose the saved analysis settings.

Note: If you have made changes, but have not saved them, the software
reverts to the default analysis settings when you click Use Comparative
Analysis Settings. The default analysis settings are the settings
automatically made by the software when the study is initially analyzed.

— Continually compare new settings with previous settings. To do this: In the
Settings Comparison pane, alternate clicking Edit in the white and green
columns, then repeat steps 3 through 6 above. This method does not allow
you to return to your saved settings; subsequent comparisons are made with
the previous analysis settings, building upon any changes that you have
already made.

Revert to the default analysis settings

IMPORTANT! The default analysis settings are defined by the software. If you make
changes to the analysis settings and save the study, the saved changes are lost when
you revert to the default analysis settings.

1. In the Settings Comparison pane, click Edit next to the settings you want to revert
to the default: Current Analysis Settings or Comparison Analysis Settings.

2. In the Analysis Settings dialog box, revert to defaults and reanalyze the data:
a. Click Revert to Default Analysis Settings.
b. At the prompt, click Yes.
warming x|

! E ou have selected to revert to Default Analysis Settings. Are you sure wou want ko continue?

Mo

c. Click Analyze to analyze the data and close the dialog box.

3. In the Settings Comparison pane, click Use Comparison Analysis Settings. In the
Results Comparison pane, values for the settings you selected to edit in step 1
(“Current Analysis Settings” or “Comparison Analysis Settings”) are generated
according to the default analysis settings.
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Export the study

Omit wells from the analysis
You can use the Well Table to omit individual wells from the analysis. To omit a well:

1. From the Study Menu pane, select one of the following analysis screens:
* Analysis » Amplification Plot
* Analysis » Multicomponent Plot
* Analysis » Multiple Plots View

2. In the Experiment Data pane, select the experiment that contains the well to omit.

3. In the Well Results Data pane, click the Well Table tab, then select the check box
in the Omit column for the well to omit.

Note: You cannot omit all technical replicates that belong to a reference sample or
a reference biological group, or that serve as the endogenous control.

Export the study

Note: If you are using RealTime StatMiner® Software to analyze the exported data,
make sure you have assigned a sample to all the wells containing data in the
individual experiments. If a sample is not assigned, the RealTime StatMiner® Software
reports an error during import.

You can export the data within a study from the Analysis screen. To export a study:
1. On the Analysis screen, click Export to access the Export Properties tab.

2. Define export properties.
a. Select the data to export. Options are:
¢ Amplification Data
* Results
* Technical Analysis Result
¢ BioGroup Analysis Result
¢ QC Summary

b. Select One File or Separate Files from the drop-down menu to export all
data to one file or in separate files for each data type respectively.

c. Enter the export file properties and file name.

d. Select the file type from the File Type drop-down menu. You can choose
from *.txt, *.xIs, and *.xIsx.

e. Enter the Export File Location. The default location is C:\ Applied
Biosystems\ ViiA7 Software v1.1\ experiments.

f. Select the Open file(s) when export is complete check box to automatically
open the file when export is complete.
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Export the study

For the example study, enter:

Field or

Selection Entry

Select Data Amplification Data
to export

Select one One File
file or
separate files

Export File  ViiA7 384-
Name Well_Comparative_Ct_with_Bioreplicates_Study_Example_data

File Type *.txt

Export File <drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments
Location

Open file(s) Unchecked
when export
is complete

Save current | Unchecked
settings as
the default

7900 Format . Unchecked

The Export Data screen looks like this:

i Export Data

Select the type of data to export, select whether to export one file or separate files, then enter export file properties. {Optional) Click "Customize Export™ to change the export format and to select fields to =,
export, Click "Start Export”™ to export your data. @

Amplification Data [ Results
[] Technical Analysis Result [] BioGroup Analysis Resuft
[ QC Summary

1. Select data to export:

2. Selact one flle or separate filss: |One File | Sewecrto export all data to one file or in separate files for each data type.

3. Enter export file properties:

Export File Name: ViiA]’ 384-Well Comparative Ct with Bioreplicates Study Example data File Type: iEJ (*.txt) V‘
Export File Location: EC:\.Apphed Biosystems\WVilA7 Software vi.l\experiments ‘

[[] open file(s) when export is complete

[1 Save current settings as the default [] 7900 Format Start Export
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Export the study

3. To change the export format, complete the tasks on the Customize Export tab.

Note: To complete the tasks on the Customize Export tab you must have at least
one type of data to export.

a. Select the data from the Export Properties tab. The type of data that you
selected in the Export Properties tab appears in the Customize field in the
Customize Export tab.

b. Select the data type content.

. Select the Tabs or Commas radio button to select the Field Separator
(Delimiter).

d. Select the Open file(s) when export is complete check box to automatically
open the file when export is complete.

For the example study, enter:

Field or Entr
Selection y

Customize Amplification Data

Field Commas

Separator

(Delimited)

Open file(s) Unchecked

when export

is complete

Save current | Unchecked

settings as

the default

7900 Format | Unchecked
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For more information

The Export Data screen for customized export of Amplification Data looks like
this:

i Export Data

Select the type of data to export, select whether to export one file or separate files, then enter export file properties. {Optional) Click "Customize Export™ to change the export format and to select fields to -
export, Click "Start Export”™ to export your data. @

Export Properties

Customize: E-Ampliﬁcation Data ;. File Mame: ViA7_384-Well_Comparative_Ct_with_Bioreplicates_Study_Example_datz  File Type: 5]
Select Amplification Dat - Amplification Data Export
All Amplification * || Experim... Well Cycle Sample Target RN ARN Omitted |
:VuA? Com... Al 1 Brain ACTB 0.002 [*] -~
Expadment-Name Via7 com... A1 2 Brain ACTE 0.002 0 —?‘
el |Via7 com... AL 3Brain ACTB 0.001 O
|Viia7 Com... Al 4 Brain ACTB 5.2215403... 2]
Cycle :V\iﬁt? Com... Al 5 Brain ACTB 5.771369E5 F]
|viia7 Com... AL 6 Brain ACTB -2.469415... 2]
Sample |ViA7 Com... AL 7 Brain ACTB -6.180111... F
|ViiA7 Com... Al 8 Brain ACTB -0.001 ]
Target Via7 com... AL 3B ACTR -0.001 0
an |Via7 com... Al 10Brain ACTB -5.690786... 2]
|ViiA7 Com... Al 11 Brain ACTB -5.289209... F]
ARn = ?V\i."\? Com... Al 12 Brain ACTB 2.0265064... 2]
L 80 13 Brain ACTB 0.002 il
[v] Omitted ¥ AT 14 Brain ACTB 0.006 F
<) | # iV\iA? Com... Al 15Brain ACTB 0.013 )
Field Separator (Delimite [VIA7 Com... Al 16Brain ACTB 0.025 2]
|ViiA7 Com... Al 17 Brain ACTB 0.047 F]
) Tabs () Commas | |VIA7 Com... AL 18 Brain ACTB 0.079 O
a7 Com A1 10 Arain ACTR ni T s
[] Open file(s) when export is complete

[1 Save current settings as the default [] 7900 Format Start Export

4. Select the Save current settings as the default check box to save the export
settings that you have modified. Alternatively, select the 7900 Format check box to
save the export settings in the 7900 format.

5. Click Start Export.

For more information

For more information on Refer to Part number
Calculating Relative User Bulletin #2: Relative Quantitation of Gene Expression. 4303859
Quantification Values
Consumables Chapter 1in Booklet 1, Getting Started with ViiA™7 System Experiments. LLA1434

Appendix A in Booklet 7, ViiA™ 7 System Experiments - Appendixes
Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™7 System Experiments. 4441434
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CHAPTER 1

About Genotyping Experiments

Chapter 1 This chapter covers:
About Genotyping About data collection. ....... ... ... 8
Experiments About TagMan® SNP Genotyping assays ............cooviiiiiiiinnnnaan.. 8
About TagqMan® MGB probes . ... 9
I S¢nuclease assay .. ... 9
Minimizing non-specific fluorescence. .................... . .. oL 10
Reading and analyzing theplates ....................................... 10
About the example experiment ........... ... .. i 11

Design the Experiment

IMPORTANT! First-time users of the ViiA™ 7 System, please read Booklet 1, Getting
Started with ViiA™ 7 System Experiments and Booklet 7, ViiA™ 7 System Experiments -
Appendixes of this binder thoroughly. The booklets provide information and general
instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Prepare the Reactions Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking &) in
the toolbar, or selecting Help » ViiA™ 7 Software Help.

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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About data collection

About data collection

Genotyping experiments are performed to detect single nucleotide polymorphism
(SNP) variants of a target nucleic acid sequence in samples. The PCR reactions contain
primers designed to amplify the sequence containing the SNP and reagents to detect
two different alleles.

You can collect the results of a genotyping experiment in two different ways: At the
end of the experiment, or continuously during the experiment. Data collection at the
end of the experiment is called end-point data collection. Data collection during the
experiment run is considered real-time PCR. The real-time data helps further data
analysis.

In end-point data collection, the normalized intensity of the reporter dye, or Rn, is the
data collected. Some end-point experiments also include pre-PCR (data collected
before the amplification process) data collection. The system calculates the delta Rn
(ARn) value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

About TagMan® SNP Genotyping assays

A Genotyping assay detects variants of a single nucleic acid sequence, without
quantifying the target. The presence of two probes in each reaction allows Genotyping
of the two possible variants at the single nucleotide polymorphism (SNP) site in a
target sequence.

Each TagMan® SNP Genotyping Assay consists of a single, ready-to-use tube
containing:
* Two sequence-specific primers for amplifying the polymorphism of interest

* Two allele-specific TagMan® MGB probes for detecting the alleles for the specific
polymorphism of interest
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57 nuclease assay

About TagMan® MGB probes

Each allele-specific TagMan® MGB probe has:

* Areporter dye atits 5" end:
— VIC® dye is linked to the 5 end of the Allele 1 probe.
— FAM™ dye is linked to the 5" end of the Allele 2 probe.

The Allele 1 VIC® dye-labeled probe corresponds to the first nucleotide inside the
square brackets of the context sequence in the assay information file (AIF)
shipped with each order. The Allele 2 FAM™ dye-labeled probe corresponds to
the second nucleotide inside the square brackets of the context sequence in the
AIF. For the context sequence ATCGATT[G/T]ATCC, the VIC® dye-labeled probe
binds to the G allele, and the FAM"" dye-labeled probe to the T allele.

* A minor groove binder (MGB), which increases the melting temperature (T,,,) for
a given probe length and allows the design of shorter probes. The use of shorter
probes results in greater differences in T,,, values between matched and
mismatched probes, and more robust genotyping.

* A non-fluorescent quencher (NFQ) at its 3" end, which allows for detection of the
reporter dye fluorescence with greater sensitivity than with a fluorescent
quencher.

5" nuclease assay

The figure below is a schematic depiction of the 5 nuclease assay. During PCR:
* Each TagMan® MGB probe anneals specifically to its complementary sequence
between the forward and reverse primer sites.

*  When the oligonucleotide probe is intact, the proximity of the quencher dye to the
reporter dye quenches the reporter signal.

* AmpliTaq Gold® DNA polymerase extends the primers bound to the genomic
DNA template.
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Minimizing non-specific fluorescence

* AmpliTaq Gold® DNA polymerase (with its 5" nuclease activity) cleaves probes
that are hybridized to the target sequence.

* C(Cleavage of the probes hybridized to the target sequence separates the quencher
dye from the reporter dye, resulting in increased fluorescence by the reporter. The
fluorescence signal generated by PCR amplification indicates which alleles are
present in the sample.

1. Assay Compenents and DNATemplate
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Minimizing non-specific fluorescence

In TagMan® assays, fluorescence from nonspecifically bound probes is reduced,
because nucleotide mismatches between a probe and a sequence reduce the chances
that the probe will be cleaved. The probe’s short length means that a one-base-pair
mismatch will a have a larger negative effect on the binding. The mismatched probe
will not bind tightly to the allele; the AmpliTaq Gold® DNA polymerase will likely
displace the probe without cleaving the dye.

Reading and analyzing the plates

The ViiA™ 7 Software genotypes the DNA samples from the reaction plate
simultaneously. First, the software normalizes the fluorescence of the reporter dyes to
the fluorescence of the passive reference dye in each well. Next, the software plots the
normalized intensities (Rn) of the reporter dyes in each sample well on an Allelic
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About the example experiment

Discrimination Plot, which contrasts the reporter dye intensities of the allele-specific
probes. Finally, the ViiA™ 7 Software algorithmically clusters the sample data, and
assigns a genotype call to the samples of each cluster according to its position on the
plot.

Note: The ViiA™ 7 Software clustering algorithm does not call genotypes when only
one genotype is present in an experiment.

45 *

4.0

Allele 2

35

3.0

LI s

24 24 34 24
Allele 1

The clustering of datapoints can vary along the horizontal axis (Allele 1), vertical axis
(Allele 2), or diagonal (Allele 1/Allele 2). This variation results from differences in the
extent of reporter dye fluorescent intensity after PCR amplification. The table below
shows the correlation between fluorescence signals and sequences in a sample.

A substantial increase in... Indicates...

VIC® dye-labeled probe fluorescence only | Homozygosity for Allele 1
FAM™ dye-labeled probe fluorescence only | Homozygosity for Allele 2

Both VIC® and FAM™ dye-labeled probes | Allele 1-Allele 2 heterozygosity
fluorescence

About the example experiment

To illustrate how to perform Genotyping experiments, this guide leads you through
the process of designing and performing an example experiment. The example
experiment represents a typical setup that you can use to quickly familiarize yourself
with a ViiA™ 7 System.

The objective of the example Genotyping experiment is to investigate SNP rs8039,
where possible genotypes are AA, AC, and CC. In the example, two unknown
genomic DNA (gDNA) samples were genotyped using TagMan® Drug Metabolism
Genotyping Assay ID C__11711420_30. The reactions were set up so that the PCR

Applied Biosystems ViiA™ 7 System Getting Started Guide for Genotyping Experiments 1



1 Chapter 1 About Genotyping Experiments
About the example experiment

primers and probes that target both alleles of SNP rs8039 were present in the same
well. The PCR was performed using the TagMan® Genotyping Master Mix and run
according to the protocol that is described in the Performing a TagMan® Drug
Metabolism Genotyping Assay.

12 Applied Biosystems ViiA™ 7 System Getting Started Guide for Genotyping Experiments



CHAPTER 2

Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.
About Genotyping
Experiments This chapter covers:
Define the experiment properties. ...................... ... ... 14
Define SNPs and samples . .. ... 15
l Assign markers and samples . ......... . 17
Setuptherunmethod ...... ... ... ... . 19
Chapter 2
Order materials for the experiment...................... ... ... .. ..., 21
Design the Experiment
For more information. ....... ... ... 21
Note: To automatically export the analyzed data to a specified location, select the Auto
I Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1in Booklet 1, Getting Started with ViiA™

7 System Experiments.

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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Define the experiment properties

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
ViiA™ 7 Software. Enter:

Field Entry
Experiment Name ViiA7_384-Well_SNP_Genotyping_Example
Barcode Leave field empty
User Name Example User
Comments Genotyping example
Block 384-Well Block
Experiment Type Genotyping
Reagents TagMan® Reagents
Ramp speed Standard

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR
collection methods:

Pre-PCR Read Checked
Amplification Checked
Post-PCR Read Checked

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identilfy this experiment?

* Experment Hame: |iA7_354-Well_SNF_Genotyping_Example |
Barcode: | !
Usar Name: !_E_;_é_(ﬁ;ll:éy_-ofal |

Comments: Genotyping example &

Which block are you using to run the experiment?

‘ v 284-Well Block | Aray Card Bhock ] L wi-wiall Block {0.2mL) | | Fast u5-Wall Block {0.1mi} |
What type of experiment do you want to set up?

| . 5 y X
[ Standard Cunve | | Relztive Standard Curye [ Comparative Cr (AACT) | [ Melt Curve d
+ Genatyping | | Prissenoe/ Absencs J

Which reagents do you wankt to use to detect the target sequence?

| ¥ TagMan® Reagents L Ot J

I(. = | —

Inchide:  [2] Pra-PCR Read (2] Amplfcstion
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Chapter 2
Define SNPs and samples

Define SNPs and samples

Click Define to access the Define screen. Enter:

1. SNP Assays

SNP
assay NCBISNP Context Allete Reporter | Quencher Allete Reporter | Quencher | Color
reference | sequence 1 2

name

SNP Allele1 | VIC NFQ-MGB | Allele2 | FAM NFQ-MGB
Assay 1

SNP Allele1 | VIC NFQ-MGB | Allele2 | FAM NFQ-MGB
Assay 2

Note: The NCBI SNP reference and Context sequence fields are optional fields
and are used for reference. They are not required to run an experiment.

2. Samples
Sample Color Sample Color Sample Color
name name name

Sample 1 . Sample 11 Sample 21

Sample 2 N Sample 12 Sample 22 .
Sample 3 . Sample 13 . . Sample 23 . .
Sample 4 | Sample 14 B Sample 24 |
Sample 5 N Sample 15 . Sample 25 .
Sample 6 Sample 16 . . Sample 26 .

Sample 7 | Sample 17 | Sample 27

Sample 8 . Sample 18 . Sample 28 .
Sample 9 . Sample 19 . . Sample 29 . .
Sample 10 N Sample 20 . Sample 30 .

ROX

3. Dye to be used as a Passive Reference

Applied Biosystems ViiA™ 7 System Getting Started Guide for Genotyping Experiments

15



2 Chapter 2 Design the Experiment
Define SNPs and samples

Your Define screen should look like this:

SMP Assay MName NCBI SNP Refer... | Context Seque...  Allele 1 Reporter Quencher Allele 2 Reporter Quencher Color
SNP Assay 1 Allele 1 WVIC NFQ-MGB Allele 2 FAM MFQ-MGB
SNP Assay 2 Allele 1 WVIC MNFQ-MGB Allele 2 FAM MFQ-MGB

Sample Name Color

Sample 1 |_ |
Sample 2 |_ w
Sample 3 |_ b | LB
Sample 4 |_ w

Sample 5 . N
Sample 6 v
Sample 7 - -
Sample 8 |_ v
lsamnle o ™ ol

Passive Reference

ROX v

Note: This example experiment does not define biological replicate groups. Leave
Biological Replicate Groups blank.
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Assign markers and samples

Assign markers and samples

Click Assign to access the Assign screen. Enter the SNP assays and samples:
e SNP Assay 1

T\aarr%eet Well number Task Sample
SNP A3, A5, A7 Unknown | Sample 3
Assay 1161 ¢, c9 Sample 4
C3, C7, C11 Sample 5
E1, Eb, E9 Sample 6
E3, E7, E11 Sample 7
G1, G5, G9 Sample 8
G3, G7, G11 Sample 9
11, 15, 19 Sample 10
13, 17, 111 Sample 11
K1, K5, K9 Sample 12
K3, K7, K11 Sample 13
M1, M5, M9 Sample 14
M3, M7, M11 Sample 15
01, 05, 09 Sample 16
03, 07, 011 Sample 17
SNP A1, A5, A9 Negative | NTC
Assay 1
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2 Chapter 2 Design the Experiment
Assign markers and samples

* SNP Assay 2

Izzzt Well number Task Sample
SNP A15, A19, A23 Unknown Sample 1
ASSay 2 13 ¢17, c21 Sample 2
C15, C19, C23 Sample 18
E13, E17, E21 Sample 19
E15, E19, E23 Sample 20
G13, 617, 621 Sample 21
G15, G19, G23 Sample 22
113, 117, 121 Sample 23
115, 119, 123 Sample 24
K13, K17, K21 ' sample 25
K15, K19, K23 " sample 26
M13, M17, M21 . Sample 27
M15, M19, M23 Sample 28
013, 017, 021 Sample 29
015, 019, 023 Sample 30
SNP A13, A17, A21 Negative NTC
Assay 2
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Markers
Name
SNP Assay 1

] SHP Assay 2

Sampla 1

]

Sample 2

)

Sample 3

Sample 4

Sample 5

Sample &

Sample 7

Sample 8

Sample 9

Sample 10

|Sample 11

Sample 12

Sample 13

Sample 14

Sample 15

Your Assign screen should look like this:

Chapter 2 2
Set up the run method

——
£

== (U |

ad
>

Sample 16

] o ] o o

Sample 17

Set up the run method

wels: [ 90 e EoEoEHo

288 Empty

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

¢ Reaction Volume Per Well: 10ul

e Thermal Profile

Ramp .
Stage Step rate Temperature Time
Pre-Read Stage Step 1 1.6°C/s 60 °C 30 seconds
Hold Stage Step 1 1.6 °C/s 95°C 10 minutes

Applied Biosystems ViiA™ 7 System Getting Started Guide for Genotyping Experiments
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Chapter 2 Design the Experiment

Set up the run method

Stage

Step

Ramp

Tem
rate

perature Time

PCR Stage

e Number of Cycles: 40

(default)

e Enable AutoDelta: Unchecked

(default)

e Starting Cycle: Disabled
when Enable AutoDelta is

unchecked

Step 1

1.6 °C/s

95°C 15 seconds

Step 2

1.6 °C/s

60°C 1 minute

Post-Read Stage

Step 1

1.6 °C/s

60°C 30 seconds

Your Run Method screen should look like this:

Run Method

10) HL

100

- o

a0 _d

xR e

ELE A R

Include:
Pre-Read Stage Hold Stage PLCR Stage Post-Read Stage
Hurmher of Cydes: 1§
Starong Cycle:
i : B
e
| Ee— “m
® i
Shept Slap =] Step Sl

[
r Legend

E| Datz Colection Dn

"= Dats Colaction OF A AutoDeka On & AutoDelta OFf

20

Applied Biosystems ViiA™ 7 System Getting Started Guide for Genotyping Experiments



Order materials for the experiment

The recommended materials are:
* MicroAmp® Optical 384-Well Reaction Plate
e MicroAmp® Optical Adhesive Film
» TagMan® Genotyping Master Mix (PN 4371355)

Chapter 2
Order materials for the experiment

Your Materials List screen should look like this:

2

Enter Gene Name or RS Number |

‘ lw Enter a gene name or RS number to search the Applied Biosystems Store for a SNP assay.

Experiment Materials List

Add Selected Items to Shopping List Display : ‘AH Items v‘ | Print Materials List
[1 check All Item Part Number Description
MicroAmp@® Optical 384-Wel Reaction Plate, constructed from a single rigid piece of |#
MicroAmp® Optical 384-Well Reaction Plate with Barcode: 50 ... 4309849 polypropylene in a 384-wel format, are engineered to work with Applied
Biosystems Real-Time PCR Systems and GeneAmp® PCR Systems
An optically-clear adhesive film used to seal the samples into the wells of a 96-wel
MicroAmp™ Optical Adhesive Film (100 films) 4311971 microplate. This will reduce the possibility of cross-contamination between sample
wells and help ensure consistent Real-Time PCR data.
. The MicroAmp™ Multi-Removal Tool makes it easier to remove caps from tubes,
™ g . 3
o MicroAmp™ Mult-Removal Tool (1 tool) 4313950 microplates from thermal cyclers and much more.
MicroAmp™ Caps Strips are designed to fit on MicroAmp® Reaction Tubes, reaction
— ., 4 Amsienl " - 42720 . 4 lmbatas Tha Antiel il b A far Danl Timma DCD

Remove Selected Items from Shopping List

Experiment Shopping List (2 items)

Shopping Basket: Name ‘WA? 384 Well SNP Genoty Basket |

[ Check Al Iltem Part Number Quantity
O MicroAmp® Optical 384-Well Reaction Plate with Barco... 4309849 1.000
O MicroAmp™ Optical Adhesive Film (100 fims) 4311871 1.000
For more information
For more information on... Refer to... Part number
Consumables Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434

Experiments

Appendix A in Booklet 7, ViiA™ 7 System Experiments - Appendixes

Data collection Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays Application 127AP05-03
Note

Using Alternative Setup Chapter 2 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments
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2 Chapter 2 Design the Experiment
For more information
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CHAPTER 3

Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Genotyping example

experiment.
About Genotyping
Experiments This chapter covers:
Assemble required materials ......... ... .. .l 24
Prepare the sample dilutions .......... ... .. ... ... 24
Prepare the reaction mix (“cocktail mix”)........... ... 24
Prepare the reaction plate . ........ ... ... .. . 25
Design the Experiment Tips for preparing reactions for your own experiments. . ................... 27
For more information.......... ... . i 27

|

Chapter 3

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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3 Chapter 3 Prepare the Reactions
Assemble required materials

Assemble required materials

e Items listed in Booklet 1, Getting Started with ViiA™ 7 System Experiments
¢ Samples - Sample 1 - Sample 30
¢ Example experiment reaction mix components:

— TaqMan® Genotyping Master Mix (2X)

— SNP 1 Assay Mix (20X)

— SNP 2 Assay Mix (20X)

Prepare the sample dilutions

For the example experiment, two targets are assigned to 45 wells each. Each well
contains 20 ng of Coriell DNA diluted from 100 ng/uL of stock.

To prepare the sample dilutions:
1. Label a separate microcentrifuge tube for each sample to be diluted.
2. Add 5uL of sample stock to each empty tube.

3. Add 45uL of sterile water (diluent) to each tube, such that each working stock
tube has a final concentration of 10 ng/uL

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Prepare the reaction mix (“cocktail mix”)

1. Label an appropriately sized tube for each reaction mix:
¢ SNP 1 Reaction Mix
* SNP 2 Reaction Mix

2. For SNP Assay 1, prepare a cocktail by adding the required volumes of each
component to the SNP 1 reaction tube, as detailed below.

Reaction volume
H 0,
Reaction component Per well (pL) 45 Reactions + 10%
excess (uL)

Dry Wet Dry Wet

TagMan® Genotyping Master Mix (2X) 10.0 10.0 500.0 500.0
SNP Assay Mix (20X) 1.0 1.0 50.0 50.0
H,0, DNase-free 9.0 7.0 450.0 350.0
Total Reaction Mix Volume 20.00 18 1000.0 900.0
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Chapter 3 3
Prepare the reaction plate

3. Gently pipette the reaction mix up and down, then cap the tube.
4. Centrifuge the tube briefly.
5. Place the reaction mixes on ice until you prepare the reaction plate.

6. Repeat step 2 through 5 for the SNP 2 assay.
Note: Do not add the sample at this time.

Prepare the reaction plate

Example experiment reaction plate components

The reaction plate for the Genotyping example experiment contains:
* A MicroAmp® Optical 384-Well Reaction Plate
¢ Reaction volume: 10 pL/well

¢ 90 Unknown wells

The reaction plate for the example experiment looks like this:

L ]

=

: T+ ] = [ 7 [ 5 [ 5 [ o[ [ [w |5 6|0 6 5 =2 [=z]=5]=
» |5 == == (H | (| (H |

s |

< | I

o |

e |-

N

|« | -
in

Ble |

B

[« |

0|

B |

v |

o [

5

wels: [ oo e [MoEHe[Ho 288 Empty
Well Summary: In Plste: 384 Set Up: 96 Analyzed: 06 Flagged: 0 Omitted by Anslysis: (1 Omitted Manualy: 0 Samples Used: 300 SHP Asszys Ussd: 2
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Prepare the reaction plate
To prepare the reaction plate: dried gDNA

1. Pipette 2.0 pL of the appropriate sample (20 ng of purified genomic DNA) into
each well of the reaction plate.

All wells belonging to the same Genotyping assay must contain approximately
the same quantity of sample or control.

Note: While preparing the reaction plate for your own Genotyping experiment,
add between 1 and 20 ng of purified DNA per reaction.

2. Dry down the samples by evaporation at room temperature in a dark, amplicon-
free location. (Cover the reaction plate with a lint-free tissue while drying.)

3. Transfer 20 pL of reaction mix to each well.

IMPORTANT! Make sure that no cross-contamination occurs from well to well.

4. Seal the reaction plate with adhesive film.
5. Vortex the reaction plate for 3 to 5 sec.
6. Briefly centrifuge the reaction plate.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the plate again at a higher speed and for a longer period of time.

To prepare the reaction plate: wet gDNA

1. Add 2 puL of DNA to the appropriate wells.

2. Add 2 pL of water to wells containing the NTCs.

3. Transfer 18 uL of reaction mix to the appropriate wells.

4. Seal the reaction plate with optical adhesive film.

5. Vortex the reaction plate for 3 to 5 seconds, then briefly centrifuge it.
6. Centrifuge the reaction plate briefly.

7. Until you are ready to perform the run, place the reaction plate at 4 °C, in the
dark.
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Tips for preparing reactions for your own experiments

Tips for preparing reactions for your own experiments

Tips for preparing samples

When you prepare the samples for your own experiment:

e Use DNAse-free water to dilute the samples.

* Use the same quantity of DNA per well for each experiment.

Tips for preparing the reaction mix

When you prepare the reaction mix for your own experiment, make sure you prepare
the reactions for each SNP separately.

Prior to use:
* Mix the master mix thoroughly by swirling the bottle.
* Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

* Thaw frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Tips for preparing the reaction plate

When you prepare the reaction plate for your own experiment:

* Make sure the reaction locations match the plate layout in the ViiA™ 7 Software.
¢ Load 1 to 20 ng of purified genomic DNA per reaction

¢ All wells belonging to the same Genotyping assay must contain approximately
the same quantity of sample or control.

* Multiple assays may be run on one reaction plate, but must be analyzed
separately.

For more information

For more information on... Refer to... Part number

Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4LLL434

components Experiments

Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4LLL434
Experiments
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For more information
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About Genotyping
Experiments

Design the Experiment

Prepare the Reactions

|

Chapter 4

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

CHAPTER 4

Run the Experiment

This chapter explains how to run the example experiment on the ViiA™ 7 Instrument.
This chapter covers:
Starttherun. ...... ... 30
Monitor the run. . ... 30

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Genotyping Experiments 29



4 Chapter 4 Run the Experiment
Start the run

Start the run

Monitor the run

. Open the Genotyping example file that you created using instructions in

Chapter 2.
Load the reaction plate into the instrument.

Start the run.

Note: To collect real-time data during a run, click the button on the Run
Method screen in the Experiment Setup menu.

Monitor the example experiment run:

From the ViiA™ 7 Software using the Run screen, while the experiment is in
progress.

From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment
started from another computer or from the ViiA™ 7 Instrument touchscreen).

From the ViiA™ 7 Instrument touchscreen.

From the Instrument Console of the ViiA™ 7 Software

30

In the Instrument Console screen, select the instrument icon.
Click Manage Instrument or double-click on the instrument icon.

On the Manage Instrument screen, click Monitor Running Instrument to access
the Run screen.
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Monitor the run

View the You can view the progress of the run in real time. During the run, periodically view all
Amplification Plot the three plots available from the ViiA™ 7 Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

Ampliification Plot
Plot Settings

Plot Type:i;ﬁﬁrTvs_Cycle % | Graph Type:l_'l__ig v_| Plot Color:[well |

i

B
&gl
6 7 & 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24

1 5
pllea g A MO WM MMMODMEMMMO N

[[] save current settings as the default

Amplification Plot ‘m

ARN

0.1

0.001 = '
W N0 2 M ¥ oM W B

Cycle mill M @ @ O A W A W W
Options o
Target: All v_| Thrashold: AUt Bas
offfi M M @ M @ @ @ @ @ @ @
Show: [[] Threshold — [] Baseline Start: Wel B Target 4 Baselne End: Well /B Target 4
=]
< |
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Monitor the run

View the Click Temperature Plot from the Run Experiment Menu.

Temperature Plot The figure below shows the Temperature Plot screen as it appears during the example

experiment.
AP B R
Temperature Plot i
AR AT AR |
s i = . A L i
=1 ;1|||1(| I \! IR “J_ \"-f__ul;|,’;|]il Bt \|I
AL R BRI
”'\I L LR e L]
self UL UL L* L L' UL ,L‘ U L‘ NERIE IR NI Ll\s_ﬁ.f L! L o
: 1
e ;:E‘; Wiaw !-T_‘:-‘nJr =
Note: The sample temperature displayed in the Current Temperatures group is a
calculated value.
View the Run Click Run Method from the Run Experiment Menu.
Method

The figure below shows the Run Method screen as it appears in the example
experiment.

Pre-Read Stage Hodd Stage PCR Stage Post-Read Stage
Nurrbar of Cyces: i__ [
Starthg Dyce: =
3
£
Slepl Stapt Slept Slep2 Stept
< >
r Legend

| =
88 Datz Colection: On & Data Collection OFf & AutoDetadn A AutnDalta OFF
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View run data

Run Data Report

Experiment Name:
Start Time:

Stop Time:

Run Duration:

User ID:

Instrument Name:
Firmweare Version:
Software Version:
Instrument Serial Number:
Sample Volume:
Cover Temperature:

Block Type:

Click View Run Data from the Run

The figure below shows the View Run Data screen as it appears in the example

experiment.

Viid7? 384-Well SNP Genotyping Example
09-16-2010 15:57:35 PDT

09-16-2010 17:30:35 PDT

93 minutes 0 seconds

DEFAULT

Yankees Rule

1.0.3

Viid7 Software v1.0.0

Experiment Menu.

Chapter 4
Monitor the run

Errors Encountered:

278880012
10.0
105.0
384-wel Block
s
-
£

A

From the ViiA™ 7 Instrument touchscreen

Experiment View

You can also view the progress of the run from the touchscreen of the ViiA™ 7

Instrument.

The Run Method screen on the ViiA™ 7 Instrument touchscreen looks like this:

t‘ MyInstrument (384-well 20uL)

Experiment: 2010-03-11-232013

[ experiment view Time View

Run Started: March 11 2010 - 11:20PM
Reaction Volume; 20 pL
Heated Cover Set Point: 105.0 °C

Sample: 95.0 °C
Heated Cover: 105.0 °C
Time Remaining: 01:28:18

Stage 2
¥ 40

S B

95.0°C
8:20 0:15

2:00

\

S0.0°C i

‘March 11 2010 - 11:20PM: Heated cover reached target temperature,
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Monitor the run

Time View
MyInstrument (384-well 20pL)

Experiment: 2010-03-11-232013

Run Started: March 112010 - 11:20PM Sample: 50.0 °C
Reaction Volume: 20 pL Stage [ Step: 1 /1
Heated Cover Set Point: 105.0 °C Cycle: 1

Display Time: (@) Remaiing () Elapsed

‘F"'lﬂl’d‘! 11 2010 - 11:20PM: Heated cover reached target temperature.
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CHAPTER 5

Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
Abg“t Genotyping of modifying experiment parameters to troubleshoot problems with experiment
xperiments . .
results before rerunning an experiment.

This chapter covers:

Section 5.1 Review Results ... 37

Analyze the example experiment. ................ ... ... .. . . 37

View clusters in the Allelic DiscriminationPlot ........................... 37

Design the Experiment Confirm setup accuracy using Plate Layout. . .............oveueneneena... 40
Assess amplification results using the Amplification Plot. .................. 43

Identify well problems using the Well Table .............................. 46

Confirm accurate dye signal using the Multicomponent Plot................ 49

Determine signal accuracy using the Raw Data Plot ....................... 51

Review the flagsinthe QCSummary ...................... ... ... ... ... 52

Prepare the Reactions For more information. .......... ... ... i i 54
Section 5.2 Adjust parameters for re-analysis of your own experiments. . ....... 55

Adjust analysis settings............ ... i 55

For more information. ........... ... ... i i 60

Run the Experiment

|

Chapter 5

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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SECTION 5.1

Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View clusters in the Allelic Discrimination Plot

The Allelic Discrimination Plot contrasts the normalized reporter dye fluorescence
(Rn) for the allele-specific probes of the SNP assay.
View the allelic discrimination plot to identify:

* C(Clusters for the three possible genotypes (Allele 1 homozygous, Allele 2
homozygous, and Allele 1/2 heterozygous).

* A cluster for the negative controls.

To view and assess the allelic discrimination plot

1. From the Experiment menu pane, select Analysis » Allelic Discrimination Plot.

2. Click the Plate Layout tab, then click any empty well to select it.

Note: In the Allelic Discrimination Plot, the software highlights all wells that are
selected in the Plate Layout tab. If the plot displays a single color for all wells,
then all wells in the plate layout are selected.

3. In the allelic discrimination plot, select SNP Assay 1 from the SNP Assay menu,
then enable Autocaller.

The Allelic Discrimination Plot displays allele symbols for each sample evaluated
for the selected SNP. The samples are grouped on the plot as follows:

Genotype Symbol Location
Homozygous for Allele 1 of the @ (red) X-axis of the plot
selected SNP assay.
Homozygous for Allele 2 of the @ (blue) Y-axis of the plot
selected SNP assay.
Heterozygous for both alleles of the (green) | Midway between the
selected SNP assay (Allele 1 and homozygote clusters
Allele 2).
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Chapter 5 Review Results and Adjust Experiment Parameters
View clusters in the Allelic Discrimination Plot

Genotype Symbol Location
A negative control. B (black] | Bottom-left corner of the
plot
Undetermined. X (black) | Anywhere on plot

Note: If the Autocaller is not enabled, the Allelic Discrimination Plot displays a
crossmark (X — Undetermined) for each sample.

4. Review each cluster in the plot:

a. Click and drag a box around the cluster to select the associated wells in the
plate layout and well table.

b. Confirm that the expected wells are selected in the well table.

For example, if you select the cluster at the bottom-left corner of the plot,
only the negative controls should be selected. The presence of an unknown
among the negative controls may indicate that the sample failed to amplify.

C. Repeat steps 4a and 4b for all other clusters in the plot.

d. The table below describes the elements of the Allelic Discrimination Plot.

Element Description

SNP Assay drop- Determines the SNP assay data that the ViiA™ 7

down menu Software displays in the plot.

Plot Type drop- Determines the type of plot (Cartesian or Polar) that the

down menu ViiA™ 7 Software uses to display the data.

Apply Call drop- When a datapoint is selected, this menu allows you to

down menu assign an allele call to the datapoint within the
scatterplot.

Toolbar Contains tools for manipulating the scatterplot:

- Selection tool.
. ’ar_ - Selection tool.
- Repositioning tool.

. - Zooms in.
. - Zooms out.
Legend Explains the symbols in the scatterplot.
Options The Reveal Traces option allows you to trace the

clusters throughout the PCR process.

This option is not activated for the example experiment.
To activate the feature, see “Adjust analysis settings” on
page 56.
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View clusters in the Allelic Discrimination Plot

The Allelic Discrimination plot for the example experiment looks like this:

Allelic Discrimination Plot

Plot Settings
SNP Assay: SNP Assayl « Apply Call: |Mixed - o i 5 i . L
Plot Type: |Cartesian = = =
[1]z s 5 6 7 8 9 10 11 1z 13 |14 15 |16 17 [16 |19 |20 |2t |22 |23 2% |
(R & A pLpamEEEE |«@dd g g d aa
Allelic Discrimination Plot n | |
e SR R R
o -HE |
L. . TR R
Lt F | |
o - r
T, | '@ @ @ @ @ v @ @@ @ 0
i |—|
v sl 3 41 4O 4O O d O d da ea
3
04 }’. !
I s «pll o o1 o1 )0 40 0 0 4O @O 4O
- |
L
03 08 13 18 23 [
Ade1 vl ol 0 O o1 O O O O <O O @
- |
wHomozygous allele 1/allele 1 »Homozygous Allele 2/allele 2 N
s Heterozygous Allele 1/allele 2 xUndetermined | - - - - - - -
— 0 9 40 9@ @030 aaa
N
wels: [ oo L6 MoEo[Ho 288 Empty
Well Summary: In Plate: 384 Set Up: 96 Anshyzed: 06 Flagged: 0 Oritted by Analysis: Onitted Manusly: Samples Used: 3(] SNP Assays Used: 2

Troubleshoot clustering on the Allelic Discrimination Plot

Do all controls have

the correct
genotype?

cluster as expected.

Clustering in positive controls

In the example experiment and in your own experiments, confirm that data points

1. From the well table, select the wells containing a positive control to highlight the

corresponding data points (symbols) in the Allelic Discrimination Plot.

2. Check that the data points for the positive controls cluster along the expected axis
of the plot. For example, if you select the Positive Control Allele 1/Allele 1, then

the controls should cluster along the X-axis.

3. Repeat steps 1 and 2 for the wells containing the other positive controls.

Failed amplification in the unknown samples

1. Select the data points of the cluster in the lower left corner of the Allelic
Discrimination Plot to select the corresponding wells in the well table.

2. Check that the selected wells in the well table are negative controls, and not
unknown samples.
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Confirm setup accuracy using Plate Layout

Samples clustered with negative controls

Samples that clustered with the negative controls may:

e (Contain no DNA
e (Contain PCR inhibitors

* Be homozygous for a sequence deletion

Confirm the results of these samples by retesting them.

Are outliers If the Allelic Discrimination Plot contains clusters other than the three representative
present? genotype clusters (heterozygous, homozygous allele 1, and homozygous allele 2), then
those can be classified as outliers.

Confirm the results of the associated samples by retesting them.

Note: The results displays are synchronized. For example, selecting a well in the plate
layout selects the corresponding data in the well table and Allelic Discrimination Plot.

Confirm setup accuracy using Plate Layout

Review the experiment results in the Plate Layout. The plate layout displays the assay-
specific setup and analysis properties for the experiment in a well format
corresponding to the type of reaction plate used for the run.

Example experiment plate layout values

For the example experiment, confirm that the ViiA™ 7 Software called:
* 54 samples as Allele 1 homozygous (@)
* 12 samples as Allele 2 homozygous (@)
* 24 samples as heterozygous ( @)
¢ 0 samples as undetermined (X)

Confirm that no wells of the reaction plate triggered QC flags (. ). The example
experiment does not display any flags.

View the layout

1. Click the € icon beside the Allelic Discrimination Plot to maximize the plate
layout.

2. Click Show in Wells, then select or deselect a parameter that you want the
wells to display. Repeat this step until the plate layout contains all of the desired

parameters.
Parameter Description
Sample Name The name of the sample applied to the well.
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Confirm setup accuracy using Plate Layout

Parameter Description
Task The task assigned to the well:
[ - Unknown
[Z] - Negative Control
[Z] - Positive Control - Allele 1
[ - Positive Control - Allele 2
[ - Positive Control - Allele 1/2
SNP Assay The name of the SNP evaluated by the well.
Name
Assay ID The Assay ID number of the SNP evaluated by the well.

Allele 1 / Allele 2

The name of the associated allele for the SNP evaluated by the
well

Allele 1 Dyes /
Allele 2 Dyes

The name of the reporter and quencher dyes of the associated
allele for the SNP evaluated by the well

SNP Assay Color | The color of the SNP evaluated by the well.
Sample Color / The color of the sample or task applied to the well.
Task Color

Genotype Call

The allele call assigned to the sample:
* @ Homozygous 1/1

* @ Homozygous 2/2

* @ Heterozygous 1/2

o MW Negative Control

e X Undetermined

Flag

The number of QC flags the well triggered as listed in the
symbol.
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Confirm setup accuracy using Plate Layout

The following figure shows the plate layout of the example Genotyping experiment.

=]

s | o [0m8 o= o [ o o= S | o[ Bu |

1

-

¥

| weis: [l oo [ 6 [EoEo@Eo 288 Enpty |

Weoll Sammary; In Platae 384 Sat Up: 9 anahaod: BG Fagged: () Omitbed by Anadyeie Omittad Maraiya (1 Sasaphks Usad: 3 SNP Amzays Useds 2

Tips for troubleshooting plate setup in your own experiment

You can adjust your view of the plate layout:
¢ Note the location of any samples that trigger QC flags (* ). Understanding the
position of errors can aid in diagnosing any failures that may occur.

* You can select the entire reaction plate, areas of the reaction plate, or specific
wells:

— Click the upper left corner of the reaction plate to select all 384 wells.
— Left-click the mouse and drag across the area to select it.

— Select Sample, SNP Assay, or Task from the Select Wells menu in the Plate
Layout tab to select wells of a specific type using the well-selection criteria.

e Use the (Zoom In), (Zoom Out), and (Fit Plate) buttons to magnify or
compress the view of the wells shown.

o Use the < arrow tabs to expand the plate layout to cover the entire screen.
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Assess amplification results using the Amplification Plot

Assess amplification results using the Amplification Plot

IMPORTANT! Amplification plots are not used to make SNP calls. Examine the plots to
help with troubleshooting and quality control.

If you collected real-time data for your experiment, review the amplification data to
further understand the flags triggered by the experiment data.

About amplification plots

The Amplification Plot screen displays amplification of all samples in the selected
wells. Use the amplification plots to confirm the results of the experiment:

* ARnvs. Cycle - ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot
displays Ag, as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

Note: Viewing the ARn vs. Cycle plot is discussed in this booklet as an example of
how to view the plot.

* Rnvs. Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs. Well - Cris the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be viewed as a linear or log10 graph type.

View the ARn vs. Cycle plot

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.
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Assess amplification results using the Amplification Plot

2. Select the plot type and format:

Menu Selection
Plot Type ARn vs. Cycle
Plot Color Target
E Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

Flot Settings |
Plat Ts':z:|.‘.‘.R.‘1 ws Cytle = | Graph T'r'ﬂE:!LA:lg ¥ Pht Caler:|Target “

[[1 Sava current sattings as the dafault

Rmplitication Plat

1E01 5

Options
Target: f.ll = | Thrashold: |

Shiowe: [| Threshod — [ Bassline Stark: Wel B Target on  Basalne End: Well "B Targst a

Well Summary; In Plate: 384 et upe B Anahyoed: Off Fagged: [| Onsdtad by Analyci: | Cositiact Manualy: Samples Used: 3] SN Ao Usad: 3

3. View the baseline values:

a. From the Graph Type drop-down menu, select Linear.
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Assess amplification results using the Amplification Plot

b. Select Baseline to show the start cycle and end cycle.

[ Plot Settings '\
Piot Type: &Rn v Cycle 0 Graph Type: Limear % Pot CoonTarget w

[ Save current settinge as tha defauk

Amplification Plot

4Rn
B

(" Options

Target: |All

Basaline End; Wal W Tagat 2

Shows [ Threshold =

Well Sumimary: In Fime: 384 Set Uipa 96 Aratprad: O6 Fingged: O Oruttad by Anabees Dmted Manualy: 0 Sampies Ussd: 30 SNF Aamys L 2

4. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. From the Target drop-down menu, select SNP Assay 1-Allele 2.
C. Select the Threshold check box to show the threshold.

Amplification Plot
Plot Settings

Plot Type:|ARNn vs Cycle v | Graph Type:|Log & | Plot Color:|Target w

[[] 5ave current settings as the default

P L a BEE E

Amplification Plot

1E01

1E00

01

ARn

om

0.001 -

Show: [¢] Threshold — [] Baseline Start: Well B Target 4+ Baseline End: Well /M Target 4~

Well Summary: In Plate: 384 Set Up: 36 Anahyzzd: 96 Flagged: 0 Omitted by Anahysis: 0 Omitted Manualy: 0 Samples Used: 30 SNP Assays Used: 2
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Identify well problems using the Well Table

Identify well problems using the Well Table

Review the details of the experiment results in the Well Table and identify any flagged
wells. The Well Table displays the assay-specific setup and analysis properties for the
experiment in a tabular format.

Example experiment values and flags

For the example experiment, look for wells that triggered QC flags (. ). The example
experiment has no flags.

View the well table

1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.
3. Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.

b. Confirm that each of the controls do not display flags ( ).

c. Click the B jcon to collapse the negative and positive controls.

The figure below shows the well table of the example Genotyping experiment.

Plot Setltings E

Flot T\rpe:iiltn ws Cycle || Graph Typa:zilog = | Pht Color: [ Target ol
7] save curent setongs as the default = well | omit Elag Sample .| SNP Az, | AssayiD | Task Alile 1
5 B om R B = e
2 reREgLE 1 a1 0 SHP Assey 1 Wagatuie C... Alsle L
b S L [ SHP Assy 1 Hegative C... Alsle 1
Amplification Plot 9 A & SNP Asssy 1 Hagatve .., Alale 1
1ECT - 13 Al3 & SHP Asmy 2 Hagatve G, Akl L
17 A17 a SHP Assay 2 Hegative C__. Al 1
2t A2 L] SHP Assiy 2 Nagatve C.., Akl 1
o)
9 [1 Sample 3 SNP Assay 1 Unknown  Alsle L
T a Sample 3 SNP Asmyd Unknown Akl 1
11 A1l ! Semple 3 GNP Assy 1 Unknown Akl 1
15 AlS a Cample 1 SHP Asmy 2 Unknoiwn  Alels 1
19 Al9 & Sample 1 SNP Asey 2 Unknown Akl 1
23 AZ3 ] Sample 1 SNP fsmv 2 Unknown Akl 1l
48 O @ Samole &SNP Assy 1 unknown Akl 1
o = | a Sample 5 SNP Assay 1 Unknown  Alsle 1
b M 1 Samnle 4 SHP Assay 1 Unknown Akl 1
55 o7 a Samplg 5 SHP Assay 1 Unknown  Alele L
57 e 1 Eample 4SNP Assay 1 Unknown  Alele 1
5% (i £l Sample 5 SHP Assay 1 Uniknown Akle 1
Bl Cl3 d Semole 2 SHF Assy 2 Unknown Akl 1
61 €15 E Cample 18 SNP Aamy 2 Unknown  Akle L
&3 Ci7 ] Sample 2 SHP Asmy 2 Unknown  Akle 1
&7 Cig [ Szmple 18 SHP Assay 2 Unknown Akl L
S — 5% C2t ] Sample 2 SHP Asmay 2 Unknown  Alele 1
Options ) 71 23 = Sample 18 SHP Asssy 2 Unknown Atk 1
Target: |SNP Assay 1-Allele 2 | Threshold: [¥] Auto (0.1 [¥] Auto Bassling 5 EL a Samole &SNP Assay 1 unknown Akl I
o3 E3 1 Sample 7 SHP Asmay 1 Unknown — Alele 1
1 ES & Sample §  SNP Asmy 1 Unknown Akl 1
103 & Ll Sample 7 SHP Assay 1 Unknown Al 1 ~
¢ = »
Well Summary: In Plabe: 384 St Up: 06 Aneiends 35 Flagges: [ Dttt b Anshoi: [ Cirnittec Marisaky: 0 Smimn Usect: 300 SHP Kunayn Lined: 2
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Identify well problems using the Well Table

The following table gives the names and description of the columns in the well

table:
Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been removed from the
analysis.
Flag A 1 indicates that the well triggered the number of flags listed

inside the symbol.

Sample Name

The name of the sample.

SNP Assay The name of the SNP assay evaluated by the well.

Name

Assay ID The Assay ID number of the SNP evaluated by the well.

Task The task assigned to the well (Unknown, Negative Control, or
Positive Control).

Allele 1/ 2 The name of the associated allele for the SNP evaluated by the

well.

Allele 1/2 Dyes

The name of the reporter and quencher dyes of the associated
allele for the SNP evaluated by the well.

Allele 1/2 g,

Normalized signal (g,,) of the reporter dye of the associated allele
for the SNP evaluated by the well.

Pass Ref The signal of the passive reference dye for the well.
Call The allele call assigned to the sample, where possible calls are:
o @ Homozygous 1/1 - Homozygous for allele 1
o @ Homozygous 2/2 - Homozygous for allele 2
. Heterozygous 1/2 - Heterozygous
e M Negative Control
e X Undetermined
Quality(%) The quality value calculated for the genotype call.
Method The method used to assign the call to the sample (Auto if
assigned by the ViiA™ 7 Software, or Manual if applied by a user).
Comments Comments entered for the associated sample well.

Allele 1/2 Cy

Threshold cycle (Cy) of the sample for the associated allele for
the SNP evaluated by the well.

Identify quality control (QC) problems

The Well Table displays columns for QC flags that are triggered by the experimental
data. If the experiment data does not trigger a QC flag, then the ViiA™ 7 Software does
not display a corresponding column for the flag.

A () in one of the following columns indicates that the associated well triggered the
flag.
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Identify well problems using the Well Table

Flag Description
BADROX The well produced a passive reference signal greater than the
limit defined in the analysis settings.
OFFSCALE The well produced a level of fluorescence greater than the ViiA™
7 System can measure.
NOSIGNAL The well did not produce a detectable level of fluorescence.
CLUSTER# For the SNP evaluated by the well, the number of clusters

generated from the experiment data is greater than the limit
defined in the analysis settings.

PCFAIL The positive control did not produce an g, for the associated
allele greater than the limit defined in the analysis settings
indicating that the control may have failed to amplify.

SMCLUSTER The number of data points in the associated cluster is less than
the limit defined in the analysis settings.

AMPNC The negative control has produced a g, greater than the limit
defined in the analysis settings indicating possible amplification.

NOAMP The well did not produce an g, for either allele that is greater
than the limit defined in the analysis settings indicating that the
well may have failed to amplify.

NOISE The background fluorescence (noise) produced by the well is
greater than the other wells on the reaction plate by a factor
greater than the limit defined in the analysis settings.

SPIKE The amplification plot for the well contains one or more data
points inconsistent with the other points in the plot.

EXPFAIL The software cannot identify the exponential region of the
amplification plot for the well.

BLFAIL The software cannot calculate the best fit baseline for the data
for the well.

THOLDFAIL The software cannot calculate a threshold for the associated
well.
CTFAIL The software cannot calculate a threshold cycle (Cq) for the

associated well.

Tips for analyzing your own experiments

Confirm the integrity =~ When you analyze the example experiment or your own experiment, if you are using
of positive controls positive controls, confirm the integrity of the positive controls:

1. From the Group By menu, select Task to organize the table rows by their function
on the reaction plate

2. Confirm that the positive controls do not display flags ( + ) and that their
normalized reporter dye fluorescence (R,) is appropriate for the genotype
(for example, if evaluating the Positive Control Allele 1/Allele 1, you would
expect to see significant increase in R, for the Allele 1 probe and very little for the
Allele 2 probe).
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Confirm accurate dye signal using the Multicomponent Plot

Adjust the Well Table

Review the data for the Unknown samples. For each row that displays (. ) in the
Flag column, note the data and the flag(s) triggered by the associated well.

* Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an
area of the table.

— Selecting Sample, SNP Assay, or Task from the Select Wells menu in the
Well Table tab to select wells of a specific type using the well-selection tool.

* Group the rows of the plate layout by selecting an option from the Group By
menu. You can then collapse or expand the lists either by clicking the +/- icon next
to individual lists, or by clicking Collapse All or Expand AlL

¢ Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose

In the example experiment, you review the Multicomponent Plot screen for:

* ROX" dye (passive reference)

e FAM'"™ dye (reporter)

e VIC® dye (reporter)

e Spikes, dips, and/or sudden changes

¢ Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown wells in the plate layout to display the corresponding data
in the Multicomponent Plot screen:

a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.
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Confirm accurate dye signal using the Multicomponent Plot

Multicomponent Flot
i Rlot Settings

4. Click [~| Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.

6. Check the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process; increase in FAM dye signal indicates
normal amplification.
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7. Select the negative control wells one at time and check for amplification. Wells
with the negative control should not show amplification. The example
experiment does not have negative controls.

Tips for confirming dye accuracy in your own experiment

50

When you analyze your own Genotyping experiment, look for:
* Passive Reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

¢ Reporter Dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

¢ Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

* Negative Control wells — There should not be any amplification in the negative
control wells.
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Determine signal accuracy using the Raw Data Plot

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose

In the Genotyping example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot
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The filters are:

PCR Filter [

Emission Filcer

ml(520=+15) m2(55811) m3(586=10) ma(623+14) m5(682=14) m&(711+12)

¥1(470+£15)

¥2(520£10)

x3(550+11)

Excitation Filter

¥4(580£10)

¥5(640£10)

¥E(662+10)

Melt Curve Filter Ca]

Ernission Filcer
ml{520+15) m2(558+11) m3(586+10) ma(623+14) m5(682=14) mB(711+12)

x1(470£15)

¥2(520£10)

¥3(550£11)

Excitation Fiter

¥4(580+10)

¥5(640+£10)

x6(562+10)

Tips for determining signal accuracy in your own experiment

When you analyze your own Genotyping experiment, look for the following in each
filter:

* Characteristic signal growth
* No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the ViiA™ 7 Software flags, including the
flag frequency and location for the open experiment.

For Genotyping experiments, flag appearance is triggered by experiment data or the
assay. If a flag has been triggered by the assay, the Plate Layout does not display the
icon. The flag details appear in the QC Summary.

In the example experiment, there are no flags.
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Review the flags in the QC Summary

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary.

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag.

4. (Optional) For those flags with frequency >0, click each flag with a frequency >0 to
display detailed information about the flag.

T

lag Details
Flag: Description Frequency Wells

BADROX Bad passive reference sianal 0

OFFSCALE Fluorescence is offscale 0

NOSIGMAL No signal in well o

CLUSTER# Number of clusters outside expected range o

PCFAIL Positive control falled o

SMCLUSTER Srmall number of samples in cluster 0

AMPNC Amplification in negative control 0

NOAMP No amplification o

NOISE Noise higher than others in plate 0

SPIKE INoise spikes 0

EXPFAIL Exponential algorithm failed 0

BLFAIL Baseline zlgorithm failed o

THOLDFAIL Thresholding algorithm failed 0

CTFAIL Cr algorithm failed 0

Total Wells: 384 | Pracessed Wells: 96 Manualy Omitted Wells: 0 | SNP Assays Used: 2
‘Wells Set Up: 96 Flagged Wells: 0 Analysis Omitted Wells: 0 | Samples Used: 30

Well Summary: In Pista: 384 Set Up: 96 Anziyzed: 96 Flagged: [ Omitted by Anaiysis: Omitted Mznualy: (1 Samples Used: 30 SNP Asszys Used: 2
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For more information

Possible flags

The flags listed below may be triggered by the experiment data or the assay.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification
NOISE Noise higher than others in plate
SPIKE Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL | Thresholding algorithm failed
CTFAIL | Cy algorithm failed

Sécondary analysis flags
AMPNC Amplification in negative control
CLUSTER# Number of clusters outside expected range
PCFAIL Positive Control failed
SMCLUSTER# Small number of samples in clusters

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™7 System LALLN434
Experiments.
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SECTION 5.2

Section 5.2 Adjust parameters for re-analysis
of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold
cycle (Cy), flags, and advanced options.

You can change the settings in the Analysis Settings dialog box, then reanalyze your
experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
¢ (Call Settings
¢ (Crp Settings
¢ Flag Settings
* Advanced Settings
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Adjust analysis settings

The Analysis Settings dialog box for a Genotyping experiment looks like this:

Il Analysis Settings for ViiA7 384-Well SNP Genotyping Example

Cr Settings Flag Settings Advanced Settings

o, R the default setti
Settings, then change

~— Data Analysis Settings

(O Analyze Data from Post-PCR Read Only (®) Analyze Data from Pre-PCR Read and Post-PCR Read
(O Analyze Real-Time Rn Data (O Analyze Real-Time Rn - Median(Rna to Rnb)
A
~— Default Call Settings
Default call settings are used to make allele calls for SMP assays without custom settings. To edit the default settings, dick Edit Default Settings.
Autocaller Enabled: No  Keep Manual Calls from Previous Analysis: No  Quality Value: 95
A
~— Select a SNP Assay — Call Settings for SNP Assay 1
SNP Assay Analysis Type Autocaller Keep Manual Calls | Quality Value Apply Call Settings: Default Ssttings
SNP Assay 1 Default Yes No o5 &
SMP Assay 2 Default Yas Mo a5
v

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

3. View and, if necessary, change the analysis (see “Adjust analysis settings” below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.

Adjust analysis settings

Call Settings Use the Call Settings tab to:

* Change the default data analysis settings. You can select from:

— Analyze data from Post-PCR Read only - Select if you do not want to use
data from the pre-PCR read to determine genotype calls.

— Analyze data from Pre-PCR Read and Post-PCR Read - If you included the
pre-PCR read in the run, select if you want to use data from the pre-PCR read
to determine genotype calls.
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Adjust analysis settings

— Analyze Real-Time Rn Data - If you included amplification in the run, select
if you want to use the normalized reporter (Rn) data from the cycling stage to
determine genotype calls.

— Analyze data from Rn - Avg (Rna to Rnb) - If you included amplification in
the run, select if you want to use the subtracted median of the normalized
reporter (Rn) data from the cycling stage to determine genotype calls, where
Rna to Rnb refers to all the cycles from the Start Cycle Number to the End
Cycle Number. The average subtraction provides improved data accuracy.

Note: To activate the Reveal Traces feature on the Allelic Discrimination Plot
scree, select either Analyze Real-Time Rn Data or Analyze data from Rn -
Avg (Rna - Rnb).

¢ [Edit the default call settings. Click Edit Default Settings, then specify the default
settings:

— Autocaller Enabled - Select for the software to make genotype calls using the
autocaller algorithm.

— Keep Manual Calls from Previous Analysis - If the autocaller is enabled,
select to maintain manual calls after reanalysis

— Quality Value - Enter a value to use to make genotype calls. If the confidence
value is less than the call setting, the call is undetermined.

¢ Use custom call settings for a SNP assay.

— Select one or more SNP assays in the table, then deselect the Default
Settings checkbox.

— Define the custom call settings.

Ct Settings * Data Step Selection

Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.

* Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.
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Adjust analysis settings

¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the alleles that do not have
custom settings. To edit the default settings, click Edit Default Settings.

* Crp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
e Above the background.
e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings Use the Flag Settings tab to:

58

* Adjust the sensitivity so that more wells or fewer wells are flagged.
¢ Change the flags that are applied by the ViiA™ 7 Software.
To adjust the flag settings:

To adjust the flag settings:
1. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.
Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

3. In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of C1 SD. For some flags, analysis results calculated before
the well is rejected are maintained.

4. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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Adjust analysis settings

The Flag Settings tab looks like this:

Analysis Settings for ViiA7 384-Well SNP Genof Example

Flag Description Use Attribute Condition Value Reject Well
AMPNC Amplification in negativ... cr = + [35.000 O
BADROX Bad passive reference ... Fluorescence = + |500.000
BLFAIL Baseline algorithm failed O
CTFAIL Cr algorithm failed O
EXPFAIL Exponential algorithm f... O
OFFSCALE Fluorescence is offscale O
NOAMP No amplification Amplification algorithm ...[< + [0.100 O
NOISE Noise higher than oth... Relative noise = + |4.000 O
SPIKE Moise spikes Spike algorithm result [ + [1.000 O
NOSIGHAL Mo signal in well O
CLUSTER# Number of clusters ou...
PCFAIL Positive control failed
SMCLUSTER Small number of sampl... Mumber of data points... [ w (2.000
THOLDFAIL Threshaolding algorithm... O

Revert to Default Analysis Settings Apply Analysis Settings W

Advanced Settings Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
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For more information

For more information

For more information on... Refer to... Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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Export Analysis Results

1. Open the Genotyping example experiment file that you analyzed in Chapter 5.
Abg:;g?;ﬁfsi”g 2. In the Experiment Menu, click % Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select ViiA™7 Format.

4. Complete the Export dialog box as shown below:

Design the Experiment

Field or Selection Entry
Select Data to Results
export/ Select
Content
Export Data To One File
Prepare the Reactions Export File Name ViiA7GTexport
File Type * txt
Export File Location | <drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments

Run the Experiment

Review Results and Adjust
Experiment Parameters

|

Chapter 6

Export Analysis Results
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Your Export screen should look like this:

[ Auto Export Forrrat SVila™ 7 - Expom Data To: & Gne Ale ) Separate Fles [ open file(s} when export & complete

Export Fiie Locazion: Chapolied Biosystemsivia? Software w1 1expenments

Expoi Fie Hame: g

He Type: |[F] (=0E) &

|' [5amphe Setup ] rawnata [ kmpifcation [ Mibicamonent

Select Content

e Wweli campla...| SNP Ag.. | Task Alalal Rn| Allele2 An | Pass.Raf | Cualite.. | call Mathod Alplal ... | Allalel ... | Allele]

[¥] All Fields 2 1 SNP Asszy 1 NTC 0.029 10,048 132,633.375 100,000 Megatwva €., Auto O (15| [ &
[ wed L

Ly Jcample T GNP Assay 1 LNKNOWN 2,542 0.340 131, 226.207 68,503 Hofmozygo.... ALto O a1 [#=
[¥] saminle Hame 4 = o
3 SHP Assay 1 NTC 0051 0.047 145,144,933 100:000 Megatwa C... Auto I:—l L5 1
[¥] SHF Asssy Hame & |} |;|
7 5ample 3 SNP Assay 1 UNKMOWN 2.263 10,251 148,858.188 98,503 Homozyge... Auto | 0. ¥l
[] Task ] | 0
- 5 z SHP Assay 1 NTC 0.033 0.048 143,244 033 100,000 Megatwe C.. Auto | 0.1 |
[#] Alelel Rn 10 0
] Alela2 i 11 5ample 3 SNP Assy 1 UNKNOWH 1810 0127 145,395,984 98.503HOMOZYe... Auto O i BT
12 o 0
[#] Pass.Raf 13 SHP Asssy 2 NTC 0.038 0,038 131,182.938 100.000 Megative C... Auto I 0.1 =
z 12 Fl [l
] Quuaty(ee) 15 5ample 1 SNP Assdy 2 LINKNOWH 1.282 0.215132,649.168 98,503 Horozy 0. Alto Il {ifs] [
16 [l |
Fel 17 SHP Asszp 2 MTC 0039 0043 136,204,844 100,000 Megatwa C... Auto [_—| {178 '7|
[#] Method 18 L |
¥ 19 5ample § SNP Assy 2 UNKNOWH 1873 0,130 143,661.406 28,503 Homozygi... Ao = 0.1 @
[=] Alelet Automatic Ct Threshold 2 O |
1 SHP Aszay 2 NTC 0.037 0.037 150,165.422 100.000 Megatwa C... Auto O 01 =
[¥] alelel Ct Thrashod 22 |l]
W T
] Aleiat Automatc Baseina gi Samphe 1 SHF Assay 2 UINKNOWH 0.931 0141 134,952.188 98,503 Homozygo... Auto I;I {155 ﬁ
[] Alelel Bassine Start | | | b - ¥

Shart Export

Your exported file when opened in Notepad should look like this:

iiA7GTexport.txt - Notepad

Fle Edit Format WView Help
* Block Type = 384-well Block ~
#* Chemistry = TAQMAN =
# Experiment File Name = C:‘Applied Biosystems'ViiA7 Software vl1.1'\experiments'examples'\ViiA7_384-well_sNP_Genotyping_Example. eds]
* Experiment Name = viiA7 384-well SNP Genotyping Example 2
® Experiment Run End Time = 2010-09-16 16:29:46 PM PDT
* EXperiment Type = Genotyping
* Instrument Name = Yankees_Rule
# Instrument Serial Number = 278880012
* Instrument Type = Viia 7
* passive Reference = ROX
# quantification Cycle Method = Ct
# 5ignal smoothing on = false
# stage/ Cycle where Analysis is performed = Stage 3, sStep 2
[rResults]
well Sample Name SNP Assay MName Task Allelel Delta Rn Allele2 Delta RN Pass. Ref quality(%)
call method Allelel automatic ct Threshold allelel ct_Threshold Allelel Automatic Baseline Allelel Baseline start
Allelel Baseline End Allele2 automatic ct Threshold Allele2 ct Threshold Allele2 automatic Baseline Allele2 Baseline
start Allele2 Baseline End Customl Custom2 Custom3 Custom4 Custom53 Customé
1: SNP ASsay 1 NTC 0.029 0.048 132,633.375 100.000 Negative cControl (NC) Auto false 0.100
true 3 39 alse 0.100  true 3 39
2
3 Sample 3 SNP Assay 1 UNKNOWN 2. 542 0.340 131, 226.297 98.503 Homozygous Allele 1/Allele 1 Auto
false 0.100  true 3 18 false 0.100  true 22
4
5 SNP ASsay 1 NTC 0.031 0.047 145,144,922 100. 000 Negative Control (NC) Auto false 0.100
true 3 39 alse 0.100 true 3 30
[
7 Sample 3 SNP Assay 1 UNKNOWN 2.263 0.251 148,858.188 98.503 Homozygous Allele 1/Allele 1 Auto
false 0.100  true 3 21 false 0.100  true 25
g
g SNP ASsay 1 NTC 0.033 0.049 143,244,922 100. 000 Negative Control (NC) Auto false 0.100
true 3 30 alse 0.100 true 3 39
10
11 Sample 3 SNP Assay 1 UNKNOWN 1.810 0.127 145, 395.984 98.503 Homozygous Allele 1/Allele 1 Auto
false 0.100  true 3 24 false 0.100  true 39
12
13 SNP ASSay 2 NTC 0.038 0.038 131,182.938 100. 000 Negative Control (NC) Auto false 0.100
true 3 30 alse 0.100 true 3 39

7
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Chapter 1
About Presence/Absence
Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and
Adjust Experiment
Parameters

Export Analysis Results

CHAPTER 1

About Presence/Absence
Experiments

This chapter covers:

B Aboutdatacollection............ ... ... 6

Setting up PCRreactions. ........ ... 6
B About theinstrumentrun......... ... ... i 7
B Abouttheanalysis .......... ... ... .. . 8
B About the example experiment .............. ... ... ... i 8

IMPORTANT! First-time users of the ViiA™ 7 System, please read Booklet 1, Getting
Started with ViiA™ 7 System Experiments and Booklet 7, ViiA™ 7 System Experiments -
Appendixes of this binder thoroughly. The booklet provides information and general
instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking &} in
the toolbar, or selecting Help » ViiA™ 7 Software Help.
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About data collection

About data collection

Presence/Absence experiments are end-point experiments that are performed to detect
a target nucleic acid sequence in a sample.

You can collect the experiment data at the end of the run or continuously in real time.

End-point PCR Data

The ViiA™ 7 System collects data at an end-point, that is after the process has
completed.

The data collected is the normalized intensity of the reporter dye, or Rn.

Note: Some end-point experiments also include pre-PCR (data collected before the
amplification process) datapoints. If so, the system calculates the delta Rn (ARn) value
per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized readings.

Real-Time PCR Data

The ViiA™ 7 System provides the option of collecting real-time data, during the PCR
process.

Note: Real-time data collection is used only for troubleshooting, and not for Presence/
Absence analysis.

Setting up PCR reactions

IPC setup

With Presence/Absence experiments, you prepare PCR reactions that contain primers
and probes to amplify the target and a reagent to detect amplification of the target. You
can set up the PCR reactions for the Presence/Absence experiments two different ways.

Note: The example experiment uses IPC setup for setting up the PCR reactions.

Use an internal positive control (IPC) to monitor the PCR progress and ensure that a
negative result is not caused by failed PCR in the sample. PCR reactions contain two
primer/probe sets: One to detect the unknown target (unknown target primer set and
TagMan® probe to detect the unknown target) and one to detect the IPC (IPC primer
set and a VIC dye-labeled TagMan® probe to detect the IPC template). With this setup,
there are three well types:

* Unknown-IPC wells contain sample template and IPC template; the presence of
the target is not known.

* Negative control-IPC wells contain IPC template and water or buffer instead of
sample template in the PCR reaction. Only the IPC template should amplify in
negative control-IPC wells because the reaction contains no sample template.
Also called IPC+.
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About the instrument run

* Negative control-blocked IPC wells do not contain sample template in the PCR
reaction. Amplification is prevented by a blocking agent. As a result, no
amplification should occur in negative control-blocked IPC wells because the
reaction contains no sample template and amplification of the IPC is blocked.
Negative control-blocked IPC is called no amplification control (NAC).

If the run method includes amplification, real-time data are plotted in an
amplification plot.

No IPC, singleplex setup

Omit the IPC from your Presence/Absence experiment. PCR reactions contain one
primer/probe set. PCR reactions do not contain the IPC. With this setup, there are two
well types:

* Unknown wells — Wells contain sample template; the presence of the target is not
known.

* Negative controls — Wells contain water or buffer instead of sample template.

About the instrument run

With Presence/Absence experiments, the instrument runs can include:
* Pre-PCR read — Perform the pre-PCR read on the ViiA™ 7 Software before PCR
amplification to collect baseline fluorescence data.

¢ Amplification — Perform amplification on the ViiA™ 7 Software to collect
fluorescence data during PCR amplification. If you do not include amplification
in the run method, perform amplification on another instrument.

* Post-PCR read — To determine the results for Presence/Absence experiments,
perform the post-PCR read on the instrument after PCR amplification to collect
endpoint fluorescence data.

Fluorescence data collected during the instrument run are stored in an experiment
data file (.eds).
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About the analysis

About the analysis

Data from the instrument run are used to determine Presence/Absence calls. Results
are plotted in a Presence/Absence plot. If the experiment includes amplification,
results are plotted in an amplification plot.

Pre-PCR read - If included, the data collected from the pre-PCR read can be used
to normalize data collected from the post-PCR read.

Amplification - If included, the data collected from the amplification can be used
to troubleshoot.
Post-PCR read — The data collected from the post-PCR read are used to make
Presence/Absence calls:
— Presence — The target amplified above the target’s threshold. The target is
present in the sample.
— Absence — The target did not amplify above the target’s threshold. The target
is absent in the sample.

— Unconfirmed - The data collected is below the target threshold, and the
intensity of IPC is below the IPC threshold.

With the IPC setup, the data collected form the post-PCR read are used to make the
following calls:

IPC Failed — The IPC target did not amplify in the IPC wells and/or the IPC target
amplified in the blocked IPC wells.

IPC Succeeded — The IPC target amplified in the IPC wells and the IPC target did
not amplify in the blocked IPC wells.

About the example experiment

To illustrate how to perform Presence/Absence experiments, this guide leads you
through the process of designing and performing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a ViiA™ 7 System.

The objective of the Presence/Absence example experiment is to determine if a
pathogen is present or absent in each batch of ground beef.

In the Presence/Absence example experiment:

DNA is extracted from samples using the PrepMan® Ultra Sample Preparation
Reagent (PN 4318930). The DNA is extracted from each of the four samples of
ground beef or from the bacteria found in the ground beef.

The target is a pathogen.

The experiment is designed for duplex PCR, where each reaction contains two
primer/probe sets. One set detects the pathogen sequence, TGFB (primer set and
FAM™ dye-labeled probe to detect the TGFB sequence). The other primer/probe
set detects the IPC primer set and VIC® dye-labeled TagMan® probe detects the
IPC template.
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CHAPTER 2

Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.
About Presence/Absence

Experiments This chapter covers:
B Define the experiment properties. . .......... ... ... i 10
Define targets and samples. .. ... 11
l B Assigntargetsand samples.......... .. ... i i 12
B Setuptherunmethod........ ... ... .. 13
Chapter 2
Desi . B Order materials for the experiment................... ... ... ... ..... 14
esign the Experiment
B For moreinformation. ........... ... 14
Note: To automatically export the analyzed data to a specified location, select the Auto
Export task from the Export screen, before running the experiment. For more

information on Auto Export, refer to Chapter 1in Booklet 1, Getting Started with ViiA™
7 System Experiments.

Prepare the Reactions

Run the Experiment

Review Results and
Adjust Experiment
Parameters

Export Analysis Results
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Chapter 2 Design the Experiment
Define the experiment properties

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
ViiA™ 7 Software. Enter:

Field or Selection Entry
Experiment Name ViiA7_384-Well_Presence_Absence_ Example
Barcode Leave field empty
User Name Example User
Comments Presence/Absence example
Block 384-Well Block
Experiment Type Presence/ Absence
Reagents TagMan® Reagents
Ramp speed Standard

Select all three data-collection check boxes: Pre-PCR, Amplification, and Post-PCR
collection methods:

Pre-PCR Read Checked
Amplification Checked
Post-PCR Read Checked

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experment Harme: [VIAT_384-Well Pressnce-Ahsence_Exampls Commants: |Presence) Abssnce sl

x|

Usar Marre: |Example Lissr

Which block are you using to run the experiment?

Array Card Block J 96-Well Binck [Ehsz‘; | Fast 96-Well Blodk (0 1mL} ]

What type of experiment do you want to set up?

| | Reela tive Standard Curve | Comparative C1 (AACT) | I Melt Curve J

| [v Presence] Absence |

What properties do you want for the instrument run?

W

| = )

Includa: Pre-PCRRead  [F] Amplfication

10
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Chapter 2
Define targets and samples

Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets
Target Name Reporter Quencher Color
TGFB FAM NFQ-MGB .
IPC VIC NFQ-MGB .
2. Samples
Sample Name Color

NTC .

NAC .
Sample (+) B

Sample (-) B

3. Dye to be used as a Passive Reference
ROX

Your Define screen should look like this:

Target Name Reporter Quencher Color Sample Name Color

TGFB FAM + |HFQ-MGE v _ || e m -

IpC vic + |nEQ-Ge v _ v || nac |. v
Sample (+)} |_ v
Sample (-} |_ ~

Passive Reference
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2 Chapter 2 Design the Experiment
Assign targets and samples

Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

If;g::t Well Number Task Sample
TGFB A1 - P3 (Columns 1 - 3] Negative | NTC
IPC IPC
TGFB A4 - P12 (Columns 4 - 12) Unknown | Sample
IPC IPC -
TGFB A13 - P15 (Columns 13 - 15) NTC NAC
IPC Blocked

IPC
TGFB A16 - P24 (Columns 16 - 24) Unknown | Sample
IPC IPC o

Your Assign screen should look like this:

Targets

Well Table

Plate Layout

|
|
C W |
N |
i I i I i i I i I i |
N N 1] 1] ] 1] ] 0] 0] 0] |

=

m

Samples — —________("a] ’

O Com O CE OB Ol OB OO OB Ol
[H S N 0 0 0 0 0 |
T |Sample (+) ||

I~ sample ()

m

i I i I i i I i I i |
N N 1] 1] ] 1] ] 0] 0] 0] |

0 Empt:
wels: [ o [Jo I233I43I43 i

ﬁ

-
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Set up the run method

Set up the run method

Chapter 2

Click Run Method to access the Run Method screen. Set the thermal profile under the

Graphical View tab. Enter:

* Reaction Volume Per Well: 20ul

e Thermal Profile

Ramp

Stage Step rate Temperature Time

Pre-Read Stage Step 1 1.6 °C/s 60 °C 30 seconds
Hold Stage Step 1 1.6 °C/s 95°C 10 minutes
PCR Stage Step 1 1.6 °C/s 95°C 15 seconds
* Number of Cycles: 40 Step?2 1.6°C/s 60°C 1 minute

(default)
¢ Enable AutoDelta:

Unchecked (default)
e Starting Cycle: Disabled

when Enable AutoDelta is

unchecked
Post-Read Stage Step 1 1.6 °C/s 60°C 30 seconds

Your Run Method screen should look like this:

Run Method

Reaction Volurne per wel: | 20 pL
Save Run Method Revarl
Include: ¥ Pre-PCR Read W Amplfication B Post-PCR Read
Pre-Read Stage Hold Stage PCR Stage Post-Read Stage
MNumber of Cycles; |4D :I
7 Enable AutoDelta
Starting Cycle: |1 3:
95.0 °C 95,0 =C
10:00 L6805 o5 \
1.6 *Cfs 1.6~
B0.0 = 50,0 *C 60,0 C
0030 01:00 L& T nn:an
1.6 °Cfs
Stepl Step1 Step1 Stepz Step1
4 »
Legend
" Data Colection On ~ = Data Collection OFf A AutcDelta On A AutoDelta Off

Applied Biosystems ViiA™ 7 System Getting Started Guide for Presence/Absence Experiments
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2 Chapter 2 Design the Experiment
Order materials for the experiment

Order materials for the experiment

The recommended materials are:
* MicroAmp® Optical 384-Well Reaction Plate
e MicroAmp® Optical Adhesive Film
e TagMan® Universal PCR Master Mix (2X)

Your Materials list screen should look like this:

Experiment Materials List

Add Selected Items to Shopping List Display © [l Items LI | Print Materials List

[~ check &l Item Fart Murnber Description

Includes: S x PfM 4308323 Containg: 10X Exogenous IPC primer and probe il
r S-Pack, TagMan® Exogenous Internal Positive Contr..,, 4308321 (WICE dye) mix, 10X Exogenous IPC blocking reagent, and 50X Exogenous

IPC DhA target

Includes: 10X exogenous IPC primet and probe (WICE dye) mix, 10%
exngenous IPC blocking reagent, and 50X exogenous IPC DMA, target,

[l TagMani@ Exogenous Internal Positive Contral Reage... 4308323

Micro&mpd Optical 384-well Reaction Plate, constructed from a single rigid
r Microsmpd Optical 384-well Reaction Plate with Barc... 4309849 piece of polypropylene in a 284-well format, are engineerad to work with
Applied Biosysterns Real-Time PCR Systemns and GeneAmp@ PCR Systems

4n ooticalv-clear adhesive fim Used to seal the samoles into the wels of a L

Experiment Shopping List (3 items)

Remove Selected Items from Shopping List shopping Basket Name I\.'HA? 284 \iell Presence A Basket
[ Check Al Itemn Part Murnber Quantity
r S-Pack, TagMan® Exogenous Intemal Positive C... 4208321 1
r Microampd Optical 334-Well Reaction Plate with. .. 4209849 1
- TagMan® Exogenous Internal Positive Control R... 4308323 1

For more information

For more information on... Refer to Part number

Consumables Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System LLL1434
Experiments

Appendix A in Booklet 7, ViiA™ 7 System Experiments - Appendixes

Data collection Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note

Using Alternative Setup Chapter 2 in Booklet 1, Getting Started with ViiA™ 7 System LALL4A34
Experiments
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CHAPTER 3

Prepare the Reactions

This chapter explains how to prepare the PCR reactions for the Presence/Absence

example experiment.
About Presence/Absence

Experiments This chapter covers:
B Assemble required materials ......... ... .. i 16
B Prepare the reaction mix (“cocktail mix”)......... ... ...l 16
B Prepare thereactionplate ........... ... 17
B For moreinformation. ............ ... i 19

Design the Experiment

|

Chapter 3

Prepare the Reactions

Run the Experiment

Review Results and
Adjust Experiment
Parameters

Export Analysis Results
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Chapter 3 Prepare the Reactions
Assemble required materials
Assemble required materials

e Items listed in Booklet 1, Getting Started with ViiA™ 7 System Experiments
e Samples - DNA extracted from ground beef (100 ng/pL)
¢ Example experiment reaction mix components:

— TaqMan® Universal PCR Master Mix

- 10X IPC Mix

- 50X IPC DNA

— 20X Primer/ Probe Mix

Prepare the reaction mix (“cocktail mix”)

For the Presence/ Absence example experiment, four cocktail mixes are used; one each
for:

* Sample (+)
e Sample (-)
e NTC/IPC+
e NAC/IPC-

The following tables list the universal assay conditions (volume and final
concentration) for using the TagMan® Universal PCR Master Mix for the four cocktail

mixes.
Volume for 160
Cocktail Mix Reaction component Y:;t:‘:nf?;d r:f:etzltl:)rls1[[;|°24
excess) (pL)
Cocktail Mix 1 for Sample (+) | TagMan® Universal PCR Master Mix (2.0X) 12.50 2000.0
10X IPC Mix 2.50 400.0
50X IPC DNA 0.50 80.0
20X Primer/ Probe Mix 1.25 | 200.0
Water/ Buffer 5.75 | 920.0
Diluted unknown 1 2.5 | 400
Total reaction mix volume 25.0 4000.0
Cocktail Mix 2 for Sample (-] | TagMan® Universal PCR Master Mix (2.0X) 12.50 2000.0
10X IPC Mix 2.50 400.0
50X IPC DNA 0.50 80.0
20X Primer/ Probe Mix 1.25 200.0
Water/ Buffer 5.75 920.0
Diluted unknown 2 25 400
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Chapter 3 3
Prepare the reaction plate

Cocktail Mix

Reaction component

Volume for 1
reaction (uL)

Volume for 160
reactions (144
wells + 10%
excess) (pL)

Cocktail Mix 3 for NTC/ IPC+ | TagMan® Universal PCR Master Mix (2.0X) 12.50 662.5
10X IPC Mix 2.50 132.5
50X |IPC DNA 0.50 26.5
20X Primer/ Probe Mix 1.25 66.25
Water/ Buffer 8.25 304.75
Total reaction mix volume 25.0 1325.0
TagMan® Universal PCR Master Mix (2.0X) 12.50 662.5

Cocktail Mix 4 for NAC/ IPC- | TagMan® Universal PCR Master Mix (2.0X) 12.50 662.5
10X IPC Mix 2.50 132.5
50X IPC DNA 0.50 26.5
20X Primer/ Probe Mix 1.25 66.25
IPC Block 2.5 132.5
Water/ Buffer 5.75 304.75
Total reaction mix volume 25.0 1325.0

To prepare the reaction mix for each of the four types:

1.

Label four appropriately sized tubes for the reaction mixes:

Sample (+), Sample (-), NTC, NAC.

Add the required volumes of each cocktail mix component to the tube.

Mix the cocktail thoroughly by gently pipetting up and down several times, then

cap the tube.

Centrifuge the tube briefly to remove air bubbles.

Place the cocktail mix on ice until you prepare the reaction plate.

Note: You can separately add the sample to the reaction plate, as opposed to
preparing individual reaction mixes for each sample.

Prepare the reaction plate

The reaction plate for the Presence/Absence example experiment contains:

A MicroAmp® Optical 384-Well Reaction Plate

Reaction volume of 20 uL./well
144 Sample (+) wells U
144 Sample (-) wells v ]|

Applied Biosystems ViiA™ 7 System Getting Started Guide for Presence/Absence Experiments
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3 Chapter 3 Prepare the Reactions
Prepare the reaction plate

e 48 NTC/IPC+ [ A4
e 48 NAC/IPC- I

The plate layout looks like this:

|+ [ 2 [ s [+ | s [ e [ 7 [ s [ o [w [ 1 |1z [ 15 |14 [15 [ 16 |7 [ 18 | 13 [ 20 [ 21 [ 22 | 235 | 24 |

i s P s s s PR PR PR P M M i Ml P P P M P s P P

e i P e e R T e e e M R e i i e i i i s i e M
i i i e M R e e i i M i i i i i i i i M i i i
i i i e M R e e i i M i i i i i i i i M i i i
i i P e e P e e P e e e e i i e e e e e i e 1 e
i i i e e i e i e e i M e i i e i e e e i e e e
e e P e e P i i P P i M i i i P i e e e e e e e
L P i P P i M i i i i i i i i P i M i i i - -
v i i P e s s PR PR P A i i i i i P e i P P P R PR
| P 1P s s PR P P s s s P A i i s s i P P P AR A
o i i i e i i i i i i i T i i i i i i i i i i i
P e e i i i i i i i i i i i i i s i i i i i i o

wels: [ o [do =l 2gg | ag ' 48 0 Empty
1 A4

To prepare the reaction plate:
1. Add 25uL of Cocktail mix 1 to wells A16 - P24.
2. Add 25uL of Cocktail mix 2 to wells A4 - P12.
3. Add 25uL of Cocktail mix 3 to wells A13 - P15.
4. Add 25puL of Cocktail mix 4 to wells Al - P3.
5. Seal the reaction plate with optical adhesive film.
6. Centrifuge the reaction plate briefly to remove air bubbles.
7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

8. Until you are ready to perform the run, place the reaction plate at 4 °C, in the
dark.
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For more information

Chapter 3

For more information

For more information on...

Refer to...

Part number

Assigning the reaction plate
components

Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System
Experiments

4LLN434

Sealing the reaction plate

Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System
Experiments

4LLN434

Applied Biosystems ViiA™ 7 System Getting Started Guide for Presence/Absence Experiments
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3 Chapter 3 Prepare the Reactions
For more information
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CHAPTER 4

Run the Experiment

This chapter explains how to run the example experiment on the ViiA™ 7 Instrument.

About Presence/Absence This Chapter covers:
Experiments
B Starttherun. .. ... ... . e 22
B Monitor the run. . ... ... e 22

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

Design the Experiment

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.

Prepare the Reactions

l

Chapter 4

Run the Experiment

Review Results and
Adjust Experiment
Parameters

Export Analysis Results
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4 Chapter 4 Run the Experiment
Start the run

Start the run

Monitor the run

. Open the Presence/Absence example file that you created using instructions in

Chapter 2.
Load the reaction plate into the instrument.

Start the run.

Monitor the example experiment run:

From the Instrument

22

From the ViiA™ 7 Software using the Run screen, while the experiment is in
progress.

From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment
started from another computer or from the ViiA™ 7 Instrument touchscreen).

From the ViiA™ 7 Instrument touchscreen.

Console of the ViiA™ 7 Software

. In the Instrument Console screen, select the instrument icon.

Click Manage Instrument or double-click on the instrument icon.

On the Manage Instrument screen, click Monitor Running Instrument to access
the Run screen.
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View the
Amplification Plot

Amplification Plot
Plot Settings

Plot Type: Ii\Rn vs Cycle =] Graph Type: JLog =] Plot Color: fwel =l

[~ Save current settings as the default

Chapter 4 4
Monitor the run

You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the ViiA™ 7 Software for potential problems.

Click Amplification Plot from the Run Experiment Menu, select the Plate Layout tab,
then select the wells to view.

The figure below shows the Amplification Plot screen as it appears at the end of the
example experiment.

[} 9

10 11

4

Options

Amplification Plot B EEF

12
-
= Y [Em —, L = =l
AP s g E | | e e e A e e e e e e S e

r r r r - r r r r
" " " ™ " " " " " r
r r r r r r r r r r
r r r r r r r r r r
" " " ™ " " " " " r

W™ @ M M W A IR M 3 3 4

Cycle

| B =

View the
Temperature Plot

Click Temperature Plot from the Run Experiment Menu.

The figure below shows the Temperature Plot screen as it appears during the example
experiment.

Temperature Plot Current Temperatures

100

a0

80

7

o

80

50

Temperature

30

20

L

(LS

Lj i ’J

H t H

S By = & W [ Cover
/O p - I_ ul v .Sarnple
Temperature Plot Mo

L

:

INATHUERLLE

Temperature Plot

00:33:20

00:37:30

00:41:40

004550 005000 005410 005820 010230 0106840 011050 01,1500 011840 01:2320 01:27:30 ]
Ti igw 1 Hour hd
ime

Fixed view [

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
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4 Chapter 4 Run the Experiment
Monitor the run

View the Run Click Run Method from the Run Experiment Menu.
Method . : :
The figure below shows the Run Method screen as it appears in the example
experiment.
Run Method Edit Run Method
Pre-Read Stage Hold Stage PCR Stage Post; Adjust # of Cyces:
Number of Cycles: |4u :| I add Melt Curve Stage to End
[T Enable AutoDelta [T &dd Holding Stage to End
Starting Cycle:_ |1 E| I7 d Infirite Hald to End
i — i [Lsentto mstrmment
10000 LB°C A0S
75 °C__| = . = L}
16 °C X0
£0.0 °C £0.0 °C
I
— 030 01:00 L
& E@l
. @ @
25 °C |
0|
Step Stepl Stepl Stepz
| | »
Legend
Data Collection On = Data Collection Off A AutoDelta On A AutoDelta OFf

View run data Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example
experiment.

Run Data Report
Experiment Mame:  ViiA7_324-Wel_Presence-absence_Example

Start Time: 01-20-2010 18:35:18 SGT
Stop Time: 01-20-2010 20:06:20 SGT
Run Duration: 91 minutes 1 seconds
User ID:
Errors Encountered:
Instrument Mame:
Firmuware Wersion:
Software Wersion:
Instrurnent Serial Mumber: 278880001
Sample volume: 20.0
Cover Temperature:  105.0

Elock Type: 324-well Plate (16x24)
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Chapter 4 4
Monitor the run

From the ViiA™ 7 Instrument touchscreen

You can also view the progress of the run from the touchscreen of the ViiA™ 7
Instrument.

The Run Method screen on the ViiA™ 7 Instrument touchscreen looks like this:

Experiment View

MyInstrument (384-well 20pL)

Experiment: 2010-03-11-232013

Run Started: March 11 2010 - 11:20PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover: 105.0 °C
Heated Cover Set Point: 105.0 °C Time Remaining: 01:28:18

Time View

@ MyInstrument (384-well 20L) : E

Experiment: 2010-03-11-232013

Run Started: March 1172010 - 11:20PM Sample: 50.0 °C
Reaction Volume: 20 pL Stage /[ Step: 1 /1
Heated Cover Set Point: 105.0 °C Cycle: 1

Display Time: Remaiing () Elapsed

‘I\'Iarch 11 2010 - 11:20PM: Heated cover reached target temperature.
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4 Chapter 4 Run the Experiment
Monitor the run
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CHAPTER 5

Review Results and
Adjust Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

About Presence/Absence
Experiments

This chapter covers:

Section 5.1 Review Results ....... ...t 29

B Analyze the example experiment. ............ ... ... ... ... 29

View the Presence/Absence Plot . ......... ... 29

Design the Experiment B Assess amplification results using the Amplification Plot................... 31
B ViewtheWell Table ............ . 35

B Confirm accurate dye signal using the Multicomponent Plot................ 38

B Determine signal accuracy using the Raw DataPlot ....................... 41

B Review the flagsinthe QCSummary .............. ... ... ... . ........ 43

B Formoreinformation.......... ... ... . i 45

Prepare the Reactions Section 5.2 Adjust parameters for re-analysis of your own experiments. ........ 47
B Adjust analysissettings. ... 47

B For more information. .. ... 52

Run the Experiment

|

Chapter 5

Review Results and
Adjust Experiment
Parameters

Export Analysis Results
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Chapter 5 Review Results and Adjust Experiment Parameters
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SECTION 5.1

Section 5.1 Review Results

Analyze the example experiment

1. Open the Presence/Absence example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Presence/Absence Plot

The Presence/Absence Plot displays the intensity of the fluorescence for each well
position. There are four Presence/Absence plot views available:

e All Calls
* Presence calls only
* Absence calls only
* Unconfirmed calls
For each view you can choose to:
¢ Show IPC

e Show Controls

Purpose
The purpose of viewing the Presence/Absence Plot for the example experiment is to
confirm that:

* The target is absent in samples NTC and Sample (-).
* The target is present in Sample (+).

® There are no unconfirmed wells.

* The IPC succeeded in all wells.

* There is no amplification in NAC wells.

To view and assess the Presence/Absence Plot

From the Experiment menu pane, select Analysis » Presence/Absence Plot.

Note: If no data are displayed, click Analyze.

1. Display all 384 wells in the Presence/Absence Plot screen by clicking the upper
left corner of the plate layout in the Plate Layout tab.
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5 Chapter 5 Review Results and Adjust Experiment Parameters
View the Presence/Absence Plot

Presence/Absence Plot

2. Enter the Plot Settings:

Menu Selection
Target Reporter TGFB
Control Reporter IPC
Show Calls All Calls
= Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

3. Click the Show IPC check box to view the fluorescence intensity of the IPC target
in the Unknown-IPC wells.

4. Click the Show Controls check box to view the fluorescence intensity of the IPC
target in the Negative Control-IPC wells and the Negative Control-Blocked IPC
wells.

5. To view the fluorescence intensity of:
* Presence calls- select Presence from the Show Calls drop-down menu.
¢ Absence calls- select Absence from the Show Calls drop-down menu.
¢ Unconfirmed calls- select Unconfirmed from the Show Calls drop-down
menu.

Note: The Presence/Absence example experiment does not contain any
unconfirmed calls.

The Presence/Absence Plot for the example experiment looks like this:

Plot Settings

[ Save current settings as the default

Target Reporter [Ters Show IPC ¥

Shaw Cantrals W

Control Reparter |1pc

KIRETREL

Shaow Calls IA” Calls

Presence/Absence Results

1.7 i i = R Ry S S Stht ++4.++ S HTE S S i ' e
1.5
13 e "Tl'm.ﬂ”""m"‘ ""\iuﬂ'“““““‘ IT"‘\.‘J{IHI.I"“I’ "'u‘l.wl,‘l‘”l”“mk lu.l.ﬁ.l‘lunll.hl“ "l’u.lu;.f"mml’ 'Ii'l'u‘.u.l‘ylumh "i“lu“l‘y“mh‘ 'lﬁ,‘mwlr,'_w " ""T.‘.I\III'IHHII“’ |‘v'\|ul\'l‘llmlluw ”"".‘..\I'm"l""“ IU‘_I“”:,.mu"H» I"'“"l‘.,ﬂ‘“”““" 'II"TI;&I"”"““ Wi
z 8
I3
E 0g
[y
Target Threshald
ua T
0.1
30 80 130 180 230 280 330 380
‘el Position
et
Uninown Calls: @) Presence S fumence 7 Unconfirmed
1PC Cails: 1= 1PC Faled B IPC Succesdedd
Cortrais: W Hetive Cortrdl g Blacked 1PC Cortrd
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Omitted by Analysis: 0 Crnitted Manually: O Samples Used: ¢ Targets Used: 2
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Section 5.1 5
Assess amplification results using the Amplification Plot

Tips for viewing presence/absence plots in your own experiments

* The IPC threshold is calculated from the Negative Control- Blocked IPC
reactions.

* The Target Threshold is calculated from the Negative Control- IPC reactions. If
the target’s intensity is:

— Above the target threshold, the call is present (regardless of the intensity of
the IPC).

— Below the target threshold, and the IPC’s intensity is above the IPC
threshold, the call is absent.

— Below the target threshold, and the IPC’s intensity is below the IPC
threshold, the call is unconfirmed.

¢ Target Calls:
— Presence
— Absence
— Unconfirmed
e IPC Calls:
— IPC Succeeded
— [IPC Failed
¢ Control Well Calls:
— Negative Control - IPC
— Negative Control - Blocked IPC

Assess amplification results using the Amplification Plot

IMPORTANT! Amplification plots are not used to make presence/absence calls.
Examine the plots to help with troubleshooting and quality control.

Amplification plots available for viewing

The Amplification Plot displays amplification of all samples in the selected wells.
There are three amplification plot views available:

* ARn vs Cycle — ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot
displays ARn as a function of cycle number. You can use this plot to identify and
examine irregular amplification and to view threshold and baseline values for the
run.

* Rnvs Cycle — Rn is the fluorescence signal from the reporter dye normalized to
the fluorescence signal from the passive reference. This plot displays Rn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cyvs Well - Cyis the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cr as a function of well
position. You can use this plot to locate outlying amplification (outliers).
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Assess amplification results using the Amplification Plot
Each plot can be viewed as a linear or log10 graph type.

Purpose

The purpose of viewing the amplification plot for the example experiment is to review
the target to identify:

e Correct baseline and threshold values
* Irregular amplification
e Qutliers

View the Amplification Plot

1. From the Experiment menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the amplification plot by clicking the upper left corner of
the plate layout in the Plate Layout tab.

3. Expand the Plate Layout tab by clicking the left facing arrow that is left of the tab.

4. In the Amplification Plot screen, enter:

Menu Selection
Plot Type ARn vs Cycle
Plot Color Well
= Check (default)

(This is a toggle button. When the legend
is displayed, the button changes to Hide
the plot legend.)

5. View the baseline values:
a. From the Graph Type drop-down menu, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.

. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is
detected. In the example experiment, the baseline is set correctly.
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Assess amplification results using the Amplification Plot

Your screen should look like this:

Amplification Plot
Plot Settings

Plot Type: [4Rn vs Cyde =] Graph Type: [lnear =] Plot Color: fwel 3|

™ Save current settings as the default

P P& BEE
Amplification Plot

1.25

1.00

LRn

050

025

0.00 = r

Options

Target: |sl vi Threshold: [ 4utn [T tuto Baseline

Show: [T Threshold — ¥ Baseline Start: Well B Target 4 Bassline End: well (B Target 4

well Summary: In Plate; 384 Set Up: 384 Analyzed: 384 Flagged: 144 Ormitted by Analysis: 0 Critted Manually: 0 Sarmples Used: < Targets Used: 2

6. View the threshold values:
a. From the Graph Type drop-down menu, select Log.
b. Select the Threshold check box to show the threshold.
€. Verify that the threshold is set correctly.

Your screen should look like this:

Amplification Plot
Plot Settings

Plot Type: Ii\Rn vs Cycle =] Granh Type: jLog =] Plot Color: el B3|

¥ Save current settings as the default

PramElE

Amplification Plot

1E01

1E0D

01

LRn

0.01

0.00m

Options

Target: |sl VI Threshald: T 4uto [T &utn Baseline

Show: ¥ Threshold — [T Baseline Start: vell B0 Target 4. Baseline End: Well M Target 4

well Summary: In Plate: 384 Set Up: 384 Anahyzed: 354 Flagged: 144 Omitted by Analysis: Craitted Marually: O Samples Used: 4 Targets Usech 2
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Assess amplification results using the Amplification Plot

7. Locate any outliers:
a. From the Plot Type drop-down menu, select Ct vs Well.

b. Look for outliers from the amplification plot. In the example experiment,
there are no outliers for IPC.

Your screen should look like this:

Amplification Plot

Plot Settings
Plot Type: [C1 ws wel vl Graph Type: ILinear 'I Plot Colar: IWeII vI
¥ Sawe current settings as the default
S e En B—
P L el E
Amplification Plot
40.0 - R ST -S———
375 ) - -
A, e = o < o\ [
350 ._.F ok 2 » [ ) o ‘!ﬂ L
325 W P S T wE mme NyR AMe WA W
300
. P L (el .- T - b -y -— e Ry
250
225
~
< 200
175
150
125
100
75
50
25
oo 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 90 25100105 10 151200251 301 351401 451 501 551600 651701 751 801 851 2SR 000ET 1(R 1 S22 22 I MDA R4R S0P 56E650TET R0 SR ESTO000S 10815320 30 T80
Well Mumber
well Summary: In Plate; 354 Set Up: 304 Analyzed: 304 Flagged: 144 Smitted by Analysis: 0 Citted Manwally: 0 Samples Used: 4 Targets Used: 2

Tips for viewing amplification plots in your own experiments

When you analyze your own Presence/ Absence experiment, look for:

e OQutliers

* A typical amplification plot — The ViiA™ 7 Software automatically calculates
baseline and threshold values based on the assumption that the data exhibit a
typical amplification plot. A typical amplification plot has four distinct sections:

— Plateau phase
— Linear phase
— Exponential (geometric phase)

— Baseline
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View the Well Table

A typical amplification plot should look like this:

Amplification Plot
Plot Settings

Plot Type: |ARN vs Cycle -l Graph Type: ILDg LI Plot Color: |We|| ;l

¥ Save current settings as the default

AL alEE
Amplification Plot

1E01

1EDD

Options
Target: |f-\|\ * | Threshald: [T auto I IF uto Baseline

Shaow: ¥ Threshold — W Baseline Start: well B0 Target -+ Baseline End: el (B Target £

wWell Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Cmitted by Analysis: 0 Crriitted Manually: 0 Samples Used: 4 Targets Used: 2

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the ViiA™ 7 Software. Applied Biosystems
recommends that you examine the Amplification Plot screen and review the assigned
baseline and threshold values for each well after analysis.

View the Well Table

The well table displays results data for each well in the reaction plate, including;:

* The well number, sample name, target name, task, and dyes

¢ The calculated values: ARn, ARn mean, and ARn SD
Note: ARn, ARn mean, and ARn SD are calculated only when the analysis call
settings specify to analyze data from the pre-PCR read and the post-PCR read.

¢ Target and IPC thresholds, Call, Comments
¢ Flags

Purpose

In the Presence/Absence example experiment, you review the well table for:

e Call
* ARn
* Flag
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View the Well Table

To view the Well Table

1. From the Experiment Menu pane, select Analysis » Amplification Plot, then
select the Well Table tab.

Note: If no data are displayed, click Analyze.

2. Use the Group By drop-down menu to group wells by a specific category. For the
example experiment, group the wells by flag, call, and ARn value.

Note: You can select only one category at a time.

a. From the Group By drop-down menu, select Flag:
* 144 wells are listed under Flagged.
e 240 wells are listed under Unflagged.

e
Plate Layout Well Table

ow in Table ¥ 5 Group By Expand All

# | wel | Omit Flag |Samp...| Target Name Dyes ARN Mean AR SO | Threshal call Comments MNOAMP EXPFA]

-
r 2 | Sampl... IPC IPC WIC-NFQ-MGE 1.404 0.012 1.09 IPC Succe...
4 A4 r 2 | Sampl... TGFE UNEMOWN FAM-MNFQ-MGE 0.38 0.3581 0.006 0.414 Absence
5 AS r 2 | sampl... IPC IPC VIC-NFQ-MGE 1,395 1.404 0.012 1.09 IPC Succe...
5 A5 I 2 | Sampl... TGFE UNEMCHWAR FAM-MFQ-MGE 0,378 0,381 0,006 0,414 Absence
6 A6 r 2 | Sampl... IPC IPC WIC-NFQ-MGE 1,403 1.404 0.012 1.09 [PC Succe...
6 A6 r 2 | Sampl... TGFE UNEMOWN FAM-MNFO-MGE 0.38 0.381 0.00& 0.414 Abzence
7 A7 r 2 | Sampl... IPC IPC VIC-NFQ-MGE 141 1.404 0.012 1.09 [PC Succe...
7oAT I 2 | Sampl... TGFE UNKMNCHWAN FAM-NFQ-MGE 0,386 0,381 0,006 0,414 Absence
8 AB r 2 | sampl... IPC IPC WIC-NFQ-MGE 1.401 1.404 0.012 1.09 IPC Succe...
8 AB r 2 | Sampl... TGFE UMW FAM-MNFO-MGE 0.289 0.381 0.006 0.414 Abzence
9 AQ r 2 | Sampl... IPC IPC VIC-MNFQ-MGE 1.395 1.404 0.012 1.09 [PC Succe...
9 29 r 2 | Sampl... TGFE UNKMNCHWAN FAM-NFQ-MGE 0,382 0,381 0,006 0,414 Absence
10 A10 r 2 | sampl... IPC IPC WIC-NFQ-MGE 1.405 1.404 0.012 1.09 IPC Succe...
10 A10 r 2 | Sampl... TGFE UMKMOWN FAM-MNFQ-MGE 0.282 0.381 0.006 0.414 Abzence
11 A11 I 2 | Sampl... IPC IPC WIC-NFQ-MGE 1,407 1.404 0.012 1.09 IPC Succe...
11 A11 r 2 | Sampl... TGFE UNKMNCHWAN FAM-NFQ-MGE 0,387 0,381 0,006 0,414 Absence
12 A12 r 2 | sampl... IPC IPC WIC-NFQ-MGE 1.402 1.404 0.012 1.09 IPC Succe...
12 A12 r 2 | Sampl... TGFE UMKMOWN FAM-MNFQ-MGE 0.282 0.381 0.008 0.414 Abzence
28 B4 I 2 | Sampl... IPC IPC WIC-NFQ-MGE 1.396 1.404 0.012 1.09 IPC Succe...
28 B4 r 2 | Sampl... TGFE UNEMOWN FAM-MNFQ-MGE 0.3584 0.3581 0.006 0.414 Abzence
2965 r 2 | sampl... IPC IPC VIC-NFQ-MGE 14 1.404 0.01z2 1.09 IPC Succe...
29B5 r 2 | Sampl... TGFE UMKMOMW FAM-MNFQ-MGE 0.284 0.381 0.008 0.414 Absence
30 BS r 2 | Sampl... IPC IPC WIC-NFQ-MGE 1,408 1.404 0.012 1.09 IPC Succe...

a0 EA _4| | il Carmel  TRER 1 IR AR E i l_RIEC_RAGE: N 20A n 2 n Nne ndid Abhcanra 1 - - 4

well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Critted by Analysis: O Omitted Manually: 0 Samples Used: 4 Targets Used: 2

b. From the Group By drop-down menu, select Call. Wells are listed in the
order:

e Absence
e Blocked IPC Control
e IPC Succeeded
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View the Well Table

* Negative Control

¢ Presence

Flate Layout

in Table ¥
Target Mame ARN Mean Threshald...
16 416 r .. TGFB UIMKMOWN FamM-MFQ-MGE 1769 1.706 0.034 0.414 Fresence
17 Al17 r sampl... TGFB LIMNKMOWMN FAM-MFQ-MGE 1789 1.706 0,034 0.414 Presence
18 418 r Sarnpl... TGFB LIMKNCHWN FAM-NFO-MGE 1.744 1,706 0.034 0.414 | Presence
19 419 r Sampl... TGFB UMKMOWM FaM-MFQ-MGE 1722 1.706 0.034 0.414 Fresence
20 420 r sampl... TGFE LIMKMOWN FAM-MFQ-MGE 1722 1.706 0,034 0.414 Fresence
21 421 r Sampl... TGFB LMK FAM-NFO-MGE 1,739 1,706 0.034 0.414 | Presence
22 b22 r Sarnpl... TGFB LIMKINCHWN FAM-NFO-MGE 1.695 1,706 0.034 0414 | Presence
23 A23 r Sampl... TGFE UMKMOWM FaM-MFQ-MGE 1.708 1.706 0.034 0.414 Fresence
24 424 r sampl... TGFE LIMNKMOWN FAM-MFQ-MGE 1716 1.706 0.034 0.414 Fresence
40 B16 r Sampl... TGFB LIMKNCWN FAM-NFO-MGE 1,773 1,706 0.034 0.414 | Presence
41 B17 r Sampl... TGFB UMKMOWN FamM-MFQ-MGE 1773 1.706 0.034 0.414 Fresence
42 B18 r Sampl... TGFB UIMKMOWN FaM-MFQ-MGE 1.745 1.706 0.034 0.414 Fresence
43 B19 r sampl... TGFE LIMNEMOWN FAM-MFQ-MGE 1737 1.706 0.034 0.414 Presence
44 B20 r Sarnpl... TGFB LIMKNCWN FAM-NFO-MGE 1726 1,706 0.034 0.414 | Presence
45 B21 r Sampl... TGFB UMKMOWN FamM-MFQ-MGE 1.688 1.706 0.034 0.414 Fresence
46 B22 r Sampl... TGFB UIMKMOWN FaM-MFQ-MGE 1711 1.706 0.034 0.414 Fresence
47 B23 r sampl... TGFE LIMNEMOWN FAM-MFQ-MGE 1.686 1.706 0.034 0.414 Presence
48 B24 r Sarnpl... TGFB LIMKNCWN FAM-NFO-MGE 1.695 1,706 0.034 0.414 | Presence
64 C16 r Sampl... TGFB UMKMOWM FamM-MFQ-MGE 1751 1.706 0.034 0.414 Fresence
RE 1T ‘I Sarnnl Tr=FR [N N RN FAMLLIFM-SR 1 743 1 7N/ n N34 nadatd Droconro I _yILI
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Omitted by Analysis: 0 Ornitted Manualhy: O Samnples Used: 4 Targets Used: 2

€. From the Group By drop-down menu, select None. In the table, click the
column heading ARn. Wells are listed in order of increasing ARn. Click the
column heading again to reverse the sort order.

Callspse All

# | Well | Omit | Flag |Samp.‘.| Target Hame Task | Dyes | ARn - ~!| |ARn Mean ARn S0 | Threshald... Cal Comments | NOAMP | EXPI
W J1 C NTC TGFE NTC FAM-NFQ-MGE 033 0.371 0015 MNegative C... ﬂ
.o HL r NTC TGFE NTC FAM-NFO-MGE 033 0.271 0.016 Megative ...

ooo 101 r NTC TGFE NTC FAM-NFO-MGE 0.337 0.371 0.016 Megative ...
. H2 [l NTC TGEFE NTC FAM-NFQ-MGE 0.34 0.371 0.015 Megative ...
w12 C NTC TGFE NTC FAM-NFQ-MGE 0.341 0.371 0015 MNegative C...
oo d2 r NTC TGFE NTC FAM-NFO-MGE 0.345 0.371 0.016 Megative ...
.. G1 i NTC TGFE NTC FAM-NFQ-MGE 0.349 0.371 0.015 Megative C...
aoo [FIL O MNTC TGFE MNTC FAM-NFQ-MGE 0.349 0.371 0.015 Megative ...
. G2 C NTC TGFE NTC FAM-NFQ-MGE 0.3534 0.371 0015 MNegative C...
. KL r NTC TGFE NTC FAM-NFO-MGE 0.356 0.371 0.016 Megative ...
aoo JLLIL i 2 Sampl... TGFB LINKNOWH FAM-NFQ-MGE 0.363 0.351 0.005 0.414 Absence
w0 HL3 O MNAC TGFE NTC FAM-NFQ-MGE 0.363 0,381 0.007 MNegative C...
. K2 r NTC TGFE NTC FAM-NFO-MGE 0.264 0.271 0.016 Megative ...
.. F14 r MNAC TGFE NTC FAM-NFQ-MGE 0.364 0.381 0.007 Megative ...
i i NTC TGEFE NTC FAM-NFQ-MGE 0.367 0.371 0.015 Megative C...
49CL O NTC TGFE NTC FAM-NFQ-MGE 0.367 0.371 0015 MNegative C...
.o HI1 r 2 Sampl... TGFB URKMOWH FAM-NFO-MGE 0.368 0.381 0.006 0.414 Absence
.. F2 [l NTC TGFE NTC FAM-NFQ-MGE 0.369 0.371 0.015 Megative C...
aoo [LILL C 2 Sampl... TGFE LIMKINOWI FAM-NFQ-MGE 0.369 0.381 0.008 0.414 Absence
w0 H2 O NTC TGFE NTC FAM-NFQ-MGE 0.369 0.371 0015 MNegative C..
oon JE r MNAC TGFE NTC FAM-NFO-MGE 0.369 0.381 0.007 Megative ...
7301 [l NTC TGFE NTC FAM-NFQ-MGE 0.37 0.371 0.015 Megative C...
. H14 C NAC TGFE NTC FAM-NFQ-MGE 0.37 0,381 0.007 MNegative C...

. J10 r 2. Sampl... TGFE URKMNOWN FAM-NFO-MGE 0.371 0.281 0.006 0.414 Absence

k11 4| 1 - Sarnml TiRFR TR R AC L F ARG nazwe n2ed noNns natd Ahcanra I _}l;I
Well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144 Cmitted by Analysis: 0 Crrnitted Marwally: 0 Samples Used: 4 Targets Used: 2
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Confirm accurate dye signal using the Multicomponent Plot

Tips for analyzing your own experiments

When you analyze your own Presence/Absence experiment, group the wells by:

¢ Flag —The software groups the flagged and unflagged wells. A flag indicates that
the software has found an error in the flagged well. For a description of the
ViiA™ 7 Software flags, see “Review the flags in the QC Summary” on page 43.

* Call - The software groups the wells by call: Negative Control, Blocked-IPC,
Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose

In the Presence/Absence example experiment, you review the Multicomponent Plot
screen for:

e ROX™ dye (passive reference)

* FAM" dye (reporter)

e VIC® dye (reporter)

* Spikes, dips, and/or sudden changes

* Amplification in the negative control wells

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the wells one at a time in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click ['~| Show a legend for the plot (default).
Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.
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Confirm accurate dye signal using the Multicomponent Plot

5

6. Check the VIC dye signal. In the example experiment the VIC dye signal should
not amplify for NC-Blocked IPC wells or if the IPC call for the Unknown-IPC well
is IPC Failed.

Multicomponent Plot
Plot Settings

Plot Color |Dye - I

™ Save current settings as the default

Well Table

P PLaBEE

Multicomponent Plot

400,000

350,000

300,000

250,000 { -

200,000

Fluorescence

150,000

100,000

50,000

o -
O M oz o2 M M M B M M\ M M 2 &

Cycle

o 2 4 & & W 2 @

Lagend
WFa ERROx [ VIC

well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: 144

ikt
M Iz .z &
wells: [[o o 233 43 43

Crnitted Manually: O

—

Omitted by Analysis: O Samples Used: ¢

"

0 Empty

Targets Used: 2

7. Check the FAM dye signal. In the example experiment, for the Sample (+), the
FAM dye signal increases throughout the PCR process; increase in FAM dye
signal indicates normal amplification.

Multicomponent Plot
Plot Settings

Flot Color |Dye - I

™ Save current settings as the default

» P a

Multicomponent Plot

400.000
350,000
200,000

250.000

200,000

Fluaorescence

150,000

100,000

50,000

o

a2 4 8 & 10 12 14 18 W 2 2 M B W\ M B M ¥ oM o4 £ 4«4

Cyclz

Legerd
Ml Fer Il ROx I VIC

wWell Summary: In Plate: 304 Set Up: 384 Anahyzed: 304 Flagged: 144

m

o P o B B B

i B .. 0
N , ;
wells: . i} JD 288 48 7 48

Smitted by Analysis: 0 Critted Manwally: 0 Samples Used: 4
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Confirm accurate dye signal using the Multicomponent Plot

8. Select the negative control (NAC) wells one at time and check for amplification. In
the example experiment, there is no amplification in the negative control wells.

N well Table

Plate Layout

Multicomponent Plot
Plot Settings

Flot Color |Dye v l

™ Save current settings as the default

PP &M=

11
Multicomponent Plot 4 ’

400,000 1
350,000
300,000 1

250.000 1

200,000 1

Fluorescence

150,000

100,000 .
=
£l

50,000

02 4 8 @ 10 12 14 18 1@ M 2 M M W W B M ¥ B} 4 &2 &

Cycle -

- 2 _ILI
e ROy I vIC 4 | g
‘ I Bl .. El 0 Empty
wells: [[o o zsa i 28 40
well Summary: In Plate: 384 Selt Up: 384 Analyzed: 384 Flagged: 144 Cmitted by Analysis: 0 Crmitted Manually: 0 Samples Used: 4 Targets Used: 2

Tips for confirming dye accuracy in your own experiment

When you analyze your own Presence/Absence experiment, look for:
* Passive reference (ROX)- The passive reference dye fluorescence level should
remain relatively constant throughout the PCR process.
* Reporter dye (FAM) — The reporter dye fluorescence level should display a flat

region corresponding to the baseline. If target is present in the sample (a Presence
call is made), the baseline will be followed by a rapid rise in fluorescence as the

amplification proceeds.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

¢ Negative control wells — There should not be any amplification in the negative
control wells.
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Determine signal accuracy using the Raw Data Plot

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

Purpose

In the Presence/Absence example experiment, review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.

View the Raw Data Plot

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.
2. Click '~ Show a legend for the plot (default). The legend displays the color code
for each row of the reaction plate (see the legend in the Raw Data Plot shown

below).

3. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

4. Select wells corresponding to a replicate group:

e Sample (-) wells: From the Select Wells with drop-down menus, select
Sample (-).

¢ Sample (+) wells: From the Select Wells with drop-down menus, select
Sample (+).

* Negative control-IPC wells: Select wells Al - P1, A2 - P2, and A3 - P3.

* Negative control-blocked IPC wells: Select wells A13 - P13, A14 -P14, and
Al5 - P15.
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5. Click and drag the Show Cycle pointer from cycle 1 to cycle 42. In the example
experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.

Raw Data Plot <

Raw Data Plot

800,000
750,000
700,000
650,000
600,000
550,000
500,000
450,000
400,000
350,000
300,000
250,000
200,000
150,000
100.000

50,000

Amplitude

x1.m1 xBamZ *3m3 xdmd x5.m5

Filter
Lagend
’V-A _J:] % o e HFr H: B+ j‘
Options
Show Cycle 42 J
P D T Tl e W
1 5 10 15 20 = 30 35 40 42
well Summary: In Plate: 384 Set Up: 384 Anahyzed: 354 Flagged: 144 Orvitted by Analysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Lised: 2
The filters used for the example experiment are:
PCR Filter =

b ba Defauilts

Save Rewert

Ermission Fiter
ml(520=15) m2(558+11) m3(586x10) m4{623+14) m5(682+14) m&(711=12)

x1(470=15)

¥2(52010)

x3(550=11)

Excitation Filter

¥4(58010)

%5(640<10)

*6(662+10)

Melt Curve Filter a0

Emission Fiter
ml(520+15) m2(558+11) m3(586+10) ma(623+14) m5(682+14) m6(711+12)

*1(470+15)

x2(520+10)

*3(550+11)

Excitation Filter

x4(580=10)

¥5(64010)

x6(662=10)
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Review the flags in the QC Summary

Tips for determining signal accuracy in your own experiments

When you analyze your own Presence/ Absence experiment, look for the following in
each filter:

¢ Characteristic signal growth

* No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the ViiA™ 7 Software flags, including the
flag frequency and location for the open experiment. In the example experiment, 144
flags have been triggered.

Note: The flags triggered in the example experiment are seen in the Sample (-) wells.
The flags, NOAMP and EXPFAIL indicate that the wells containing the Sample (-) did
not amplify and that the software could not identify the exponential region of the
amplification plot (as amplification did not take place). The occurrence of these flags in
the example experiment is valid because it indicates the absence of the target in the
sample.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

In the example experiment, there are 144 flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment:
e The NOAMP flag appears 144 times, in the wells A4 - P4, A5 - P5, A6 -P6, A7
-P7, A8-P8, A9 - P9, A10 - P10, A1l - P11, and A12 - P12.
¢ The EXPFAIL flag appears 144 times, in the same wells as the NOAMP flag,
thatis, A4 - P4, A5-P5, A6 -P6, A7 -P7, A8 - P8, A9 -9, A10 - P10, A1l -
P11, and A12 - P12.
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Review the flags in the QC Summary

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

QC Summary <
Flag Details
Flag: Description Freguency ells

EADROX Fad passive reference signal (o]
MNOSIGNAL Mo signal in well (o]
OFFSCALE Fluorescence is offscale ]
AMPNC ismplification in negative contral (o]
NOAMP Mo amplification 144 A4, A5, AG, A7, AD, AB, A10, A11, A12, B...
MNOISE Moise higher than others in plate 0
SPIKE Moise spikes (]
EXPFAIL Exponential algorithm faled 144 A4, AS, BB, AF, AB, AD, A10, ALl A12, B...
ELFAIL Easeline algorithrn failed (]
THOLDFAIL Thresholding algorithrn failed (]
CTFAIL ICT algorithm falled (]

Flag: MOAMP—No amplfication =

Flag Detail: The sample did not amplify
Flag Criteria: Ampiification algorithm result < 0.1

Flagged Wells: A4, AS, AS, A7, AB, A9, AL0, ALL, Al2,B4,B5,BS, B7,B8,B9,B10,B11,B12, C4, C5, C6, C7,CB, C9,C10,C11,C12, 04, D5, D,
D7,08,09,010,011,012, B4, E5, BES, EV, BB, ES, E10,E11, E12, F4, F5, F&, F7, FB, F2, F10, F11, F12, G4, G5, G&, 57, G5, G2,
G10,G11, G12, B4, H5, HE, HY, HE, H2, H10, H11, H12, 4, 15, 16, [/, 18,19, [10, 111, [12, 34, 15, J&, 17, 13, 12, 110, 111, 112, K4,
KE, K&, K7, K8, K9, K10, K11, K12, L4, L5, L&, L7, L8, LS, L10,L11, L 12, M4, M5, Mg, M7, M3, M3, M10, M11, M12, N4, NS, N&, N7,
ME, N2, N10, N11, M12, 04, 05, 06, 07, 08, 09, 210, 011, 012, P4, PS5, P&, P7, PG, PS, P10, P11, P12

Wiew MOAMP Troubleshooting Information 4|

Tatal wells: 384 | Processed wels: 384 Manually Omitted wels: 0 | Targets Used: 2

Wells Set Up: 384 | Flagged ‘Wells: 144 Analysis Omitted Wells: 0 | Samples Used; 4
well Summary: In Plate: 334 Set Up: 284 Analyzed: 384 Flagged: 144 Cmitted by Anahysis: 0 Omitted Manually: 0 Samples Used: 4 Targets Used: 2

Possible flags

For Presence/Absence experiments, the flags listed below may be triggered by the
experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flags

BADROX Bad passive reference signal
NOAMP No amplification

NOISE Noise higher than others in plate
SPIKE Noise spikes

NOSIGNAL | No signal in well

EXPFAIL | Exponential algorithm failed
BLFAIL . Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Ct algorithm failed
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For more information

Flag Description

Secondary analysis flags

AMPNC Amplification in negative control

Note: If the experiment does not include amplification, then the only flags are
BADROX, NOSIGNAL, and OFFSCALE.

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,

THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments
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For more information

46 Applied Biosystems ViiA™ 7 System Getting Started Guide for Presence/Absence Experiments



SECTION 5.2

Section 5.2 Adjust parameters for re-analysis
of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the call, threshold
cycle (Cy), flags, and advanced options.

If the default analysis settings in the ViiA™ 7 Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then
reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
¢ (Call Settings
e Crp Settings
¢ Flag Settings
* Advanced Settings

Applied Biosystems ViiA™ 7 System Getting Started Guide for Presence/Absence Experiments 47
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Adjust analysis settings

The Analysis Settings dialog box for a Presence/Absence experiment looks like
this:

Pﬁ Analysis Settings for YiiA7_384-Well_f

=k the target from the table, ¢ =t Use Default

Data Analysis Settings

 Analyze Data from Post-PCR Read Only @ &nalyze Data from Pre-PCR Read and Post-PCR Read }

~—Default Call Settings
Default call settings are used ko make presencefabsence calls for targets without custom settings. To edit the defaulk settings, click Edit Default Settings.

Confidence Value: 99% Edit Default Settings

~—Select a Target —Call Settings for TGFB
Target Analysis Type Confidence

TGFE Defalt 99% ;I

Call Settings to Use: W Use Default Settings

Confidence Value: |95% vI

PC Defallt 99%

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

3. View and, if necessary, change the analysis settings (see “Adjust analysis settings”
below).

Note: You can save the changes to the analysis settings to the Analysis Settings
Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note: You can go back to the default analysis settings, by clicking Revert to
Default Analysis Settings.
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Adjust analysis settings

Adjust analysis settings

Call Settings Use the Call Settings tab to:

* Change the default data analysis settings. You can select from:
— Analyze data from Post-PCR Read only
— Analyze data from Pre-PCR Read and Post-PCR Read

e Edit the default call settings.

— Click Edit Default Settings, then select the confidence value to use to make
presence/absence calls. If the confidence value is less than the call setting, the
call is unconfirmed.

— Click Save Changes.
¢ Use custom call settings for a target.

— Select one or more targets in the table, then deselect the Default Settings
checkbox.

— Select the confidence value to use to make presence/absence calls for the
selected target(s).

Ct Settings * Data Step Selection
Use this feature to select one stage/step combination for Ct analysis when there is
more than one data collection point in the run method.
* Algorithm Settings
You can select the algorithm that determines the Cp values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.

The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.

The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.

¢ Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

* Crp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
e Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.
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Adjust analysis settings

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Flag Settings Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.

Change the flags that are applied by the ViiA™ 7 Software.

To adjust the flag settings:

50

. In the Use column, select the check boxes for flags to apply during analysis.

2. (Optional) If an attribute, condition, and value are listed for a flag, specify the

setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

. In the Reject Well column, select the check boxes if you want the software to reject

wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of Ct SD. For some flags, analysis results calculated before
the well is rejected are maintained.

. Click Apply Analysis Settings in the Analysis Settings dialog box. If the run

status is complete, the data are reanalyzed.
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Adjust analysis settings

The Flag Settings tab looks like this:

[l analysis Settings for ViiAT_384-Well_Pres

Flag Description Use Attribute Condition Value Reject Well
AMPMNC armplification in negati... W T < w (|25 [
BADRCH Bad passive reference... W Fluorescence = w [|500 I
BLFAIL Baseline algorithm failed | m
CTFAIL T algarithm failed W [
EXPFAIL Exponential algarithmm .. 4 | =
OFFSCALE Fluorescence is offscale 2 O
MNOAMP Mo amplification 3 arnplification algorithm...| < w (0.1 [mi
MNOISE Moise higher than oth... 172 Relative noise > w |4 [
SPIKE Moise spikes 3 Splke algorithm result | = » |1 [
MNOSTGMAL Mo signal in wel W |
THOLDFAIL Threshalding algarith... W mm

Save to Library Load from Library Revert to Default Analysis Settings Apply Analysis Settings W

Advanced Settings Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

e TFor automatic baseline calculations, select the Automatic Baseline check
box.

¢ To define the baseline, deselect the Automatic Baseline check box, then enter
the baseline start cycle and baseline end cycle.
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For more information

For more information

For more information on... Refer to Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene 127AP05-03
Expression Assays Application Note.
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About Presence/Absence
Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and
Adjust Experiment
Parameters

|

Chapter 5.

. In the Experiment Menu, click

CHAPTER 6

Export Analysis Results

. Open the Presence/Absence example experiment file that you analyzed in

=3 Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

Select ViiA™7 Format.

Complete the Export dialog box as shown below:

Field or Selection

Entry

Select Data to Results
export/ Select

Content

Export Data To One File
Export File Name ViiA7PAexport
File Type * txt

Export File Location

<drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments

Chapter 6

Export Analysis Results
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Chapter 6 Export Analysis Results

Your Export screen should look like this:

[T Auto Export Format :IViiA'” 7 ﬂ Export Data To: @ One Fle ¢ Separate Fles W Open file(s) when export is complete
Export File Locatian:IC:LApplied BiosystemsiiiA7 Software vl Dexperiments Export File Mame:viia7-Paexport File Type: IF (*txt) =
[:] Sample Setup [:] Raw Data [:] Amplification [:] Multicomponent

54

Select Content
[ All Fields

¥ iwvell

¥ Sarple Mame
¥ Target Name
¥ Task

¥ Reporter

¥ Quencher

¥ Rn

¥ Rn Maan

[# Rn 5D

¥ Threshald value

v cal

wel Sample Ma...| Target Ma... Task Reporter I Quencher | RN Rn Mean Rn SD Threshald. .. I (o]
= 1 NTC IPC IPC WIC MFQ-MGE ﬂ
1 NTC TGFB NTC FaM MFQ-MGE
2 NTC IPC IPC WIC MFQ-MGE
2 NTC TGFB NTC FarM MFO-MGE
3 NTC IRC 1PC WIC MFO-MGE
] NTC TGFB NTC FamM MFO-MGE
4 Sample (-} IPC IFC WIC NFQ-MGE
4 Sample () TiEFB UMKHOWM - FAM MF-MGE
=] Sample () IPC IPC WIC MF-MGE
=1 sample () TiEFB UMEMOWT - FAM MFQ-MGE
6 Sample (-] IPC 1PC WIC NFQ-MGE
(s} Sample () TGFB UMEMOWN - FaM MFOQ-MGE
7 Sample (=) IPC IPC WIC MFQ-MGE
7 Sample () TGFB UMKHOWN - FaM MFQ-MGE
(=} Sample (-)  IPC 1PC WIC MFO-MGE
(=] Sample (-)  TGFB UMKMOWN  FaM MFO-MGE
el Sample (-} IPC IPC WIC MF-MGE
el Sample () TGFB UMKHOWM - FAM MF-MGE
_I ].P Sample (-1 IPC IPC WIC | MFO-MGE LILI

Start Export || Save Export Set As ll Load Export Set

Your exported file when opened in Notepad should look like this:

loix|
File Edt Format View Help
" Block Type = 384-Well Block -
* Calibration is expired = MNo

* Calibration performed on = 2010-01-14 11:43:58 AM S5CT

* Calibration Background is expirad = No

™ Calibration Background performad on = 2009-12-09 11:41:30 AM S5CT
* Calibration FAM is expired = Mo

* Calibration FAM performed on = 2009-12-03 11:58:25 AM S5CT

* Calibration ROl is expired = No

* Calibration ROl performed on = 2003-12-0% 11:35:41 AM SCT

* Calibration ROX is expired = No

* Calibration ROX performed on = 2009-12-03 12:07:33 PM 5CT

™ Calibration Uniformity is expired = No

* Calibration Uniformity performed on = 2008-12-03 11:45:27 AM SCT
* Calibration ¥IC is expired = MNo

* Calibration VIC performed on = 2009-12-03 14:23:34 PM 5CT

™ Chemistry = TAQMAN

* Experiment File Name = C:YApplied Biosystems\WiiA7 Software v1.0\experiments \examples \¥iiA7 _384-Well_Presence-Absence_Example.eds
* Experimeant Mame = ViiA7_384-Well_Presence-Absence_Example

™ Experiment Run End Time = Mot Started

* Experimant Type = PrasencefAbsence

* Instrument Serial Mumber = 278880001

* Instrumeant Type = ViiA 7

™ Passive Refarence = ROX

* Quantification Cycle Method = Ct

* Signal Smoothing On = false

* Stagef Cycle whera Analysis is performed = Stage 3, Step 2

[Results]

el Sample Name Target Mame Task Reporter  Quencher Rn Rn Mean Rn 5D Threshold Value Call
Comments Automatic Ct Threshold Ct Threshold Automatic Baseline Baseline Start Baseline End Customl
CustomZ Custom3 Customd CustomS Customé

1 MTC IRC IPC WIC MNFQ-MCB true 0.2 true
3 15

1 MTC TCFE MTC FAM MFQ-MCE true 0.2 true
3 15

2 MTC IFC IPC WIC MNFQ-MGE true 0.2 trus
3 15

2 MTC TCFE MTC F AR MFQ-MCE true 0.2 true
3 15

3 MNTC IPC IPC YIC MNFQ-MCE true 0.2 true =]
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Chapter 1

About Melt Curve
Experiments

Design the Experiment

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results

CHAPTER 1

About Melt Curve Experiments

This chapter covers:

B OV OIVIOW ottt e e e e 6
B Aboutthe Melt Curve reactionsS. .. ..ottt e e 6
B About the example experiment ........... ... ... i i 6

IMPORTANT! First-time users of the ViiA™ 7 System, please read Booklet 1, Getting
Started with ViiA™ 7 System Experiments and Booklet 7, ViiA™ 7 System Experiments -
Appendixes of this binder thoroughly. The booklet provides information and general
instructions that are applicable to all the experiments described in this binder.

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems ViiA™ 7 Software by pressing F1, clicking &) in
the toolbar, or selecting Help » ViiA™ 7 Software Help.
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1 Chapter 1 About Melt Curve Experiments
Overview

Overview

A Melt Curve, also known as dissociation curve, is a plot of data collected during the
Melt Curve stage of an experiment. Melt Curve experiments are performed to
determine the melting temperature (Tm) of a target nucleic acid sequence or to identify
nonspecific PCR amplification.

Melting temperature (Tm) is the temperature at which 50% of the target DNA is
double-stranded and 50% is dissociated into single-stranded DNA.

The melting temperature and non-specific PCR amplification can be identified as
peaks in the melt curve stage of an experiment.

About the Melt Curve reactions

With Melt Curve experiments, the reactions consist of completed PCR reactions that
contain amplified products and SYBR® Green dye to detect double-stranded DNA.

The ViiA™ 7 Software detects the number of fluorescence peaks, determines the
melting temperature (Tm) for each peak, and plots the results in a melt curve.

The fluorescence data collected during the ViiA™ 7 Instrument run are stored in an
experiment data file (*.eds).

There are two types of reactions in a Melt Curve experiment:

¢ Unknowns - Wells containing PCR product with unknown melting
temperature(s).

¢ Negative controls - Wells containing buffer or water instead of sample. Negative
controls should contain no double-stranded DNA.

About the example experiment

To illustrate how to perform Melt Curve experiments, this guide leads you through the
process of designing and performing an example experiment. The example experiment
represents a typical setup that you can use to quickly familiarize yourself with a
ViiA™ 7 System.

The objective of the example Melt Curve experiment is to investigate the melting
temperature of Target 1, and verify that no extraneous peaks appear. The SYBR Green
reagent is used to detect the melting temperature stage.

Note: The example experiment performs a melt curve analysis on PCR products from
a PCR performed on the ViiA™ 7 System or on another thermal cycler.
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CHAPTER 2

Design the Experiment

This chapter explains how to design the example experiment from the Experiment

Setup menu.
About Melt Curve

Experiments This chapter covers:
B Define the experiment properties. ........... ... ... i 8
Define targets and samples. . . ... 9
l B Assigntargetsand samples.......... ... .. ool 10
B Setuptherunmethod........ ... ... . i 10
Chapter 2
B Order materials for the experiment................... ... ... ... .. ... 12
Design the Experiment
B For moreinformation. ........... ... 13
Note: To automatically export the analyzed data to a specified location, select the Auto
I Export task from the Export screen, before running the experiment. For more
information on Auto Export, refer to Chapter 1in Booklet 1, Getting Started with ViiA™

7 System Experiments.

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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Define the experiment properties

Define the experiment properties

Click Experiment Setup » Experiment Properties to create a new experiment in the
ViiA™ 7 Software. Enter:

Field or Selection Entry
Experiment Name ViiA7_384-Well_SYBR_Green_Melt_Example
Barcode Leave field empty
User Name Example User
Comments Melt Curve example
Block 384-Well Block
Experiment Type Melt Curve
Reagents SYBR® Green Reagents
Ramp speed Standard
Include PCR Unchecked

Save the experiment.

Your Experiment Properties screen should look like this:

How do you want to identify this experiment?

* Experment Marme: [WiA7 384-Ukell SYBR Grean Malt Example Commants: |Mek Curve axarrple ﬁ
Barcode:; |
Usar Mame! |Examaple Usar w

Which block are you using to run the experiment?

v S64-well Block . | Array Card Block J 95 well Block [0, 2mL} | Fast o6-wall Biodk (0, 1L} ]

Standard Curve | [ Relative Standard Curve | Comparative C1 (AACT) | [+ Melt Curve

Ganotyping | l Presence/Absence J

What properties do you want for the instrument run?

E Standard [ Fast J

[l irclice PCR
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Define targets and samples

Define targets and samples

Click Define to access the Define screen. Enter:

1. Targets
Target Name Reporter Quencher Color
Target 1 SYBR None .
2. Samples

Sample Name Color

Sample 1 .

3. Dye to be used as a Passive Reference
ROX

Your Define screen should look like this:

Target Name Reporter Quencher Color Sample Name Color

Target 1 ||SYER + [None vh . Sample 1 |_ v

Passive Reference

Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments



2 Chapter 2 Design the Experiment
Assign targets and samples

Assign targets and samples

Click Assign to access the Assign screen. Enter the targets and samples:

Target Name Sample Well Number Task

SYBR Sample 1 A1 - P24 (Columns 1 -24) Unknown

Your Assign screen should look like this:

Targets Plate Layout

Il

_.Targetl
A w B fv Bv BNv HBv Bv Huv Mo N
95 Bv fAv fv fBv fv fHv fc fHv Qv fv B
,cn-__rs-_n-_n-_n-_p

Sample —m0 —m——— -

Hl| dv B Hv Bv HBv Bv fHv Bv Hv Qv Hv B

- I O O O O O O O O .

n

-
| | »

wals: [ 384 [ o 0 Empty

Set up the run method

Set the thermal profile

Click Run Method to access the Run Method screen. Set the thermal profile under the
Graphical View tab. Enter:

* Reaction Volume Per Well: 20ul
e Thermal Profile

Stage Step Ramp rate Temperature Time
Melt Curve Stage Step 1 1.6 °C/s 95°C 15 seconds
Step 2 1.6 °C/s 60°C 1 minute
Step 3 0.05°C/s 95°C 15 seconds
(Dissociation)
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Chapter 2 2
Set up the run method

Edit the ramp increment
Edit the ramp increment for a melt curve (dissociation) step.

1. Select a melt curve ramp increment method:

¢ Step and Hold - Increases or decreases the ramp temperature in 0.1 °C
increments over the time (duration) for the melt curve ramp.

¢ Continuous (default) — Increases or decreases the ramp rate in 0.005 °C per
second increments.

2. If you selected the Step and Hold ramp increment method, edit the melt curve
ramp time:
¢ To increase or decrease the time in 1-minute or 1-second increments, click the
Step and Hold field, select the minutes or seconds, then use the up or down
arrow keys or click the up or down buttons in the field until you reach the
desired time.

¢ To enter the desired time, click the Step and Hold field, select the minutes or
seconds, then enter the desired time.

3. Edit the melt curve ramp increment:

¢ To increase or decrease the ramp increment, click the melt curve
(dissociation) ramp increment in the thermal profile, then use the up or
down arrow keys or click the up or down buttons in the field until you reach
the desired value.

¢ To enter the desired ramp increment, click the melt curve (dissociation) ramp
increment in the thermal profile, select the value in the field, then enter the
desired value.

Note: To view the maximum and minimum allowed values, place the cursor
over melt curve (dissociation) ramp increment in the thermal profile and
wait for the tooltip to pop up.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments 1



2 Chapter 2 Design the Experiment
Order materials for the experiment

Your Run Method screen should look like this:

Run Method

Reaction volume per well 20 L

Optical Filers

Melt Curve Stage

€ Step and Hold ID: 05 3:

& Continuous

100 76— 95.0 °C 95.0 °C
—
\E‘ 00:15
pR ] 0,05 *Cfs
G0.0 *C
o100
0ec,
Stept Step2 Step? (Dissaciation)
4 »
Legend
{ Data Collection On ~ = Data Collection Off A AutoDelta On A autoDelta Off

Order materials for the experiment

The recommended materials are:
* MicroAmp® Optical 384-Well Reaction Plate
e MicroAmp® Optical Adhesive Film
e Power SYBR® Master Mix

e Two target-specific primers (one forward, one reverse)

12 Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments



Chapter 2 2

For more information

Your Materials List screen should look like this:

Experiment Materials List

Add Selected Items to Shopping List Display IAII ltems LI
[T check al Item Part Mumber Description

Microfmp@ Optical 384-wel Reaction Plate, constructed from a single rigid [

¥ MicroAmpE Optical 384-wWel Reaction Plate with Barc.., 4309849 piece of polypropylens in a 384-wel format, are enginesred to work with
Applied Biosysterns Real-Time PCR Systemns and Genefmp® PCR. Systems
an optically-clear adhesive film used to seal the samples into the wells of a

~ Microdmp™ Optical Adhesive Filrn {100 films) 4211971 at-well micraplate. This will reduce the possihiity of cross-contamination
between sarmple wells and help ensure consistent Real-Time PCR data,

. . The MicroAmp™ Multi-Rernoval Tool makes it easier to remove caps from

r MicroArmp ™ Multi-Rernoval Tool (1 tool) 4313550 tubes, microplates from thermal cyclers and much mare.

Microfmb@ Ootical 384-Wel Reaction Plate. constructed from a sinale rigid LI

Experiment Shopping List (2 items)

Remove Selected Items from Shopping List

Shopping Basket Mame |V\iA7384WeIISYBRGm.edS

™ Check &l [tem Part Number Quantity
r Microamp™ Optical Adhesive Fim (100 fims) 4311971 |1
r MicroAmp® Optical 384-well Reaction Plate with.., 4209249 |1

For more information

For more information on...

Refer to

Part number

Consumables

Using Alternative Setup

Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System IAVAVACTA

Experiments

Appendix A in Booklet 7, ViiA™ 7 System Experiments - Appendixes

Chapter 2 in Booklet 1, Getting Started with ViiA™ 7 Systems LALLN434

Experiments

Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments
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For more information
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CHAPTER 3

Prepare the Reactions

This chapter explains how to prepare the reactions for running a PCR prior to running

a Melt Curve.
About Melt Curve
Experiments To perform a Melt Curve experiment without running a PCR, use the reaction plate

containing the PCR product.

Note: The example experiment performs a melt curve analysis on PCR products from
a PCR performed on the ViiA™ 7 System or on another thermal cycler.

This chapter covers:

Design the Experiment B Assemble required materials ......... ... ..o i 16

Prepare the sample dilutions ...................... i 16

B Prepare the reaction mix (“cocktail mix”).......... ... ... 16

B Prepare thereactionplate .......... ... 17

l B For more information. .......... ..ottt 18
Chapter 3

Prepare the Reactions

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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3 Chapter 3 Prepare the Reactions
Assemble required materials

Assemble required materials

e Items listed in Booklet 1, Getting Started with ViiA™ 7 System Experiments
e Sample1
¢ Example experiment reaction mix components:

- Power SYBR® Master Mix

— Target - Assay Mix Forward primer (10pM)

— Target - Assay Mix Reverse primer (10uM)

Prepare the sample dilutions

The stock concentration of each sample is 100 ng/uL. After you dilute the sample
according to the Sample Dilutions Calculations table, the sample will have a
concentration of 10 ng/uL. Add 2uL to each reaction.

Stock Samole Diluent Total volume
Sample name concentration volumep[ L) volume (pL) of diluted
(ng/pL) H H sample (L)
Sample 1 100.0 2 18 20

Prepare the reaction mix (“cocktail mix”)

The following table lists the universal assay conditions [volume and final
concentration for using the Power SYBR Master Mix (2X)].

Volume for 384

Reaction Component Volume for 1 reactions + 10%
P reaction (pL) excess (pL) = 424
reactions
Power SYBR®Green PCR Master Mix (2X) 10 4240
Forward primer (10pM) 0.1 42.4
Reverse primer (10uM) 0.1 42.4
Water 7.8 3307.2
Total reaction mix volume 18 7632

Procedure
1. Label an appropriately sized tube for the reaction mix: Power SYBR Reaction Mix.
2. Add the required volume of each cocktail mix component to the tube.

3. Mix the cocktail thoroughly by gently pipetting up and down several times, then
cap the tube.
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Chapter 3 3
Prepare the reaction plate

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the cocktail mix on ice until you prepare the reaction plate.

Calculations

Determine the quantity of primer to be added to the reaction mix by performing the
following calculation:

Concentration (initial) C1 x Volume (primer stock) V1 = Concentration (final) C2 x
Volume (final reaction) V2

(10uM) x (V1) = (0.05uM) (20uL)
V1=(0.05x20)/10=0.1

Prepare the reaction plate

1. Add reaction mix and sample to a tube.

a. To an appropriately sized tube, add the volumes of reaction mix and sample

listed below.
Reaction
. Sample
Unknown . . mix

Tube . Reaction mix Sample volume

reaction volume (uL)

(uL) K
1 Target 1 Power SYBR 7632 Sample 1 848
reaction mix

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.
2. Pipette 20 pL of the unknown (sample) reaction to each well in the reaction plate.
3. Seal the reaction plate with optical adhesive film.
4. Centrifuge the reaction plate briefly to remove air bubbles.
5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of

time.

6. Until you are ready to perform the PCR run, place the reaction plate at 4 °C, in the
dark.

7. Run the PCR.

8. After the PCR is completed, use the same reaction plate containing the PCR
product to run the Melt Curve as described in Chapter 4.

Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments 17



3 Chapter 3 Prepare the Reactions
For more information

For more information

For more information on... Refer to... Part number
Assigning the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
components Experiments
Sealing the reaction plate Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434

Experiments
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CHAPTER 4

Run the Experiment

This chapter explains how run the example experiment on the ViiA™ 7 Instrument.

About Melt Curve This chapter covers:
Experiments
B o Starttherun. .. ... ... . e 20
B Monitor the run. .. ... ... e 20

IMPORTANT! Run the experiment at the same ambient temperature at which you
calibrated the instrument. Extreme variations in ambient temperature can affect the
heating and cooling of the instrument and influence experimental results.

Design the Experiment

IMPORTANT! Do not attempt to open the access door during the run. The door is
locked while the ViiA™ 7 Instrument is in operation.

Prepare the Reactions

|

Chapter 4

Run the Experiment

Review Results and Adjust
Experiment Parameters

Export Analysis Results
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4 Chapter 4 Run the Experiment
Start the run

Start the run

Monitor the run

. Open the Melt Curve example file that you created using instructions in

Chapter 2.

IMPORTANT! The example experiment includes the melt curve analysis of a PCR
product from PCR on ViiA™ 7 System or another thermal cycler. To run a Melt
Curve on the example file you created in Chapter 2, ensure that PCR has already
been performed on the reaction plate you load into the instrument. Absence of the
PCR product will lead to no results in the Dissociation Step of the Melt Curve
Stage.

Load the reaction plate, containing the PCR product, into the instrument.

Start the run.

Monitor the example experiment run:

From the ViiA™ 7 Software using the Run screen, while the experiment is in
progress.

From the Instrument Console of the ViiA™ 7 Software (to monitor an experiment
started from another computer or from the ViiA™ 7 Instrument touchscreen).

From the ViiA™ 7 Instrument touchscreen.

From the Instrument Console of the ViiA™ 7 Software

. In the Instrument Console screen, select the instrument icon.

Click Manage Instrument or double-click on the instrument icon.

On the Manage Instrument screen, click Monitor Running Instrument to access
the Run screen.

View the Melt Curve  You can view the progress of the run in real time. During the run, periodically view all
the three plots available from the ViiA™ 7 Software for potential problems.

Click Melt Curve from the Run Experiment Menu, select the Plate Layout tab, then
select the wells to view.

20
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Chapter 4 4

Monitor the run

The figure below shows the Melt Curve as it appears at the end of the example

experiment.
T
(Mot Settings !__. : e >
Plat Targat [all w | color |s2mole -
[7] Save curent ssttngs as the defauk
A LA RpERE [ W v o |5 v Ju v |u s (v v |v |
i et i - {0 T
c o ju jo v o Jo Ju |w (v jo jo o ]
§ E [ O T T T TN T T TN O [ [
é e v ju o o jov Ju ju |jw v |o (o |ju |
2 5 [N CCENN T N NN [ CE N N T T O |
N @ v ju o o o v jw |jw [o |jw (o o )
e me e e e | | N N N N T
s e | 0 0 NI
| £ »
. \r-_h i EYR L] ] Eﬂ;t,- |
View the Click Temperature Plot from the Run Experiment Menu.

Temperature Plot The figure below shows the Temperature Plot screen as it appears during the example

experiment.

Temperature Plot Current Temperatures

 [Wcaover

~ Mlsarple
Temperature Plot Block

110
100
a0

20

J
]
- =

50

a0 ;
30

20

Temperature

10

Temperature Plot

0
00:00:00 000410 0D:08:20 00:12:30 00:16:40 00:20:50 002500 0029010 00:33:20  00:37:30 004140 004550 005000 00:5410  00:58:20 Vigw 1 Hour =
Time

Fived vigw [~

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.
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4 Chapter 4 Run the Experiment
Monitor the run

View the Run Click Run Method from the Run Experiment Menu.
Meth . . .
ethod The figure below shows the Run Method screen as it appears in the example
experiment.
Run Method Edit Run Method
Adjust # of Cycles: I
Melt Curve Stage
7 Add Melt Curve Stage to End
# Step and Hod ID 05 : I I Add Halding Stage to End
& Continuous
= add Infinite Hold to End
I
\6 00:1s
750 _| “a
1B .05 °Cjs
60.0 °C
&0°C_ 01:.00
25 °C |
0|
Stent Sten2 Step3 (Dissociation)
4 »
Legend
Data Collection On = Data Collection Off A AutoDelta On A AutoDelta OfFf

View run data Click View Run Data from the Run Experiment Menu.

The figure below shows the View Run Data screen as it appears in the example
experiment.

Run Data Report
Experiment Name: ViA7_384-Wel_SYBR_Green_Mel:_Example

Start Time: 04-29-2010 23:41:31 PDT
Stop Time: 04-29-2010 23:56:52 PDT
Run Duration: 15 minutes 20 seconds
User ID:  DEFAULT
Instrument Name: 278880026
Firmware Version: 1.0.0
Software Version: MNfA
Instrument Serial Number: 278880026
Sample Volume: 20.0
Cover Temperature: 105.0

Block Type: 384-wWell Block

Errors Encountered:

22 Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments



Chapter 4 4
Monitor the run

From the ViiA™ 7 Instrument touchscreen

You can also view the progress of the run from the touchscreen of the ViiA™ 7
Instrument.

The Run Method screen on the ViiA™ 7 Instrument touchscreen looks like this:

Experiment View

MyInstrument (384-well 20pL)

Experiment: 2010-03-11-232013

Run Started: March 11 2010 - 11:20PM Sample: 95.0 °C
Reaction Volume: 20 pL Heated Cover: 105.0 °C
Heated Cover Set Point: 105.0 °C Time Remaining: 01:28:18

Time View

@ MyInstrument (384-well 20L) : E

Experiment: 2010-03-11-232013

Run Started: March 1172010 - 11:20PM Sample: 50.0 °C
Reaction Volume: 20 pL Stage /[ Step: 1 /1
Heated Cover Set Point: 105.0 °C Cycle: 1

Display Time: Remaiing () Elapsed

‘I\'Iarch 11 2010 - 11:20PM: Heated cover reached target temperature.
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Monitor the run
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CHAPTER 5

Review Results and Adjust
Experiment Parameters

In Section 5.1 of this chapter you review the analyzed data using several of the analysis
screens and publish the data. Section 5.2 of this chapter walks you through the process
of modifying experiment parameters to troubleshoot problems with experiment
results before rerunning an experiment.

About Melt Curve
Experiments

This chapter covers:

Section 5.1 Review Results ....... ...t 27

B Analyze the example experiment. ............ ... ... ... ... 27

View the Melt Curve Plot ....... ... .. . i 27

Design the Experiment B Identify well problems using the Well Table .............................. 29
B Confirm accurate dye signal using the Multicomponent Plot................ 31

B Determine signal accuracy using the Raw DataPlot ....................... 32

B Review the flagsinthe QCSummary ................. ... ... ........ 34

B Formoreinformation. ......... ... ... i 36

Section 5.2 Adjust parameters for re-analysis of your own experiments. . ....... 37

Prepare the Reactions B Adjustanalysissettings.......... ... .. i 37
B Formoreinformation........... ... . . 42

Run the Experiment

|

Chapter 5
Review Results and
Adjust Experiment

Parameters

Export Analysis Results

Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments 25



Chapter 5 Review Results and Adjust Experiment Parameters

26 Applied Biosystems ViiA™ 7 System Getting Started Guide for Melt Curve Experiments



SECTION 5.1

Section 5.1 Review Results

Analyze the example experiment

1. Open the example experiment file that you ran in Chapter 4.

2. Click Analyze. The software analyzes the data using the default analysis settings.

Note: You can also access the experiment to analyze from the Home screen.

View the Melt Curve Plot

View the Melt Curve Plot as the Derivative Reporter (-Rn) versus the Temperature Plot
generated by the target.

The Melt Curve screen displays the melt curve of the targets in the selected wells. Use
the Melt Curve plots to confirm the results of the experiment:

¢ Normalized Reporter (Rn) vs. Temperature — This plot displays the fluorescence
signal from the reporter dye normalized to the fluorescence signal of the passive
reference. You can use this plot to see the change in Rn with change in the
temperature. You cannot use this plot to determine the Tm of the target.

* Derivative Reporter (-Rn) vs. Temperature — This plot displays the derivative
reporter signal in the y-axis. The peaks in the plot indicate significant decrease in
SYBR Green signal, and therefore the Tm of the target.

Purpose

The purpose of viewing the Melt Curve Plot for the example experiment is to review
the melting temperature of the target.

To view and assess the Melt Curve

1. From the Experiment menu pane, select Analysis » Melt Curve Plot.

Note: If no data are displayed, click Analyze.

2. Enter the Plot Settings:

Menu Selection
Plot Derivative Reporter
Target All
Plot Color Target
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Chapter 5 Review Results and Adjust Experiment Parameters
View the Melt Curve Plot

Menu Selection

E Check (default]
(This is a toggle button. When the
legend is displayed, the button
changes to Hide the plot legend.)

The Melt Curve for the example experiment looks like this:

Plot \Deriuative Repart.._ = Target &l

[Tl 5ava curant satiings as the dafault

» | Color [Target w

Melt Curve Plot
-
7
i
i
&
;
Temperare (0]
- o
!. Targat 1
Well Summany: In Fiatar 384

St Up: 384 Anaheed: 384 Flaggad (1 Ownitted by &naves: 0 Onvitbed Manuaty: (1 Samphes Used- 1 Targeds Usad ]

Tips for viewing melt curves in your own experiments

28

When you analyze your own Melt Curve experiment, look for wells with multiple
peaks, indicating non-specific amplifications or primer dimer formation.

If your experiment does not amplify properly or indicates non-specific amplification,

troubleshoot by manually adjusting the Melt Curve settings (see “Adjust analysis
settings” on page 37).
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Identify well problems using the Well Table

Identify well problems using the Well Table

Review the details of the experiment results in the well table and identify any flagged
wells. The well table displays the assay-specific setup and analysis properties for the
experiment in a tabular format.

Example experiment values and flags

For the example experiment, confirm that no wells of the reaction plate triggered
QC flags

View the well table

1. Select the Well Table tab.

2. Click the Flag column header to sort the data so that the wells that triggered flags
appear at the top of the table.

3. Confirm the integrity of the controls:

a. From the Group By menu, select Task to organize the table rows by their
function on the reaction plate.

b. Confirm that each of the controls do not display flags ( ).

The figure below shows the well table of the example Melt Curve experiment.

Expand 2l

# el it Flag |Samp...| Target Name Task Dyes Tl Tm2 Tm3 Comments

1 4l r Sarpl... SYER UMMM SYBR-None 79,8994 j

2 A2 I Sarmpl... SYBR UMNMOWN SYBR-None 79.894

3 A3 r Sarmpl... SYER UMNKMNCWMN SYBR-None 79.804

4 A4 r Sarnpl... SYER UMNKMNOWMN SYBER-None 79,804

5 A3 r Sarnpl... SYER UMNEMNOWM SYBR-None 79,8994

6 Af r Sarnpl... SYBR UMNMOWN SYBR-None B0.06

7 A7 r Sarmpl... SYER UMNKMNCWMN SYBR-None 79.804

=) r Sarnpl... SYER UMNKMNOWMN SYBER-None 79,804

o A% r Sarnpl... SYER UMNEMNOWM SYBR-None 79,8994

1o A1D I Sarnpl... SYBR UMNMOWN SYBR-None B0.06

11 a1l r Sampl... SYER UMNKMNCWMN SYBR-None B80.06

12 alz2 r Sarnpl... SYER UMNEMNOWM SYBER-None &0.06

13 Al3 I Sarmpl... SYBR UMNKMOWN SYER-None 20,06

14 Ald I Sarnpl... SYBR UMNRMOWN SYBR-None 80.06

15 415 r Sampl... SYER UMNKMNOWMN SYBER-None &0.06

16 Al6 r Sarpl... SYER UMMM SYBR-None 20.06

17 A7 I Sarmpl... SYBR UMNMOWN SYBR-None B0.06

18 418 r Sarmpl... SYER UMNKMNCWMN SYBR-None 79.804

19 419 r Sarnpl... SYER UMNKMNOWMN SYBER-None 79,804

20 A20 r Sarnpl... SYER UMNEMNOWM SYBR-None 79,8994

21 A2l I Sarnpl... SYBR UMNMOWN SYBR-None 79.894

22 AZ22 r Sampl... SYER UMNKMNCWMN SYBR-None 79.804

23 A23 r Sarnpl... SYER UMNEMNOWM SYBER-None 79,8094

24 424 I Sarmpl... SYBR UMNKMOWN SYER-None 70,894

AT e L ol P am——] ~umn VIR IR AR PR R e =0 EmA LI
Well Summary: In Plate: 334 Set Up: 284 Anabyzed: 334 Flagged: 0 Crnitted by Analysis: 0 Crritted Manually: 0 Samples Used: 1 Targets Used: 1
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Identify well problems using the Well Table

The table below gives the description of each column in the well table.

Column Description
Well The position of the well on the reaction plate.
Omit A check mark indicates that the well has been

removed from the analysis.

Flag A 1 indicates that the well triggered the number
of flags listed inside the symbol.

Sample Name The name of the sample.

Target Name The name of the target evaluated by the well.

Task The task assigned to the well (Unknown, Negative
Control, or Positive Controll.

Dyes The name of the reporter and quencher dyes of the
associated sample for the target evaluated by the
well.

Tm1 The melting temperature of the target.

Tm?2 The second melting temperature (for targets with

multiple melting temperatures).

Tm3 The third melting temperature (for targets with
multiple melting temperatures).

Tips for viewing well tables your own experiments

30

When you analyze your own experiment:

Review the data for the Unknown samples. For each row that displays /. in the
Flag column, note the data and the flag(s) triggered by the associated well.

Select areas of the table or wells of a specified type by:

— Left-clicking the mouse and dragging across the area you want to select an
area of the table.

— Selecting Sample, Target, or Task from the Select Items menu in the Well
Table tab, then selecting the sample, target, or task name from the second
Select Items menu to select wells of a specific type using the well-selection
tool.

Group the rows of the plate layout by selecting an option from the Group By
menu. You can then collapse or expand the lists either by clicking the +/- icon next
to individual lists, or by clicking & Collapse All or Expand All

Omit a well from the analysis by selecting the Omit check box for that well. To
include the well in the analysis, deselect the Omit check box.

Note: You must reanalyze the experiment each time you omit or include a well.
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Confirm accurate dye signal using the Multicomponent Plot

Confirm accurate dye signal using the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each
dye in a selected well over the duration of the PCR run.

Purpose

In the Melt Curve example experiment, you review the Multicomponent Plot screen
for:

e ROX™ dye (passive reference)
* SYBR® dye (reporter)
* Spikes, dips, and/or sudden changes

View the Multicomponent Plot

1. From the Experiment Menu pane, select Analysis » Multicomponent Plot.
Note: If no data are displayed, click Analyze.
2. Display the unknown wells in the plate layout to display the corresponding data
in the Multicomponent Plot screen:
a. Click the Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.

3. From the Plot Color drop-down menu, select Dye.

4. Click ['~| Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process; a constant ROX dye signal
indicates typical data.

6. Check the SYBR dye signal. In the example experiment, because the PCR run has
already been completed, the SYBR dye signal shows gradual decrease throughout
the run and a sudden dip in the fluorescence at one point; the sudden drop in the
SYBR dye signal indicates the melting temperature of the target.
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Determine signal accuracy using the Raw Data Plot

The Multicomponent Plot screen for the example experiment looks like this:

Multicomponent Plot
Plot Settings

Flot Calor |Dye x I

™ Save current settings as the default

Multicomponent Plot
900,000
800,000
700,000
600,000
500,000

400,000

Fluorescence

300,000

200,000

100,000 =<2

o

0 20 a0 & 20 100 120
Cycle
Legend
Sver I RCX
well Summary: In Plate: 384 Set Up: 384 Analyzed: 384 Flagged: O Omitted by Analysis: 0 Cmitted Manually: 0 Samples Used: 1 Targets Used: 1

Tips for confirming dye accuracy in your own experiment

When you analyze your own Melt Curve experiment, look for:
* Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

¢ Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds. If the Melt Curve is being performed post-PCR, then there
should be a gradual decrease in fluorescence and a sudden dip indicating the
melting temperature of the target.

* Irregularities in the signal — There should not be any spikes, dips, and/or sudden
changes in the fluorescent signal.

Determine signal accuracy using the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for
each optical filter for the selected wells during each cycle of the real-time PCR.

About the example experiment

In the Melt Curve example experiment, you review the Raw Data Plot screen for a
stable increase in signal (no abrupt changes or dips) from the appropriate filter.
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Determine signal accuracy using the Raw Data Plot

View the Raw Data Plot

Section 5.1

1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 384 wells in the Raw Data Plot screen by clicking the upper left corner
of the plate layout in the Plate Layout tab.

3. Click E Show a legend for the plot (default). The legend displays the color
code for each row of the reaction plate (see the legend in the Raw Data Plot shown
below).

4. Click and drag the Show Cycle pointer from cycle 1 to cycle 130. In the example
experiment, the signal from filter 1, which corresponds to the SYBR™ dye filter, is
stable throughout.

Note: The readings shown below are from the example experiment. Actual
results will vary with individual experiment setup.

Note: The cycle number in the Melt Curve represents the number of data
collection points for that experiment.

The Raw Data plot for the example experiment looks like this:

Raw Data Plot <

£ L B EEE
Raw Data Plot
950,000
900,000
850,000
500,000
750,000
700,000
650,000
600,000
550,000
% 500,000
= 450,000
400,000
350,000
300,000
250,000
200,000
150,000
100,000 o
50,000 __7__7__—4——_—¢.__;_—_:___:—:____7___7__7___
. —
durid
Filter
Legend
. e E HF HG 'H =
{ 1 ) v Hy o EP =
Options
Show Cycle 130 2 F ‘ i ' ' 'j
]‘. SID IDID 130

well Summary: In Plate: 384 Set Up: 384

Analyzed: 384 Flagged: 0 Oritted by Analysis: 0 Oritted Marwally: 0
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5 Chapter 5 Review Results and Adjust Experiment Parameters
Review the flags in the QC Summary

The filters used for the example experiment are:

PCR Filter =
Emission Fiter
ml(520=15) m2(558=+11) m3(586+10) ma(623x14) mS(682+14) m&(711=12)
*1(470£15)
z X2(520+10)
[y
5 ¥3(S5011)
=
o x4(580=10)
w
¥5(540+10)
%6(662=10)
Melt Curve Filter =

Emission Fiter

ml(520=15) m2(558=+11) m3(586x10) ma(623=14) m5(682x14) me(711=12)

Excitation Filter

Tips for determining signal accuracy in your own experiments

When you analyze your own Melt Curve experiment, look for the following in each
filter:

¢ Characteristic signal growth
* No abrupt changes or dips

Review the flags in the QC Summary

The QC Summary screen displays a list of the ViiA™ 7 Software flags, including the
flag frequency and location for the open experiment.

View the QC Summary

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.
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QC Summary <

Section 5.1 5
Review the flags in the QC Summary

Note: A 0 displayed in the Frequency column indicates that the flag does not
appear in the experiment. If the frequency is >0, the flag appears somewhere in
the experiment; the well position is listed in the Wells column.

2. Review the Flags Summary.

In the example experiment, there are no flagged wells.

3. In the Flag Details table, click each flag with a frequency >0 to display detailed
information about the flag. In the example experiment, the Frequency column
displays O for the three flags NOSIGNAL, OFFSCALE, and MTP.

4. (Optional) For those flags with frequency >0, click the troubleshooting link to view
information on correcting the flag.

The QC Summary for the example experiment looks like this:

Flag Details
Flag: Description Frequency Wells
MNOSIGMAL Mo signal in well (]
OFFSCALE Fluorescence is offscale 0
MTP Multiple Trm peaks 0

Flag: MOSIGHAL—Mo signal in wel

Flag Detail: The well produced wery low or no fluorescence.
Flagged Wells: MNone
Wigw WOSIGMAL Troubleshooting Informaton

Total Wells: 384 | Processed Wells: 334 Manually Omitted Wells: 0 | Targets Used: 1
wels Set Up: 284 | Flagged wells: 0 Analysis Omitted wells; 0 | Samples Used: 1
Well Summary: In Plate: 384 Set Up: 354 Analyzed: 384 Flagged: 0 Omitted by Analysis: Cmitted Manually: 0 Samples Used: 1 Targets Used: 1

Possible flags

For Melt Curve experiments that do not include amplification, the flags listed below
may be triggered by the experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale

Primary analysis flag
NOSIGNAL No signal in well
Secondary analysis flag
MTP Multiple Tm peaks
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5 Chapter 5 Review Results and Adjust Experiment Parameters
For more information

For Melt Curve experiments that include amplification, the flags listed below may be
triggered by the experiment data.

Flag Description

Pre-processing flag

OFFSCALE Fluorescence is offscale
Primary analysis flags

BADROX Bad passive reference signal
NOAMP " No amplification
NOISE . Noise higher than others in plate
SPIKE " Noise spikes
NOSIGNAL No signal in well
EXPFAIL Exponential algorithm failed
BLFAIL Baseline algorithm failed
THOLDFAIL Thresholding algorithm failed
CTFAIL Cy algorithm failed

Secondary analysis flags
MTP Multiple Tm peaks
OUTLIERRG Outlier in replicate group
AMPNC Amplification in negative control
HIGHSD . High standard deviation in replicate group

Note: When you use the Relative Threshold algorithm, the EXPFAIL, BLFAIL,
THOLDFAIL, and CTFAIL flags are not reported by the algorithm, but they appear in
the QC Summary (by default, a 0 is displayed in the Frequency column for each flag).

For more information

For more information on... Refer to... Part number

Publishing data Chapter 1 in Booklet 1, Getting Started with ViiA™ 7 System 4441434
Experiments
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SECTION 5.2

Section 5.2 Adjust parameters for re-analysis
of your own experiments

Adjust analysis settings

The Analysis Settings dialog box displays the analysis settings for the Melt Curve and
flags.

If the default analysis settings in the ViiA™ 7 Software are not suitable for your own
experiment, you can change the settings in the Analysis Settings dialog box, then
reanalyze your experiment.

View the analysis settings

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis » Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used for each tab:
* Melt Curve Settings
e Crp Settings
¢ Flag Settings
* Advanced Settings

Note: The Cr Settings and Advanced Settings tabs appear in the Analysis
Settings dialog box only if the Melt Curve experiment you are performing
includes the PCR process.

Note: Select the Include PCR check box on the Experiment Properties screen
to include amplification in your Melt Curve experiment.
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Chapter 5 Review Results and Adjust Experiment Parameters
Adjust analysis settings

The Analysis Settings dialog box for a Melt Curve experiment looks like this:

then change th

— Select a Target -~ Multi-Peak Setting for Target 1
Target Multi-Peak Calling Peak Level (%)
i o Enable Multi-Peak Caling
Target 1 Enabled 10.00 —_
Peak level relative to the dominant peak (%) : !10,00
L =N =4

Save to Library Load from Library

Revert to Default Analysis Settings Apply Analysis Settings W

38

3. View

and, if necessary, change the analysis settings (see “Adjust analysis settings”

below).

Note:

You can save the changes to the analysis settings to the Analysis Settings

Library for later use. For more information, see About the Analysis Settings
Library in Booklet 1, Getting Started with ViiA™ 7 System Experiments.

4. Click Apply Analysis Settings to apply the current analysis settings.

Note:

You can go back to the default analysis settings, by clicking Revert to

Default Analysis Settings.
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Adjust analysis settings

Adjust analysis settings

You may change the following settings:

Melt Curve Settings  Use this tab to:

* Enable or disable multi-peak calling.

— Select the Enable the Multi-Peak Calling check box if you expect to amplify
more than 1 PCR product and you want to determine the Tm for more than
one peak.

— Deselect the Enable the Multi-Peak Calling check box if you expect to

amplify 1 PCR product and you do not want to determine the Tm for more
than one peak.

* Enter a value (in percentage) for the peak level relative to the dominant peak.

Specify a fractional level value as the peak detection threshold. The detected
peaks are measured relative to the height of the tallest peak, which has a perfect
fractional level 100%. The default value is initially set at 10%.

For example, if you set a fractional level detection threshold value at 40, then only
peaks above 40% of the tallest peak are reported and the peaks at lower height are
regarded as noise.

Ct Settings * Data Step Selection

Use this feature to select one stage/step combination for Cy analysis when there is
more than one data collection point in the run method.

* Algorithm Settings

You can select the algorithm that determines the Cy values. There are two
algorithms: Baseline Threshold (the default) and Relative Threshold.
The Baseline Threshold algorithm is an expression estimation algorithm that
subtracts a baseline component and sets a fluorescent threshold in the exponential
region for gene quantification.
The Relative Threshold algorithm lets you compare the data on a per-well or per-
target basis. This setting is ideal for analyzing a single gene across samples or a
single sample across genes with no dependence on targets, thereby reducing
variability. Any settings for baseline or threshold do not affect the analysis when
you use the Relative Threshold algorithm.

e Default Cy Settings

Use the default Cr settings feature to calculate Cr for the targets that do not have
custom settings. To edit the default settings, click Edit Default Settings.

® Cp Settings for Target
When you manually set the threshold and baseline, Applied Biosystems

recommends:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:

e Above the background.
e Below the plateau and linear regions of the amplification curve.

e Within the exponential phase of the amplification curve.
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Adjust analysis settings

Flag Settings

40

Setting Recommendation

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescent signal is detected.

Note: This setting is applicable only to the Baseline Threshold algorithm.

Note: Selecting Automatic Threshold implies selection of automatic setting of the
baseline. However, if Automatic Threshold is deselected, then you can choose
between setting the baseline either automatically or manually.

Use the Flag Settings tab to:

* Adjust the sensitivity so that more wells or fewer wells are flagged.
* Change the flags that are applied by the ViiA™ 7 Software.

To adjust the flag settings:

1.

2.

In the Use column, select the check boxes for flags to apply during analysis.

(Optional) If an attribute, condition, and value are listed for a flag, specify the
setting for applying the flag.

Note: If you choose to adjust the setting for applying a flag, make minor
adjustments as you evaluate the appropriate setting.

In the Reject Well column, select the check boxes if you want the software to reject
wells with the flag.

Note: After you have rejected the flagged wells, analysis results depend on
factors such as the experiment type and flag type. For example, rejecting wells
flagged by HIGHSD in experiments using the Standard Deviation calculations
may change the result of C1 SD. For some flags, analysis results calculated before
the well is rejected are maintained.

Click Apply Analysis Settings in the Analysis Settings dialog box. If the run
status is complete, the data are reanalyzed.
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Adjust analysis settings

The Flag Settings tab looks like this:

=n a flagis raised.
Flag Description Use Attribute Condition Value Reject Well
OFFSCALE Fluorescence is offscale v H
MTR Multiple Tm peaks ¥ [}
MOSIGHAL Mo signal in well 2 Im
Save to Library Load from Library Revert to Default Analysis Settings | Apply Analysis Settings W

Advanced Settings Use the Advanced Settings tab to change baseline settings well-by-well.

Note: The baseline and threshold values do not affect the analysis using the Relative
Threshold setting.

To use custom baseline settings for a well-target combination:
1. Select one or more well-target combinations in the table.
2. Deselect the Use Ct Settings Defined for Target check box.

3. Define the custom baseline settings:

¢ For automatic baseline calculations, select the Automatic Baseline check

box.

e To define the baseline, deselect the Automatic Baseline check box, then enter

the baseline start cycle and baseline end cycle.
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For more information

For more information

For more information on... Refer to Part number

Amplification efficiency Amplification Efficiency of TagMan® Gene Expression Assays 127AP05-03
Application Note.
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CHAPTER 6

Export Analysis Results

1. Open the Melt Curve example experiment file that you analyzed in Chapter 5.
About Melt C ; .« B=
g;‘perﬁneng"e 2. In the Experiment Menu, click E Export.

Note: To export data automatically after analysis, select the Auto Export check
box during experiment setup or before running the experiment. Auto export is
unchecked for the example experiment.

3. Select ViiA™7 Format.

4. Complete the Export dialog box as shown below:

Design the Experiment

Field or Selection Entry
Select Data to Results

export/ Select

Content

Export Data To One File

Export File Name ViiA7MCExport

Prepare the Reactions

File Type *.txt

Export File Location | <drive>:\Applied Biosystems\ViiA7 Software v1.1\experiments

Run the Experiment

Review Results and Adjust
Experiment Parameters

|

Chapter 6

Export Analysis Results
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Chapter 6 Export Analysis Results

™ Auto Export

Export Fla Location:lc:u\pplied Binsystemsiviia7 Software v1.Dexperiments Export File Narme: viia TMCExpart File Type:

Your Export screen should look like this:

Format :IVi\A"‘ 7 hd Export Data To: @ One Fle ¢ Separate Files ¥ Open filags) when export is complete
Tt LI

[:] Sample Setup [:] Raw Data [:] Amplification [:] Multicompanent

Select Content

wiell Sample Ma...| Target Ma... Task Reporter | Quencher T Ct Mean Ct 5D I Cluartity | Quant

[¥ All Fields = Sample L SYBR UNKNOWN  SYBR None N
¥ well 2 Sample 1 SYBR UNKMOWN  SYER Fone
3 Sample 1 SYBER UNKMNOWN - SYBR MNone
¥ Sample Name 4 Sample 1 SYER UNEMOWN  SYER MNone
5 Sample 1 SYER UNKMNOWN  SYBR Mone
¥ Target Mame i Sample 1 SYER URNENOWN - SYER Mone
7 Sample 1 SYER UNEROWMN - SYBER MNone
[¥! Task =] Sarmple 1 SYER UMEROWN - SYER MNone
¥ Reorter 9 Sample 1 SYER UMNEROWN - SYER MNone
10 Sample 1 SYBR UMNKMNOWN - SYBR Mone
¥ Quencher 11 Sample 1 SYER UNKNOWN  SYER Mone
12 Sample 1 SYBR UMNEMOWIN - SYBR Mone
¥ cT 13 Sample 1 SYBR UNKMNOWN  SYBR Mone
14 Sample 1 SYBR UNKMOWN - SYER Mone
¥ Ct Maan 15 Sample 1 SYBR UNKNOWN — SYBR None
¥ ctsD 16 Sample 1 SYBR UNKMOWN - SYBR Mone
17 Sample 1 SYER UNEROWN - SYER MNone
¥ Quantity 18 Sample 1 SYBR UMKNOWM - SYBR MNone
19 Sample 1 SYER UNEROWMN - SYBER MNone
W Quantity Mean 20 Sarmple 1 SYER UNKNOWMN - SYER MNone
= |21 Sample 1 SYBR UMNKMNOWN - SYBR Mone
¥ Quantity 5D 2 Sample 1 SYER UMEMOWE  SYER. Mo
. 23 Sample 1 SYBR UMNEMNOWN - SYBR MNone
! Automatic Ct Threshold [7a Samnle 1 SYRR IIRKMIMATL SRR Rl

Your exported file when opened in Notepad should look like this:

lolx]
File Edit Format View Help
* Block Type = 384-Well Block -
* Calibration Expired = No
* Chemistry = SYBR_GREEM
* Bxperiment File Mame = CihApplied Biosystems\Final ViiA7 BExample
Data-Mar10,20104RUCYVITAT _384-Well _SYBR_Creen_Melt_Example.eds
* Bxperiment Mame = ViiA7 _384-Wall _SYBR_GCreen_Melt_Example
* Bxperiment Run End Time = Mot Started
* Bxpeariment Type = Melt Curve
* Instrument Type = ViiA 7
* Passive Refarence = ROX
* Signal Smoothing On = false
[Results]
|| Sample Mame Target Mame Task Reporter Quencher CT Ct Mean Ct 3D Quantity Quantity Mean
Quantity 5D Automatic Ct Threshold Ct Threshold Automatic Baseline Baseline Start Easeline End Tml
Tm2 Tm3 Comments Customl Custom2 Custom3 Customd CustomS Customb
1 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
2 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
3 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
4 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
5 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
& Sample 1 SYER UMNKMOWTN SYER Maone
30,0538
7 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
3 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
9 Sample 1 SYER UMNKMOWTN SYER Maone
79.834
10 Sample 1 SYER UMNKMOWTN SYER Maone
30,0538
11 Sample 1 SYER UMNKMOWTN SYER Maone =
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adjusting analysis settings adjusting 37
adjusting parameters, re-analyzing own
experiments 37
Advanced Settings tab 41
Algorithm Settings
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Analyze 27
Melt Curve Plot 27
Multicomponent Plot 31
QC Summary 34
Raw Data Plot 32
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BLFAIL flag 36
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cocktail mix 16

Cr settings
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target 39

Cr Settings tab 39, 36

D

designing experiment
assigning targets and samples 10
defining experiment properties 8

Index

Index

defining targets and samples 9
ordering materials 12
setting up run method 10
dissociation curve 6
dye accuracy
irregularities in the signal 32
passive reference 32
reporter dye 32

E

Enable the Multi-Peak Calling 39
example experiment 6
experiment properties, defining 8
EXPFAIL flag 36

Export 43

export analysis results 43
extraneous peaks 6

F

Flag Settings tab 40

flags, QC
AMPNC 36
BADROX 36
BLFAIL 36
CTFAIL 36
EXPFAIL 36
HIGHSD 36
MTP 35, 36
NOAMP 36
NOISE 36
NOSIGNAL 35, 36
OFFSCALE 35, 36
OUTLIERRG 36
SPIKE 36
THOLDFAIL 36

fluorescence peaks 6

H
HIGHSD flag 36

include amplification, Pre-processing flag
OFFSCALE 36
include amplification, Primary analysis flags
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BADROX 36
BLFAIL 36
CTFAIL 36
EXPFAIL 36
NOAMP 36
NOISE 36
NOSIGNAL 36
SPIKE 36
THOLDFAIL 36

include amplification, Secondary analysis flags

AMPNC 36
HIGHSD 36
MPT 36
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M

melt curve experiments
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melt curve reactions 6
overview 6
Melt Curve Plot 21, 27
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reactions type, negative controls 6
reactions type, unknowns 6
tips for analyzing own experiment 28
viewing 20, 27
Melt Curve Settings tab 39
melt curve stage 6
Melting temperature (Tm) 6
MTP flag 35, 36
multicomponent plot
confirming dye accuracy 31
tips for analyzing own experiment 32
viewing 31

N

no PCR, Pre-processing flag
OFFSCALE 35

no PCR, Primary analysis flags
NOSIGNAL 35

no PCR, Secondary analysis flags
MPT 35

NOAMP flag 36

NOISE flag 36

NOSIGNAL flag 35, 36
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Experiment View 23

Time View 23
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multiple peaks 28
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W
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tips for viewing own experiments 30

viewing 29
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Dyes 30

Flag 30
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Target Name 30
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Tm3 30

Well 30
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Ordering Information
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B General-use materials and consumables. . .......... ... ... .. . ... 10
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A Appendix A
Consumables

Consumables

The consumables listed below are required for calibrating the ViiA™ 7 Instrument and
for performing experiments with the ViiA™ 7 System.

Note: For reagent or consumable shelf-life expiration date, see the package label.

Calibration and verification consumables

The following table shows the reagents and consumables required to calibrate the
ViiA™ 7 Instrument.

384-well sample

block
Shelf-life at Storage
Part - .
Consumable environmental | conditions
number °
temperature (°C)
384-Well Spectral Calibration Plate with FAM™ Dye 4432271 Use the -15to -25
384-Well Spectral Calibration Plate with VIC® Dye 4432278 | consumable by
the expiration
384-Well Spectral Calibration Plate with ROX™ Dye 4432284 | date mentioned
L . ® on the package
384-Well Spectral Calibration Plate with SYBR® Green Dye 4432290
384-Well Spectral Calibration Plate with TAMRA™ Dye 4432296
384-Well Spectral Calibration Plate with NED™ Dye 4432302
384-Well Region of Interest (ROI) and Background Plates 4432320
384-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes 4432308
TagMan® RNase P Fast 384-Well Instrument Verification Plate 4455280

6 ViiA™ 7 System Experiments - Appendixes



96-well (0.2pL)
sample block

Appendix A
Consumables

Part Shelf-life at Storage
Consumable number environmental | conditions
temperature (°C)
96-Well Spectral Calibration Plate with FAM™ Dye 4432327 Use the -15 to -25
96-Well Spectral Calibration Plate with VIC® Dye 443233, | consumable by
the expiration
96-Well Spectral Calibration Plate with ROX™ Dye 4432340 date mentioned
96-Well Spectral Calibration Plate with SYBR® Green Dye 432346 | ON the package
96-Well Spectral Calibration Plate with TAMRA™ Dye 4432352
96-Well Spectral Calibration Plate with NED™ Dye 4432358
TagMan® RNase P 96-Well Instrument Verification Plate 4432382
96-Well Region of Interest (ROI) and Background Plates 4432364
96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes 4432370
TagMan® RNase P 96-Well Instrument Verification Plate 4432382
Fast 96-well (0.1pL)
sample block
Part Shelf-life at Storage
Consumable number environmental | conditions
temperature (°C)
Fast 96-Well Spectral Calibration Plate with FAM™ Dye 4432389 Use the -15to -25
Fast 96-Well Spectral Calibration Plate with VIC® Dye 4432396 | Cconsumable by
the expiration
Fast 96-Well Spectral Calibration Plate with ROX™ Dye 4432402 | date mentioned
Fast 96-Well Spectral Calibration Plate with SYBR® Green Dye 432408 | On the package
Fast 96-Well Spectral Calibration Plate with TAMRA™ Dye 4432414
Fast 96-Well Spectral Calibration Plate with NED™ Dye 4432420
Fast 96-Well Region of Interest (ROI) and Background Plates 4432426
Fast 96-Well Normalization Plates with FAM™/ROX™ and VIC®/ROX™ Dyes = 4432432
TagMan® RNase P Fast 96-Well Instrument Verification Plate 4351979
Array card sample
block
Part Shelf-life at Storage
Consumable number environmental | conditions
temperature (°C)
ViiA™ 7 Array Card Spectral Dye Calibration Kit 4432314 Use the -15to -25
ViiA™ 7 Array Card RNase P Instrument Verification Kit 4432265 | Consumable by
the expiration
date mentioned
on the package
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Experiment consumables

The following table shows the reagents and consumables required to perform

experiments with the ViiA™ 7 System.

Shelf-life at

Consumable Part number environmental St0|_'a_ge
temperature conditions
Array Card Buckets/Clip Set 1st Generation 4337762 Use the Room
2nd Generation 44462571 fﬁgi‘ir;?:tlg by | temperature
TagMan® Array Micro Fluidic Card Sealer 4331770 date mentioned
MicroAmp® Optical 384-Well Reaction Plate | 1000 plates 4343814 on the package
with Barcode 500 plates 4326270
50 plates 4309849
MicroAmp® Optical 384-Well Reaction Plate, 1000 plates 4343370
MicroAmp® Optical 96-Well Reaction Plate 500 plates 4316813
(0.2t 10 plates N8010560
MicroAmp® Optical 96-Well Reaction Plate 500 plates 4326659
with Barcode (0.2uL 20 plates 4306737
MicroAmp® Fast Optical 96-Well Reaction 10 plates 4346907
Plate (0.1uL)
MicroAmp® Fast Optical 96-Well Reaction 200 plates 4366932
Plate with Barcode (0.1pL) 20 plates 4346906
Centrifuge Buckets, Array Card 15t Generation 4337230
2nd Generation 4442573
Clip, Array Card Centrifuge Adaptor 4334682
MicroAmp® Optical Adhesive Film 100 films 4311971
25 films 4360954
MicroAmp® Multi-Removal Tool (1 tool) 4313950
RT-PCR Grade Water AM9935
MicroAmp® Optical 8-Cap Strip 300 strips 4323032
MicroAmp® Optical 8-Tube Strip (0.2uL) 125 strips 4316567
MicroAmp® Fast 8-Tube Strip (0.1uL) 125 strips 4358293
MicroAmp® Optical Tube without cap (0.2uL) | 2000 tubes N8010933
MicroAmp® Fast Reaction Tube with cap 1000 tubes 4358297
(0.1uL)
MicroAmp® 96-Well Tray/Retainer Set (Blue] | 10 pairs 4381850
(for 0.2uL)
MicroAmp® 96-Well Tray (Black) (for 0.1pL) 10 plates 4379983
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Shelf-life at Storage
Consumable Part number environmental rag
conditions
temperature
ViiA™ 7 System 96-Well Plate Adapter (0.2uL) | 1 piece 4459845 Use the Room
VIiA™ 7 System Fast 96-Well Plate Adapter | 1 piece 4459846 Cﬁ”s“m.abl.e by | temperature
(0.1uL) the explra_tlon
' date mentioned
ViiA™ 7 System 96-Well Tube Adapter (0.2uL) | 1 piece 4462077 on the package
ViiA™ 7 System 96-Well Tube Adapter (0.1uL) | 1 piece 4462078
ViiA™ 7 System 384-Well Plate Adapter 1 piece 4457087
ViiA™ 7 System Array Card Adapter 1 piece 4454166
MicroAmp® Cap Installing Tool (Handle) (1 tool) 4330015
MicroAmp® Adhesive Film Applicator (5 applicators) 4333183

Reagents
The following table lists the reagents that can be ordered for performing experiments
with the ViiA™ 7 System.
Recommended reagent kits
To perform Reagent Part Number
Reverse Transcription SuperScript® VILO™ cDNA Synthesis Kit 4453650
TagMan® PCR TagMan® Fast Advanced Master Mix 4444557
TagMan® GTXpress™ Master Mix 4401892
TagMan® Fast Virus 1-Step Master Mix LALLAZ2
TagMan® Gene Expression Master Mix 4369016
TagMan® Genotyping Master Mix 4371355
TaqMan® Universal Master Mix I, with UNG 4440038
TagMan® RNA-to-CT™ 1-Step Kit 4392938
SYBR® Green PCR Fast SYBR® Green Master Mix 4385612
Power SYBR® Green PCR Master Mix 4367659
Power SYBR® Green RNA-to-CT™ 1-Step Kit 4389986
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General-use materials and consumables

The following general-use materials and consumables are required to calibrate,
maintain, and perform experiments with the ViiA™ 7 System. Unless indicated
otherwise, all materials shown below are available from major laboratory suppliers
(MLS). The materials are applicable to all sample blocks.

Material/Consumable Source
Bleach, 10% solution MLS
Lint-free lab tissues MLS
Cotton or nylon swabs and lint-free cloths MLS
Centrifuge with buckets appropriate for your consumable type MLS
Ethanol, 95% solution MLS
Glasses, safety MLS
Gloves, powder-free MLS
Permanent marker or pen MLS
Pipettors: 100-pL and 200-pL (with pipette tips) MLS
Screwdriver, flathead MLS
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Instrumentation safety

Symbols on instruments

Electrical
symbols on
instruments

Safety symbols

12

The following table describes the electrical symbols that may be displayed on Applied
Biosystems instruments.

Symbol

Description

Symbol

Description

]
O

Indicates the On position of the
main power switch.

Indicates the Off position of the
main power switch.

Indicates a terminal that may
be connected to the signal
ground reference of another
instrument. This is not a
protected ground terminal.

S

Indicates a protective grounding
terminal that must be
connected to earth ground
before any other electrical
connections are made to the
instrument.

Indicates a terminal that can

o~ : _
receive or supply alternating
current or voltage.

- Indicates that the device

(Y Y]

receives or supplies direct
current or voltage.

The following table describes the safety symbols that may be displayed on Applied
Biosystems devices. Each symbol may appear by itself or with text that explains the
relevant hazard. These safety symbols may also appear next to DANGERS,
WARNINGS, and CAUTIONS that occur in the text of this and other product-support

documents.

Symbol

Description

Description

/N

Indicates that you should
proceed with appropriate
caution and consult the product
insert for further information. If
a product insert does not exist,
or if the product insert does not
contain the symbol or the
required information, consult
the user manual.

Indicates the presence of a
pinching hazard and to proceed
with appropriate caution.

Indicates the presence of
moving parts and to proceed
with appropriate caution.

Indicates the presence of a
biological hazard and to proceed
with appropriate caution.

Indicates the presence of an
electrical shock hazard and to
proceed with appropriate
caution.

Indicates the presence of a
laser light in the instrument and
to proceed with appropriate
caution.

/0N
/N

Indicates the presence of a hot
surface or other high-
temperature hazard and to
proceed with appropriate
caution.

> PR

Indicates the presence of an
ultraviolet light and to proceed
with appropriate caution.

ViiA™ 7 System Experiments - Appendixes



Appendix B
Instrumentation safety

Environmental The following symbol applies to all Applied Biosystems electrical and electronic
symbols on products placed on the European market after August 13, 2005.
instruments

Symbol Description

Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
environmental impact of waste electrical and electronic equipment (WEEE).

Call your local Applied Biosystems Customer Service office for equipment
pick-up and recycling. See www.appliedbiosystems.com for a list of
customer service offices in the European Union.

é
—@ European Union customers:
|
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Locations of safety labels on instruments

The ViiA™ 7 Instrument contains warnings at the locations shown below:

I||II|II

i IIIIHIHI

i Wil

i
I

i
III;

i

i

il o
iy g
I i3
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General instrument safety

WARNING! PHYSICAL INJURY HAZARD. Use this product only as specified
in this document. Using this instrument in a manner not specified by Applied
Biosystems may result in personal injury or damage to the instrument.

Moving and lifting CAUTION! PHYSICAL INJURY HAZARD. The instrument is to be moved and

the instrument positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been
installed, do not attempt to lift or move the instrument without the assistance of
others, the use of appropriate moving equipment, and proper lifting techniques.
Improper lifting can cause painful and permanent back injury. Depending on
the weight, moving or lifting an instrument may require two or more persons.

Moving and lifting WARNING! Do not attempt to lift or move the computer or the monitor without
stand-alone the assistance of others. Depending on the weight of the computer and/or the
computers and monitor, moving them may require two or more people.

monitors

Things to consider before lifting the computer and/or the monitor:
* Make sure that you have a secure, comfortable grip on the computer or the
monitor when lifting.

* Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

* Do not lift an object and twist your torso at the same time.

¢ Keep your spine in a good neutral position while lifting with your legs.

¢ Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the Ensure that anyone who operates the instrument has:

instrument ¢ Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Safety Data Sheets (SDSs). See “About SDSs”

on page 20.
Cleaning or CAUTION! Before using a cleaning or decontamination method other than
decontaminating the those recommended by the manufacturer, verify with the manufacturer that the
instrument proposed method will not damage the equipment.
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Physical hazard safety

Ultraviolet light

Moving parts

Electrical safety

Fuses

Power

Overvoltage rating

16

A WARNING! ULTRAVIOLET LIGHT HAZARD. Looking directly at a UV light
source can cause serious eye damage. Never look directly at a UV light source
and always prevent others from UV exposure. Follow the manufacturer’s

recommendations for appropriate protective eyewear and clothing.

WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and cut.
Keep hands clear of moving parts while operating the instrument. Disconnect
power before servicing the instrument.

WARNING! ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the ViiA™ 7 Instrument without its instrument panels in
place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

WARNING! FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the
instrument, verify that the fuses are properly installed and that the instrument
voltage matches the power supply in your laboratory.

WARNING! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

WARNING! ELECTRICAL HAZARD. Grounding circuit continuity is required
for the safe operation of equipment. Never operate equipment with the
grounding conductor disconnected.

WARNING! ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

WARNING! ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

The ViiA™ 7 Instrument has an installation (overvoltage) category of II, and is
classified as portable equipment.
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Bar code scanner laser safety

Laser The bar code scanners included with the ViiA™ 7 Instrument are categorized as
classification Class 2 (II) lasers.

Laser safety Class 2 (II) lasers are low-power, visible-light lasers that can damage the eyes. Never
requirements look directly into the laser beam. The scanner is designed to prevent human access to

harmful levels of laser light during normal operation, user maintenance, or during
prescribed service operations.

WARNING! LASER HAZARD. Class 2 (II) lasers can cause damage to eyes.
Avoid looking into a Class 2 (II) laser beam or pointing a Class 2 (II) laser beam
into another person’s eyes.

Workstation safety

Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD.
These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static
unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:

* Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and electromagnetic compatibility (EMC) standards

U.S. and Canadian
safety
standards

¢ (UL )us

Canadian EMC
standard

European safety and

C€

standards

Australia and New
Zealand EMC
standards

18

This section provides information on:

¢ U.S. and Canadian safety standards

¢ (Canadian EMC standard

¢ European safety and EMC standards

* Australia and New Zealand EMC standards

The instrument has been tested to and complies with standard:

UL 61010-1:2nd Edition/CSA C22.2 No. 61010-1, “Safety Requirements for Electrical
Equipment for Measurement, Control, and Laboratory Use, Part 1: General
Requirements.”

UL 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating
of Materials.”

This instrument has been tested to and complies with standard:

ICES-001, Issue 3: “Industrial, Scientific, and Medical Radio Frequency Generators.”
Cet appareil numerique de la classe B est conforme a la norme NMB-001 du Canada.

Safety

This instrument meets European requirements for safety (Low Voltage Directive 2006/
95/EC). This instrument has been tested to and complies with standards:

EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement,
Control and Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010:2003, “Particular Requirements for Laboratory Equipment for the
Heating of Materials.”

EN 61010-2-081:2002+A1:2003, “Particular Requirements for Automatic and Semi-
Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

The ViiA™ 7 Real-Time PCR System meets European requirements for emission and
immunity (EMC Directive 2004/108/EC).

EN 61326-1:2006 “Electrical equipment for measurement, control and laboratory use-

Part 1 General EMC requirements.” (Group 1, Class B)

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of
Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chemical safety

General chemical safety

Chemical hazard WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to
warning the Safety Data Sheet (SDS) provided by the manufacturer, and observe all
relevant precautions.

WARNING! CHEMICAL HAZARD. All chemicals in the instrument are
potentially hazardous. Always determine what chemicals have been used in the
instrument before changing reagents or instrument components. Wear
appropriate eyewear, protective clothing, and gloves when working on the
instrument.

A WARNING! CHEMICAL HAZARD. Four-liter reagent and waste bottles can

crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in
the upright position. Wear appropriate eyewear, clothing, and gloves when
handling reagent and waste bottles.

& WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste in

a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines e Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “About SDSs” on page 20.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

¢ Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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SDSs

About SDSs Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of
hazardous chemicals to new customers. They also provide SDSs with the first
shipment of a hazardous chemical to a customer after an SDS has been updated. SDSs
provide the safety information you need to store, handle, transport, and dispose of the
chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to
replace the appropriate SDS in your files.

Obtaining The SDS for any chemical supplied by Applied Biosystems is available to you free
SDSs 24 hours a day. To obtain SDSs:

1. Go to www.appliedbiosystems.com, click Support, then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS part
number, or other information that appears in the SDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

* Open - To view the document
¢ Print Target — To print the document

e Save Target As — To download a PDF version of the document to a
destination that you choose

Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Chemical waste safety

Chemical waste CAUTION! HAZARDOUS WASTE. Refer to Safety Data Sheets and local
hazards regulations for handling and disposal.

WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied
Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste in
a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.
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Chemical waste To minimize the hazards of chemical waste:

safety guidelines * Read and understand the Safety Data Sheets (SDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

¢ Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste
material and meet federal, state, and local requirements for container storage.)

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

¢ Handle chemical wastes in a fume hood.
* After emptying a waste container, seal it with the cap provided.

* Dispose of the contents of the waste tray and waste bottle in accordance with
good laboratory practices and local, state/provincial, or national environmental
and health regulations.

Waste disposal If potentially hazardous waste is generated when you operate the instrument, you
must:

® Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.
¢ Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported, and disposed
of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

General biohazard

22

2\

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:

In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (www.cdc.gov/
biosafety/publications/index.htm)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/ nara/cfr/waisidx_01/
29c¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at
www.cdc.gov.

In the EU:

Check local guidelines and legislation on biohazard and biosafety
precaution and refer to the best practices published in the World Health
Organization (WHO) Laboratory Biosafety Manual, third edition http://
www.who.int/csr/resources/publications/biosafety/
WHO_CDS_CSR_LYO_2004_11/en/
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Safety alerts

For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words” on page 8.

General alerts for all chemicals

Avoid contact with (skin, eyes, and/or clothing). Read the SDS, and follow the
handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

General alerts for instrumentation

CAUTION! Before using a cleaning or decontamination method other than
those recommended by the Applied Biosystems, verify with Applied
Biosystems that the proposed method will not damage the equipment.

C WARNING! This instrument is designed for 12 V, 75 W halogen lamps only.

Specific alerts for instrumentation

CAUTION! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with listed and certified fuses of the same type and rating as
those currently in the instrument.

CAUTION! PHYSICAL INJURY HAZARD. Do not attempt to lift the
instrument or any other heavy objects unless you have received related training.
Incorrect lifting can cause painful and sometimes permanent back injury. Use
proper lifting techniques when lifting or moving the instrument. At least two
people are required to lift the instrument.

A CAUTION! PHYSICAL INJURY HAZARD. Do not remove the instrument

cover. There are no components inside the instrument that you can safely
service yourself. If you suspect a problem, contact an Applied Biosystems
Service Representative.

ii WARNING! PHYSICAL INJURY HAZARD. The ViiA™ 7 Instrument and
lamp are hot! The lamp can become very hot while in use. Allow the lamp to
cool for 15 minutes and put on protective, powder-free gloves before handling
it.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following
procedure, be sure to wait until the sample block reaches room temperature.
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CAUTION! PHYSICAL INJURY HAZARD. Wear disposable, powder-free
gloves when handling the lamp to prevent burns and to prevent shortening the
life of the replacement lamp.
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Documentation and Support

Related documentation

The following related documents are shipped with the system:

Document

PN

Description

Applied Biosystems ViiA™ 7 Real-Time PCR System
Calibration, Maintenance, Networking, and Security User
Guide

4442661

Explains how to use and maintain the Applied
Biosystems ViiA™ 7 Real-Time PCR System

Intended for laboratory staff responsible for the
use and maintenance of the ViiA™ 7 Real-Time
PCR Instrument.

Applied Biosystems ViiA™ 7 Real-Time PCR System
Getting Started Guide

4441434

Contains five individual booklets that explain how
to perform the six different experiments on the
ViiA™ 7 Real-Time PCR Instrument

The experiments include Standard Curve, Relative
Standard Curve and Comparative Cy, Genotyping,
Presence/ Absence and Melt Curve. Each Getting
Started Guide booklet functions as both:

e A tutorial, using example experiment data
provided with the ViiA™ 7 Software.

e A guide for your own experiments.
Intended for laboratory staff and principal

investigators who perform experiments using the
ViiA™ 7 System.

Applied Biosystems ViiA™ 7 Real-Time PCR System
Quick Reference Guide

4448987

Explains how to install and maintain the ViiA™ 7
Real-Time PCR Instrument

Intended for laboratory staff responsible for the
use and maintenance of the ViiA™ 7 Real-Time
PCR Instrument.

Applied Biosystems ViiA™ 7 Real-Time PCR System Site
Preparation Guide

4445302

Explains how to prepare your site to receive and
install the ViiA™ 7 Real-Time PCR Instrument

Intended for personnel who schedule, manage,
and perform the tasks required to prepare your
site for installation of the ViiA™ 7 Real-Time PCR
Instrument.
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Other related documents

Document PN Description

ViiA™ 7 Software Help NA Explains how to use the ViiA™ 7 Software to:

e Set up, run, and analyze experiments.

¢ Monitor a networked ViiA™ 7 Real-Time PCR
Instrument.

e (Calibrate the ViiA™ 7 Real-Time PCR
Instrument.

e Verify the performance of ViiA™ 7 Real-Time
PCR Instrument with an RNase P run.

¢ Intended for:

- Laboratory staff and principal investigators
who perform experiments using the ViiA™ 7
System.

- Laboratory staff responsible for the
installation and maintenance of the ViiA™ 7
Real-Time PCR Instrument.

Note: For additional documentation, see “How to obtain support” on page 27.

Other related documents

Documents related

to Genotyping Document PN
experiments Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212
Card
Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856
Documents related
to Presence/ Document PN
Absence DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal Swabs | 4343586
experiments Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925

26 ViiA™ 7 System Experiments - Appendixes



How to obtain support

Documents related

to Relative Standard Document PN

Curve and_ Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05

Comparative Cy — _ : —

experiments Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents related

to Standard Curve Document PN

experiments Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
® Search through frequently asked questions (FAQs).
¢ Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, SDSs, certificates of analysis, and
other related documents.

¢ Download PDF documents.
¢ Obtain information about customer training.
* Download software updates and patches.

Obtaining information from the Help system

The ViiA™ 7 Software has a Help system that describes how to use each feature of the
user interface. Access the Help system by doing one of the following:

e (Click @ in the toolbar of the ViiA™ 7 Software window.
* Select Help » ViiA™ 7 Software Help.
e Press F1.
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You can use the Help system to find topics of interest by:

¢ Reviewing the table of contents
* Searching for a specific topic

* Searching an alphabetized index

You can also access PDF versions of all documents in theViiA™ 7 Software document
set from the Help system.
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AlF

AIX

allele

allelicdiscrimination

plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

amplification stage

Analysis Settings
Library

Glossary

See assay information file (AIF).

XML version of the assay information file.

See also assay information file (AIF).

In a diploid organism, one of two DNA sequences found at the same locus (for
example, a particular gene), but located on homologous chromosomes. Two
corresponding alleles may have the identical sequence, or they may differ somewhat,
often at one or more single-base sites (SNPs).

Display of genotyping data collected during the post-PCR read. The allelic
discrimination plot is a graph of the normalized reporter signal from the allele 1 probe,
plotted against the normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR amplifies the target. Fluorescence data
collected during amplification are displayed in an amplification plot, and the data are
used to calculate results.

Note: Only quantitative real-time PCR experiments, not end-point experiments, take
amplification data into account.

Calculation of the efficiency of the PCR amplification in an experiment. EFF% is
calculated using the slope of the regression line in the standard curve. A slope close to
-3.32 indicates optimal, 100% PCR amplification efficiency.

Display of data collected during the cycling stage of PCR amplification. The
amplification plot can be viewed as:

* Baseline-corrected normalized reporter (ARn) vs. cycle

* Normalized reporter (Rn) vs. cycle

® Threshold cycle (Ct) vs. well

Part of the instrument run in which PCR amplifies the target. The amplification stage,
called a cycling stage in the thermal profile, consists of denaturing, primer annealing,

and extension steps that are repeated. Fluorescence data collected during the extension
stage are displayed in an amplification plot, and the data are used to calculate results.
With TagMan chemistry, the last two steps of a PCR stage are typically combined.

See also cycling stage.

In the software, a collection of analysis settings to use in experiments. You can save
settings and reuse them. You cannot edit or import settings into the library.
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In a PCR reaction mix, two target-specific primers or two primers and a probe used to
amplify a target.

Identifier assigned by Applied Biosystems to TagMan® assays.

Tab-delimited data file on a CD shipped with each assay order. The AIF contains
technical details about all assays in the shipment. It includes information about assay
concentrations; reporters and quenchers used; part and lot numbers; and assay, vial,
and plate ID numbers. The file name includes the number from the bar code on the
plate.

PCR reaction component in Applied Biosystems TagqMan® assays. The assay mix
contains primers designed to amplify a target and a TagMan® probe designed to detect
amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a
step with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a
cycling stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: A
e AutoDelta off: &

An analysis setting in which the software calculates the baseline start and end cycles
for the amplification plot.

See also baseline.

An analysis setting in which the software calculates the baseline start and end cycles
and the threshold in the amplification plot. The software uses the baseline and
threshold to calculate the threshold cycle (Cy).

See also threshold cycle (Cr).

Type of calibration in which the instrument performs reads of a background plate,
averages the spectra recorded during the run, and extracts the resulting spectral
component to a calibration file. The software then uses the calibration file during
subsequent runs to remove the background fluorescence from the run data.

In the amplification plot, a cycle-to-cycle range that defines background fluorescence.
This range can be set manually on an assay-by-assay basis, or automatically to set each
individual well.

The magnitude of normalized fluorescence signal generated by the reporter. In
experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs Cycle amplification plot, ARn is calculated at each cycle as:

ARn (cycle) = Rn (cycle) —Rn (baseline), where Rn = normalized reporter

In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments) and
the presence/absence plot (presence/absence experiments), ARn is calculated as:
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Cgr algorithm
Cr

Cy algorithm

cycle threshold

cycling stage

ARn =Rn (post-PCR read) —Rn (pre-PCR read), where Rn = normalized reporter

See also normalized reporter (Rn).

Expression estimation algorithm (Ct) which subtracts a baseline component and sets a
fluorescent threshold in the exponential region for gene quantification.

Reactions that contain identical components and volumes, but evaluate separate
samples of the same biological source (for example, samples from three different mice
of the same strain, or separate extractions of the same cell line or tissue sample).

When an experiments uses biological replicate groups in a gene expression study, the
values displayed in the Biological Replicates tab are calculated by combining the
results of the separate biological samples and treating this collection as a single
population (that is, as one sample). For ACt computations (normalizing by the
endogenous control) in a singleplex experiment, the software treats separate biological
samples as unpaired data when computing variability estimates of the single biological
replicate. Individual contributions of the separate biological samples to the single
biological replicate results are observed in the Technical Replicates tab.

See also technical replicates.

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In ViiA™ 7 Software, also the

name of the task for the IPC target in wells that contain IPC blocking agent. See also
negative control-blocked IPC wells.

See reference sample.
See reagents.

Method for determining relative target quantity in samples. The software measures
amplification of the target and of the endogenous control in samples and in a reference
sample. Measurements are normalized using the endogenous control. The software
determines the relative quantity of target in each sample by comparing normalized
target quantity in each sample to normalized target quantity in the reference sample.

See relative threshold cycle (Ciy).
See Relative Threshold algorithm.
See threshold cycle (Cy).

Algorithm used to determine the threshold cycle.

The software provides two Cr algorithms: Baseline Threshold and Relative Threshold.

See threshold cycle (Cy).

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage.

ViiA™ 7 System Experiments - Appendixes 31



Glossary

Cq

data collection

delta Rn (ARn)
diluent
dilution factor

dye calibration

Dye Library

EFF%

efficiency correction

endogenous control

endpoint read

error

32

See also amplification stage.
See quantification cycle (Cy).

During the instrument run, a process in which an instrument detects fluorescence data
from each well of the reaction plate. The instrument transforms the signal to electronic
data and saves the data in the experiment file. In the ViiA™ 7 Software, a data
collection point is indicated by an icon in the thermal profile:

¢ Data collection on:
* Data collection off:

See baseline-corrected normalized reporter (ARn).
A reagent used to dilute a sample or standard before it is added to the PCR reaction.
See serial factor.

Type of calibration in which the software collects spectral data from a series of dye
standards and stores the spectral information for the dye standards in a pure spectra
calibration file. This file is used during experiment runs to characterize and distinguish
the individual contribution of each dye in the total fluorescence collected by the
instrument.

In the software, a collection of dyes to use in experiments. Custom dyes can be added
to the library, but system dyes cannot be removed. Before using a dye, make sure that
the dye calibration is current in the Instrument Console.

See amplification efficiency (EFF%).

In Comparative C experiments, a feature that allows you to manually enter
previously-determined amplification efficiencies for each experiment, following the
experimental run. The real-time software mathematically compensates for differences
in efficiency between each target assay and the endogenous control when calculating
sample-to-sample relative quantities. This method can be employed as a substitute for
the Relative Standard Curve Method.

A gene that is used to normalize template differences and sample-to-sample or run-to-
run variation.

See post-PCR read.

The standard error of the slope of the regression line in the standard curve.

The error can be used to calculate a confidence interval (CI) for the slope. Because the
amplification efficiency (EFF%) is calculated from the slope, knowing the error allows
a CI for the amplification efficiency to be calculated.
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experiment
document

experiment name

Experiment Setup

experiment type

export

filter

flag

forward primer

Refers to the entire process of performing a run, including setup, run, and analysis.
You can perform the following types of experiments:

¢ Quantification - Standard curve

¢ Quantification - Relative standard curve

* Quantification - Comparative Ct (AACr)

e Melt Curve

* Genotyping

e Presence/absence

The Applied Biosystems name for the electronic records that comprise all information
about a particular plate or array card consumable, including metadata (name, bar
code, comments), plate setup (well contents, assay definitions), run method (thermal
cycling protocol), run results, analysis protocol, analysis results, audit records, and
other plate-specific data. Experiment documents have the suffixes .eds (experiment
document single), .edt (template), and .edm (multiple).

Entered during experiment setup, the name that is used to identify the experiment.

A software feature that allows you to set up an experiment according to your
experiment design. Experiment Setup provides you with maximum flexibility in the
design and setup of your experiment.

The type of experiment to perform:

e Standard curve

¢ Comparative Cp (AACy)
e Relative standard curve
¢ Genotyping

¢ Presence/absence

e Melt curve

The experiment type that you select affects setup, run, and analysis.

A software feature that allows you to export experiment setup files, experiment
results, instrument information, and security and auditing settings to spreadsheet,
presentation, or text files. You can edit the default location of the exported file.

Dye excitation and emission filter combination that you select for an experiment. The
ViiA™ 7 System includes a six-color filter set that supports FAM™, ROX™, TAMRA™,
and VIC® dyes.

A quality control (QC) indicator which, when applied by the software to a well during
analysis, indicates a possible issue with that reaction. For example, a flag may be
issued if no amplification is detected in a well. Flags indicating potential problems are
displayed in the Quality Control tab of the plate layout, well table, and QC Summary
screens.

Oligonucleotide that flanks the 5° end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.
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An experiment used to identify known mutations in a DNA sample. With this
experiment type, you can determine if a DNA sample is:

* Homozygous (samples having only allele 1). Also called wild type homozygote.
* Homozygous (samples having only allele 2). Also called variant homozygote.
* Heterozygous (samples having both allele 1 and allele 2).

Samples having both allele 1 and allele 2.

See also genotyping experiment.

In the thermal profile, the stage that holds the temperature constant for a defined
period of time. A stage that includes one or more steps. You can add a holding stage to
the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a
reaction.

Samples having only allele 1 or only allele 2. See also genotyping experiment.

A gene that is involved in basic cellular functions and that may be constitutively
expressed. Housekeeping genes may be candidates for use as endogenous controls;
however, their constancy should always be validated experimentally.

See also endogenous control.

A software feature that allows you to import plate setup information or security
settings before an experiment run. You can also import information into some libraries
in the system.

A software feature that allows you to view information about instruments on the
network. In the Instrument Console, you can monitor the status of any instrument on
the network; view calibration, maintenance, and instrument properties for a selected
instrument; and open and close the instrument drawer.

A software feature that allows you to view information about instrument available on
the network. In the Instrument Manager, you can monitor the status of an instrument;
monitor amplification plots and temperature plots in real time; view the calibration
status, perform calibrations and manage files on the instrument, including
downloading completed experiments to your computer.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. The IPC can be used to distinguish between true negative results (the target
is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagqMan® SNP Genotyping Assays that have
been previously manufactured, passed quality control specifications, and stored in
inventory.

See internal positive control (IPC).
Reagent added to PCR reactions to block amplification of the internal positive control

(IPC).
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See negative control-IPC wells.

TagMan® Gene Expression Assays that are manufactured at the time of order. Only
assays that pass manufacturing quality control specifications are shipped.

An analysis setting for the Baseline Threshold algorithm. You enter the baseline start
and end cycles for the amplification plot.

See also baseline.

An analysis setting for the Baseline Threshold algorithm. You enter the threshold value
and select whether to use automatic baseline or manual baseline values. The software
uses the baseline and the threshold values to calculate the threshold cycle (Cr).

A plot of data collected during the melt curve stage. Peaks in the melt curve can
indicate the melting temperature (T},,) of the target, or they can identify nonspecific
PCR amplification. In the software, you can view the melt curve as normalized
reporter (R,,) vs. temperature or as derivative reporter (-R,,” ) vs. temperature. In a
high resolution melting experiment, you can view the melt curve as fluorescence vs.
temperature. Also called dissociation curve.

The melt curve shape and the difference in melting temperature (T ;) values.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

The temperature at which 50% of the DNA is double-stranded and 50% of the DNA is
dissociated into single-stranded DNA. In a melt curve experiment, the melt curve plot
displays the melting temperature.

A plot of the complete spectral contribution of each dye for the selected well(s) over
the duration of the PCR run.

The task for targets or SNP assays in wells that contain water or buffer instead of
sample. No amplification of the target should occur in negative control wells.
Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of
sample in the PCR reaction. No amplification should occur in negative control-blocked
IPC wells because the reaction contains no sample and amplification of the IPC is
blocked. Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).
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Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting
fluorescence signal. Because the NFQ does not fluoresce, it produces lower
background signals, resulting in improved precision in quantification. The minor
groove binder (MGB) increases the melting temperature (T,,,) of the probe without
increasing its length, allowing for the design of shorter probes.

Type of calibration in which the software collects data from the normalization
standards, then stores it in a normalization calibration file. This file is used in
comparisons of data from multiple instruments within a study.

Either the Cy Avg. of the target gene minus the Cy Avg. of the endogenous control
(Comparative Ct experiments), or the Q Avg. of the target divided by the Q Avg. of the
endogenous control (Relative Standard Curve experiments).

The relative standard curve equivalent of the ACt mean value found in Comparative
Cr experiments (computed as the geometric mean).

The relative standard curve equivalent of the ACt SE value found in Comparative Ct
experiments (computed as the geometric standard error of the mean).

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference dye (usually ROX dye on Applied Biosystems instruments).

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.
You can add wells back in to the analysis; no information is permanently discarded.

A measurement (such as a Cr) that deviates significantly from the measurement of the
other replicates for that same sample.

A dye that produces fluorescence signal independent of PCR amplification, and that is
added to each reaction at a constant concentration. Because the passive reference
signal should be consistent across all wells, it is used to normalize the reporter dye
signal to account for non-PCR related fluorescence fluctuations caused by minor well-
to-well differences in volume. Normalization to the passive reference signal generally
results in data with noticeably high precision among technical replicates.

An illustration of the grid of wells and assigned content in the reaction plate. The
number of rows and columns in the grid depends on the sample block that you use.

In the software, you can use the plate layout as a selection tool to assign well contents,
to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

A file (.txt, .csv, .xml, or .sds) that contains setup information such as the well number,
sample name, sample color, target name, dyes, and other reaction plate contents.
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QuickStart

One standard in a standard curve. The standard quantity for each point in a standard
curve is calculated based on the starting quantity and serial factor.

In genotyping and presence/absence experiments, a DNA sample with a known
genotype, homozygous or heterozygous.

In the software, the task for the SNP assay in wells that contain a sample with a known
genotype.

In genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected
during the post-PCR read are displayed in the allelic discrimination plot and used to
make allele calls. In presence/absence experiments, fluorescence data collected during
the post-PCR read are displayed in the presence/absence plot and used to make
detection calls. Also called endpoint read.

In genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer
designed to amplify the target.

PCR reaction component that contains the primers designed to amplify the target and
a TagMan® probe designed to detect amplification of the target.

Fluorescent compound used to calibrate the instrument.

See system dye.

The fractional PCR cycle used for quantification, according to the Real-time PCR Data
Markup Language (RDML) data standard. Cy and Cgr are the algorithm-specific
calculations of Cg.

In quantification experiments, the method used to determine the quantity of target in
the samples.

In quantification experiments, the amount of target in the samples. Absolute quantity
can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the
fold-difference between normalized quantity of target in the sample and normalized
quantity of target in the reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the
quencher.

A feature that allows you to run an experiment without entering plate setup
information, if your instrument and computer are in the same network. QuickStart
requires an experiment template file.
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Regression coefficient calculated from the regression line in the standard curve. An
important quality value, the R? value indicates the closeness of fit between the
standard curve regression line and the individual Ct data points from the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points.

The step at which the temperature changes during the instrument run. The ramp rate
is defined as °C per second. In the graphical view of the thermal profile, the ramp rate
is indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available
ramp speeds include fast and standard.

A plot of raw fluorescent signal as detected through each emission filter, used to view
raw data for individual wells and at individual cycles.

A solution that contains all components to run the PCR reaction, except for the
template (sample, standard, or control). Also called a “PCR cocktail”.

The PCR reaction components used to amplify the target and to detect amplification.

Process of collecting fluorescence data during PCR. Data from the real-time PCR are
used to calculate results for quantification experiments or to troubleshoot results for
genotyping or presence/absence experiments.

A reporting format that is compliant with the Minimum Information for Publication
for Quantitative Real Time Experiments (MIQE) guidelines.

In relative standard curve and Comparative Ct (AACt) experiments, the sample used
as the basis for relative quantification results. Also called the calibrator.

The reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also
called an rs number.

Type of calibration in which the software maps the positions of the wells on the sample
block of the instrument. The software uses the ROI calibration data to associate
increases in fluorescence during a run with specific wells of the plate. A calibration
image for each individual filter must be generated to account for minor differences in
the optical path.

Values calculated from the regression line in standard curves, including the R2 value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:
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Cr=m[log (Qty)] +b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells
from further analysis if a specific flag is applied to the well.

An experimental method to determine relative quantities. This method compensates
for target and endogenous control efficiency differences within each run. In all
experiments, unknown samples and dilution series of template (such as cDNA) are
amplified. Following a run, the instrument software interpolates relative quantities for
each unknown sample from the appropriate dilution curve, then normalizes the data
for each sample (or set of replicates) as follows: target QAvg. + endogenous control
QAvg.

Expression estimation algorithm (Cgt) which calculates a relative threshold from a
fitted efficiency model for gene quantification.

The PCR cycle number for the threshold calculated from the modeled amplification
efficiency profile.

A user-defined biological grouping. A replicate group may be a set of identical
reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

A fluorescent dye used to detect amplification. With TagqMan® reagents, the reporter
dye is attached to the 5 end. With SYBR® Green reagents, the reporter dye is SYBR®
Green dye. SYBR® and HRM-specific dyes are DNA-binding dyes.

An oligonucleotide that flanks the 3 end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the instrument. ROX dye
is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the instrument run. The
run method specifies the temperature, time, ramp, and data collection points for all
steps and stages of the instrument run.

The biological tissue or specimen that you are testing for a target gene.
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A tab-delimited file (*.txt or *.csv) that contains the following setup information: well
number, sample name, and custom sample properties.

In the software, an editable collection of sample names to use in experiments. The
samples in the library contain the sample name and the sample color. The samples in
the library may also contain comments about the sample.

In genotyping experiments, the combination of the sample to test and the SNP assay to
perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantification experiments, the combination of the sample to test and the target to
detect and quantify in one PCR reaction.

An optional software module that provides:

e System Security — Controls user access to the software. A default Administrator
user account is provided, and you can define additional user accounts and
permissions.

* Auditing — Tracks changes made to library items, actions performed by users, and
changes to the Security and Audit settings. The software automatically audits
some actions silently. You can select other items for auditing and specify the audit
mode. Provides reports for audited library items, Security and Audit changes,
and actions.

¢ Electronic Signature (eSignature) — Controls whether users are permitted,
prompted, or required to provide a user name and password when accessing
certain software features. You can select which features are controlled and the
number of signatures required for access. When authorized persons use this
feature, they are creating a legally binding signature.

In the software, a numeric value that defines the sequence of quantities in the standard
curve. The serial factor and the starting quantity are used to calculate the standard
quantity for each point in the standard curve. For example, if the standard curve is
defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points
in the curve is 10-fold.

Regression coefficient calculated from the regression line in the standard curve. The
slope indicates the PCR amplification efficiency for the assay. A slope of -3.32 indicates
100% amplification efficiency.

See also amplification efficiency (EFF%) and regression line.

Single nucleotide polymorphism. The SNP can consist of a base difference or an
insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the
SNP and two probes to detect different alleles.

In the software, an editable collection of SNP assays to add to genotyping experiments.
The SNP assays in the library contain the SNP assay name; SNP assay color; and for
each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP
assays in the library may also contain the assay ID and comments about the SNP assay.
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In the thermal profile, a group of one or more steps. Examples: PCR stage, cycling
stage (also called amplification stage), and hold stage.

A sample that you dilute and amplify along with unknown samples. This dilution
series can contain known starting quantities of the target of interest (absolute standard
curve) or it can be of known dilution factor (relative standard curve). Following the
run, the software interpolates the Cy values of the unknowns to this curve, yielding
either specific quantities of the target (for absolute curves) or relative quantities (for
relative dilution curves).

See also standard curve.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the
standard curve reactions are used to generate the standard curve. The standard
curve is defined by the number of points in the dilution series, the number of
standard replicates, the starting quantity, and the serial factor.

Method for determining absolute target quantity in samples. With the standard curve
method, the software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate
the standard curve. Using the standard curve, the software interpolates the absolute
quantity of target in the samples.

See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards
containing a range of known quantities. The standard dilution series is prepared by
serially diluting standards. For example, the standard stock is used to prepare the first
dilution point, the first dilution point is used to prepare the second dilution point, and
so on. In the software, the volumes needed to prepare a standard dilution series are
calculated by the number of dilution points, the number of standard replicates, the
starting quantity, the serial factor, and the standard concentration in the stock. See also
standard curve.

In the PCR reaction, a known quantity. In standard curve experiments, the quantity of
target in the standard. In the software, the units for standard quantity can be for mass,
copy number, viral load, or other units for measuring the quantity of target. Standard
quantity can also refer to dilution factor.

When defining a standard curve in the software, the highest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set
the ramp rate (ramp increment for melt curve steps), hold temperature, and hold time
(duration).You can turn data collection on or off for the ramp or the hold parts of the
step. For cycling stages, a step is also defined by the AutoDelta status.

PCR reaction components that consist of two primers designed to amplify the target
and SYBR® Green dye to facilitate detection of the PCR product.
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Dye supplied by Applied Biosystems and precalibrated on the ViiA™ 7 System. Before
you use system dyes in your experiments, make sure the system dye calibration is
current in the Instrument Console.

The system dyes are:
o FAM™ dye
e JOE™ dye
o ROX™ dye
e NED"dye
* SYBR® Green dye
e TAMRA™ dye
e VIC®dye

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence to amplify and detect.

In the software, a color assigned to a target to identify the target in the plate layout and
analysis plots.

In the software, an editable collection of targets to use in experiments. Targets in the
library contain the target name, reporter, quencher, and target color. The targets in the
library may also contain comments about the target.

In the software, the type of reaction performed in the well for the target or SNP assay.
Available tasks:

¢ Unknown

* Negative Control

¢ Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

e IPC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)

Wells containing identical reaction components, including sample; important for
evaluating precision.

In the software, a display of temperatures for the instrument cover and instrument
block during the instrument run.

The type of nucleic acid to add to the PCR reaction.

A user-created file that contains experiment setup information (experiment type,
sample names, target name, and thermal conditions) to be used as a starting point for
new experiment setup. Template files have an .edt extension.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the instrument run.
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threshold

threshold cycle (Cy)

Tm
touchscreen

uniformity
calibration

unknown

unknown-IPC wells

y-intercept

* In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region. For the Baseline Threshold algorithm, the threshold
can be determined automatically (see automatic threshold) or can be set manually
(see manual threshold).

* In presence/absence experiments, the level of fluorescence above which the
software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the
amplification plot.

See melting temperature (T},).
Instrument display that you touch to control the instrument.

Type of calibration in which the software measures sample block uniformity. The
calibration generates data that compensate for the physical effects of the ViiA™ 7
System filters on data collected during an experiment.

In the software, the task for the target or SNP assay in wells that contain the sample
being tested. In quantification experiments, the task for the target in wells that contain
a sample with unknown target quantities. In genotyping experiments, the task for the
SNP assay in wells that contain a sample with an unknown genotype. In presence/
absence experiments, the task for the target in wells that contain a sample in which the
presence of the target is not known. In melt curve experiments, the task for the target
in wells that contain a sample with an unknown melt curve profile.

In presence/absence experiments, wells that contain a sample and internal positive
control (IPC).

In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (Ct) for a sample with quantity equal
to1.
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A

AIF 29

AIF 29

AIX 29

allele 29

allelic discrimination plot 29
amplicon 29

amplification 29
amplification efficiency (EFF%) 29
amplification plot 29
amplification stage 29
Analysis Protocol Library 29
assay 30

Assay ID 30

assay index file 29

assay information file (AIF) 30
AutoDelta 30

automatic baseline 30
automatic threshold 30

background calibration 30
baseline 30

baseline-corrected normalized reporter (DRn) 30

biohazardous waste, handling 22
biological replicate 31
blocked IPC 31

C

Calibration and verification consumables

384-well 6

96-well (0.2uL) 7

array card 7

Fast 96-well (0.1uL) 7
calibrator 31
chemical safety 19
chemical waste safety 20, 21
comparative CT method 31
Ct algorithm 31
cycle threshold 31, 32
cycling stage 31

D

data collection 32
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Index

delta Rn 32
diluent 32

dye calibration 32
Dye Library 32

E

efficiency correction 32
electrical safety 16
endogenous control 32
endpoint read 32
ergonomics, safety 17
error 32

experiment consumables 8
experiment document 33
experiment name 33
experiment type 33
expiration date 6

export 33

F

filter 33
flag 33
forward primer 33

G

genotyping experiment 34
guidelines
chemical safety 19
chemical waste disposal 20
chemical waste safety 21

H

hazard icons. See safety symbols, on instruments 12
hazard symbols. See safety symbols, on instruments
hazards. See safety

Help system 27

heterozygote 34

holding stage 34

homozygote 34

housekeeping gene 34

import 34
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Index

installation outlier 36

category 16 overvoltage category (rating) 16
instrument

operation, safety 15 P

Instrument Console 34

Instrument Manager 34 package label 6

internal positive control (IPC) 34 P a551've reference 36
inventoried assays 34 physical hazard safety 16

IPC blocking agent 34 plate layout 36

plate setup file 36
positive control 37

L post-PCR read 37
laser classification 17 pre-PCR read 37
laser safety primer mix 37

bar code scanner 17 primer/probe mix 37

requirements 17 pure dye 37

M Q

made-to-order assays 35 quantification method 37

manual baseline 35 quantity 37
manual CT 35 quencher 37
melt curve 35 QuickStart 37
melting temperature (Tm) 35
moving and lifting safety
! R

computers and monitors 15

instrument 15 radioactive waste, handling 21
moving parts, safety 16 ramp 38
multicomponent plot 35 ramp speed 38

raw data plot 38

N RDML 38

) reaction mix 38
negative control (NC) 35 reagents 38
real-time PCR 38
reference sample 38
refSNP ID 38

region of interest (ROI) calibration 38

negative control-blocked IPC wells 35
negative control-IPC wells 35

no amplification control (NAC) 35

no template control 35

nonfluorescent quencher-minor groove binder 36 . .
o D regression coefficient 38
normalization calibration 36 . -
) ) regression coefficients 38
normalized quantity 36 ion li
lized quantity mean 36 regression [ine 35
normal. i 9 t'ty SE 36 reject well 39
norma;zed quantity Re) 36 relative standard curve method 39
normalized reporter (Rn) repetitive motion, safety 17

NTC 35 replicate group 39
replicates 39

0 reporter 39

omit well 36 reverse primer 39

Ordering Information 5 reverse transcriptase 39
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ROX™ dye 39
run method 39

S

safety
bar code scanner 17

before operating the instrument 15

biological hazards 22
chemical 19
chemical waste 20
electrical 16
ergonomic 17
guidelines 19, 20, 21
instrument operation 15
laser 17
moving and lifting 15
moving parts 16
physical hazard 16
repetitive motion 17
ultraviolet light 16
workstation 17
safety labels, on instruments 14
safety symbols, on instruments 12
sample 39
sample definition file 40
Sample Library 40
sample/SNP assay reaction 40
sample/target reaction 40
SDSs
description 20
obtaining 20
security and auditing 40
serial factor 40
slope 40
SNP 40
SNP assay 40
SNP Assay Library 40
stage 41
standard 41
standard curve 41
standard curve method 41
standard quantity 41
starting quantity 41
step 41
SYBR® Green dye 41, 9
symbols, safety 12
system dye 42
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.

TagMan® Reagents 9, 42
target 42

target color 42

Target Library 42

task 42

technical replicate 42
Temperature Plot 42
template 42

template file 42
threshold 43

threshold cycle 43
threshold cycle (CT) 43
training, information on 27

U

ultraviolet light, safety 16
uniformity calibration 43
unknown 43
unknown-IPC wells 43

W

waste disposal, guidelines 21

waste profiles, description 21

workstation safety 17

Y

y-intercept 43

Index
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